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GE Communicator EXT

Chapter 1: Installing GE 
Communicator EXT 
1.1

GE Consumer & Industrial
Multilin

Installing GE Communicator EXT 1.1

1.1 System Requirements 

• IBM-PC Compatible, Pentium 200MHz or better 

• Windows® 98 with Service Pack 1 or Release 2; NT 4 with Service Pack 5; 
Windows® 2000 with at least Service Pack 1 

• 32 MB RAM 

• XVGA Card and Monitor with 1024x768 and 65k colors 

• Available RS-232 Serial Port 1.2: 
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1.2 Installing GE Communicator EXT Software 

GE Communicator EXT can be used with the following GE meters: All EPM 4000, 5000, 6000, 
7000 and 9000 Series Meters.

Double-click on the GE Communicator EXT Setup.exe icon and 
follow the on-screen instructions. 
The Read Me File provides Version Numbers and Dates for the GE 
Communicator EXT Setup and the component files. 

Note If necessary, Setup will update your computer’s Windows® files to make them compatible 
with GE Communicator EXT. After the Windows® files have been updated, GE 
Communicator EXT may sometimes have to be installed a second time. 
Screen messages will guide you through this process. 
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1.3 GE Communicator EXT Basic Screen Elements

Start up Screen: Displays the version number of the GE Communicator EXT software. To 
view a similar screen at any time, select Help, About GE Communicator EXT. An additonal 
button, System Info, can provide Microsoft system information. Click OK to exit the screen. 

Menu Bar: Accesses all GE Communicator EXT commands and screens. 

Computer Status Bar: Displays communication information about the computer — not the 
meter connected to it . Enable or disable the Status Bar from the View menu.  

FIGURE 1–1: GE Communicator EXT Start-up Screen
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1.3.1 Menu Bar Icons 

Access to all GE Communicator EXT features: 

• Profile: Retrieves the Device Profile from the currently connected meter. 
Same as selecting Tools > Edit Current Device Profile. 
Use to configure the meter. (See Chapters 3, 4, 5.) 

• Retrieve Logs: Downloads logs from the currently connected meter to the 
computer. 
Same as selecting Logs > Retrieve Log(s) from Device. (See Chapter 8.) 

• Open Log: Opens a previously retrieved EPM Log File. 
Same as selecting File > Open > EPM Log File. (See Chapter 8.) 

• Connection Manager: Establishes communication between the computer and 
multiple meters at local or remote sites. 
Same as selecting Connection > Connection Manager. (See Chapter 2.)

• Connect: Establishes communication between the computer and one directly 
connected meter. 
Same as selecting Connection > Quick Connect . (See Chapter 2.) 

• Disconnect: Terminates the connection between the computer and the currently 
connected meter(s). 
Same as selecting Connection > Disconnect . (See Chapter 2.) 

• Polling: Displays instantaneous polling data from the currently connected meter. 
Same as selecting Real-Time Poll > Instantaneous Polling. (See Chapter 7.) 

• Energy: Displays Power and Energy readings from the currently connected meter. 

• THD: Displays magnitude and angle readings for Volts and Current values. 
Spectrum presents selected magnitude in a bar graph. Waveform combines 
magnitudes and angles in a graph. 

• Phasors: Displays a three-phase phasor diagram and data from the currently 
connected meter. 
Same as selecting Real-Time Poll > Phasors. (See Chapter 7.) 

• EN 50160 Flicker: Displays Instantaneous, Short Term and Long Term Readings. 
Same as selecting Real Time Poll > Power Quality & Alarms > Flicker. (See 
Chapter 16.)

• Log Status: Displays logging statistics for the currently connected EPM meter. 
Same as selecting Logs > Statistics. (See Chapter 8.) 

• Device Status: Displays list of the currently connected meter(s). 
Same as selecting Tools > Device Status. (See Chapter 2.) 

• Alarms: Displays the Limit Status Screen for EPM 9450Q, 9650Q, 9800Q, 7450D and 
5300P. 
Same as selecting Real Time Poll > Power Quality & Alarms > Alarm Status. (See 
Chapter 9.) 
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1.3.2 Computer Status Bar (Modem)
When using Serial Port or Modem Connection to the meter: 

• Connection Status: displays either “Connected”, “Disconnected” or “Not Found”. 

• Communication Port: displays the computer port currently in use for the 
connection.

• Baud Rate: displays the baud rate of the computer’s communication port. 

• Device Address: displays the address of the connected device. 

• Device Name: displays the name of the connected device. 

• Communication Protocol: displays the communication protocol currently in use. 

• Date and Time: displays the computer’s current date and time. 

• Protection Status: displays whether the password protection feature is enabled or 
disabled. 
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1.3.3 Computer Status Bar (Network)
When using Network Connection to the meter: 

• Connection Status: displays either “Connected”, “Disconnected” or “Not Found”. 

• Communication Port: displays the computer port currently in use for the 
connection.

• Network Protocol: displays the protocol being used for communication to the 
network. 

• Device Address: displays the (network) address of the connected device. 

• Device Name: displays the name of the connected device. 

• Communication Protocol: displays the protocol used for communication to other 
devices. 

• Protection Status: displays whether the password protection feature is enabled or 
disabled. 

• Low Battery / Modem Battery Status: displays “Low Bat EPM” on the EPM 9800 
when the meter requires a battery and if the Internal or Modem battery is low, 
dead or missing. 
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1.4 Help

1.4.1 Help Menu 
Displayed above; it provides the following sources of information: 

Contents 

Click on the Contents button to display the Index Page of the Help 
Files. 

To access Links to Topics, click on the Bookmarks tab and scroll 
through Chapters. 

Double-click on Chapter to view all topics in that chapter. 

Click on Topic to view Help on that topic. 

Check for Software Updates 

Click on Software Updates. GE Communicator EXT will 
automatically search the GE website for updates for you. 
If the software does find updates, GE Communicator EXT will ask 
you if you would like to “Update Now?”

You can click Yes or No. 

Average File Size is 20MB. High Speed Internet access is recommended. 

About GE Communicator EXT 

Screen displays software version number and Microsoft® systems information. It is similar 
to the Start Up screen discussed in section 1.3.
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1.5 Software License 

GE Communicator EXT V3.0 is shipped to the user in DEMO MODE. While the software is in 
DEMO MODE, it can be installed into your computer and used with a GE meter. However, 
while in DEMO MODE, some features are disabled or limited.  A list of those features 
appears below. 

Installation is easy. An installation screen will walk you through the simple process. Once 
installation is complete, you will have to restart your computer to finish the installation. 

Enter Registration Number for Full Access 

To access all the features of the software, you must enter a 
Registration Number (see below). 
The Registration Number is a 20-digit number supplied to the 
licensee by GE at the time software is purchased. 

How to purchase software

Contact your Regional Sales Representative 

How to Enter the Registration Number

From the Help Menu, click Software License. 

Type in the 20-digit Registration Number. After Registration 
Number is entered, a small screen appears validating registration.

DEMO MODE - Disabled and Limited Features 

1. No Device Address greater than “1” can be used and no I/O Modules can be 
used. 
If you change the address to anything but “1”, you will not be able to 
communicate with the meter. 

2. Some Log Viewer Features are disabled: 

• Cannot view data from multiple devices. 

• Cannot run multiple instances. 

• Cannot print pages to a printer. 
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3. Script & Scheduler Features disabled: 

• Cannot print pages to a printer. 

4. Script & Scheduler Features Limited: 

• Scheduler only runs one script. 

• Each Script only allows one device at Address 1. 
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1.6 Feature Comparison for Advanced Models 

Advanced Meters are available in three models, each with an array of features. The Table 
below shows the Advanced Models with possible features for each model. 

Table 1–1: Advanced Meter Models with Features

Feature EPM 
9450*****

EPM 
9650*****

EPM 
9800*****

Waveform Full Scales Yes Yes Yes 

Transformer Loss Compensation Yes Yes Yes

*Trending Setup for Historical 
Logs 

Yes Yes Yes

**PQ & Waveform Thresholds Yes Yes Yes 

Pulse Accumulations Yes Yes Yes

Program External I/O Modules Yes Yes Yes

Programmable Onboard Display Yes

Test Mode Yes

DNP Level 1 + Custom Class Map Yes

DNP Level 2 + Custom Class Map Yes Yes

Internal KYZ Output Option Yes

Custom Modbus Map Level 1 2 2

***Network Card Runtime 
Update

Yes Yes Yes

INP2 Modem with Dial Out 
Option

Yes Yes Yes

INP100 Total Web Solutions Yes Yes Yes

INP102 Combo Card Yes

****View Logs Yes Yes Yes

Flicker Yes Yes

****Energy Billing Module Yes Yes Yes

****Script & Scheduler Yes Yes Yes

17V Internal Power for I/O 
Modules to 12VA

to 12VA to 12VA

Scaled Energy Yes

Programmable Rollover Yes Yes
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* With 512 K or higher memory.

** With 2 MEG or higher memory.

*** INP10, INP100 and INP102 Only.

**** MUST use Licensed version of GE Communicator EXT to access this feature.
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1.7 Options 

Select Options from the View menu. 

Click tabs to show the following screens:

Paths

View or change the paths Communicator EXT uses to store any 
copied, exported or retrieved data. 
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Data Scan Mode 

Select Normal Scan Rate or create Custom Scan Rate between 0 and 65535 scans per 
millisecond. 

Tech Mode Settings

Enter Password to enable Tech Mode. If a Password is not entered, 
Tech Mode will remain disabled.  
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Log Retrieval

Click the first box on this screen to keep a log from being updated 
while it is being retrieved. 

Click the second box to disable Backup of the retrieved log file.

Click the third box to enable the software to insert missing records 
(from when meter is not in Normal Operation Mode and therefore 
not recording) with value of 0 for each log retrieval process. 

Energy Billing Module

Click the box on this screen to enable the Energy Billing Module.
The Energy Billing Module can help you manage your Load Profile. 
(See Chapter 14.) 

Miscellaneous 

Click the box on this screen to enable the Kh/Ke Test Pulse 
Calculation screen. Set the Ethernet Packet Delay in milliseconds. 
Some systems may require a longer delay if they are slow. 

Make any adjustments using the Browse buttons. 

Click Apply to execute the changes. 

Click OK to return to the main GE Communicator EXT screen. 
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GE Communicator EXT

Chapter 2: Connecting to a GE 
Meter

GE Consumer & Industrial
Multilin

Connecting to a GE Meter

2.1 Overview 

There are six ways to connect to a GE Meter: 

• RS-232 Direct Connect (section 2.2) 

• RS-485 Direct Connect (section 2.2) 

• RS-232 Modem Connect (section 2.3) 

• RS-485 Modem Connect (section 2.3) 

• RS-485 Internal Modem Option (section 2.4) 

• RS-485 Internal Network Option (section 2.6) 

Direct Connections made through GE Communicator EXT must use either Modbus RTU or 
Modbus ASCII protocol. Modbus RTU is recommended. 

Modem Connections (Internal or External) made through GE Communicator EXT must use 
Modbus ASCII only. 

Network Connections made through GE Communicator EXT must use Modbus TCP. 

Section 2.5 details connecting to multiple meters on an RS-485 bus. 

Consult the meter’s Installation and Operation Manual for details of the hardware 
requirements for each configuration. 

Note EPM 9650 and EPM 9800 include customizable DNP V3.00 Level 2. 

Note If you are using the Connection Manager to connect a PC to a meter, you may want to 
copy the Connection Manager Settings to other PCs. Simply copy the file Cnexcom.mdb 
from Computer A to Computer B using the same directory for source and destination. 
Use the following steps: 
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Using the originate computer, go to the drive where the file is 
installed. 
For example: C:\Program Files\GE\GE Communicator directory. 

Copy the file Cnexcom.mdb (this is the database that contains the 
Connection Manager Settings). 

Replace the Cnexcom.mdb file on the destination computer with 
the copy from the previous step. 

Note Make sure GE Communicator EXT is not running on the destination computer when 
replacing the file. 
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2.2 Direct Serial (RS-232, RS-485) and Network Connections 

This section details connecting directly to one GE device. See sections 2.3 and 2.4 for 
modem connections. 
To connect to multiple GE units on an RS-485 bus, see sections 2.4 and 2.5. 

2.2.1 Serial Connections 
Insert an RS-232 or RS-485 cable into an available serial port on the 
computer. 

• RS-232: Insert the opposite end of the cable into the GE Meter’s 
RS-232 port (9450/9650 - Port 1; 9800 - Optical Port). Set 9450/
9650 selector switch. 
See Chapter 6 of the EPM 9800 Installation and Operation Manual 
for details on the special Optical Port connection. 

• RS-485: Insert the opposite end of the (RS-232) cable into the RS-
232 port of an RS-232/RS-485 converter, if required. (See the 
meter’s Installation and Operation Manuals for details). 
Use an RS-485 cable to connect the RS-485 converter output to 
any port on the EPM 9450 or 9650. If you use Port 1, set the 
selector switch to RS-485. For EPM 9800, use Port 1 or Port 4. 

Click the Connect button on the tool bar or select Connect > Quick 
Connect . The screen below appears. 

Note If you click the Network button, the screen changes to the Network screen.

. 

Enter settings for Serial Port Connection: 

• In the Device Address field, enter the address of the device’s port 
to which the computer is connected. Meters are programmed for 
your specific applications. Some EPM 9800 units are shipped 
programmed with the following preset addresses and baud rates: 



2–4 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

DIRECT SERIAL (RS-232, RS-485) AND NETWORK CONNECTIONS CHAPTER 2: CONNECTING TO A GE METER

Port 1: Address 1, 57600 baud (first time connection, leave 
Address set at 1) 

Port 2: Address 1, 57600 baud (fixed Optical Port on EPM 9800) 

Port 3: Address 1, 9600 baud (EPM 9450/9650 Only) (for External 
Display or I/O Modules) 

Port 4: Address 1, 57600 baud, Master/Slave (for External I/O 
Modules) 

Note You may use a connected External Display to view each port’s baud rate, address and 
communication protocol. See the meter’s Installation and Operation Manuals for details. 
See Chapter 3 (EPM 9450/9650), Chapter 4 (EPM 9800) and Chapter 5 (EPM 4000, 5000, 
6000, 7000 Series Meters) for details of how to configure the meter’s communication ports. 

In the Baud Rate field, enter a baud rate that matches the baud 
rate of the device’s port to which your computer is connected. 
The port’s baud rate, address and protocol must always match the 
baud rate, address and protocol of the computer.  

In the Serial Port field, enter the computer’s communication port 
into which the RS-232 cable is inserted. 
Most computers use Com 1 or Com 2 for the serial port. 

In the Protocol field, enter the type of communication the GE Meter 
port is using. 
Direct Connections made through GE Communicator EXT must use 
either Modbus RTU or Modbus ASCII. Modbus RTU is recommended. 
All meter port defaults are Modbus RTU and the meters are shipped 
set to Modbus RTU. 

In the Flow Control field, enter None or Hardware. 
EPM setting should be None. 
PM 6000 IrDA setting is Hardware. 

Example: in the sample screen above, the computer’s Com Port 2 has been set to operate 
at 57600 baud, using Modbus RTU to communicate with a meter port located at address 1. 
The baud rate, address and protocol set for the computer’s Com Port 2 match those of the 
meter port. 

If the connection fails, make sure an approved Category 5 Cable is connected to the 
Network Jack and that the Link Light on the GE Device is illuminated. 

2.2.2 Network Connections 

At the Remote (Meter) Location

Insert an RJ-45 line into the RJ-45 port on the face of an EPM 9450/
9650 Meter that has an Internal Network Option. 
A connection for an EPM 9800 Meter with the Ethernet Option is 
made by inserting an RJ-45 line into the RJ-45 Network port. 
Make an RJ-45 connection for other GE meters. 
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At the Originating (Computer) Location

Click the Network radio button on this screen. 
The screen changes for Network settings. 

Enter settings for Network Connection. (See your Network 
Administrator for correct settings.) 

In the Device Address field, enter 1. 

In the Host field, enter an IP Address or a Registered Name. (See 
your Network Administrator). 

In the Network Port and Protocol fields, the example settings are 
probably correct. 
Check with your Network Administrator to be sure. 

Click Connect . 
GE Communicator EXT locates the meter and the Device Status 
screen appears, confirming the connection. (See section 2.8 for 
details). 

Click OK. 
The computer is now connected to the meter. 

The Computer Status Bar at the bottom of the screen confirms the computer’s 
connection parameters. Status Bars will differ slightly for the two connections. 

Note You may use an internal or external display to view the baud rate, address and 
communication protocol of each port. 
See Chapters 3,4,5 for details of how to configure the meter’s communication ports. 

Note For details on Network Hardware Connections, refer to the Network sections of the 
meter’s Installation and Operation Manuals.  
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2.3 Serial (RS-232, RS-485) Modem Connections 
Note For an RS-485 Internal Modem Option Connection see section 2.4 below.

Modem Connections Require Modbus ASCII Protocol. 

The meter’s communication port that you use for the modem connection, must be 
configured to speak/listen to Modbus ASCII and operate at either 9600 baud or match the 
speed of the remote modem. 

Note Modbus RTU does not support modem communication. If you use Modbus RTU to 
communicate with a modem, it will fail or be unreliable. 

2.3.1 Before Setting the General Configuration
Establish a direct RS-232 or RS-485 connection to the meter. (See 
section 2.2.)

After you have established a direct connection, refer to Chapter 3 
(EPM 9450/9650) and Chapter 4 (EPM 9800) for details on how to 
configure the meter’s communication ports. 

Set the port to Modbus ASCII at 9600 baud. (If you are connecting to 
multiple meters on a bus, you must also assign a unique address to 
each meter; see section 2.5.) 

Install the modem connected to the computer (the “originate 
modem”) and the modem connected to the GE meter (the “remote 
modem”). 
See the Installation and Operation Manuals for the meter(s) in use 
for details of the hardware requirements. 

2.3.2 At the Remote (Meter) Site...
If you are using RS-232 communications without a Modem Manager:

Set the remote modem to operate at 9600 baud (remote and 
originating). 

Disable Hardware Flow Control (remote and originating). 

If you are using RS-485 Communication with a Modem Manager (recommended by 
G.E.): 

Set the baud rate for the meter higher (up to 38400). 
Generally, it will provide reliable communication. 

Enable Flow Control  (remote and originating). 

Note Because a GE meter’s four ports operate independently, you need only configure the 
address and baud rate of the port that will be connected to the bus. 
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2.3.3 On the Originating Computer...
Click on the Connection Manager icon, or select Connection > 
Connection Manager. 
The following screen appears: (To copy the Connection Manager 
Settings to other PCs, see Note on page 2-1.) 

Adding a Location

Click on the Add button. 
The Location Editor screen appears, displaying the computer’s 
communications settings and the location name "New Location":
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Enter your Location Name in the Location Name field at the top of 
the screen, replacing "New Location". 

2.3.4 Handling Multiple Locations
If you already have several locations on your List of Locations:  

To add additional locations, click on the Add Button. 

To sort locations, use the pull-down menu to select a sort method, 
A to Z, Z to A, Newest-->Oldest or Oldest-->Newest, and click Sort 
By. 

To remove locations, select and click Remove. 

Click once on the location to which you would like to connect your 
computer. 
You may only connect to one location at a time. 

To change to a different location, you must first disconnect from 
the current location by clicking on the Disconnect button or by 
selecting Disconnect from the Connection menu. 

Choose your new location.

Click Connect . 
The computer begins dialing.

When GE Communicator EXT has located the GE meter(s) at the selected location, 
the Device Status screen appears, confirming the connection (see section 2.8 for 
details). The Computer Status Bar at the bottom of the screen confirms the 
computer’s connection parameters. 
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2.3.5 Setting Up the Originate (Computer) Modem
In the Com Port field, enter the computer’s communication port 
connected to the computer’s modem (the "originate" modem). 

In the Baud Rate field, enter a baud rate for the computer’s 
modem, that will match the baud rate of the "remote" modem and 
the meter port. 

In the Flow Control field, select the remote (meter) modem’s 
configuration. 

Leave the Data Bits field at 8 for Modbus ASCII. Other protocols 
may require a different setting. 

Leave the Parity field at None for Modbus ASCII. 
Other protocols may require a different setting. 

Click the Use Modem box. 

Enter the Phone Number of the remote modem. 

Enter a setup string in the Setup String field if this originate 
modem has been used for another program and needs to be reset. 

Use the Data Switch section to send any Data Switch strings to the 
remote modem. 
The typical Data Switch string from a meter to the Substation 
Multiplexor to a PC:  ,,%%%,,PTnn 

Check the manual for the device you are using in order to create 
the Data Switch String appropriate for this device. 
Typical characters used include:

 ,  (pause one second) 

%%%  (escape sequence or switch to command mode) 

PTnn  (command) (number 01-16) 

Enter  ( <CR> ASCII character 13 ) 

2.3.6 Adding New Devices (Meters) to a Location
Click on the Add button in the Devices at Location section to add 
meters to this location. 

Select the new device and click on the Edit button to edit its 
location information. 
The Location Device Editor screen appears, displaying the meter’s 
communications settings.
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In the Device Address field, enter the address assigned to the 
meter port you will use for this connection. 
If you are connecting to multiple meters, each one should have a 
unique address. See section 2.5. 

In the Name field, enter a unique name for the device at the 
location. 

In the Protocol field, select MODBUS ASCII. 
Be sure the port has been previously set to Modbus ASCII, as 
detailed in Step 1. 

Leave the Device Type field set to type of meter. 

Set the Com Port . 

Click on the Close button when all information is entered. 

2.3.7 If the Connection Fails 
Check that all cables are secure.

Check that the RS-232 cable is connected to the correct Com Port 
on the computer

Check that the computer and the GE device(s) are set at 9600 baud 
using Modbus ASCII.
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2.4 RS-485 Internal Modem Option Connection 

Internal Modem Option Connection Requires Modbus ASCII Protocol. 

Some meter models offer an Internal Modem Option, which eliminates all the modem 
hardware and cable that used to be required for a modem connection. A modem 
connection to the meter is now as simple as plugging in a phone line. 

At the originate end, simply install a modem inside the computer (the originate modem) 
and connect a phone line. At the remote (meter) end, the meter must be configured to 
speak Modbus ASCII. (Modbus RTU does not support modem communication. If you use 
Modbus RTU to communicate with a modem, it will fail or be unreliable.) The meter’s 
Internal Modem Option may operate at a programmable baud rate up to 57600. We 
recommend this baud rate. 

To set the overall configuration, you must: 

Install the computer’s modem (the “originate modem”). 
See the Installation and Operation Manual for the meter in use, for 
details of computer’s hardware requirements. 

Set the originate modem to operate at 57600 baud 

Enable Hardware Flow Control. 
See Note about Baud Rate in Step 5 below. 

2.4.1 At the Remote (Meter) site... 
Plug a phone line into the meter. 
The address will be 1. (If you are connecting to multiple units on a 
bus, you must also assign a unique address, other than 1, to each 
additional unit. See section 2.5.) 

Note Because a GE meter’s four ports operate independently, you need only configure the 
address and baud rate of the port that will be connected to the bus. 

2.4.2 On the Originating Computer... 
Click on the Connection Manager icon, or select Connection > 
Connection Manager. 
The following screen appears: (To copy the Connection Manager 
Settings to other PCs, see Note on page 2-1.) 
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2.4.3 Adding a Location
Click on the Add button. 
The Location Editor screen appears, displaying the computer’s 
communications settings and the location name "New Location":

Enter your Location Name in the Location Name field at the top of 
the screen, replacing "New Location": 
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2.4.4 Handling Multiple Locations
If you already have several locations on your List of Locations:  

To add additional locations, click on the Add Button. 

To sort locations, use the pull-down menu to select a sort method, 
A to Z, Z to A, Newest-->Oldest or Oldest-->Newest, and click Sort 
By. 

To remove locations, select and click Remove. 

Click once on the location to which you would like to connect your 
computer. 
You may only connect to one location at a time. 

To change to a different location, you must first disconnect from 
the current location by clicking on the Disconnect button or by 
selecting Disconnect from the Connection menu. 

Choose your new location.

Click Connect . 
The computer begins dialing.

When GE Communicator EXT has located the GE meter(s) at the selected location, 
the Device Status screen appears, confirming the connection (see section 2.8 for 
details). The Computer Status Bar at the bottom of the screen confirms the 
computer’s connection parameters. 

2.4.5 Setting Up the Originate (Computer) Modem
In the Com Port field, enter the computer’s communication port 
that is connected to the modem (the originate modem). 

In the Baud Rate field, enter 57600 (recommended baud rate for 
internal modem connections).

Note For modems prior to V.90, use a lower baud rate. Example: 38400 for a 33.6k modem, 
19200 for a 14.4k modem. 

In the Flow Control field, select the originate modem’s 
configuration - hardware flow control. 

Leave the Data Bits field at 8 for Modbus ASCII. 
Other protocols may require a different setting. 

Leave the Parity field at None for Modbus ASCII. 
Other protocols may require a different setting. 

Click the Use Modem box. 

Enter the Phone Number of the Internal Modem of the meter. 

Enter a Setup String in the Setup String field, if required. 
For U.S. Robotics modems, the data switch (Setup) string is: &F1  
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Check with the manual for the device you are using in order to 
create the Data Switch String appropriate for the device. 

2.4.6 Adding New Devices (Meters) at one Location
Click on the Add button in the Devices at Location section if you 
want to add (up to 31) GE units at that location. 

To remove devices, select and click Remove. 

Use Port 2 (EPM 9450/9650) or Port 3 (EPM 9800) of the Internal 
Modem Option meter to add additional units. 

Each unit must be configured to speak Modbus ASCII and set to 
the same baud rate as the primary unit.

Note Additonal units DO NOT have to be Internal Modem units.

 

Select each new device and click on the Edit button to edit its 
location information. 
The Location Device Editor screen appears, displaying the GE 
unit’s communication settings.

 

In the Device Address field, enter the address assigned to each 
additional GE unit. 
Each meter MUST have a unique address other than 1; see section 
2.5. 

In the Name field, enter a name for the device that will 
differentiate it from any others at that location. 

In the Protocol field, select MODBUS ASCII. 

Leave the Device Type field set to type of meter. 
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Set the Comm Port . 

Click on the Close button when you have finished adding or 
removing devices. 
The first Connection Manager screen returns. 

2.4.7 If the Connection Fails
Check that all cables are secure; that the RS-485 cable is connected to the Modem 
Gateway on the Modem unit and that other GE units are set at 57600 baud using Modbus 
ASCII. 
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2.5 Internal Network Option Connection 

Internal Network Option Connection Requires Modbus TCP Protocol. 

Some meter models offer an Internal Network Option, which allows them to communicate 
over a network. Connection to a network is now as easy as plugging in a phone. Simply 
connect a meter to a computer using Port 1 (EPM 9450/9650) or Port 3 (EPM 9800) to 
configure the network parameters and add a network connection. The meter must be 
configured to speak Modbus TCP. (Modbus TCP is the common protocol used for Modbus 
communication over a network.) 

Note The Internal Network Option operates internally at a fixed Baud Rate of 115200. The 
Gateway operates as a Modbus RTU Master with a programmable Baud Rate up to 
115200. 

Note For Direct Connection, refer to section 2.2 of this manual. 

2.5.1 To Set the Configuration
Connect the network to the computer using Port 1. 
See the meter’s Installation and Operation Manuals for details of 
the hardware requirements. 

At the RJ-45 Ethernet connection jack on the meter, plug in a 
network connection. 

Click on the Connection Manager icon, or select Connection > 
Connection Manager. 
The following screen appears: (To copy the Connection Manager 
Settings to other PCs, see Note on page 2-1.)
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2.5.2  Adding a Location
Click on the Add button. 
The Location Editor screen appears, displaying the computer’s 
communications settings and the location name "New Location":

Enter your Location Name in the Location Name field at the top of 
the screen, replacing "New Location": 

 

Click on the Network button. 
The screen will change to the following: 
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In the Host field, enter the meter’s IP Address. 

In the Network Port field, enter 502 (assigned port for Modbus 
TCP). 

2.5.3 Handling Multiple Locations
Click once on the location to which you would like to connect your 
computer. 
You may only connect to one location at a time. 

To change to a different location, you must first disconnect from 
the current location by clicking on the Disconnect button or by 
selecting Disconnect from the Connection menu. 

Click Connect . 
The computer connects to the meter via the network. 

When GE Communicator EXT has located the device(s) at that location, the Device 
Status screen appears, confirming the connection (see section 2.9 for details). The 
Computer Status Bar at the bottom of the screen confirms the computer’s connection 
parameters. 

2.5.4 Adding New Devices (Meters) at one Location
To add or remove devices to the network, click on the Add button. 

To remove a device, select and click Remove. 
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If you are adding a device, click on Edit to change the device Name, 
Address and/or Description. 
The following screen will appear: 

Ethernet Gateway (Port 2 - EPM 9450/9650) (Port 3 - EPM 9800) of the Internal Network 
Option meter is used to add multiple additional units. Additional units must be 
configured to speak Modbus RTU and set to the same Baud Rate (up to 115200) as the 
Internal Network Option meter (set in section 3.5 (EPM 9450/9650) or 4.5 (EPM 9800). 

Note A computer “talks” to the Internal Network Option meter via Modbus TCP. This meter 
receives data in Modbus TCP “incoming message format” and communicates with other 
devices via Modbus RTU. The other meters do not have to be Internal Network Option units.

If additional devices are required, in the Device Address field, 
enter the Address assigned to the additional unit. 
Each unit MUST have a unique address other than 1; see section 
2.5.  “1” is reserved as the address of the primary unit connected to 
the network. 

In the Name field, enter a name for the device that will 
differentiate it from any others at that location. 

In the Protocol field, select Modbus TCP. 

Leave the Device Type field set to Type of meter. 

Set the IP Address and the Network Port. 

Click on the Close button when all information is entered. 

If you are connecting to multiple units at this location, repeat the above process for all 
units. Each device MUST have a unique address. 
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Click on the Close button when you have finished adding or 
removing devices. 
The first Connection Manager screen returns. 

2.5.5 Troubleshooting tthe Connection
If the connection fails, check the connection at the Internal Network Option meter first. 
Once that connection is confirmed, check the connections with other devices. Suggested 
checkpoints: 

Internal Network Option Meter 

Check cables 

Check IP Address, Subnet Mask and Default Gateway settings 
configured in section 3.5. 

Check that the Address is 1 (this section). 

Check that Modbus TCP was selected in Device Properties (this 
section). 

Other Devices 

Check all the above except for the address, which must be unique 
and not set to 1. 

Check that the Baud Rate settings for the Ethernet Gateway (Port 2 
- EPM 9450/9650) (Port 3 - EPM 9800) and the Devices are the same 
(configured in section 3.5 or 4.5). 
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Pinging

Try “Pinging” to a known good network device, such as another computer, to verify that 
your computer is connected properly to the network. 

Go to the DOS Prompt (or, Console, if you are using Windows® NT). 

Ping IP Address. 
Example: “Ping 135.15.173.19”. 
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2.6 Changing the Primary Device 

One copy of the GE Communicator EXT connected to multiple GE devices (section 2.5) may 
only view data or edit Device Profiles from one device at a time—the Primary Device. (An 
exception is the Poll Multiple Devices screen; see Chapter 7 for details.) 

To change the Primary Device: 

Select Connection > Change Primary Device. 
The following screen appears. 

Enter the unique address of the device you would like to designate 
as the Primary Device. 

Click OK. 

The Device Status screen, reached by clicking on the Device Status button or by 
selecting Tools > Retrieve Device Status, will now list the new Primary Device first. 
See section 2.9 for details on the Device Status screen.  
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2.7 Disconnecting from a GE Meter 

To disconnect from a GE meter or to disconnect from a location, do one of the following: 

Click on the Disconnect icon, or from the menu bar select 
Connection > Disconnect . 

Click on the Connection Manager icon, or from the menu bar 
select Connection > Connection Manager. 

Select the Location from the List of Locations and click the 
Disconnect button. 

Note When using a modem, it is important to disconnect from communicating so that the 
remote modem receives a “hang up” command. Some modems may “freeze” when 
improperly disconnected. 
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2.8 Device Status 

The Device Status screen displays information about the GE devices connected to your 
computer. 

To access, click on the Device Status button or select Tools > 
Retrieve Device Status.

• Device: The Primary Device is listed first. See section 2.5 for details. 

• Device Name: The name you give to the Primary Device. 

• Boot: Version number of the GE Initialization and Diagnostic Firmware. 
This firmware runs first on power-up. This firmware is not field-
upgradeable. 

• Run-time: Version number of the GE Communicator EXT Operating 
Firmware. See Chapter 13 for details on upgrading firmware. 

• DSP Boot: Version number of the DSP Initialization and Flash 
Reprogrammer. This firmware runs first on power-up (as part of the 
Boot). This firmware is not field-upgradeable. 

• DSP Run-time: Version number of the DSP operating firmware. See 
Chapter 13 for details on upgrading firmware. 

• Com State: Health status of the communication processor. 

• DSP State: Health status of the DSP processor. 

• On Time: Date and Time at which the GE meter was last powered up. 

• Serial Number: The device’s Unique Identification Number. 

• NVRAM: Amount of NVRAM (nonvolatile RAM) available to the device. 
This memory is used for Logs. 

• Protection: Status of the Password Protection function (see Chapter 12). 
Scroll to the right to find this section of the Device Status Bar. 
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GE Communicator EXT

Chapter 3: Configuring the EPM 
9450/9650 Meter

GE Consumer & Industrial
Multilin

Configuring the EPM 9450/9650 Meter

3.1 Overview

GE Communicator EXT lets you configure an EPM 9450/9650 meter’s Programmable 
Settings, which are stored in the unit’s Device Profile. Click on the +/- in front of each group 
of settings to view the menu..

The following is an overview of the procedure for configuring a meter:
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1. Retrieve the meter’s Device Profile (see section 3.2);

2. Configure the Programmable Settings stored in the Device Profile (sections 
3.3 to 3.7);

3. Send the new Device Profile back to the meter (section 3.2).

Note If you click the Save, Load or Update buttons, you MUST have a unique Meter Destination 
Label so that the file is saved, loaded or updated to the intended device.

This chapter also details:

• Resetting Meter Information (section .10) and Manual Waveform Capture (section 
3.11).

• Setting and Retrieving Meter Time (section 3.9) and Options (section 3.12).

Note Actual programming screens may vary depending on the options ordered with your meter.

Note The settings shown are Initial Settings for the EPM 9650 meter, unless otherwise noted. 
Most 9450 Meter settings are similar to the 9650 meter settings. 

The EPM 9650 Meter supports DNP Level 2. For details on DNP Level 2, see chapter 16 of 
the GE Communicator EXT User Guide.
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3.2 Retrieve and Send Device Profiles

Click on the Profile button, or select Tools > Edit Current Device 
Profile. 
GE Communicator EXT retrieves the programmable settings from 
the currently connected meter. The following screen appears:

A dialogue box appears to confirm that the profile was retrieved successfully. Then, 
the Device Profile screen appears:

This screen contains all the programmable settings currently stored in the connected 
meter. Double-click on the +/- in front of each group to view the settings in that group.

Configure each of the programmable settings by clicking on the +/- 
icon then double-clicking on the selected parameter.  (See sections 
3.3 to 3.7 for details on editing each setting.)
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After you have finished configuring any or all of the programmable settings, 
use the BUTTONS at the bottom of the screen to execute the following tasks:

Implement the changes by clicking on the Update Device button. 
This sends the new, edited Device Profile to the meter. 
YOU MUST UPDATE THE METER DEVICE PROFILE FOR ANY OF THE 
PROGRAMMABLE SETTINGS TO TAKE EFFECT. 
A warning will appear asking you if you want to Save Connected 
Device Settings. Click on the settings you would like to save, then 
proceed with the Update.

Store the profile for later use by clicking on the Save button. 
A dialogue box will ask where you would like to save the profile.

Open a previously saved profile by clicking on the Load button. A 
dialogue box will ask for the location of the saved profile.

Print a copy of the profile by clicking on the Report button. 
The Report screen will appear:

3.2.1 Using the Report Page
Page Arrows: Select a page to view.

Zoom: Adjust the Viewing Magnification.
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Print Pages: Adjust the Range of Pages to be printed at 100%.

Buttons:

Copies: How many copies do you want to print?

Print Pages: Select indiviual pages to print. Separate numbers by commas.

Print: This screen sends you to Print Setup screen where you select printer, 
properties, paper and orientation. Click OK to Print.

Save: Save these selections for future use.

Done: Exit the screen and return to the Device Profile screen.

Note If you change the Com settings for the meter, you will not be able to communicate with the 
meter. You will have to sign off and sign on again with the new settings.
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3.3 General Settings

From the Device Profile screen (see section 3.2), click on the +/- 
button or double-click on the General Settings line. All of the 
settings in the General Settings group are listed.

Click on the particular programmable setting you would like to 
program. The settings will be detailed in the order on the Device 
Profile screen.

3.3.1 CT and PT Ratios and System Hookup
From the Device Profile screen (see section 3.2), click on the +/- 
button for General Settings, then double-click on the CT, PT Ratios 
and System Hookup line. 

The following submenu appears:
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This screen displays the current Device Profile’s settings for CT, PT ratios and 
connection type. The values shown are for example only.

Double-click on any of the settings; the CT and PT Ratios screen 
appears:

Make changes to this screen according to the requirements of your 
application:

When you change a PT or CT Ratio, GE Communicator EXT updates 
the corresponding Full Scale value entered in the Limit and 
Waveform Full Scales setting. 

When you click OK on this screen, GE Communicator EXT opens the 
Limit & Waveform Full Scales window so that you can verify the 
settings (see section 3.3.2).

Using the pull down menu, choose the hook up mode that matches 
the connection you have to the meter. 
Choose from one of the following: 4-Wire 3-Element Direct Voltage 
(4 CTs), 4-Wire 2.5 or 3 Element Wye (3 or 4 CTs), 3-Wire Delta (2 or 3 
CTs), 3-Wire Delta Direct Voltage (3 CTs) or 4-Wire Grounded Delta 
(4 CTs). See the EPM 9650 Installation and Operation Manual for 
diagrams.

Note Changes to the Operational Frequency Range do not change the Full Scale value for 
Frequency. Changes must be made in the “Limits and Waveform Full Scales” screen. Like 
voltage and current, the nominal value should be used. For example, 50 for 50Hz.

Click OK. 
The following screen asks you to verify the Kh/Ke Ratio for the Test 
Pulse Setting. Kh/Ke Ratio is Secondary watthour constant over 
kWh (the energy).
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Note If the Ke screen does not appear, go to View>Options>Misc. Enable the Ke screen.

Click Yes. Or, Click No and re-enter values in the CT & PT Ratio 
screen.

Click OK on the CT & PT Ratio screen. 

If changes have been made, verify Full Scale values and click OK.

Select the “G” option ONLY if you have a “G” Option Meter.
Warning : Only Select The 300 Volt Option If You Ordered The 
Meter With The “G” Option!!! If you connect 300 volts to a meter 
that does not have the “G” option, you will damage the meter. 
Please check the end label on your meter and your invoice to make 
sure you have the “G” Option! 

"G" must be in the 
part number for a 
300volt direct 
connection

Max Voltage also 
shows the max 
voltage the unit 
can measure
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“G” must be in the part number for a 300 volt direct connection. Max Voltage also 
shows the max voltage the unit can measure. To select the 300 Volt Option, check 
the “300 Volt Secondary” box. Are you sure you want to select this box?

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you must click on the Update 
Device button. This sends the new profile to the meter. Then, Reset 
Logs.

Warning: Resetting Logs clears Logs and Accumulations. Be sure.to capture needed meter 
information before updating the Device. Data will no longer be available after the Reset. 
The meter will be prepared for new installation.

3.3.2 One Amp Current Input Addendum (Modification Number M10.0)

For special circumstances, the meter can be ordered with one amp current 
transformers.

This will give the meter a range of 0 - 1 amps with an additional over-range of 1 amp. This 
option is used where 1A IEC meters are required or extended low current performance is 
needed and higher current performance is not needed. This option is not used for most 1A 
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installations. The standard Meter has the capability of very accurability monitoring 1A 
loads and providing extended current overload. This section shows how to change the CT 
Ratios in the Meter (ONLY EPM 9450 Hardware Rev. A) to reflect the hardware change:

In order to maintain maximum accuracy with one (1) amp current inputs, the wire is wound 
around the internal toroids five (5) times, instead of the usual one time. This effectively 
multiplies the current input by five (5) times, to maintain maximum resolution.

Configuring CT Ratios with Modification Number M10.0 (EPM 9450 
Hardware Rev. A):

EPM 9650 (and other Hardware Revs) adjust internally for the hardware change.

Because the GE Communicator EXT “sees” the one (1) amp input as five (5) amps, it is 
necessary to configure the CT secondary to five (5) amps.

Example: 

Normal One Amp CT Ratio - 1000:1 

Meter M10.0 One Amp CT Ratio - 1000:5 

The CT Ratio screen shows the correct input for the typical one amp user: 

Modified 1-amp input 
(5 winds around 
internal meter toroid)

Standard 5 amp input 
(one wind around 
internal meter toroid)
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PLEASE NOTE: This adjustment is for EPM 9450 Hardware Rev. A ONLY.

Note Even though the software is configured from 1000:5, it is actually displaying current from 
1000:1 amps. If you are not concerned with maximum accuracy, you can use the standard 
Meter (without specially ordering the M10.0 option) to display readings from a 0 to 1 amp 
CT.

3.3.3 Limit and Waveform Full Scales
All Limit and Waveform settings (sections 3.10 and 3.14, respectively) are based on a 
percentage of the Full Scale. Full Scales are based on the CT and PT ratios (see see section 
3.3).

Be sure to set the CT and PT ratios first 

GE Communicator EXT automatically recalculates the Full Scales every time the CT and PT 
ratios change and should be verified every time CT and PT Ratios are changed. NOTE: 
Changing the CT and PT Ratios Resets the meter, clearing Logs and stored data. This action 
prepares the meter for placement in a new installation or change of the Instrument 
Transformers.
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From the Device Profile screen (see section 3.2), click on the +/- 
button beside “Limit and Waveform Full Scales” or double-click on 
the Limit and Waveform Full Scales line. 
The following submenu appears:

This screen displays the current Device Profile’s settings for the Limit and Waveform Full 
Scales. The values shown are for example only.

Note Frequency and Voltage values are nominal values. The Phase Powers are computed using 
nominal voltage and rated maximum current.

Double-click on any of the settings. 
The Limit and Waveform Full Scales screen appears.

Enter the Full Scale for each parameter:
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• The Limits and Waveform settings (section 3.10 and 3.14, 
respectively) will be based on a percentage of the Full Scales 
entered here.

• GE Communicator EXT automatically recalculates the Full Scale 
Voltages, Currents and Power every time the CT and PT ratios 
change. Frequency is not changed, even if the Range Selection is 
changed. Frequency must be changed on the Limits screen.

• Power Phase is the amount of power per each phase.
• Power Total is the power of all phases combined.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you must click on the Update 
Device button. This sends the new profile to the meter.

Reset Logs after changing any settings that will effect the Logs

From the Menu Bar select Tools > Reset Meter Information. 

Click Reset All Logs. 

Click OK. (See section 3.25)

3.3.4 Time Settings

To Edit a Device Profile’s Time Settings:

From the Device Profile screen (see see section 3.2), click on the +/- 
button in front of General Settings. 

Double-click on the Time Settings line. The above  submenu 
appears.

Note DST=Daylight Savings Time.
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Double-click on any of the programmable settings
The Time Settings screen appears.

Make changes to this screen according to the requirements of your 
application   
Zone Descriptor: A Zone Descriptor sets the Time Zone for the EPM 
Monitor.

Note 0 = Greenwich Mean Time

See the chart below for the Zone Descriptor for your Time Zone.

Table 3–1: Greenwich Mean Time (GMT) Table (Dublin, London)

-1:00 Azores +1:00 Brussels, Paris, Warsaw

-2:00 Mid-Atlantic +2:00 Athens, Cairo, Helsinki

-3:00 Buenos Aires, Georgetown +3:00 Baghdad, Kuwait, Moscow, 
Teheran

-4:00 Atlantic Time (Canada), 
Santiago

+4:00 Kabul, Baku

-5:00 Eastern Time (US & Canada), 
Lima

+5:00 Karachi

-6:00 Central Time (US & Can), Mx 
City

+6:00 Daka

-7:00 Mountain Time (US & Canada) +7:00 Bankok, Hanoi, Jakarta
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Daylight Savings Information

Enable: Enables an automatic adjustment for daylight savings.

Disable: Disables an automatic adjustment for daylight savings.

Auto DST: Sets Daylight Savings Time automatically for the United States only. Time 
changes automatically occur at 2:00 AM (your local time), on the first Sunday in April 
and the last Sunday in October.

User Defined: Allows you to set the Daylight Savings Time manually.

Start:: Set the Month, Day and Hour when the adjustment for Daylight Savings will 
commence.

End: Set the month, day and hour when the adjustment for Daylight Savings will 
conclude.

Line Synchronization - Set Enable or Disable and Frequency

The basic function of Line Synchronization is to adjust the real time clock to track the time 
based on the power line frequency. For this purpose, Phase A voltage ONLY is used.

Line Sync is disabled if a GPS signal is present.

How Time is Adjusted

After the clock is synced to the line, the meter periodically checks the cumulative 
difference between the real time clock in cycles and the line cycle count. If the absolute 
difference is greater than 50 (60) cycles, the clock is adjusted + / - 1 second accordingly.

To set the meter’s on board clock, use Set Meter Time from the 
Tools Menu.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you must click on the Update 
Device button. This sends the new profile to the meter.

-8:00 Pacific Time (US & Can), 
Tijuana

+8:00 Beijing, Hong Kong, Singapore

-9:00 Alaska +9:00 Osaka, Sapporo, Seoul

-10:00 Hawaii +10:00 Brisbane, Melbourne, Guam, 
Hobart

-11:00 Midway Island +11:00 Magadan, Solomon Islands

-12:00 Eniwetok +12:00 Auckland, Fiji

Table 3–1: Greenwich Mean Time (GMT) Table (Dublin, London)



3–16 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

GENERAL SETTINGS CHAPTER 3: CONFIGURING THE EPM 9450/9650 METER

3.3.5 Labels
Labels are user-defined names for the meter, the Auxiliary Voltage terminal and the I N 
Measured terminal.

Note It is important to label the meter (under “Meter Designation”) with a Unique Name because 
that label will become the name of the file for any logs retrieved from that meter. Duplicate 
meter designations interfere with retrieved log databases. 

From the Device Profile screen (section 3.2), click on the +/- button 
beside General Settings. 

Double-click on the Labels line. 
This submenu appears:

Double-click on any of the Designation Names. 
The following screen appears:

Enter the labels in the appropriate fields. Meter Designation MUST 
be set for Partial Log Retrieval.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter.

Note For Meter Designations, you can use any character allowed by Windows Operating System 
for a File Name (since that Meter Designation will be used as the File Name).
In English versions the following characters will not work: \ / : * ? “ < > |.

For meters used internationally by multilingual users, it is recommended that you use 
ONLY alphanumeric characters allowed by your Operating System.
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3.3.6 Communications
From the Device Profile screen (see section 3.2), click on the +/- 
button beside General Settings and double-click on the 
Communications line. 
This submenu appears:

This screen displays the current Device Profile’s settings for the meter’s four 
Communications Ports: Address, Baud Rate, Data Bits, Parity, Stop Bits, Transmit Delay, 
Communication Protocol, Network Option and Internal Modem Option. You may use a 
connected External Display to learn the current baud rate, address and communication 
protocol of each meter port. See EPM 9450/9650 Installation and Operation Manual for 
details.

• Port 2 settings are ignored when the Internal Network and Internal Modem options 
are installed and the address is 1. 

• Port 3 is factory set to the External Display’s baud rate of 9600. 

• The External Display only communicates to Address 1. 

• You must use Port 3 or Port 4 to connect any external devices, such as a External I/
O module. 

• Port 3 and Port 4 are Master/Slave selectable. If you use Port 3 as a Master Port, 
you can use one of the other ports for the display (change the baud rate to 9600 
and set address to 1). 

• For all External I/O Devices, set the Communication Protocol to Modbus RTU.
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Double-click on any of the settings (“Serial Port 1”).
The Communications Settings screen appears:

Make changes to this screen according to the requirements of your 
application by clicking on the box or pull-down menu of any of the following 
settings:

Address: Assign an address to each port to communicate with 
other devices. Multiple meters on an RS-485 bus must each have a 
unique address set for the port that is connected to the bus.
Type in unique address.

Baud Rate: The baud rate entered in this field must match the 
baud rate of the device that will be connected to the Primary Meter 
at this port.
Use 9600 for modem connections. 
From the pull-down menu, select 4800, 9600, 19200, 38400, 57600, 
or 115200.

Data Bits: for Modbus RTU and ASCII, leave the Data Bits at 8. Other 
protocols may require a different setting. 
Use the pull-down menu to select from: 5, 6, 7 or 8.

Parity: for Modbus RTU and ASCII, leave the Parity at None. Other 
protocols may require a different setting. 
Use the pull-down menu to select from: None, Even, Odd, Mark or 
Space.
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Stop Bits: for Modbus RTU and ASCII, leave the Stop Bits at 1. Other 
protocols may require a different setting. 
Use the pull-down menu to select from: 1, 1.5 or 2.

TxDelay (Transmit Delay): leave the TxDelay at 0ms unless you are 
using equipment that requires a delay in the response time, such 
as a radio modem. 
Use the pull-down menu to select from: 0ms, 10ms, 20ms, 30ms, 
40ms, 50ms, 60ms, 60ms or 70ms.

Protocol: Direct Connections made through GE Communicator EXT 
must use either Modbus RTU or Modbus ASCII protocol (Modbus 
RTU is recommended). Modem Connections made through GE 
Communicator EXT must use Modbus ASCII only. 
Use the pull-down menu to select from: Modbus RTU, Modbus ASCII 
or DNP 3.0. See Chapter 2 for details.

Mode (Port 3 or Port 4 only): If you are using I/O modules, set one of 
these ports in Master mode. Set the port to operate at 57600 baud. 
To change the setting, use the pull-down menu to select Slave or 
Master. 
Make other changes for your application.

Internal Network Option: If your meter has the Internal Network 
Option, see your Network Administrator for the correct settings. 
Settings will vary from network to network.
If your meter has the INP100 Option (10/100BaseT) and you click on 
the Advanced Settings button, this set of screens will appear:

.

The meter is shipped with initial settings, or you can fully configure the 
settings using these screens and FTP Client. The process is detailed in Chapter 
6 of the GE Communicator EXT User Guide.
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Note These screens are not supported by meters with the INP10 Option.

Internal Modem Option: If your meter has this option, set the 
number of Rings to Answer from the pull-down menu. 
Set the Baud Rate to 57600, or to match your system baud rate.

Dial Out Profile: Click the Dial Out Profile button and the following 
screen appears. 
Details on programming this screen and on the Modem Dial In/Dial 
Out Function are in Chapter 9 of the GE Communicator EXT User 
Guide .

Note Any changes you make here may adversely affect communications. For example, if you 
change the baud rate of the port connected to a computer, be sure to make the same 
change to the computer port’s baud rate. If you change a port’s address, be sure to update 
the address settings of any device that communicates with the port. The baud rate of the 
port used by the meter’s external display should always be set to 9600 and the address set 
to 1.

The Edit Gateway Port Devices button at the bottom of the screen is used to enable up to 
8 devices connected to the gateway to be monitored. When the user clicks the Edit 
Gateway Port Devices button, this screen is displayed:
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Click on the box next to the Device to be monitored.
A Device Address will appear next to the Enabled Device.

Change the Device Address, if needed, to any address except 1.
The Number 1 is always reserved for the Primary Device.

Click OK to return to the Modem Programming screen.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the meter.

3.3.7 DNP Custom Class Map
The DNP Custom Class Map is a useful tool for prioritizing the readings in your system and 
the frequency of the readings. The DNP Custom Classes Map also keeps your system free 
from thousands of unwanted readings. For a list of available readings, see Appendix E in 
the GE Communicator EXT User Manual. 

From the Device Profile screen (section 3.2), click on the +/- button 
beside “General Settings”.

Click on the DNP Custom Classes Map +/- button.

Double-click on the DNP line. 
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The EPM 9650 supports DNP V3.00 Level 2, and this screen appears:

For details on programming the DNP Level 2 screens, see Chapter 17 of this manual.

The EPM 9450 supports DNP V3.00 Level 1. The lower screen shown here appears if the 
connected device is an EPM 9450:

Click on the arrow  to the right of the Edit/View window. 

Select the type of reading you want to edit or view. 

Select a Port and a Class (0, 1, 2 or 3) for that reading. 

A Compressed Map creates a number sequence (starting with 0) 
for only those points selected for a Class. 
A Non-Compressed Map (like the one shown) follows exactly the 
original DNP Mapping. The Compressed Map is a more efficient 
way to search for assigned values. Refer to EPM DNP Manual 
Revision 1.4 for details.

Click Enable DNP Time Sychronization, if you would like to set the 
time through DNP. 

When Time Synchronization is Enabled, a Sync Interval pull-down 
menu appears. The Sync Interval can be set from 1 Minute up to 1 
Day in 1-minute intervals. The Factory Initial Setting is 1 Day. The 
EPM 9450 meter initiates the Time Synchronization sequence by 
sending the appropriate response to the Master connected to the 
meter. The meter continues to synchronize time by sending the 
appropriate response to the Master every time the Selected 
Interval is reached.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you must click on the Update 
Device button. This sends the new profile to the meter.
Example: The DNP Level 1 screen shown here displays a selection 
of 1 Second Readings from Port 1 with No Class selected. A Class 
can be assigned to certain readings. Those readings will be 
collected by an RTU (or similar device) and displayed on your PC. 
Other readings will be displayed in other classes at other 
frequencies or not at all.
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3.3.8 Custom Modbus Map
The Custom Modbus Map for EPM 9650 can position up to 256 Registers (or the equivalent 
of 2K, whichever is lower) to readily provide the functionality you want from your Meter. In 
addition, you can customize selected values for Format Type, Scaling, Byte Order, Data 
Size, etc. 

From the Device Profile screen (section 3.2), click on the +/- button 
beside “Custom Modbus Map” or double-click on the Custom 
Modbus Map line. 
This screen appears:

Data entry is straightforward. Each type of data is described 
below. Note that not all selections will appear on the screen at 
the same time. You have to scroll the screen from right to left to 
reach some of the functions. Certain entries (such as Format, 
Data Size, etc.) have different allowable selections depending on 
the data point used. The pull-down menu will automatically 
adjust to provide the appropriate selections for that data point.

Note Most Frequently Used Custom Modbus Map Readings are shown on table 3.2 below.

Data Point Selection 

There are two different ways to select a Data Point:

Refer to the Modbus Map and find the associated Line and Point 
for the value you want. 
When you enter those values into the table, the software will 
complete the associated Group and Channel.

OR

Double-click the Group field. 

From the pull-down menus, select a Group and Associated 
Channel value. 
The software will complete the Map and Line values.
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Number of Registers

The number of registers polled for this Data Point is automatically computed. The number 
is dependent on the Data Size selected in the Data Size column.

Start Register

Start Register numbers are automatically assigned. The registers are assigned and 
adjusted automatically to take into account previous entries and data sizes. This is the 
Start Number for the first register to use in polling.

Format

From the pull-down menu, select a type of Format for a value such as Floating, Integer, etc.

Data Size

From the pull-down menu, select the Number of Bytes you want to represent the Data 
Point.

Unit

If the polled value is viewed as an integer, the Unit field tells you where to place the 
decimal point.

Examples: 

If you select .01, a polling value 1234 would be interpreted as 12.34.

If you select 100, a polling value 1234 would be interpreted as 123400.

Pri/Sec

The meter normally computes values in secondary units. Where applicable, you may select 
primary or secondary. If Primary is selected, the value is multiplied by the appropriate CT 
and/or PT values.

Sign/Abs

Where appropriate, you may have the option of having the data point computed as a 
signed or absolute value.

Byte Order

For most of the Data Points, the user can select the polling order of the number of bytes 
selected by the Data Size field.

Example: For a four-byte Data Point, the bytes can be arranged in any order for 
polling.

Display/Modulo/Offset

Depending on the Data Point, select one or more additional options with appropriate 
subselections.

Display 

For certain Data Points, interpretation and display options are offered.
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Example: For An Angle values, you can represent and display as 0 to 360 degrees 
or -180 to +180 degrees, etc. Selections will appear in a pull-down menu for the 
associated point.

Modulo 

Certain values are cumulative and can roll over and start recounting from zero. For 
those values, where required, you can enter a point at which the rollover will occur.

Offset 

Where allowed, you can enter a value (offset) which will be added to the data point 
when it is computed.

EPM 9450 Custom Modbus Map 

This screen appears if the connected device is an EPM 9450.

Type in the Line and Point (a Most Frequently Used List is below) for 
the reading you would like to view.

Click Enter. 
The Description automatically appears.

Table 3–2: Most Frequently Used Custom Modbus Readings

Line Point Description

34 0 One Second Phase to Neutral Volts: Volts AN

34 1 One Second Phase to Neutral Volts: Volts BN

34 2 One Second Phase to Neutral Volts: Volts CN

35 0 One Second Auxiliary Volts: V Aux

36 0 One Second (A, B, C): 1A

36 1 One Second (A, B, C): 1B
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36 2 One Second (A, B, C): 1C

37 0 One Second Measured N Current: 1Nm

38 0 One Second Calculated N Current: 1Nc

39 0 One Second Phase to Phase Volts: Volts AB

39 1 One Second Phase to Phase Volts: Volts BC

39 2 One Second Phase to Phase Volts: Volts CA

40 0 One Second VA (A, B, C): VA A

40 1 One Second VA (A, B, C): VA B

40 2 One Second VA (A, B, C): VA C

41 0 One Second VA Total: VA Total

42 0 One Second One Second VAR (A, B, C): VAR A

42 1 One Second One Second VAR (A, B, C): VAR A

42 2 One Second One Second VAR (A, B, C): VAR A

43 0 One Second VAR Total: VAR Total

44 0 One Second One Second Watts (A, B, C): Watts A

44 1 One Second One Second Watts (A, B, C): Watts B

44 2 One Second One Second Watts (A, B, C): Watts C

45 0 One Second Watts Total: Watts Total

46 0 One Second Frequency: Frequency

47 0 One Second Power Factor (A, B, C): PF A

47 1 One Second Power Factor (A, B, C): PF B

47 2 One Second Power Factor (A, B, C): PF C

48 0 One Second Power Factor Total: PF Total

49 0 One Second Imbalance: Voltage

49 1 One Second Imbalance: Current

216 2 Block Window Average Watt

217 3 Maximum Block Window Positive Watt

217 4 Maximum Block Window Negative Watt

218 3 Minimum Block Window Positive Watt

218 4 Minimum Block Window Negative Watt

194 4 Phase A-N/Phase A-B Voltage THD

195 0 Phase B-N/Phase B-C Voltage THD

Table 3–2: Most Frequently Used Custom Modbus Readings
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196 0 Phase C/Phase C-A Voltage THD

197 0 Phase A Current THD

198 0 Phase B Current THD

199 0 Phase C Current THD

Table 3–2: Most Frequently Used Custom Modbus Readings
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3.4 Revenue and Energy Settings

3.4.1 Demand Integration Intervals
From the Device Profile screen (see section 3.2), click on the +/- 
button beside Revenue and Energy Settings.

Double-click on the Demand Integration Intervals line.
The following submenu appears:

Double-click on any of the settings (“Rolling Sub-Intervals”, etc.) 
The Demand Integration Programming screens appear:

Make changes to the screens according to the requirements of your 
application:
• Block Averaging Time Interval Window: Sets the length of the Block 

Interval used for Demand Calculation and other Interval-based 
functions.
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• Block Window Sync: Synchronizes the meter with pulses from a High 
Speed Input connected to another meter. Click the Use Sync Pulse box 
and select the Input number (Block Window Demand Only).

• Rolling Subinterval Window: Sets the length of the Demand Subinterval 
when Rolling Demand is used. (Subinterval Length X Number of 
Subintervals = Length of Demand Interval Window)

• Rolling Subintervals: Set the number of Rolling Demand Subintervals in 
the Rolling Demand Window. (Subinterval Length X Number of 
Subintervals = Length of Demand Interval Window.)

• Predictive Rolling Window Average: Increasing the length of the 
Predictive Demand Window increases the accuracy of the prediction by 
including more of the current Demand Window up to 100%. Decreasing 
the length of the Prediction Window gives earlier warnings of High 
Demands.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button to send the new profile to the meter.
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3.4.2 Internal KYZ Outputs (and Test LED Settings)
The EPM 9450/9650 has no Internal KYZ Outputs. The Internal KYZ Outputs settings allow 
you to assign a channel and determine other settings for the Heartbeat LED. (The EPM 
9800 is available with the KYZ Output Option.)

From the Device Profile screen (section 3.2), click on the +/- button 
beside “Internal KYZ Settings” or double-click on the Internal KYZ 
Settings line. 
This screen appears:

Using the pull-down menu next to HB LED, assign a channel to the 
Heartbeat LED. 

Make changes to Watt Hour per Pulse, Pulse Width and Mode for 
the Heartbeat LED. 
There may also be a Form column on your screen. Form A = 
Transition. Form C = Pulse.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter.

Note For EPM 9650 Only: To make the EPM 9650 follow the settings on this screen, go to the Test 
Pulse screen after the Device Profile has been updated. On the Test Pulse screen, click the 
On button. Ignore the settings on this screen (see section 3.26).

3.4.3 External Display Options
This setting of the Device Profile configures the Meter’s External Display to read either 
Primary or Secondary volts. All other readings will be in the Primary, regardless of this 
setting.

Many utility companies want to read secondary volts and primary power readings. This 
feature allows them to do this.
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From the Device Profile screen (see section 3.2), double-click on 
External Display Options line.

Use the pull down menu to select either Primary or Secondary units 
for voltage. 

Click OK to return to the main Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter.

3.4.4 Programming Transformer Loss Compensation
From the Device Profile screen (see sction 3.2), click on the +/- 
button beside Transformer Loss Compensation or double-click on 
the Transformer Loss Compensation line. 
The following submenu appears:

This screen displays the current values for the meter’s Transformer Loss 
Compensation.

•  %LWFE = Percent Loss of Watts due to Iron

•  %LVFE = Percent Loss of Vars due to Iron

•  %LWCU = Percent Loss of Watts due to Copper

•  %LVCU = Percent Loss of Vars due to Copper

Consult Appendix B of the GE Communicator EXT User Guide for an overview of 
Transformer Loss Compensation.
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If you have a Standard Unit , double-click on any loss value, 
“%LWFE” etc.
This screen appears:

Click on TLC Calculator to find the values to enter into the Percent 
Loss windows. 
The Calculator button will launch an Excel Spreadsheet which will 
do the calculations for you once the required data is entered. A 
copy of the Excel Spreadsheet is in Appendix B of the GE 
Communicator EXT User Guide.

GE Communicator EXT will automatically launch the Excel Spreadsheet as part of its 
software package. But, for the TLC Button to work, you must have the Excel program in 
your system. If you do not have Excel software or if the spreadsheet file is not in the 
Communicator directory, a  warning will be displayed instead of the worksheet. You can do 
your own calculations using the hardcopy Transformer Loss Compensation Worksheet in 
Appendix B of the GE Communicator EXT User Guide.

Note For most Excel users, the spreadsheet will not run until permission is given to run the 
Macros contained in the sheet. This is done by changing the Excel Security Setting from 
High to Medium.

The Excel Commands are:

From the Excel Toolbat, select Tools>Security>Options

On the Security Tab Page, click on the Macro Security button.

Select Medium Security. 
This setting will allow Excel to run in GE Communicator EXT.

In the Device Profile: Transformer and Line Loss Compensation Window (above)
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Enter the percent Loss of Watts and Vars for copper and iron in the 
appropriate fields. 

Enable or Disable Transformer Loss Compensation with the top 
pull-down menu.

Click Disable, or, to Enable, click one of the following: Fe only, Cu 
only or Both Fe and Cu.

With the second pull-down menu select from the following:

• Add to Watts and Subtract from VAR.
• Subtract from Watts and Add to VAR.
• Add to Watts and VAR.
• Subtract from Watts and VAR.

Note Enhanced “E” 9650 Units have additional choices and firmware to support the additional 
features. A  warning may appear if you DO NOT have an Enhanced Unit.

Warning: The last Watt-VAR Combinations are only available if you have an Enhanced Unit 
or the DSP Firmware Version is greater than 212. Check with Technical Support if you have 
a question.

When all settings are complete, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter.
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3.4.5 Transformer Loss Compensation for Enhanced Units
If you have an Enhanced “E” 9650 Unit, double-click on any loss 
value, “%LWFE” etc. 
A similar Transformer Loss Compensation screen appears but with 
additional calculation choices.

Click on TLC Calculator to find the values to enter into the Percent 
Loss windows. 

The Calculator button will launch an Excel Spreadsheet which will 
do the calculations for you once the required data is entered. A 
copy of the Excel Spreadsheet is in Appendix B of the GE 
Communicator EXT User Guide.

Warning! GE Communicator will automatically launch the Excel Spreadsheet as part of its 
software package. But, for the TLC Button to work, you must have the Excel program in 
your system. If you do not have Excel software or if the spreadsheet file is not in the 
Communicator directory, a Warning will be displayed instead of the worksheet. You can 
do your own calculations using the hardcopy Transformer Loss Compensation Worksheet 
in Appendix B.
(See NOTE in section 3.4.4 regarding Excel.)

Enter the Percent Loss of Watts and Vars for copper and iron in 
the appropriate fields. 

Enable or Disable Transformer Loss Compensation with the top 
pull-down menu. 

Click Disable, or, to Enable, click one of the following: Fe only, Cu 
only or Both Fe and Cu.

With the second pull-down menu select from the following:
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• Add to Watts and Subtract from VAR.
• Subtract from Watts and Add to VAR.
• Add to Watts and VAR.
• Subtract from Watts and VAR.

The “Enhanced” 9650 has a third pull-down menu to apply the loss based on the 
power flow direction. 

From the menu select one of the following:

• Both +Watts and -Watts.
• Watts only.
• +Watts only.

Warning! Do NOT use the last settings if you do not have the appropriate firmware. Check 
with Technical Support if you have a question.

When all settings are complete, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter.

3.4.6 Cold Load Pickup
From the Device Profile screen (see section 3.2), click on the +/- 
button beside Cold Load Pickup or double-click on the Cold Load 
Pickup line. 
The following submenu appears:

On this screen the user sets the Cold Load Pickup Delay in minutes. This value is the 
delay from the time control power is restored, to the time at which the user wants 
to resume demand accumulation.
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Double-click on one of the parameters.
The following screen appears:

• Cold Load Pickup: Delay can be 1 to 60 minutes or Disabled.

• Minimum time control power must be off before using Cold Load Pickup: 
Value is set from 0 to 255 seconds.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button to send the new profile to the meter.

3.4.7 Cumulative Demand Type
From the Device Profile screen (see section 3.2), click on the +/- 
button beside Cumulative Demand Type or double-click on the 
Cumulative Demand Type line. 
The following submenu appears:

Click the radio button in fron of Rolling (sliding) Window or Block 
(fixed) Window to select Cumulative Demand Type.

Click OK to exit the screen and return to the main GE 
Communicator EXT screen.
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3.4.8 Energy, Pulses and Accumulations in the Interval
From the Device Profile screen (see section 3.2), click on the +/- 
button beside “Energy, Pulses and Accumulations in the Interval” 
or double-click on the Energy, Pulses and Accumulations in the 
Interval line. 
This window appears:

Set the number of minutes for the Energy Interval. 

Click OK to close the window and return to the main GE 
Communicator EXT screen.

3.4.9 Pulse Accumulations
This section of the Device Profile displays a series of eight running totals. Each total can be 
added to (or subtracted from) other totals. This allows you to set the High Speed Inputs 
located directly on the meter to pulse accumulate. 

Note If you use these inputs for pulse accumulations, do not set them to record waveforms. If 
you do, you will record endless waveforms.
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From the Device Profile screen (see section 3.2), click on the +/- 
Revenue and Energy Settings button and double-click on the 
Pulse Accumulations line. 
The following screen will appear:

Purpose of Pulse Accumulations: 

Pulse Accumulators are used to accumulate Pulse information from External Devices such 
as gas, water or electricity meters, energy management systems, SCADA devices or any 
pulse generating device. Pulse Accumulation is a very flexible way to accumulate 
information from external devices. 

Pulses from other meters can be algebraically combined with the host  meter’s pulse 
accumulations to generate one reading for a set of meters in a complex arrangement.

Source: This is the particular input on the meter which will be accumulated. 

Units/Pulse: This is the scale factor which normalizes the pulses so that they 
can be aggregated, if desired. Pulses are stored in primary values.

Accumulator: This allows you to place the pulse register into a separate 
accumulation register, which can aggregate or net values.

User assigned label: This window allows a user to enter a label designation so 
that when reading the Aggregator, the meter will display the source.

To add or subtract data, use pull down menu in each window of 
Accumulator column(s).

Note EPM 9450 does not support Averaging for Total Values that are NEGATIVE. 
EPM 9650 DOES support that type of Averaging.

When all data has been entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter.
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3.4.10 Primary Hour Readings Rollover
From the Device Profile screen (see section 3.2), click on the +/- 
button beside Primary Hour Readings Rollover or double-click on 
the Primary Hour Readings Rollover line. 
This window appears:

Set the number at which the Rollover will occur.

Click OK to close the window and return to the main GE 
Communicator EXT screen.
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3.5 Power Quality and Alarm Settings

This is the third group of settings in the Device Profile.

From the Device Profile screen (see section 3.2), click on the +/- 
button or double click on the Power Quality and Alarm Settings 
line.

Click on the Programmable Setting you would like to configure. 
The settings are detailed in the order they appear in the Device 
Profile.

3.5.1 Limits
Limit settings are based on a percentage of the Full Scales (% of FS), which are set in the 
Limit and Waveform Full Scales section of the Device Profile. Full Scales are based on CT 
and PT ratios set in the CT, PT Ratios and System Hookup section of the Device Profile 
(section 3.3.1).

Before programming Limits, set the CT and PT ratios first, then, 
set the Limit and Waveform Full Scales. 
The software automatically updates the Full Scale. However, you 
can set it separately from the CT and PT Ratios.

From the Device Profile screen (see section 3.2), click on the +/- 
button beside Limits or double click on the Limits line. 
The following submenu appears:

This screen displays the current Device Profile’s settings for Limits. Not all 
limits are shown above; “Limit ID” extends to 32.
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Double-click on any of the settings (“Limit ID 01:”, etc.). 
The Limits screen appears.

Percentage of Full Scale settings: The limits are set in % of full scale (% of FS) so that when 
a user creates a profile, that limit setting will be constant. This is true even though the CT 
and PT Ratios change when the meter (or a new meter) is placed in a different location. 
Changing the CT and PT Ratios will not effect the % of full scale limits previously set. This is 
useful when using large numbers at meters.

Make changes to this screen according to the requirements of your 
application:

To set the type of limit and the channel assigned to it, double click 
in either the Type or Channel column. 

From the pop-up menu, choose the desired settings and click OK.

To designate the limit as either Above or Below a percentage of the 
Full Scale, click once in each Settings column and select the desired 
setting from the pull-down menu.

To set the percentage of the Full Scale at which the limit will trip, 
enter the value in the % of FS column. 
GE Communicator EXT automatically calculates the Primary value.

The Combination Limit 3 is the logical combination of Limit 1’s state 
and Limit 2’s state.
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Example 1:

Limit ID 1:

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is below 12V.

Limit 2 Setting: Limit exceeded if Volts AN is above 132V.

Combination Limit 3 Setting: AND

If Limit 1 AND Limit 2 are exceeded then Limit 3 is exceeded.

Example 2:

Limit ID 1:

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is below 12V.

Limit 2 Setting: Limit exceeded if Volts AN is above 132V.

Combination Limit 3 Setting: OR

If Limit 1 OR Limit 2 are exceeded then Limit 3 is exceeded.

To combine Limits of different Limit IDs, use the Relay Logic Diagrams.

Full Scale settings are shown in the lower left of the screen. These values are set in the 
Limits and Waveform Full Scales section of the Device Profile (section 3.4).
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To set the Power Factor Limits, double click on any of the Power 
Factor settings in the Limit 1 or Limit 2 Column. 
The Power Factor Programming Screen will appear:

Power Factor is broken into four quadrants. The screen lets you set a limit in two of the four 
quardrants. 

To set a limit: 

From the pull-down menus, select a Quadrant and Less Than or 
Greater Than (Full Scales). 

Type in the Power Factor number. 

The graph will illustrate your selections by shading the Out of 
Limit bands. The area of the graph not covered by shading is 
within Normal Operational Range. Method 1 Quadrants: Q1 +Lag, 
Q2 -Lag, Q3 -Lead, Q4 +Lead.

To display a graph of Method 2 Quadrants: Q1 +Lag, Q2 -Lead, Q3 
+Lag, Q4 -Lead, go to the Programming Labels screen (section 3.18) 
of the Device Profile. 

In the lower drop down menu, click on Method 2, then, return to 
the Limits screen. 

Click on any PF setting.

Note This meter is a real four quadrant meter. Therefore, limits can be set for capacitive and 
inductive PF when generating or consuming power.

When all settings are complete, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter. 

(Make sure you save Connected Device Settings.) A pop-up screen 
will ask if you want to Reset Logs. It is recommended that you 
reset logs when you change any settings that effect logs.
See sections 3.2 and 3.2.5.
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3.5.2 ElectroLogic Relay Control
To edit a Device Profile’s GE Relay settings:

From the Device Profile screen (see section 3.2), click on the +/- 
button or double-click on the GE Relay line.

The following screen appears. This screen displays the current Device Profile’s 
settings:

To assign an item to the Relay Logic Tree, select an Input for the 
tree by clicking on a bullet next to numbers 1 through 8.

Choose Limits or Digital Inputs by clicking on the bullet in front of 
the word.

Select the Limit or Input you want to assign to the Relay Logic Tree 
Input you selected.

Press Set to confirm your selection.
The software will place the selection in the appropriate window in 
the screen.

After you have assigned all the Relay Logic Inputs, select the gates 
that will be used to combine the logic to trigger the relay. 

To select a gate, click on the gate or choose one from the pulldown 
menu below the gate.
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To change items on the Relay Logic Tree, use the following steps:

To change the selected relay and/or relay modules, select from the 
drop-down menu at the upper right hand corner of the screen.

To change the relay Set Delay, select from the drop-down menu to 
the right of the Set Delay Label.

To change the Relay Reset Delay, select from the drop-down menu 
to the right of the Reset Delay Label.

To clear an item from the Relay Tree, click on that item then click 
the Clear Button.

To clear ALL ITEMS from the Relay Tree, click the Clear Assigned 
Items Button.

Note In order to use this screen, you must have purchased at least one External Relay Out 
module.

For more details about External Modules, see Chapter 11 of this manual.

3.5.3 PQ Thresholds (Waveform Recording)
The Power Quality (PQ) and Waveform Thresholds setting determines at what point the 
meter will execute a waveform capture and/or record a power quality event. See Chapter 
8 for how to view logs.

PQ and waveform thresholds are given as a percentage of the Full Scale (% of FS). Set the 
Full Scale in the Limits and Waveform Full Scales section of the Device Profile (section 3.4). 
Full Scales are based on the CT and PT ratios set in the CT, PT Ratios and System Hookup 
(section 3.3.

Before programming the PQ and Waveform Thresholds, set the CT 
and PT ratios. 

Set the Limits and Waveform Full Scales. 

Caution: Changing the CT & PT Ratios will reset the meter and 
clear all Logs and Accumulations.

Note Note on Sampling Rate

A higher sampling rate allows for transients to be monitored. Generally, users will set the 
meter to 128 samples per cycle for this purpose. Lower sampling rates have advantages 
because they allow you to record more cycles of information per event screen. Low 
sampling rates are better for long duration events, like motor starts or distribution faults. 

The meter enables users to tailor the recording for both these applications. For more 
information on Sampling Rate, see the graph later in this section.
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From the Device Profile screen (see section 3.2), double-click on the 
PQ Thresholds (Waveform Recording) line. 
The Waveform—CBEMA Profile screen appears:

Software Triggers

To set the threshold for a PQ Event and Waveform capture, enter the desired percentage of 
Full Scale in the Value (%) column of the Above Setpoint and Below Setpoint sections. 
Full Scales are shown in the lower right corner of the screen.

Note Note on CBEMA 

The CBEMA plotting is a power quality standard known world-wide for recording the 
amount of damage voltage transient conditions have done to the equipment being 
monitored. The meter automatically records this information. 

For CBEMA purposes, the user programs internal set points for voltage below 90% and 
above 110% of full scale (+/- 10% from the nominal voltage). These setpoints are defined 
by the ITI (CBEMA) specification. The ITI (CBEMA) Curve is published by Information 
Technology Industry Council (ITI) and is available at: http://www.itic.org/iss_pol/techdocs/
curve.pdf.

A user can set a recording with tighter voltage limits to trigger a waveform recording. 
However, CBEMA plotting will be based only on the limits internally set.

Note Note on Setting the EPM 9450/9650 Meter to Record Current Faults

As discussed, the voltage setpoints are used to record voltage type events, such as voltage 
surges, sags and transients. The current settings are used to record faults on the line or in-
rush currents from devices such as motors.

Typically, to catch these events, set the limit to above 200% of full scale.
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Waveform Clipping Threshold

• EPM 9450/9650 5 Amp Standard Hardware - 61.9437A Peak before clipping.

• EPM 9450/9650 1 Amp Hardware - 12.09A Peak before clipping

Hardware Triggers

To enable a waveform or PQ recording for any of the 8 High Speed Inputs, click in the 
appropriate box. This will trigger a recording based on a contact trigger. This is useful to 
monitor an open device and to capture the waveform during that operation.

Samples per Cycle

To choose the Samples per Cycle to be recorded at 60 Hz, click on the Sampling Rate pull 
down menu. Choose from 16, 32, 64, 128, 256 and 512 samples per cycle. The number of 
samples per cycle you choose will inversely effect the number of cycles per capture.

• If you select 256, a Capture Only pop up screen will ask you to select Volts A, B, C or 
I A, B, C.

• If you select 512, a Capture Only pop-up screen will ask you to select one of the 
individual channels.

As you increase the number of samples, you will record more detailed information. The 
table below illustrates the “Effects of Sampling Rate” on the number of cycles captured. 
Increasing Sampling Rate increases waveform definition but reduces the length of the 
observed window. The approximate length of the observed window is shown in the last 
column. 

For example: For observed events of approximately 1/2 second, a sampling rate of 32 
samples should be used.

Note Note on Waveform Event Captures 

A screen of data is one capture. If you set Total Captures to 3 and you are recording at 16 
samples per cycle, you will record:

16 Samples: 3 x 64 = 192 cycles of recorded waveforms

Table 3–3: Effects of Sampling Rate

Samples 
per 

Cycle
Channels

Samples 
per 

Channel

Cycles per 
Capture

Time 
(Approx.)

Analog HSI

16 7 8 1024 64 1 second

32 7 8 1024 32 1/2 second

64 7 8 1024 16 1/4 second

128 7 8 1024 8 1/8 second

256 3 8 2048 8 1/8 second

512 1 8 4096 8 1/8 second
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128 Samples: 3 x 8 = 24 cycles of recorded waveforms

With the 2 MB module, you can have a total of 64 captures. With the 4 MB module, you can 
have a total of 96 captures. You can partition the memory in any fashion required for the 
specific application. There is no limitation on the number of cycles that can be recorded 
per event.

To choose the total amount of captures, click on the Total 
Captures pull down menu. 

Select from 0 to 96 captures. 
The higher the number, the more information you will be “stringing 
together”.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter. 

Reset Logs.

3.5.4 EN 50160 Flicker
With the Flicker Settings screen, the user can set the test times for the Flicker function.

From the Device Profile screen (section 3.2), click on the +/- button 
beside Flicker Settings or double-click on the Flicker Settings line. 
This screen appears:

From the pull down menus, select a Short term test time and a 
Long term test time.

From the Frequency pull-down menu, select 50 or 60 Hz.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter.

Note Flicker is discussed in detail in Chapter 15 of the GE Communicator EXT User Guide.
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3.5.5 I Squared T and V Squared T Thresholds
With the I Squared T and V Squared T Thresholds screen, the user can set at what point the 
Current and Voltage should accumulate.

From the Device Profile screen (section 3.2), click on the +/- button 
beside I Squared T and V Squared T or double-click on the I 
Squared T and V Squared T line. 
This screen appears:

Input the desired thresholds.

Click OK to exit the screen and return to the GE Communicastor 
EXT main screen.

3.5.6 High Speed Inputs
This section of the Device Profile enables you to label the eight High Speed Inputs.

Use of this storage field allows a user to label the inputs so that when the data is later 
analyzed, the user knows the source of the status change.

From the Device Profile screen (see section 3.2), click on the +/- 
button or double-click on the Digital Inputs line and double-click 
on High Speed Inputs.
The following submenu appears:
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Double-click on High Speed Inputs. 
The following submenu appears.

Double-click on the input you would like to label. 

Enter text in each field. 

Click OK to return to the main Device Profile screen. 

Click Update Device Profile to send the new profile to the meter.

3.5.7 Trending Profile Settings and Load Profile Recording
This section of the Device Profile enables you to set the Trending Profiles for historical logs.

From the Device Profile screen (see section 3.2), click on the +/- 
button beside Trending Profile Settings or double-click on the 
Trending Profile Settings line. 
The following submenu appears:

Double-click on one of the Trending topics to access the 
programming screens.

Load Profile Recording - Definition

Load Profile Recording is a subset of the meter’s more general Logging and Trending 
capability. The same screens are used for setup but Load Profile Recording deals only with 
Accumulated Values, Energy (Wh), Reactive Energy (VARh) and Apparent Power (VAh).

Historically, Load Profile Recording referred to recording of Quadrant 1 Energy (Wh) 
because electromechanical meters only measured energy and were detented to prevent 
reverse rotation outside of Quadrant 1.

3.5.8 Programming the Trending Log Time Intervals
Trending Log Time Intervals determine the interval at which Historical Logs 1 and 2 will 
take a snapshot. To set the parameters for the logs, see section 3.12.

See Chapter 8 of the GE Communicator EXT User Guide, for how to view and retrieve logs.
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From the Device Profile screen (see section 3.2), click on the +/- 
button beside Trending Log Time Intervals or double-click on the 
Trending Log Time Intervals line. 
The following submenu appears:

This screen displays the current Device Profile’s Trending Log Time Intervals. The 
values shown are for example only.

Double-click on either Log 1 Interval or Log 2 Interval. 
The Interval Log Setting screen appears:

Enter the hours, minutes and seconds for each log. 
The logs will be time-stamped based on the meter’s time, which is 
set using the Tools menu. See section3.2.5.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter. 

Reset Logs.

3.5.9 Programming the Trending Setup for Historical Logs 1 and 2
The Trending Setup controls the channel assignments for Historical Logs 1 and 2. To set 
the Time Intervals for these Logs, see section 3.12. See Chapter 8 of the GE Communicator 
EXT User Guide, for how to view logs.

From the Device Profile screen (see section 3.2), click on the +/- 
button beside Trending Setup or double-click on the Trending 
Setup line. 
The Trending submenu appears. 

To change the settings for Log 1 double-click on Log 1. 
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To change the settings for Log 2 click on Log 2. 
The Snapshot Channel Assignment Log 1 or 2 screen appears:

Make changes to this screen according to the requirements of your application:

Type: Using pull down menu, select the type of snapshot.

Channel: Using pull down menu, select a channel for the snapshot.

Click on Add to include the selections in the Log; click on Remove 
to delete.

To remove multiple items, hold Control while clicking items to be 
removed. Click Remove.

To remove a range of items, click the first item, hold Shift , then 
click the last item.  Click Remove.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

Click on the Update Device button. 
This sends the new profile. 

Reset Logs.

Total bytes used and Bytes remaining screens display the memory status for that 
particular file. meter assumes 256 bytes of memory for each file. Total memory is 
determined at time of purchase.



CHAPTER 3: CONFIGURING THE EPM 9450/9650 METER POWER QUALITY AND ALARM SETTINGS

GE COMMUNICATOR EXT – INSTRUCTION MANUAL 3–53

3.5.10 Pad Missing Records for Historical Logs
When the meter is not in normal operation, it will not record any data for Log 1 and Log 2. 
For example, during firmware updates or loss of power, data will not be saved. Some 
applications may require data logs to contain those missing records. 

To remedy this problem, you can: 

Enable the feature in Options > Log Retrieval > Pad Log File.

Click the box in front of the feature. 

Click OK.

This feature pads missing records for the Meter’s Log 1 and Log 2. The software causes the 
Log Converter program to automatically pad the missing records with a value of 0 for each 
log retrieval process and stores them in the Log DB file. By default, if the meter’s Trending 
Interval is set for Greater than 1 Hour, the meter will always save a record on the hour in 
the Trending Logs.
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3.6 External Devices

The setting of the Device Profile configures the meter’s External Devices, a variety of I/O 
Modules configurable using the screen below.

From the Device Profile screen (see section 3.2), double-click on the 
External I/O Modules line. 
The following screen appears:

Click in the Type column and use the pull down menu to select the 
specific I/O you wish to add and enter a unique address for each. 

Use the Edit buttons to configure each module further. 

Click OK to return to the main Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter. 
For more details on I/O Modules, refer to Chapter 10 of the GE 
Communicator EXT User Guide.
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3.7 Set and Retrieve Meter Time

The meter uses its on-board clock for time-stamping any logs it is recording. To set the 
meter’s clock:

Select Tools > Set Meter Time. 
The meter’s On-board Clock screen appears:

To synchronize the meter with your computer, leave the Use PC 
Time box checked.

To set the date and time to be independent from the PC, deselect 
the Use PC Time box and enter the time and date settings.

Click the Send button to update the meter’s time settings.

To retrieve the meter’s current time and date settings:

Select Tools >, Retrieve Meter Time. The following screen appears. 
Date and Running Time are displayed in LEDs. If the IRIG-B signal is 
present on the IRIG-B Input of the Device, a green IRIG-B appears 
next to the time.

Click OK to return to the main GE Communicator EXT screen.
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3.8 Reset Meter Information

From the menu bar select Tools > Reset Meter Information. 
The following set of screens appears:

Click in the tabs to navigate between screens.
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Click on the box beside the value(s) you would like to reset. 

Click OK.

Note If you click Reset Logs, a warning will appear asking you if you want to Save Connected 
Device Settings. Click on the settings you would like to save, then proceed with the 
Update. If you do not save the settings, they will be overwritten.

For each box you select, a window will appear which states that the “Reset is 
Completed”. Click OK. The reset is completed.

You can password protect this feature by enabling the Password feature of 
the Meter. (See Chapter 12 of the GE Communicator EXT User Guide, for 
details).
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3.9 Manual Waveform Capture

From the Menu bar, click on Tools > Manual Waveform Capture. 
The Manual Waveform Capture screen appears:

This screen displays the Waveform Log Statistics of the logs that have 
possible Waveform Triggers.

Click the Trigger Now button at the bottom of the screen to create 
a waveform. 
GE Communicator EXT creates a waveform in the Meter’s memory. 
The Records on the screen will increase by 1. 

To retrieve the Waveform, from the Menu Toolbar, click Logs > 
Retrieve Log from Device.

Click OK to return to the main Device Profile screen.
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GE Communicator EXT

Chapter 4: Configuring the EPM 
9800 Meter

GE Consumer & Industrial
Multilin

Configuring the EPM 9800 Meter

4.1 Overview

GE Communicator EXT enables you to configure an EPM 9800 Socket Meter’s 
programmable settings, which are stored in the unit’s Device Profile. The Device Profile has 
four sections (below) plus I/O Modules.

Following is an overview of the procedure for configuring an EPM 9800 Meter:
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1. Retrieve the meter’s Device Profile (section 4.2)

2. Configure the programmable settings stored in the Device Profile (sections 
4.3–4.7)

3. Send the new Device Profile back to the Meter (section 4.2).

Note If you click the Save, Load or Update buttons, you MUST have a unique meter Destination 
Label so that the file is saved, loaded or updated to the intended device.

Note This chapter also covers:

• Resetting Meter Information (section 4.9)

• Setting and Retrieving Meter Time (section 4.10)

• Test Mode Preset Accumulators (section 4.14) and Options (section 4.15)

Note Actual programming screens may vary depending on the options ordered with your meter.

Note The settings shown are for the EPM 9800, which supports DNP Level 2. For a Feature 
Comparison of GE models, refer to section 1.6 of the GE Communicator EXT Guide. For 
details on DNP Level 2, see Chapter 17 of the GE Communicator EXT Guide. The External 
Devices section of the Device Profile is covered in Chapter 11 of this same guide.
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4.2 Retrieve and Send Device Profiles

Click on the Profile button, or select Tools > Edit Current Device 
Profile. GE Communicator EXT retrieves the programmable 
settings from the currently connected meter. 
The following screen appears:

When the settings have been retrieved successfully, the Device Profile screen appears. This 
screen contains all the programmable settings currently stored in the connected meter. 

Configure each of the programmable settings by clicking on the 
+/- icon and then double-clicking on the selected parameter. 
(See sections 4.3–4.25 for details on editing each setting.)

After you have finished configuring any or all of the programmable settings, use the 
BUTTONS at the bottom of the screen as follows:

Click on the settings you would like to save, then proceed with the 
Update.
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Implement the changes by clicking on the Update Device button. 
This sends the new, edited Device Profile to the meter. 

Note You must update the Meter Device profile for any of the programmable settings to take 
effect.

A Warning will appear asking you if you want to Save Connected Device Settings. 

Store the profile for later use by clicking on the Save button. 
A dialogue box will ask where you would like to save the profile.

Open a previously saved profile by clicking on the Load button. 
A dialogue box will ask for the location of the saved profile.

Print a copy of the profile by clicking on the Report button. 
The Report screen will appear as shown here:

Using the Report Page:

Page Arrows: Select a page to view.

Zoom: Adjusts the Viewing Magnification.

Print Range: Adjusts the Range of Pages to be printed at 100%.



CHAPTER 4: CONFIGURING THE EPM 9800 METER RETRIEVE AND SEND DEVICE PROFILES

GE COMMUNICATOR EXT – INSTRUCTION MANUAL 4–5

Buttons:

Copies: How many copies do you want to print?

Print Pages: Select individual pages to print. Separate Page Numbers by Commas.

Print: This button sends you to Print Setup screen where you select printer, 
properties, paper and page orientation. Click OK to Print.

Save: Save these selections for future use.

Done: Exit the screen and return to the Device Profile screen.

Note If you change the Com settings for the meter, you will not be able to communicate with the 
meter. You will have to sign off and sign on again with the new settings.
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4.3 General Settings

“General Settings” is the first group of settings in the Device Profile.

From the Device Profile screen (see section 4.2), click on the (+/-) 
button or double-click on the “General Settings” line. 
All of the settings in the General Settings Group are listed.

Click on the particular Programmable Setting you would like to 
configure. 
The settings will be detailed in the order they appear on the Device 
Profile screen.

4.3.1 CT and PT Ratios and System Hookup
From the Device Profile screen (see section 4.2), click on General 
Settings

Double-click on the CT, PT Ratios and System Hookup line. 
The following submenu appears:
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This screen displays the current Device Profile’s settings for CT, PT ratios and the meter 
form used for hookup. The values shown are for example only.

Double-click on any of the settings.
The CT and PT Ratios screen appears:

Make changes to this screen according to the requirements of your application. 

• When you change a PT or CT ratio, GE Communicator EXT updates the 
corresponding Full Scale value entered in the Limits and Waveforms Full Scale 
setting.

• Using the pull-down menu, choose the hook up service that matches the 
connection you have to the EPM 9800. Selections may include: 9S 4-Wire Wye or 
Delta, 36S 4-Wire Wye, 39S 4-Wire Wye and 45S 3-Wire Delta or 4-Wire Wye. The 
Device Profile screen, including the Form above the connection window, will reflect 
your selection. 



4–8 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

GENERAL SETTINGS CHAPTER 4: CONFIGURING THE EPM 9800 METER

Note Changes to the Operational Frequency Range do not change the Full Scale Value for 
Frequency. Changes must be made in the “Limits and Waveform Full Scale Settings” 
screen. Like Voltage and Current, the nominal value should be used. For example, 50 for 
50Hz circuits.

Click OK. 
The following screen asks you to verify the Kh/Ke Ratio for the Test 
Pulse Setting. Kh/Ke Ratio is Secondary Watthour Constant over 
kWh (the energy).

Click Yes, or Click No, and re-enter values in the CT & PT Ratio 
screen.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

Click on the Update Device button. 
This sends the new profile to the Meter. 

Reset Logs, clearing logs and accumulations.

Be sure to capture needed meter information before updating the device. Data will no 
longer be available after the Reset. The meter will be prepared for new installation.

4.3.2 One Amp Current Input Addendum (Modification Number M10.0)
For special circumstances, the Meter can be ordered with one amp current transformers. 
This will give the Meter a range of 0 to 1 amps with an additional over-range of 1 amp.

This option is used where 1A IEC meters are required or extended low current performance 
is needed and higher current performance is not needed. This option is not used for most 
1A installations. The standard Meter has the capability of very accurately monitoring 1A 
loads and providing extended current overload.
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The following shows the change made to the toroid to adjust for the modification.

In order to maintain maximum accuracy with one (1) amp current inputs, the wire is wound 
around the internal toroids five (5) times, instead of the usual one time. This effectively 
multiplies the current input by five (5) times, to maintain maximum resolution.

No modification is required to the CT Ratios because EPM 9800 CT 
Ratios automatically adjust internally for this modification.

Note Use of the M10.0 Option is not recommended unless direct 1A IEC meter replacement of 
very extended low current performance is needed.

4.3.3 Limit and Waveform Full Scales
All Limit and Waveform settings (sections 4.5.1 and 4.5.3, respectively) are based on a 
percentage of the Full Scale. Full Scales are based on the CT and PT ratios (see section 
4.3.1).

Be sure to set the CT and PT ratios first
GE Communicator EXT automatically recalculates the Full Scales 
every time the CT and PT ratios change and should be verified 
every time CT and PT Ratios are changed.

Standard 5 amp input 
(one wind around 
internal meter toroid)

Modified 1-amp input 
(5 winds around 
internal meter toroid)
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Note Changing the CT and PT Ratios will reset the meter, clearing logs and stored data. This 
action prepares the meter for placement in a new installation or changing of the 
Instrument Transformers.

From the Device Profile screen (see section 4.2), click on the +/- 
button beside General Settings

Click on the Limit and Waveform Full Scales line. 
The following submenu appears:

The EPM 9800 screen displays the Device Profile’s settings for the 
Limit and Waveform Full Scales.

Note Frequency and Voltage values are nominal values. The Phase Powers are computed using 
nominal voltage and rated maximum current.

Double-click on any of the settings.
The Limit and Waveform Full Scales screen appears.

Enter the Full Scale for each parameter:
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• The Limit and Waveform settings (section 4.5.1 and 4.5.3, 
respectively) will be based on a percentage of the Full Scales 
entered here.

• GE Communicator EXT automatically recalculates the Full Scales 
Voltages, Currents and Power every time the CT and PT Ratios 
change. Frequency is not changed, even if the Range

• Selection is changed. Frequency must be changed on the Limits 
screen. ï Power Phase is the amount of power per each phase.

• Power Total is the power of all phases combined.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you must click on the Update 
Device button. 
This sends the new profile to the meter. 

To Reset Logs, see section 4.26

4.3.4 Time Settings

To edit a Device Profile’s time settings:

From the Device Profile screen (see section 4.2), click on the +/- 
button or double-click on the Time Settings line. 
The following submenu appears: 

This screen displays the current Device Profile’s time settings.  
(DST=Daylight Savings Time.)
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Double-click on a programmable setting (eg: Time Zone). 
The Time Settings screen appears.

Make changes to this screen according to the requirements of your 
application:

• Zone Descriptor: 
Sets the Time Zone for the Meter. (0=Greenwich Mean Time).

Table 4–1: Greenwich Mean Time (GMT) Table (Dublin, London)

-1:00 Azores +1:00 Brussels, Paris, Warsaw

-2:00 Mid-Atlantic +2:00 Athens, Cairo, Helsinki

-3:00 Buenos Aires, Georgetown +3:00 Baghdad, Kuwait, Moscow, 
Teheran

-4:00 Atlantic Time (Canada), 
Santiago

+4:00 Kabul, Baku

-5:00 Eastern Time (US & Canada), 
Lima

+5:00 Karachi

-6:00 Central Time (US & Can), Mx 
City

+6:00 Daka

-7:00 Mountain Time (US & Canada) +7:00 Bankok, Hanoi, Jakarta

-8:00 Pacific Time (US & Can), 
Tijuana

+8:00 Beijing, Hong Kong, Singapore

-9:00 Alaska +9:00 Osaka, Sapporo, Seoul

-10:00 Hawaii +10:00 Brisbane, Melbourne, Guam, 
Hobart
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• Daylight Savings Information:

Enable: Enables an automatic adjustment for daylight savings.

Disable: Disables an automatic adjustment for daylight savings.

Auto DST: Sets Daylight Savings Time automatically for the 
United States only. Time changes automatically occur at 2:00 
AM (your local time), on the first Sunday in April and the last 
Sunday in October.

User Defined: Allows you to set the Daylight Savings Time 
manually.

Start: Set the Month, Day and Hour when the adjustment for 
Daylight Savings will commence.

End: Set the month, day and hour when the adjustment for 
Daylight Savings will conclude.

• Line Synchronization: Set Enable or Disable and Frequency.

The basic function of Line Synchronization is to adjust the real 
time clock to track the time based on the power line frequency. 
For this purpose, Phase A voltage ONLY is used. Line Sync is 
disabled if a GPS signal is present.

• How Time is Adjusted: 

After the clock is synchronized to the line, the meter periodically 
checks the cumulative difference between the real time clock in 
cycles and the line cycle count. If the absolute difference is 
greater that 50 (60) cycles, the clock is adjusted ±1 second 
accordingly.

To set the meter on-board clock, use Set Meter Time from the 
Tools menu. (see section 4.26).

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you must click on the Update 
Device button. 
This sends the new profile to the Meter. 

To Reset Logs, see later sections.

4.3.5 Labels

Labels are user-defined names for the Meter, the Auxiliary Voltage 
terminal and the I N Measured terminal.

Note It is important to label the meter (under Meter Designation because the label given will 
become the name of the file for any logs retrieved from that meter; see Chapter 8 of the GE 
Communicator EXT Guide for details on viewing stored logs.

-11:00 Midway Island +11:00 Magadan, Solomon Islands

-12:00 Eniwetok +12:00 Auckland, Fiji

Table 4–1: Greenwich Mean Time (GMT) Table (Dublin, London)
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From the Device Profile screen (section xxx), click on the +/- button 
beside General Settings, then click on Labels. 
The following submenu appears:

Double-click on any of the designation names.
The following screen appears.

Enter the labels in the appropriate fields. 
Meter Designation MUST be set for Partial Log Retrieval.

When all changes are entered, 

Click OK to return to the main Device Profile screen. 

Click on the Update Device button to effect changes. 
This sends the new profile to the meter.

Note For meter designations, you can use any character allowed by Windows Operating System 
for a File Name (since that meter designation will be used as the File Name).
In English versions the following characters will not work:
                                             \ / : * ? “ < > |.
For meters used internationally by multilingual users, it is recommended that you use ONLY 
alphanumeric characters allowed by your Operating System.
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4.3.6 Communications
From the Device Profile screen (see section 4.2), click on the +/- 
button next to General Settings, then click on Communications 
Ports. 
The following submenu appears:

Double-click on the port you would like to change. 
The Communications Settings screen appears: 

This screen displays the Device Profile’s settings for the meter’s two programmable 
Communications Ports: Address, Baud Rate, Data Bits, Parity, Stop Bits, Transmit Delay, 
Communication Protocol, Network Option and Internal Modem Option. 
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You may use the on-board display or one of the meter’s External Displays to learn the 
current baud rate, address and communication protocol of each meter port. The settings 
for the Optical Port are fixed and cannot be changed. Port 1 and Port 4 are the meter’s 
RS-485 ports and are used for RS- 485 communication with a variety of devices. Port 3 is 
an internal modem or Ethernet. Ports 1 and 4 are factory set at 115200 and 9600 baud 
rates, Modem Gateway is 38,400 maximum.

Make changes to this screen according to the requirements of your 
application, by clicking on the box or pull-down menu of any of the 
following settings:

• Address: Assign an address to each port to communicate with 
other devices. Multiple Meters on an RS-485 bus must each have 
a unique address set for the port that is connected to the bus. 
Type in unique address.

• Baud Rate: The baud rate entered in this field must match the 
baud rate of the device that will be connected to the Meter at this 
port. Use 9600 for modem connections. From the pull-down 
menu, select 4800, 9600, 19200, 38400, 57600, or 115200.

• Data Bits: for Modbus RTU and ASCII, leave the Data Bits at 8. 
Other protocols may require a different setting. Use the pull-
down menu to select from: 5, 6, 7 or 8.

• Parity: for Modbus RTU and ASCII, leave the Parity at None. Other 
protocols may require a different setting. Use the pull-down 
menu to select from: None, Even, Odd, Mark or Space. ï 

• Stop Bits: for Modbus RTU and ASCII, leave the Stop Bits at 1. 
Other protocols may require a different setting. Use the pull-
down menu to select from: 1, 1.5 or 2.

• TxDelay (Transmit Delay): leave the TxDelay at 0ms unless you 
are using equipment that requires a delay in the response time, 
such as a radio modem. Use the pull-down menu to select from: 
0ms, 10ms, 20ms, 30ms, 40ms, 50ms, 60ms, 60ms or 70ms.

• Protocol: Direct Connections made through GE Communicator 
EXT must use either Modbus RTU or Modbus ASCII protocol 
(Modbus RTU is recommended). Modem Connections made 
through GE Communicator EXT must use Modbus ASCII only. Use 
the pull-down menu to select from: Modbus RTU, Modbus ASCII or 
DNP 3.0. See Chapter 2 of the GE Communicator EXT Guide for 
details.

•  Mode (Port 4 only): If you are using I/O modules, set this port to 
Master mode. Set the port to operate at 57600 baud. To change 
the setting, use the pull-down menu to select Slave or Master. 
Make other changes for your application.

• Internal Network Option: If your Meter has the Internal Network 
Option, see your Network Administrator for the correct settings. 
Settings will vary from network to network.

If your meter has the INP100 Option (10/100BaseT) and you click 
on the Advanced Settings button, the following set of screens will 
appear. The meter is shipped with initial settings, or you can fully 
configure the settings using these screens and FTP Client. The 
process is detailed in Chapter 6 of the GE Communicator EXT 
Guide. 
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Note This screen is not supported by meters with the INP10 Option

.

• Internal Modem Option: If your meter has this option, set the 
number of Rings to Answer from the pull-down menu. Set the 
Baud Rate to 57600, or to match your system baud rate.

• Dial Out Profile: Click the Dial Out Profile button and the 
following screen appears. Details on programming this screen 
and on the Modem Dial In/Dial Out Function are in Chapter 9 of 
this manual. This feature is ordered as INP 2.
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Note Any changes you make here may adversely affect communications. For example, if you 
change the baud rate of the port connected to a computer, be sure to make the same 
change to the computer port’s baud rate. If you change a port’s address, be sure to update 
the address settings of any device that communicates with the port. The baud rate of the 
port used by the Meter’s External Display should always be set to 9600 and the address set 
to 1.

• Edit Gateway Port Devices: The Edit Gateway Port Devices 
button at the bottom of the screen is used to Enable up to 8 
devices that are connected the gateway and are to be 
monitored. When the user clicks the Edit Gateway Port Devices 
button, this screen is displayed: 

Click on the box next to the Device to be monitored. 
A Device Address will appear next to the Enabled Device. 

Change the Device Address, if needed, to any address except 1. 
The Number 1 is always reserved for the Primary Device. 

Click OK to return to the Modem Programming screen.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

Click on the Update Device button. 
This sends the new profile to the EPM 9800 Meter. 

Reset Logs.
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4.3.7 DNP Custom Classes Map
The DNP Custom Class Map is a useful tool for prioritizing the readings in your system and 
the frequency of the readings. The DNP Custom Class Map also keeps your system free 
from thousands of unwanted readings.

From the Device Profile screen (section 4.2), click on the +/- button 
beside DNP Custom Class Map. 

Double-click on a DNP Custom Class Map parameter. 
The following set of screens appears. (EPM 9800 meters support 
DNP V3.00 Level 2.  See Chapter 16 of the GE Communicator EXT 
Guide for details.)

4.3.8 Custom Modbus Map

EPM 9800 Custom Modbus Map 

You can select up to 256 Registers (or the equivalent of 2K, whichever is lower) to provide 
the functionality you want from your Meter. In addition, you can customize selected values 
for Format Type, Scaling, Byte Order, Data Size, etc.
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From the Device Profile screen (section 4.2), click on the +/- button 
beside Custom Modbus Map or double-click on the Custom 
Modbus Map line. 
The screen appears:

Data entry is straightforward. Each type of data is described below. Note that not all 
selections will appear on the screen at the same time. You have to scroll the screen from 
right to left to reach some of the functions. Certain entries (such as Format, Data Size, etc.) 
have different allowable selections depending on the data point used. The pull-down menu 
will automatically adjust to provide the appropriate selections for that data point.

Note Table of the Most Commonly Used Modbus Map Readings on page 4-18. 

Data Point Selection 
(There are two different ways to select a Data Point.)

Refer to the Modbus Map and find the associated Line and Point for 
the value you want. 
When you enter those values into the table, the software will 
complete the associated Group and Channel.

OR

Double-click the Group field. 

From the pull-down menus, select a Group and Associated 
Channel value. 
The software will complete the Map and Line values.

• Number of Registers
The number of registers polled for this Data Point is automatically 
computed. The number is dependent on the Data Size selected in 
the Data Size column.

• Start Register
Start Register numbers are automatically assigned. The registers 
are assigned and adjusted automatically to take into account 
previous entries and data sizes. This is the Start Number for the 
first register to use in polling.

• Format 
From the pull-down menu, select a type of Format for a value 
such as Floating, Integer, etc.
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• Data Size 
From the pull-down menu, select the Number of Bytes you want 
to represent the Data Point.

• Unit 
If the polled value is viewed as an integer, the Unit field tells you 
where to place the decimal point. 
Example: If you select .01, a polling value 1234 would be 
interpreted as 12.34. 
Example: If you select 100, a polling value 1234 would be 
interpreted as 123400. 

• Pri/Sec
The meter normally computes values in secondary units. Where 
applicable, you may select primary or secondary. If Primary is 
selected, the value is multiplied by the appropriate CT and/or PT 
values.

• Sign/Abs 
Where appropriate, you may have the option of having the data 
point computed as a signed or absolute value.

• Byte Order 
For most of the Data Points, the user can select the polling order 
of the number of bytes selected by the Data Size field. Example: 
For a four-byte Data Point, the bytes can be arranged in any 
order for polling purposes.

• Display/Modulo/Offset 
Depending on the Data Point selected, you may select one or 
more additional options with the appropriate subselections.
Display: For certain Data Points, interpretation and display 
options are offered.
Example: For An Angle values, you can represent and display as 0 
to 360 degrees or -180 to +180 degrees, etc. Selections will 
appear in a pull-down menu for the associated point.
Modulo: Certain values are cumulative and can roll over and start 
recounting from zero. For those values, where required, you can 
enter a point at which the rollover will occur.
Offset: Where allowed, you can enter a value (offset) which will be 
added to the data point when it is computed.

Table 4–2: Custom Modbus Readings

Line Point Description

34 0 One Second Phase to Neutral Volts: Volts AN

34 1 One Second Phase to Neutral Volts: Volts BN

34 2 One Second Phase to Neutral Volts: Volts CN

35 0 One Second Auxiliary Volts: V Aux

36 0 One Second (A, B, C): 1A

36 1 One Second (A, B, C): 1B

36 2 One Second (A, B, C): 1C
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37 0 One Second Measured N Current: 1Nm

38 0 One Second Calculated N Current: 1Nc

39 0 One Second Phase to Phase Volts: Volts AB

39 1 One Second Phase to Phase Volts: Volts BC

39 2 One Second Phase to Phase Volts: Volts CA

40 0 One Second VA (A, B, C): VA A

40 1 One Second VA (A, B, C): VA B

40 2 One Second VA (A, B, C): VA C

41 0 One Second VA Total: VA Total

42 0 One Second One Second VAR (A, B, C): VAR A

42 1 One Second One Second VAR (A, B, C): VAR A

42 2 One Second One Second VAR (A, B, C): VAR A

43 0 One Second VAR Total: VAR Total

44 0 One Second One Second Watts (A, B, C): Watts A

44 1 One Second One Second Watts (A, B, C): Watts B

44 2 One Second One Second Watts (A, B, C): Watts C

45 0 One Second Watts Total: Watts Total

46 0 One Second Frequency: Frequency

47 0 One Second Power Factor (A, B, C): PF A

47 1 One Second Power Factor (A, B, C): PF B

47 2 One Second Power Factor (A, B, C): PF C

48 0 One Second Power Factor Total: PF Total

49 0 One Second Imbalance: Voltage

49 1 One Second Imbalance: Current

216 2 Block Window Average Watt

217 3 Maximum Block Window Positive Watt

217 4 Maximum Block Window Negative Watt

218 3 Minimum Block Window Positive Watt

218 4 Minimum Block Window Negative Watt

194 4 Phase A-N/Phase A-B Voltage THD

195 0 Phase B-N/Phase B-C Voltage THD

196 0 Phase C/Phase C-A Voltage THD

Table 4–2: Custom Modbus Readings
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Use the buttons at the bottom of the screen to Clear All, Clear, 
Cancel or Print your selections.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click the Update 
Device button to send the new profile to the meter.

197 0 Phase A Current THD

198 0 Phase B Current THD

199 0 Phase C Current THD

Table 4–2: Custom Modbus Readings
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4.4 Revenue and Energy Settings

“Revenue and Energy Settings” is the second group of settings in the 
Device Profile.

From the Device Profile screen (see section 4.2), click on the +/- 
button or double-click on the Revenue and Energy Settings line. 
All of the settings in the Revenue and Energy Settings Group are 
listed.

Click on the particular programmable setting you would like to 
configure. 
The settings will be detailed in the order they appear on the Device 
Profile screen.
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4.4.1 Energy Scaling
From the Device Profile screen (see section 4.2), click on the +/- 
button or double-click on the Energy Scaling line. 
The following set of screens appears:

Using the EPM 9800 Energy Scale Setting screens, the user can 
select the Number of Digits, Decimal Point Placement and Energy 
Unit for displayed readings. 

Click on the tabs to navigate between screens, except for Global 
Settings.  Click on Global Settings to access that screen.

• Energy

Watt Hour (Above)

VA Hour

VAR Hour
• Uncompensated Energy

VA, Watt and VAR readings not adjusted by Transformer Loss 
Compensation.
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• Test Mode Energy

Energy Readings while in Test Mode.

• Pulse Accumulation

Accumulators

Aggregators
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• I and V Squared T Readings

I2T: Data will not accumulate until Current reaches programmed 
level.

V2T: Data stops accumulating when Voltage falls below 
programmed level.

• Q Hours

Q Hours are obtained by lagging the applied voltage to a 
wattmeter by 60 degrees.
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• Global Settings

Settings configured on one screen apply to screens associated 
with filled-in rows. If a row is left blank, the associated screen is 
not modified.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

Click on the Update Device button.
This sends the new profile to the EPM 9800 Meter.
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4.4.2 Program Demand Integration Intervals (Demand Intervals)

See EPM 9800 Installation and Operation Manual for details on Demand 
Integration.

From the Device Profile screen (see section 4.2), click on the +/- 
button or double-click on the Demand Integration Intervals line.
The following submenu appears:

Double-click on any of the settings and the Demand Integration 
Programming screens appear:

Click on the tabs at the top of the screens to navigate from one 
screen to the others. 

Make changes to the screens according to the requirements of 
your application.

Following is a brief description of each setting and its function.

• Thermal Averaging Time Interval Window (above): Allows you to set hours, 
minutes and seconds for a precise thermal window of demand data.
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• Block Averaging Time Interval Window: Sets the length of the Block Interval used 
for Demand Calculation and other Interval-based functions.

• Block Window Sync: Synchronizes the meter with pulses from a High 
Speed Input connected to another meter. 

Click Generate End of Interval Pulse on the lower section of the 
above screen (not shown) to produce a synchronizing output and 
select a Relay and Pulse Width for the output.

• Rolling Average Subinterval Window: Sets the length of the Demand Subinterval 
when Rolling Demand is used. (Subinterval Length X Number of Subintervals = 
Length of Demand Interval Window)

• Rolling Subintervals: Sets the number of Rolling Demand Subintervals in 
the Rolling Demand Window. (Subinterval Length X Number of 
Subintervals = Length of Demand Interval Window)

• Predictive Rolling Window Average: Increasing the length of the 
Predictive Demand Window increases the accuracy of the prediction by 
including more of the Current Demand Window (up to 100%).
Decreasing the length of the Prediction Window gives earlier warnings 
of high demands.
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When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button to send the new profile to the meter.

4.4.3 Internal KYZ Outputs (and Test LED Settings)
The Internal KYZ Outputs Settings allow you to assign channels to the KYZ Outputs and to 
the Test LED Test. The Channel Selection sets the type of pulse that will be generated. 

For example, the Test LED can generate Energy Pulses for conventional testing or Reactive 
(VARh) Pulses for complex testing and approvals. The settings also allow you to determine 
the frequency and the duration of the pulse for each output and for the Test LED.

From the Device Profile screen (section 4.2), click on the +/- button 
beside Internal KYZ Settings or double- click on the Internal KYZ 
Settings line. 
The screen appears:

Click on the arrow of the pull-down menu next to KYZ Output to 
which you would like to assign a channel. 

Make changes to: 

Watt Hour per Pulse, 

Pulse Width, 

Mode and Form, 

for each output and for the Test LED. 

Note on Form: Form A = Transition. Form C = Pulse.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the EPM 9800 Meter.

Note If your EPM 9800 meter is equipped with the KYZ Output Option, the KYZ Output Settings 
will appear. Otherwise, only the Test LED will appear on the screen.
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4.4.4 Display Configuration
From the Device Profile screen (section 4.2), click on the +/- button 
beside Display Configuration or double-click on the Display 
Configuration line. 
The following set of screens (Meter Display Programmable Settings) 
appears:

Click tabs at the top of the screens to access the Programmable 
Settings.

• Display Modes: 

Enter a three-letter Label for each of the three View Modes. 
Enter a Description for each View Mode using the Line 1 and 2 
Description windows.
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• Screen Assignments: 

Enter up to 16 screens for each View Mode. 
Your label for each View Mode appears at the top of each column.

• Power and Energy Display: 

Set Scale, Digits and Decimal Point . 
Previews appear at the bottom of the screen. 

Settings on this screen control the display of energy related 
numbers. Care should be given to match the values on the 
display with those in historical logs. These settings apply to VA-
hours, Watt-hours (+/-), VARhours (+/-) and VAR-hours 
(quadrants) in the meter. 

Scale factor is the user-programmable setting that determines 
how measurements made by the meter will be displayed. In most 
applications, the measurements made in the metering circuit on 
the secondary side on the Instrument Transformers are displayed 
as Primary Values using the Scale Factor.

The Scale Factor (Primary Value = Secondary Value X Scale 
Factor) and the Transformer Factor (TF = Voltage Transformer 
Ratio X Current Transformer Ratio) are the same for energy 
measurements. 

For display of voltage and current measurements, VTR and CTR 
are used.

Note Scale Factor takes precedence over all other settings, i.e. - all other settings are based on 
this setting.
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• Miscellaneous: 

Set Screen Settings, Optical Port and User Inactivity Time-outs. 
The Screen Settings replace Adjustments Mode in the default 
profile. 

• Screen Settings: 

Set Back Light Level (brightness), Back Light Time (when Back Light 
shuts off), Contrast, Scroll Stop, Phasor Rotation and  Cumulative 
Demand. 

• Cumulative Demand Settings: 

Set to: 
Regular: Running Total 
Continuous: Running Total + Current Max/Min.

• Optical Port: 

Set Baud Rate and Optical Receive (Normal or Inverted). 
Inverted Operation is used with the Smart Coupler.

• User Inactivity Time Outs: (number of minutes since last user action when Mode 
reverts to View Mode 1). 

• Settings are: 
5 - 60 minutes. 
Leave Test Mode After_ Minutes: Reverts with or without energy 
accumulation. 
Leave View Mode 2 or 3 After _ Minutes: Reverts Automatically.

• Use Buttons for Functions below: 
• Update Display: 

Must click to update the display. After settings update, View Mode 
1 is displayed. 

• Retrieve from Display: 

Click to retrieve existing settings. 
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• Cancel: 

Cancel any new settings and return to main GE Communicator EXT 
screen. 

• Save: 

Save new settings to a file. 

• Load: 

Load saved settings from a file. 

Click Update Display to send new display settings and return to 
main GE Communicator EXT screen.

Note See the EPM 9800 Installation and Operation Manual for further details.

4.4.5 CT and PT Compensation
From the Device Profile screen (see section 4.2), click on the +/- 
button beside CT and PT Compensation or double-click on the CT 
and PT Compensation line. 
The following screen appears:

Check the Enable CT box to Enable CT and PT Compensation. 
(Leave unchecked to Disable. )

Click OK to close the screen and return to the main GE 
Communicator EXT screen.

Note The term "Potential Transformer" was changed to "Voltage Transformer" by the IEEE in 
1982. Most Instrument Transformers now use the term Voltage Transformer.
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4.4.6 Transformer/Line Loss Compensation
From the Device Profile screen (see section 4.2), click on the +/- 
button beside Transformer / Line Loss Compensation or double-
click on the Transformer / Line Loss Compensation line. 
The following submenu appears:

This screen displays the current values for the meter’s Transformer Loss Compensation.

• %LWFE = Percent Loss of Watts due to Iron ï 

• %LVFE = Percent Loss of Vars due to Iron ï 

• %LWCU = Percent Loss of Watts due to Copper

• %LVCU = Percent Loss of Vars due to Copper

Consult Appendix B of the GE Communicator EXT Guide, on 
Transformer Loss Compensation in the appendix pages of this 
manual.

Double-click on any of the loss values,“%LWFE” etc. 
The Transformer and Line Loss Compensation screen appears (see 
next page).

Click on TLC Calculator to find the values to enter into the Percent 
Loss windows. 
The Calculator button will launch an Excel Spreadsheet which will 
do the calculations for you once the required data is entered. A 
copy of the Excel Spreadsheet with example numbers is in 
Appendix B of the GE Communicator EXT Guide. 

GE Communicator EXT will automatically launch the Excel Spreadsheet as part of its 
software package. But, for the TLC Button to work, you must have the Excel program in 
your system. If you do not have Excel software or if the spreadsheet file is not in the GE 
Communicator directory, a Warning will be displayed instead of the worksheet. You can do 
your own calculations using the hardcopy Transformer Loss Compensation Worksheet in 
Appendix B of the GE Communicator EXT Guide.

Note For most Excel users, this spreadsheet will not run until permission is given to run the 
Macros contained in the sheet. This is done by changing the Excel Security Setting from 
High to Medium.
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The Excel Command

From Excel Toolbar, select Tools > Security > Options.

On the Security Tab Pag, click on the Macro Security button.

Select Medium Security.
This setting allows Excel to run in GE Communicator EXT.

Enter the percent Loss of Watts and Vars for copper and iron in the 
appropriate fields. 

Enable Transformer Loss Compensation by selecting Iron only, 
Copper Only or Both Iron and Copper from the pull-down menu at 
the bottom of the screen.

With the second pull-down menu, select from the following:

• Add to Watts and Subtract from VAR
• Subtract from Watts and Add to VAR.
• Add to Watts and VAR.
• Subtract from Watts and VAR.

With a third pull-down menu, apply the loss based on the power 
flow direction. From the menu select one of the following:

• Both +Watts and -Watts.
• -Watts only.
• +Watts only.

Do NOT use the last settings if you do not have the appropriate firmware. Check with 
Technical Support if you have a question.
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When all settings are complete, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the EPM 9800 Meter.

4.4.7 Cold Load Pickup
From the Device Profile screen (see section 4.2), click on the +/- 
button beside Cold Load Pickup or double-click on the Cold Load 
Pickup line. 
The following submenu appears, showing the current settings for 
Cold Load Pickup.

Double-click on one of the parameters and the following screen 
appears:

• Cold Load Pickup: Delay can be 1 to 60 minutes or Disabled. 
This value is the delay from the time control power is restored to 
the time when the user wants to resume demand accumulation.

• Minimum time control power must be off before using Cold Load 
Pickup: Value is set from 0 to 255 seconds.

When all changes are entered, click OK to return to the main 
Device Profile screen.

Note For these changes to take effect, you must click on the Update Device button to send the 
new profile to the Meter
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4.4.8 Cumulative Demand Type
From the Device Profile screen (see section 4.2), click on the +/- 
button beside Cumulative Demand Type or double-click on the 
Cumulative Demand Type line. 
This window appears:

Click the radio button in front of Rolling (sliding) Window or Block 
(fixed) Window to select Cumulative Demand Type.

Click OK to exit the screen and return to the main GE 
Communicator EXT screen.

4.4.9 Energy, Pulses and Accumulations in the Interval
From the Device Profile screen (see section 4.2), click on the +/- 
button beside Energy, Pulses and Accumulations in the Interval 
or double-click on the Energy, Pulses and Accumulations in the 
Interval line. 
This window appears:

Set the number of minutes for the Energy Interval. 
This the Demand and Accumulation Interval Duration.

Click OK to close the window and return to the main GE 
Communicator EXT screen.

4.4.10 Pulse Accumulations
This section of the Device Profile displays a series of eight running totals available on 
Meter. Each total can be added to (or subtracted from) other totals. This allows you to set 
the high speed inputs located directly on the meter to pulse accumulate. 
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Note If you use these inputs for pulse accumulations, do not set them to record waveforms. If 
you do, endless waveforms record.

From the Device Profile screen (see section 4.2), click on the +/- 
button or double-click on the Pulse Accumulations line. 
The following screen will appear:

Purpose of Pulse Accumulations

Pulse Accumulators are used to accumulate pulse information from external devices. 
These devices may be gas, water or electricity meters, energy management systems, 
SCADA devices or any pulse-generating device. Pulse accumulation is a very flexible 
way to accumulate information from external devices. Using the meter’s pulse 
accumulator, pulses from other meters can be algabraically combined with the host 
meter’s accumulations to generate one reading for a set of meters in a complex 
arrangement.

• Source: This is the particular input on the meter which will be accumulated. 

Units/Pulse: This is the scale factor which normalizes the pulses so that they 
can be aggregated, if desired. Pulses are stored in primary values.

Accumulator: This allows you to place the pulse register into a separate 
accumulation register, which can aggregate or net values. 

User assigned label: This window allows a user to enter a label designation so 
that when reading the Aggregator, the meter will display the source.

To add or subtract data, use pull down menu in each window of 
Accumulator column(s).

Note EPM 9800 supports Negative Averaging for Total Values.
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When all data has been entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. This sends the new profile to the meter.
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4.5 Power Quality and Alarm Settings

This is the third group of settings in the Device Profile.

From the Device Profile screen (see section 4.2), click on the +/- 
button or double-click on the Power Quality and Alarm Settings 
line. 
All of the settings in this group are listed.

Click on the particular Programmable Setting you would like to 
configure. 
The settings will be detailed in the order they appear on the Device 
Profile screen.

4.5.1 Limits
Limit settings are based on a percentage of the Full Scales (% of FS), which are set in the 
Limit and Waveform Full Scales section of the Device Profile (section 4.3.2). Full Scales are 
based on CT and PT ratios set in the CT, PT Ratios and System Hookup section of the Device 
Profile (section 4.3.1) (120V L-N, 208V L-L and 5A).

Before programming Limits, set the CT and PT ratios first. 

Then, set the Limit and Waveform Full Scales. 
The software automatically updates the Full Scale. However, you 
can set it separately from the CT and PT Ratios.
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From the Device Profile screen (see section 4.2), click on the +/- 
button beside Limits or double click on the Limits line. 
The following submenu appears:

This screen displays the current Device Profile’s settings for 
Limits. Not all limits are shown above; “Limit ID” extends to 32.

Double-click on any of the settings (“Limit ID 01:”, etc.) 
The Limits screen appears.

Percentage of Full Scale settings 

The limits are set in % of full scale (% of FS) so that when a user creates a profile, he can 
keep his settings. This is true, even though the CT and PT Ratios change when the meter (or 
a new meter) is placed in a different location. Changing the CT and PT Ratios will not effect 
the % of full scale limits previously set. This is useful when using large numbers at meters

Make changes to this screen according to the requirements of your application:

To set the type of limit and the channel assigned to it, double-click 
in either the Type or Channel column. 

From the pop-up menu, choose the desired settings and click OK.

To designate the limit as either Above or Below a percentage of the 
Full Scale, click once in each Settings column and select the 
desired setting from the pull-down menu.
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To set the percentage of the Full Scale at which the limit will trip, 
enter the value in the % of FS column. 
GE Communicator EXT automatically calculates the Primary value.

The Combination Limit 3 is the logical combination of Limit 1’s state and Limit 2’s state.

Example 1:

Limit I D:

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is below 12V.

Limit 2 Setting: Limit exceeded if Volts AN is above 132V.

Combination Limit 3 Setting: AND If Limit 1 AND Limit 2 are exceeded then 
Limit 3 is exceeded.

Example 2:

Limit I D:

Type: 1 Second Readings

Channel: Volts AN

Limit 1 Setting: Limit exceeded if Volts AN is below 12V.

Limit 2 Setting: Limit exceeded if Volts AN is above 132V.

Combination Limit 3 Setting: OR If Limit 1 OR Limit 2 are exceeded then Limit 3 
is exceeded.

To combine Limits of different Limit IDs, use the Relay Logic Diagrams.

Full Scale settings are shown in the lower left of the screen. These values are set in the 
Limits and Waveform Full Scales section of the Device Profile (section 4.4).

To set the Power Factor Limits, double click on any of the Power 
Factor settings in the Limit 1 or Limit 2 column.
The Power Factor Programming Screen will appear:

Power Factor is broken into four quadrants. The screen lets you set a limit in two of the four 
quadrants. 
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To set a limit from the pull-down menus, select a Quadrant and 
Less Than or Greater Than (Full Scales). 

Type in the Power Factor Number. 
The graph will illustrate your selections by shading the Out of Limit 
bands. The area of the graph not covered by shading is within 
Normal Operational Range. Method 1 Quadrants: Q1 +Lag, Q2 -
Lag, Q3 -Lead, Q4 +Lead.

To display a graph of Method 2 Quadrants: Q1 +Lag, Q2 -Lead, Q3 
+Lag, Q4 -Lead, go to the Programming Labels screen (section 4.19) 
of the Device Profile. 
In the lower drop down menu, click on Method 2. 

Return to the Limits screen. 

Click on any PF setting in the Limit 1 or Limit 2 column.

Note This meter is a real four quadrant meter. Therefore, limits can be set for capacitive and 
inductive PF when generating or consuming power.

When all settings are complete, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the Meter. 

You may Reset Logs after updating the device. See section 4.26.
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4.5.2 ElectroLogic Relay Control
To edit a Device Profile’s ElectroLogic Relay settings:

From the Device Profile screen (see section 4.2), click on the +/- 
button or double-click on the GE Relay line. 

The following screen appears. This screen displays the current Device Profile’s settings:

To assign an item to the RelayLogic Tree: 

Select an Input for the tree by clicking on a bullet next to numbers 1 
through 8.

Choose Limits or Digital Inputs by clicking on the bullet in front of 
the word.

Select the Limit or Input you want to assign to the RelayLogic Tree 
Input you selected.

Press Set to confirm your selection and the software will place the 
selection in the appropriate window in the screen.

After you have assigned all the RelayLogic Inputs, select the gates 
that will be used to combine the logic to trigger the relay. 

To select a gate, click on the gate or choose one from the 
dropdown menu below the gate.

To change items on the RelayLogic Tree, use the following steps:
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To change the selected relay and/or relay modules, select from the 
drop-down menu at the upper right hand corner of the screen.

To change the relay Set Delay, select from the drop-down menu to 
the right of the Set Delay Label.

To change the Relay Reset Delay, select from the drop-down menu 
to the right of the Reset Delay Label.

To clear an item from the Relay Tree, click on that item then click 
the Clear button.

To clear ALL ITEMS from the Relay Tree, click the Clear Assigned 
Items button.

Note In order to use this screen, you must have purchased at least one External Relay Out 
module. For more details on External Modules, see Chapter 11 of the GE Communicator 
EXT Guide.

4.5.3 PQ Thresholds (Waveform Recording)
The Power Quality (PQ) and Waveform Thresholds setting determines at what point the 
Meter will execute a waveform capture and/or record a power quality event. See Chapter 8 
of the GE Communicator EXT Guide for how to view logs.

PQ and waveform thresholds are given as a percentage of the Full Scales (% of FS). Set the 
Full Scales in the Limits and Waveform Full Scales section of the Device Profile (section 4.4). 
Full Scales are based on the CT and PT ratios set in the CT, PT Ratios and System Hookup.

Note Before programming the PQ and Waveform Thresholds, set the CT and PT ratios. 
Then, set the Limits and Waveform Full Scales.

CAUTION: Changing the CT and PT Ratios will Reset the meter and clear all logs and 
accumulations. Be sure to capture needed meter information before changing CT and PT 
Ratios.

Note on Sampling Rate

A higher sampling rate allows for transients to be monitored. Generally, users will set the 
monitor to 128 samples per cycle for this purpose. Lower sampling rates have advantages 
because they allow you to record more cycles of information per event screen. Low 
sampling rates are better for long duration events, like motor starts or distribution faults. 
The meter enables users to tailor the recording for both these applications. For more 
information on Sampling Rate, see the graph on page 4-39.
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From the Device Profile screen (see section 4.2), double-click on the 
PQ Thresholds (Waveform Recording line; 
The Waveform—CBEMA Profile screen appears:

1. Software Triggers: 

To set the threshold for a PQ event and waveform capture, enter 
the desired percentage of Full Scale in the Value(%) column of the 
Above Setpoint and Below Setpoint sections. 
Full Scales are shown in the lower right corner of the screen.

Note Note on CBEMA 

The CBEMA plotting is a power quality standard known world-wide for recording the 
amount of damage voltage transient conditions have done to the equipment being 
monitored. The meter automatically records this information. For CBEMA purposes, 
the user programs internal set points for voltage below 90% and above 110% of full 
scale (+/- 10% from the nominal voltage). These setpoints are defined by the ITI 
(CBEMA) specification. The ITI (CBEMA) Curve is published by Information Technology 
Industry Council (ITI) and is available at: 

http://www.itic.org/iss_pol/techdocs/curve.pdf. 

A user can set a recording with tighter voltage limits to trigger a waveform recording. 
However, CBEMA plotting will be based only on the limits internally set.

Note Note on Setting the Meter to Record Current Faults

As discussed, the voltage setpoints are used to record voltage type events, such as 
voltage surges, sags and transients. The current settings are used to record faults on 
the line or in-rush currents from devices such as motors. Typically, to catch these 
events, set the limit to above 200% of full scale.

2. Waveform Clipping Threshold: EPM 9800 Standard Hardware - 91.0924A Peak before 
clipping.
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3. Hardware Triggers: 

To enable a Waveform or PQ recording for any of the 8 High Speed 
Inputs, click in the appropriate box. 
This will trigger a recording based on a contact trigger. This is 
useful to monitor an open device and to capture the waveform 
during that operation.

4. Samples per Cycle:  

To choose the Samples per Cycle to be recorded at 60 Hz, click on 
the Sampling Rate pull down menu. 

Choose from 16, 32, 64, 128, 256 and 512 samples per cycle. 
The number of samples per cycle you choose will inversely affect 
the number of cycles per capture.  

• If you select 256, a Capture Only pop up screen will ask you to 
select Volts A, B, C or I A, B, C.

• If you select 512, a Capture Only pop up screen will ask you to 
select one of the individual channels.

As you increase the number of samples, you will record more detailed information. The 
Table below illustrates the “Effects of Sampling Rate” on the number of cycles captured. 
Increasing the Sampling Rate increases Waveform Definition but reduces the length of the 
observed window. The approximate length of the observed window is shown in the last 
column. 
For example, to observe events of approximately 1/2 Second, a Sampling Rate of 32 
Samples per Cycle or less should be used.

Note Note on Waveform Event Captures

A screen of data is one capture. If you set Total Captures to 3 and you are recording at 16 
samples per cycle, you will record: 

16 Samples: 3 x 64= 192 cycles of recorded waveforms

128 Samples: 3 x 8= 24 cycles of recorded waveforms

Table 4–3: Effects of Sampling Rates

Samples 
per 

Cycle
Channels

Samples 
per 

Channel

Cycles per 
Capture

Time 
(Approx.)

Analog HSI

16 7 8 1024 64 1 second

32 7 8 1024 32 1/2 second

64 7 8 1024 16 1/4 second

128 7 8 1024 8 1/8 second

256 3 8 2048 8 1/8 second

512 1 8 4096 8 1/8 second
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With the 2 MB module, you have a total of 64 total captures. With the 4 MB module, you 
have a total of 96 captures. You can partition the memory in any fashion required for the 
specific application. There is no limitation on the amount of cycles that can be recorded 
per event.

To choose the total amount of captures, click on the Total 
Captures pull down menu. 

Select from 0 to 96 captures. 
The higher the number, the more information you will be “stringing 
together”.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the Meter.

4.5.4 EN 50160 Flicker
With the Flicker Settings screen, the user can set the test times for the Flicker function.

From the Device Profile screen (section 4.2), click on the +/- button 
beside EN50160 Flicker or double- click on the Flicker Settings 
line.
This screen appears

From the pull-down menus, select a Short Term test time and a 
Long Term test time. 
Typical values for PST and PLT are 10 minutes and 120 minutes.

From the Frequency pull-down menu, select 50 or 60 Hz.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the EPM 9800 Meter.

Note Flicker is discussed in detail in Chapter 16 of the GE Communicator EXT Guide.
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4.5.5 I Squared T and V Squared T Thresholds
With the I Squared T and V Squared T Thresholds screen, the user can set at what point the 
Current and Voltage should accumulate.

From the Device Profile screen (section 4.2), click on the +/- button 
beside I Squared T and V Squared T or double-click on the 
I Squared T and V Squared T line. 
This screen appears:

Input the desired thresholds.

Click OK to exit the screen and return to the GE Communicator EXT 
main screen.

4.5.6 High Speed Inputs
This section of the Device Profile enables you to label the eight High Speed Inputs. Using 
this storage field allows a user to label the inputs so that when the data is later analyzed, 
the user knows the source of the status change.

From the Device Profile screen (see section 4.2), click on the +/- 
button or double-click on the Digital Inputs line. 

Double-click on High Speed Inputs. 
The following submenu appears:
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Double-click on any of the Input # lines.
The High Speed Digital Input Assignments screen appears.

Double-click on the Input you would like to label. 

Enter text in each field. 

Click OK to return to the main Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the EPM 9800 Meter.
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4.6 Trending Profile Settings and Load Profile Recording

This section of the Device Profile enables you to set the Trending Profiles for historical logs.

From the Device Profile screen (see section 4.2), click on the +/- 
button or double-click on the Trending Profile Settings line. 
This submenu appears:

Double-click on one of the Trending topics to access the 
programming screens.

Load Profile Recording - Definition

Load Profile Recording is a subset of the Meter’s more general Logging and Trending 
capability. The same screens are used for setup but Load Profile Recording only deals with 
Accumulated Values; Energy (Wh), Reactive Energy (VARh) and Apparent Power (VAh).

Historically, Load Profile Recording referred to recording of Quadrant 1 Energy (Wh) 
because electromechanical meters only measured energy and were detented to prevent 
reverse rotation outside of Quadrant 1.

4.6.1 Trending Log Time Intervals
Trending Log Time Intervals determine the interval at which Historical Logs 1 and 2 will 
take a snapshot. To set the parameters for the logs, see section 4.6.2.

See Chapter 8 of the GE Communicator EXT Guide for how to view and retrieve logs.

From the Device Profile screen (see section 4.2), click on the +/- 
button beside Trending Log Time Intervals or doubleclick on the 
Trending Log Time Intervals line. 
This submenu appears:

This screen displays the current Device Profile’s Trending Log 
TimeIntervals. The values shown are for example only.



4–54 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

TRENDING PROFILE SETTINGS AND LOAD PROFILE RECORDING CHAPTER 4: CONFIGURING THE EPM 9800 METER

Double-click on either Log 1 Interval or Log 2 Interval.
The Interval Log Setting screen appears:

Enter the hours, minutes and seconds for each log. 
The logs will be time-stamped based on the meter’s time, which is 
set using the Tools menu. See section 4.10.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the meter. 

It is recommended that you Reset Logs (see section 4.11) when 
changing settings that effect the logs.

4.6.2 Trending Setup
The Trending Setup controls the channel assignments for Historical Logs 1 and 2. To set 
the Time Intervals for these Logs, see section 4.6.1. See Chapter 8 of the GE Communicator 
EXT Guide for how to view logs.

From the Device Profile screen (see section 4.2), click on the +/- 
button beside Trending Setup or double-click on the Trending 
Setup line. 
The following submenu appears:

To change the settings for Log 1 double-click on Log 1. To change 
the settings for Log 2 click on Log 2. The Snapshot Channel 
Assignment Log 1 or 2 screen appears:
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Make changes to this screen according to the requirements of your application:

Type: Using pull down menu, select the type of snapshot.

Channel: Using pull down menu, select a channel for the 
snapshot.

Click on Add to include the selections in the Log; click on Remove 
to delete.

To Remove multiple items, hold Control while clicking items to be 
removed and click Remove.

To Remove a range of items, click the first item, hold Shift , then 
click the last item, then click Remove.

When all changes are entered, click OK to return to the main 
Device Profile screen. 

Click on the Update Device button to effect changes. 

Resetting Logs is recommended (see section 4.9).

Total Bytes Used and Bytes Remaining screens display the memory status for that 
particular file. The Meter assumes 256 bytes of memory for each file. Total memory is 
determined at time of purchase.
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4.6.3 Pad Missing Records for Historical Logs
When the meter is not in normal operation, it will not record any data for Log 1 and Log 2. 
For example, during firmware updates or loss of power, data will not be saved. Some 
applications may require data logs to contain those missing records.

To remedy this problem, you can Enable the feature in View > Options > Log 
Retrieval. 

Click the Pad Meter Log File box in front of the feature. 

Click OK.

This feature pads missing records for Log 1 and Log 2. The software causes the Log 
Converter program to automatically pad the missing records with a value of 0 for each log 
retrieval process and stores them in the Log DB file.

By default, if the Meter Trending Interval is set for Greater than 1 Hour, the meter will 
always save a record on the hour in the Trending Logs.
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4.7 External Devices

This setting of the Device Profile configures the Meter’s External Devices, a variety of I/O 

From the Device Profile screen (see section 4.2), double-click on the 
External Devices line.
The following screen appears.

Click in the Type column and use the pull down menu to select the 
specific I/O you wish to add 

Enter a unique address for each. 

Use the Edit buttons to configure each module further. 

Click OK to return to the main Device Profile screen. 

For these changes to take effect, you MUST click on the Update 
Device button. 
This sends the new profile to the EPM 9800 Meter. 
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4.8 Set and Retrieve Meter Time

The EPM 9800 uses its on-board clock for time-stamping any logs it is recording. 

To set the meter’s clock:

Select Tools > Set Meter Time. 
The meter’s On-board Clock screen appears:

To synchronize the meter and your computer, leave the Use PC 
Time box checked.

To set the date and time to be independent from the PC, deselect 
the Use PC Time box and enter the time and date settings.

Click the Send button to update the meter’s time settings.

To retrieve the Meter device’s current time and date settings:

Select Tools > Retrieve Meter Time. 
This screen appears. Date and running time display in LEDs.

Click OK to return to the main GE Communicator EXT screen.
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4.9 Reset Meter Information

From the menu bar select Tools > Reset Meter Information. 
The following set of screens appears:



4–60 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

RESET METER INFORMATION CHAPTER 4: CONFIGURING THE EPM 9800 METER

Click on the tabs to navigate between screens.

Click on the box beside the value(s) you would like to reset. 

Click OK.

Note If you click Reset Logs, a Warning will appear asking you if you want to Save Connected 
Device Settings. Click on the settings you would like to save, then proceed with the 
Update. If you do not save the settings, they will be overwritten.

For each box you select, a window will appear which states that the “Reset is 
Completed”. 

Click OK. 
The reset is completed.

You can password protect this feature by enabling the Password feature of the meter. 
(See Chapter 12 of the GE Communicator EXT Guide for details).
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4.10 Manual Waveform Capture

From the Menu bar, click on Tools > Manual Waveform Capture. 
The Manual Waveform Capture screen (shown here) appears, if the 
connected device is an EPM 9800.

This screen displays the Waveform Log Statistics of the logs that have possible 
Waveform Triggers.

Click the Trigger Now button at the bottom of the screen to create 
a waveform. 
GE Communicator EXT creates a Waveform in Meter memory. 
The Records on the screen will increase by 1. 

To retrieve the Waveform, from the Menu Toolbar, click Logs > 
Retrieve Log from the device

Click OK to return to the main Device Profile screen.
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4.11 Test Mode Preset Accumulators

There are two reasons why a user might want to use the Preset Accumulators screens:

1. A meter in Test Mode is out of service and is therefore not monitoring 
accumulations. The New Value can be used to adjust for the values not 
monitored while in Test Mode.

2. When replacing an old meter, that has accumulations, with a new meter that 
has no accumulations, the New Value can be set with the value of the 
accumulations of the old meter.

Setting Test Mode Preset Accumulators for EPM 9800

From the menu bar select Tools > Test Mode > Preset 
Accumulators. 
The set of screens shown here appears.
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Each screen has a Current Value, New Value and Preset Box for each accumulator. A 
new meter will have zeros for Current Values.

Click Tabs at the top of the screens to access the individual 
screens.

Settings can be preset for the following sets of values: 

• Primary Energy

• Secondary Energy

• Primary Energy (Quadrants)

• Secondary Energy (Quadrants)

• Internal Input  Accumulators

• KYZ Output Accumulators

• I & V Squared T Accumulators

• Cumulative Demand (Secondary) 

• Uncompensated Energy and Q Hours

Click the Preset Boxes for the values you want to set. 

Click Set or Cancel.
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4.12 CT and PT Compensation

The CT and PT Compensation feature allows users to remove the error caused by the CTs 
(external to unit) and PTs that are connected to the unit.

Enable CT and PT Compensation:

The steps:

From the Device Profile (Revnue and Energy Settings), click CT & PT 
Compensation > State.

Enable CT & PT Compensation. 

To send the new profile to the meter click OK and click Update 
Device Profile. 

Exit Device Profile.

Click Tools > CT & PT Compensation > Calibration Table Status

Click the First Time CT & PT Comp Selection.

Click Preload CT & PT Comp with Initial Values. 

Click OK.
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Click Tools > CT & PT Compensation > View Callibration Tables.

Click Copy Factory Table to CT & PT Comp Table. 

Click OK.

CT & PT Compensation is now Enabled and ready for corrections.

Collect data to determine the correction required.

Compensate CTs & PTs:

Click Tools > CT & PT Comp > Compensate CTs & PTs.

Follow direction on screens. Click tabs to make additional 
corrections. 

Click OK.
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Configuring the EPM 6000 Panel Meter

5.1 Introduction 

GE Communicator EXT Software enables you to configure the EPM 6000, 9450/9650 and 
9800 GE Panel Meters. 

To configure the EPM 9450/9650, see Chapter 3. 

To configure the EPM 9800, see Chapter 4. 

To configure the EPM 6000, see Chapter 5. 

Note If you cannot make a connection, make sure your communication settings match those 
shown here. 
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5.2 EPM 6000 Configuration 

The EPM 6000 meter can be configured using the meter Face Buttons (Menu, Enter, Down 
and Right) or the software, GE Communicator EXT, using the IrDA port (Com 1) on the face 
of the meter or the RS-485 port (Com 2) on the back panel of the meter. (Hardware 
installation and Face Button Configuration are detailed in the EPM 6000 Installation and 
Operation Manual.) Once a wired or wireless connection is established and the GE 
Communicator EXT 3.0 software is installed in your computer, you can begin to 
communicate between your computer and the meter. 

5.2.1 Quick Connect 
Quick Connect is the easiest way to connect GE Communicator EXT to your meter. 

From the GE Communicator EXT Menu, click Quick Connect or click 
on the Connect Icon. 
The Connect screen appears. 

Configure the Connect Screen: 

Click on Serial Port or Network. 
The Initial Settings for the meter appear on the screen. If you have 
a Licensed version of GE Communicator EXT, you can change any 
of the settings. 

Note If you have a demo version, you cannot change the Device Address; it must be “1”. 

Settings: 

Device Address: 1 - 249 

Baud Rate: 9600; 17,600; 34,600; 52,700 

Port: COM 1 - COM 99 (OS dependent) 

Protocol: Modbus ASCII or RTU 
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Flow Control: None or Hardware 

Note Settings for EPM 6000 IrDA Port Connection: 

Device Address - 1; 

Baud Rate - 57600; 

Protocol - Modbus ASCII; 

Flow Control - Hardware. 

Click the Connect button to connect software to your meter. 
If a connection is established, the Device Status screen appears, 
showing the Currently Connected Devices. 

Note If there is more than one device, a list will appear on this screen. Click OK. The GE 
Communicator EXT 3.0 Main Screen Appears.

5.2.2 Connection Manager 
Connection Manager is used if you want to Add or Remove Connecton Locations and/or 
Devices at Locations. 

From the GE Communicator EXT Menu, click Connection Manager. 
The Connection Manager screen appears. 
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List of Locations: 

On the left side of the Connection Manager screen is a List of Locations. These are 
locations of one or more meters to which you might want to connect. 

Add a Location: 

Click on the Add button.
The Connection Manager Location Editor screen appears. 

On this screen, you program the communication settings for each New 
Location: 

Type a name for the New Location. 

Click Serial Port or Network. 

Enter settings. 

Com Settings: 

Com Port: COM 1 - 99 

Baud Rate: 1200 - 115200 

Flow Control: None or Hardware 

Data Bits: 8 (or 7) 

Parity: None (Even, Odd)
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Add a Device: 

Click the Add Button in the Devices at Location box. 
If, at the top of the screen, you clicked Serial Port, a Serial Port 
Device Connection is added. 

Click Network to add a Network Device Connection. 
Here you can add up to 255 Devices (Serial Port and/or Network 
connections) at one Location. 

Note All devices must have the same connection parameters: Baud, Parity and Flow Control. 

Note Multiple Devices slow down polling.  

Edit Devices at Location: 

Scroll down to find all devices. 

Click on any Device Address, Device Name or Description to edit 
Device Settings. 
The Connection Manager Location Device Editor screen appears. 
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On this screen, program the Device Properties for each device at a 
Location. 
If the Device has a Serial Port Device Connection, the top example 
screen appears.  If it has a Network Device Connection, the lower 
example screen appears:

FIGURE 5–1: Network Device Connection Settings

:

FIGURE 5–2: Serial Port Device Connection Settings

Device Properties: 

Address: 1 - 247 (Unique Address) 
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Name: Easily Recognizable Name 

Description: (Type and Number, for example) 

Protocol: Modbus RTU or ASCII (Modbus TCP, EI Protocol for other devices) 

Device Type: EPM 6000  (Others: EPM 4000, 5000, 7000, 9000 Series Meters and I/O 
Modules) 

Comm Port: 1 or 2  (Serial Port Only) 

IP Address: 100.10.10.10 (Example) (Network) 

Port Number: 502 (Default) (Network) 

Click Close to save settings and return to the previous screen. 

Edit another Device 

Repeat steps above. 

or 

Click Close to return to the Connection Manager screen. 

Edit a Location: 

Select a “New Location” listing in the List of Locations Field. 
Your selection is highlighted. 

Click the Edit button. 
The Location Editor screen appears, displaying the computer’s 
communication settings.

Follow the above procedure to Edit Locations and/or Devices. 

Sort Locations: 

Use the pull-down menu to select a sort method, A to Z, Z to A, 
Newest to Oldest or Oldest to Newest. 

Click Sort By. 

Remove a Location: 

Select and click Remove. 

Connect to a Location: 

Click once on the location to which you would like to connect your 
computer. 
You may only connect to one location at a time. 

To change to a different location, you MUST disconnect from the 
current location by selecting it and clicking Disconnect . 

Click Connect. 

When the connection is made, the selected location appears in the Connected To 
Locations section. 
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Click Close. 
The Device Status screen appears, confirming the connection. The 
Computer Status Bar at the bottom of the screen confirms the 
computer’s connection parameters. 

If the Connection Fails 

A popup screen will alert you. Check that all cables are secure, that the RS- 232 cable is 
connected to the correct Com Port on the computer and that the computer is set to use 
the same baud rate and protocol as the GE Meters to which the computer is connected. 

5.2.3 Disconnect from a GE Meter 
To disconnect from a GE Meter or to disconnect from a location, do one of the following: 

Click on the Disconnect Icon. 

From the menu bar select Disconnect .

Click on the Connection Manager icon, or from the menu bar 
select Connection Manager. 

Select the location from the List of Connections.

Click the Disconnect button. 

5.2.4 Change the Primary Device 
One copy of GE Communicator EXT connected to one or multiple GE Devices may only view 
data or Edit Device Profiles from one device at a time - the Primary Device. (An exception is 
the Poll Multiple Devices screen; see Chapter 7 for details.) 



CHAPTER 5: CONFIGURING THE EPM 6000 PANEL METER EPM 6000 CONFIGURATION

GE COMMUNICATOR EXT – INSTRUCTION MANUAL 5–9

To change the Primary Device: 

Select Connection. 

Change Primary Device/Address. 
The following screen appears. 

If you have multiple meters connected to GE Communicator EXT, a window with a pull-
down menu appears: 

Select the device you would like to designate as the Primary 
Device. 

Click OK. 

The Device Status screen, reached by clicking on the Device Status button or by selecting 
Tools > Retrieve Device Status, will now list the New Primary Device first. 

5.2.5 Merge Connection Databases
This is a tool for combining old Connection directories with new Connection directories.

From the GE Communicator EXT Toolbar: 

Click on Merge Connection Databases. 
The Merge Connection Databases screen appears.
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Type in the Source File or browse for the file by clicking Browse. 

Type in the Destination File or browse for the file by clicking 
Browse. 

Click Merge to import the Source File into the Destination File. 

Click OK to exit the screen and return to the Main GE 
Communicator EXT screen. 
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5.3 Configure the EPM 6000 Device Profile 

From the GE Communicator EXT Toolbar, click the Profile icon. 
A group of screens appears, the EPM 6000 Profile screens: 

All screens have buttons across the bottom which do the following

To Print a Report, click Report . 
A list of all settings on these screens is printed.

To Save current Profile settings to a file, click Save. 

To Load Profile settings from a file, click Load. 

Click Update Device to send changes to the Device. 
Input Password (if Enabled). 

Click OK. 

Note To Update a Device, you MUST be connected to that device.
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5.3.1 Configure Settings 
The primary screen of the EPM 6000 Device Profile is the Settings screen. Click tabs to 
move to the other screens.

To change settings: 

Check or uncheck box to Enable or Disable Password for Reset or 
Configuration. 

Click Change Password or Change V-Switch. 

Change Device Designation by inputting a new designation on this 
screen. See the next sections for details. 

Password Settings 

Enable or Disable Password for Reset (Reset Max/Min Energy Settings) or Configuration 
(Device Profile) by clicking the boxes next to the settings. Enabling the Password protection 
will prevent unauthorized tampering with devices. 
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When the user attempts to make an unauthorized change, GE Communicator EXT will ask 
for a Password using the screen shown here. If the correct Password is not entered, the 
change will not take place. 

Change Password by clicking on the Change button. 
The Enter New Password screen appears. 

Type in the new password  (0 - 9999). 

Retype it. 

Click Change. 
The Enter Password screen appears (as shown above).

Input the OLD Password. 

Click OK. 
The Device will save the New Password and Restart. 

V-Switch Change 

The EPM 6000 is equipped with V-Switch® Technology. V-Switch® is a virtual firmware-
based switch that allows you to enable meter features through communication. This 
allows the unit to be upgraded after installation to a higher model without removing the 
unit from service. 

Available V-Switches®: 

V-Switch 1 (-V1): Volts and Amps Meter - Default 

V-Switch 2 (-V2): Volts, Amps, kW, kVAR, PF, kVA, Freq 

V-Switch 3 (-V3): Volts, Amps, kW, kVAR, PF, kVA, Freq., kWh, kVAh, kVARh 

V-Switch 4 (-V4): Volts, Amps, kW, kVAR, PF, kVA, Freq., kWh, kVAh, kVARh, %THD 
Monitoring and Limit Exceeded Alarms 

To change the V-Switch®, follow these simple steps: 

Install GE Communicator EXT 3.0 on your PC. 

Set up the EPM 6000 to communicate with your computer; power 
up your meter. 
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Log on to GE Communicator EXT 3.0 software. 

Click on the Profile icon. 
The SETTINGS screen appears. 

Click CHANGE V-SWITCH. 
A small screen appears that requests a code.

 

Enter the code which GE provides. 
The V-Switch® will be changed automatically and the meter will 
restart. 

How to get a V-Switch 

V-Switches are based on the particular serial number of the ordered meter. To obtain a 
higher V-Switch, you need to provide GE with the following information: 

1. Serial Number or Numbers of the meters for which you desire an upgrade. 

2. Desired V-Switch Upgrade. 

3. Credit Card or Purchase Order Number. 
Contact your GE representative with the above information. GE will issue you 
the Upgrade Code. 
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5.3.2 Configure Communications
The Communication Settings on this screen are the settings for the EPM 6000’s two ports, 
the IrDA Port (COM 1) and RS485 Port (COM 2). 

The settings that appear are the Inital Settings for communication. Any changes may 
effect communications between the EPM 6000 and your PC. 

Response Delay: 0 to 750 (50msec increments) 

Address: 1 to 247

Protocol: Modbus RTU or ASCII 

Baud Rate: 9600 to 57600 

Response Delay: 0 to 750 (50msec increments) 
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5.3.3 Configure Energy and Display 
This screen displays the Power and Energy Format, Demand Averaging, Auto Scrolling and 
Display Configuration. 

Power and Energy Format 

Power Scale: Unit, kilo (k), Mega (M), Auto 

Energy Digits: 5, 6, 7, 8 

Decimal Places: 0 - 6 

Energy Scale: Unit, kilo (k), Mega (M) 

Note The Energy Digits, Scale and Decimal Places settings determine how the Energy Values are 
displayed. 

Power Direction 

View as Load 

View as Generator 

Demand Averaging 

Average Method: Block or Rolling 

Interval: 5, 15, 30 or 60 Minutes 

Subinterval: 1, 2, 3 or 4 
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Auto Scroll Display 

Check On box for Parameters checked in the Display Configuration 
section of this screen to be automatically scrolled on the faceplate 
of the meter. 

Display Configuration 

Check the Readings that you want displayed on the faceplate of 
the meter. 

If invalid CT, PT and Interval Settings are entered, a warning will appear on the screen. 

5.3.4 Configure Scaling 
This screen displays the CT and PT Ratios and System Wiring. 

CT Ratios 

CT Numerator: 5 (1 - 9999) 

CT Denominator: 5 (Preset to 5 or 1 Amp and cannot be changed) 

CT Multiplier (Scaling): 1 (1, 10 or 100) 

PT Ratios 

PT Numerator: 600 (1 - 9999)

PT Denominator: 600 (1 - 9999) 

PT Multiplier (Scaling): 1 (1, 10 or 100)
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System Wiring 

3 Element Wye 

Delta with 2 CTs

2.5 Element Wye 

If invalid CT, PT and Interval Settings are entered, a warning will appear on the screen. 
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5.4 Using EPM 6000 Polling and Tools Menus 

5.4.1 Using EPM 6000 Polling Menu 
The Polling Menu for the EPM 6000 is similar to that of the other GE meters, with two 
exceptions: 

1. There are fewer screens for the EPM 6000. Unavailable screens may appear 
on the menu and be greyed out. 

2. EPM 6000 has a unique screen - Real Time Trending.  Details in Polling - 
Chapter 7. 

The Polling Screens for the EPM 6000 display the following: 

Volts, Current: Instantaneous, Minimum and Maximum Values for Voltage, Current 
and Frequency. 

Poll Multiple Devices: View polling data from multiple connected meters. 

Power and Demand: Instantaneous, Minimum and Maximum Values for Power 
and Accumulated Energy 

Real Time Trending: Displays a graph of instantaneous values. Also provides 
Logging of instantaneous values in a .csv (Comma Separated Value) Excel file. 

5.4.2 Using EPM 6000 Tools Menu 
The Tools/Reset Screens for the EPM 6000 are similar to the other GE meters. 

Reset Meter Information: Resets stored Max/Min and Energy Accumulations. 
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5.5 Real-Time Poll 

After connecting to the meter, on the menu bar, select Real-Time Poll button. A menu of 
screens allows the user to select one of the following polling screens: 

• Instantaneous Polling 

• Poll Max and Min Readings 

• Poll Power Readings 

• Poll Harmonics 

• Poll Internal Inputs 

• Poll Limit Status 

The individual screens are readings that result from the settings in the Device Profile which 
were discussed in the earlier sections of this chapter. The screens are very similar to the 
EPM 9450/0650 and 9800 screens. Occasionally, the meter screens will have slightly fewer 
readings. 

For details on how to utilize the data on the screens, see sections 6.3, 6.5, 6.6, 6.7, 6.8 and 
6.11 of this manual.  
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5.6 Tools 

After connecting to the meter, on the menu bar, select Tools. A menu of the following tools 
will appear: 

• Edit Current Device Profile (covered in earlier sections of this chapter) 

• Set Meter Time 

• Retrieve Meter Time 

• Reset EI Device Information

• Retrieve Device Status 

• Low Level Access 

• Analog Output Programmer 

Each of these Tools will be described in the following sections, with the exception of Edit 
Current Device Profile, which was described in detail in sections 5-1 to 5-15 of this chapter. 
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5.7 Set Device Time 

After connecting to the meter, on the menu bar, select Tools.

Click Set Device Time. 

Set the Month, Day, Year, Hour Minute and Second, or click Use PC 
Time. 

Click Send to send the new settings to the meter, or click Cancel. 
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5.8 Retrieve Device Time 

After connecting to the Meter, on the menu bar, select Tools. 

Click Retrieve Device Time. 
The following screen will appear. 

Click OK to return to the main screen. 
To adjust Meter Time, see section 5.18. 
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5.9 Reset Device Information 

After connecting to the meter, on the menu bar, select Tools. 

Click Reset Device Information. 
The following screen will appear. 

Select the parameters that you want to reset. 

Click OK. 
A screen will appear that confirms the reset. 

Click OK to return to the main screen. 
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5.10 Retrieve Device Status 

After connecting to the meter, on the menu bar, select Tools.

Click Retrieve Device Status. 
The following screen will appear:
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5.11 Low Level Access 

After connecting to the meter, on the menu bar, select Tools > GE 
Multilin Programmer. 

Click Low Level Access. 

Low Level Access is not required for normal operation. Low Level Access is a 
diagnostic tool for third party software and devices. It is designed to be used ONLY by 
appropriate level Programming Personnel in conjunction with the Modbus Map. 

The latest version of the Modbus Map can be downloaded from the Free Downloads 
section of our website: www.GEmultilin.com. 
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Total Web Solutions

6.1 Overview 

The 10/100BaseT Ethernet Option (INP100) for GE’s EPM 9450, 9650 and 9800 Meters, a 
fully customizable web server, provides access to real-time data via Internet Explorer. 

GE’s name for this dynamic system is Total Web Solutions©. This is an open design that 
enables you to communicate with any device via a variety of open protocols. The system 
incorporates a highly programmable network card with built-in memory, installed in 10/
100BaseT Option meters. Each card can be programmed to perform an extensive array of 
monitoring functions. 

Note The EPM meter with the INP10 Option does not support Total Web Solutions©. 
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6.2 System Components 

The components of the Total Web Solutions© system are detailed below. Each component 
adds special features to this fully configurable system. For Flow Charts of the components 
see 6.10 to 6.12. 

WebExplorer©: This component uses your Web Browser to provide you with direct access 
to all power data. Using your browser, you can access any data file, and because it looks 
like a standard HTML web page to an IT department, the data transmits through corporate 
firewalls. This fully configurable component allows you to customize your own SCADA 
quality web pages, graphics and configurations via FTP Server and/or FTP Client. The Main 
Default Page is shown below. This is just an example; the web pages for your data may be 
changed or created to your own needs and specifications. 

The URL address for this page is: http://www.myEPMmeter.com

WebXML©: A very versatile component for configuring data to your specifications. The 
data is polled, then stored in an XML file for later access by any client on the network. The 
data can be viewed via a host of applications including Internet Explorer and Microsoft 
Excel, PowerPoint and Word. 

WebReacher©: With this component, you can access meters anywhere in the world. 
WebReacher© has a built-in Modbus data concentrator that allows you to poll up to 8 
devices or 512 unique polling items from any device that uses Modbus RTU and/or Modbus 
TCP protocols. WebReacher© can retrieve the data and consolidate it into web pages 
without separate software. 

WebMod©: The 10/100BaseT design allows the unit to communicate using Modbus TCP. 
Once the programmable network card is placed inside the meter, Port 2 becomes a 
gateway. The gateway enables a high-speed interface between the Network LAN and 
other Modbus-based IED (Intelligent Electronic Device) equipment. Modbus TCP is an 
industry-proven open protocol that can be easily integrated with other software or 
hardware. 
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WebAlarm©: Real-Time Email alerts are sent via the Internet to up to 9 recipients 
simultaneously for any combination of event notifications. You decide what message is 
sent and to whom. Email format can be Short Format or Long Format. Short Format is for 
cellphones with text messaging service. Long Format provides detailed alarm conditions 
for any devices with full email support (computers, PDAs, cellphones). 
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6.3 Hardware Connection 

The EPM 9450, 9650 and 9800 meters with the 10/100BaseT Ethernet Option (INP100) have 
all the components of the standard Meters PLUS the capability of connection to a network 
through an Ethernet LAN or to the Internet via Modbus TCP, HTTP, SMTP, FTP and/or DHCP. 
Monitors with the 10BaseT Option (INP10) connect via Modbus TCP ONLY. 

INP100 can auto detect the cable type and works with either straight or crossover cable. 
INP10 does not have the straight connection capability. 

Example: A direct connection between a PC and INP100 can use a straight or a crossover 
cable. But, for an INP10 connection, you must use a crossover cable. 

EPM 9450/9650: RJ-45 Connection - Meter with 10/100BaseT Option to 
Multiple PCs 

The 10/100BaseT Option conforms to the IEEE 802.3 specification using unshielded twisted 
pair (UTP) wiring, allowing inexpensive RJ-45 connectors and CAT5 (or better) cabling to be 
used.

This LAN connection allows multiple PCs to be connected concurrently. The RJ-45 line is 
inserted into the RJ-45 Port on the face of the EPM 9450/9650 with 10/100BaseT option. 
The connection using RJ-45 into the EPM 9450/9650 can connect the meter to a network 
using Modbus TCP protocol over the Ethernet. To connect with other meters using Modbus 
RTU in either remote or local locations, you MUST use Port 2 (which is labeled Ethernet 
Gateway) as a Master, and an RS-485 connection. The link using RS-485 is viable for up to 
4000 feet (1219 meters). 

RS-232: Insert RS-232 cable from a PC into Port 1 and set the Selector Switch to RS-232. 
This connection is necessary in order to set the initial software configuration. For details on 
EPM 9450/9650 connections and wiring, see the EPM 9450/9659 User’s Manual. 

EPM 9800: RJ-45 Connection 

The 10/100BaseT option conforms to the IEEE 802.3 specification using unshielded twisted 
pair (UTP) wiring. This allows the use of inexpensive RJ-45 connectors and CAT5 (or better) 
cabling. An RJ-45 connector is supplied with the meter. 

This LAN connection allows multiple PCs to be connected concurrently. The RJ-45 line is 
inserted into the RJ-45 Port (or Jack) on the Port 3 cable coming from the back of the EPM 
9800 with 10/100BaseT option. 

The connection using RJ-45 into the EPM 9800 connects the meter to a network using 
Modbus TCP protocol over the Ethernet. You can access the meter with a SCADA system, 
MV90 and PCs all at the same time. 

RS-232: Use the Optical Port on the face of the meter to make the RS-232 connection. The 
magnetic coupler snaps into place; the other end of the cable connects to your PC. This 
connection is necessary to set the initial software configuration. For additional details on 
EPM 9800 connections and wiring, refer to the EPM 9800 User’s Manual. 
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6.4 Software Connection 

All EPM 9450/9650 and 9800 Meters: 

Connect a meter to a computer using Port 1 (9450/9650) or Port 3 (9800) to configure the 
network parameters and add a network connection. The meter must be configured to 
speak Modbus TCP. (Modbus TCP is the common protocol used for Modbus communication 
over a network.) 

Note The Gateway operates as a Modbus RTU Master with programmable Baud Rate up to 
115200. 

Direct Connection: 

Click the Connect button on the Tool Bar or select Connect > Quick 
Connect . 

Click the Network radio button. 
The Connect screen will change from the Serial Port version to this 
example.

Enter settings for Network Connection (see your Network Administrator for 
correct settings): 

In the Device Address field, enter 1. 

In the Host field, enter an IP Address or a Registered Name (see 
your Network Administrator). 

In the Network Port and Protocol fields, the example settings are fixed. 

Click Connect . 
GE Communicator EXT locates the meter and the Device Status 
screen appears, confirming the connection. 

Click OK. 
The computer is now connected to the meter. 
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The Computer Status Bar at the bottom of the screen confirms the 
computer’s connection parameters. Status Bars vary, depending on the 
connection parameters. 

Note You may use a connected external display to view the baud rate, address and 
communication protocol of each port. See Chapter 3 for details of how to configure the 
meter’s communication ports. 

Connection Manager: 

Connect a meter to a computer using Port 1 (9450/9650) or Port 3 (9800) to configure the 
network parameters and add a network connection. The meter must be configured to use 
Modbus TCP. (Modbus TCP is the common protocol used for Modbus communication over a 
network.) 

Note The Gateway operates as a Modbus RTU Master with programmable Baud Rate up to 
115200. 

Click the Connection Manager icon, or select Connection > 
Connection Manager. 
The example screen appears: 

Select the New Location listing in the Locations field. 
Your selection will be highlighted. 

Click the Edit button. 
The Location Editor screen appears, displaying the computer’s 
communication settings:

Enter a Location Name in the field at the top of the screen, if 
desired. 
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Click on the Network button. 
The screen will change to the following:  

Enter a Computer’s IP Address in the Host field. 

In the Network Port field, enter 502 (assigned port for Modbus 
TCP). 

To add or remove devices from the network, click Add or Remove. 

If you are adding a device, click Edit to change the device Name, 
Address and/or Description. 
The following screen will appear: 
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Ethernet Gateway (Port 2) of the Internal Network Option Meter is 
used to add multiple additional units. Additional meters must be 
configured to speak Modbus RTU and set to the same Baud Rate 
(up to 115200) as the Internal Network Option Meter. 

Note A computer “talks” to the Internal Network Option Meter via Modbus TCP. This meter 
receives data in Modbus TCP “incoming message format” and communicates with other 
devices via Modbus RTU. They do not have to be Internal Network Option units. 

If additional devices are required: 

In the Device Address field enter the address assigned to the 
additional meter. 
Again, each unit MUST have a unique address other than 1. “1” is 
reserved as the address of the meter connected to the network.

In the Name field, enter a name for the device, one that is different 
from any others at that location. 

In the Protocol field, select Modbus TCP. 

Leave the Device Type field set to Meter. 

Click on the Close button when all information is entered. 

If you are connecting to multiple meters at this location: 

Repeat the above process for all meters. 
Each device MUST have a unique address. 

To remove devices, select and click Remove. 

Click on the Close button when you have finished adding or 
removing devices. 
The first Connection Manager screen returns.  

Click once on the Location to which you would like to connect your 
computer. 
You may only connect to one location at a time. 
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To change to a different location, you must first disconnect from 
the current location by clicking on the Disconnect button or by 
selecting Disconnect from the Connection Menu. 

Click Connect . 
The computer connects to the meter via the network. 

When GE Communicator EXT has located the meter(s) at that location, the Device Status 
screen appears, confirming the connection. The Computer Status Bar at the bottom of the 
screen confirms the computer’s connection parameters. 

Note Troubleshooting the Connection: If the connection fails, check first to see if the both the 
physical and software connections to the primary Internal Network Option Meter are 
viable (see below). Once these connections have been checked, check the connections 
with other devices. 

Suggested checkpoints: 

Internal Network Option Meter: 

Check cables. 

Check IP Address, Subnet Mask and Default Gateway settings. 

Check that the Address is 1. 

Check that Modbus TCP was selected in Device Properties. 

Other Devices: 

Check all the above except the Address. 

Check that the Address is unique and not set to 1. 

Check that the Baud Rate settings for the Ethernet Gateway (Port 2) 
and the Devices are the same. 
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Try “Pinging” to a known good network device, such as another computer, to verify 
that your computer is connected properly to the network: 

Go to the DOS Prompt (or, Console, if you are using Windows® NT). 

Ping IP Address. 
Example: “Ping 10.0.0.1”.  
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6.5 Setting Up the 10/100BaseT Connection 

Setting up the 10/100BaseT Option consists of configuring the web connection and the 
Advanced Network Card Screens so that you can access the data you need from the Web.

Once the initial configuration is set, you will not need software, unless you want to make 
changes to the configuration. With the Basic Setup, you will be able to access the Default 
Screens (page 6-1) that display a variety of Real-Time readings. You may wish to customize 
your screens. (See details in section 6.6.) 

In order for the Web to access the data from a meter, the meter must have an IP Address. 
An IP Address is a number (typically written as four numbers separated by periods, e.g. 
107.3.2.54) which uniquely identifies a computer attached to the Internet. An IP Address 
can be assigned using a DHCP Server or it can be entered manually. 

For your information, here is a brief explanation of DHCP: 

DHCP  (Dynamic Host Configuration Protocol) was created by IETF (Internet 
Engineering Task Force) to enable individual computers on an IP network to extract 
their configurations from a server (the “DHCP Server”), or servers, that have no exact 
information about the individual computers until they request the information. The 
DHCP Server “leases” the IP Address to the DHCP Client for a period of time from 15 
minutes to a year. More information can be found in the Internet RFCs (Request for 
Comments) regarding available servers and technical details. 

Note In DHCP Mode, if a NACK message is received from the DHCP server, INP100 will stop all 
Ethernet activities immediately and start a new DHCP process. 

6.5.1 DHCP Setup 
Enable the DHCP Mode in the meter: 

From Device Profile in GE Communicator EXT, open the 
Communication Ports screen. 

Click on Advanced Settings. 

Click DHCP tab. 

Click Enable DHCP. 

Access a working DHCP Server. 

DHCP Servers automatically assign an IP Address and Subnet 
Mask. Some DHCP Servers, such as the one in Windows 2000® 
allow you to assign a Default Gateway IP (DHCP Option #3), DNS 
IP (DHCP Option #6) and SMTP Server IP (DHCP Option #69) to the 
meter. If your DHCP Server does not let you assign parameters 
other than the IP Address, enter those values manually. 

Enter a unique computer name (Optional). 

This allows the user to access the meter by name, if there is a 
DNS Server working in conjunction with the DHCP Server. Please 
see your network administrator and the server’s user manuals 
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for further details. The Default Computer Name is GE 
MultilinNET_XXXXXX where the X’s are the last 3 octets of the 
MAC Address. 

Manual Set Up 

Manually enter an IP Address, if DHCP Mode is OFF. 

For reference - IP Addresses reserved for Internal Networks: 

Class A -- 10.0.0.0 - 10.255.255.255 

Class B -- 172.16.0.0 to 172.31.255.255 

Class C -- 192.168.0.0 to 192.168.255.255 

Note See RFC1918 for Internal IP Reference. 

Basic Items: 

IP Address

Subnet Mask

Default Gateway

Nonconfigurable Gateway Port Items: 

Data Bits = 8  

Stop bits = 1  

Parity = none 

Advanced Items: 

Gateway Port (RS-485) Baud Rate 

Gateway Port Delay 

DNS IP (will be needed for WebAlarm email and FTP Client if the Server 
Address is entered as a name string, not an IP Address). 
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6.5.2 Services & Security 
Click the Services tab. 

Check the boxes in front of the listed Services to Enable the 
features desired. 
Unless these Services are Enabled, they will not work. 

If you do not want to Block Password Protected Access, press 
OK > OK to return to the main screen and press the Update Device 
button. 

Block Password Protected Access 

This feature blocks access to an EPM 9650 or 9800 at Modbus Address 1 in INP100/102.

The feature was added to INP100/102 runtime firmware in v0.1.52.  

Once it is enabled, the INP100/102 network card will block all network requests when it 
detects that a user is sending a password to the meter at Modbus Address 1. 

As a result, if the meter is password-enabled and the user is trying to gain access by 
sending a password through the network interface via Modbus TCP or through the modem 
via Modbus ASCII, the operation will be stopped and the user will not be able to access the 
password enabled area. 

Note Use of this feature requires an INP100/102 firmware update and a GE Communicator EXT 
software update. 

Update Procedures: 

Go to the meter’s /update1.htm page to update its firmware.
(Example: 100.0.0.0/update1.htm) 

When done, go to /reset_ethernet.htm page to reset it. 

Uninstall the old software. 
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Install the new software. 

Connect to a meter via serial port and retrieve its Device Profile. 

Under Communications > Advanced Settings (for network card) > 
Services & Security, check the box for Block password protected 
access to device with address 1. 

Press OK > OK to return to the main screen, and press the Update 
Device button. 

Go to menu bar Tools > Password > Enable/Disable to enable 
password protection for the meter. 

In the meter’s /diag_modbus_tcp_server.htm web page, you should see:

Block set password to meter: Enabled 

6.5.3 Computer Name / DNS 
Click the Computer Name / DNS tab. 

Enter the Computer Name. 

Enter the IP Addresses for Domain Name Servers 1 and 2. 

Click OK to save settings. 
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6.5.4 Auto TFTP Download 
Click the Auto TFTP Download tab. 

Enable Auto TFTP Download; the port is 69. 

Enter the TFTP Server IP Address, Client IP Address, Subnet Mask, 
Default Gateway and the Download Filename. 

Click OK to Save. 

Once that data is saved, it is downloaded automatically until you change it.  

6.5.5 WebAlarm/Email 
This feature sends out email when an alarm condition occurs. The settings are configured 
in the Advanced Network Card Settings. An additional 8 email addresses can be configured 
in the poll_profile.xml file. 

Access those settings from Device Profile > Communication Ports 
> Advanced Settings. 

Click the Services tab. 
The Services screen appears. 

Enable/Disable the sending of Email by clicking SMTP Client . 
The Initial Setting is OFF. 
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Click on the Alarm/Email tab. 
The screen appears as it is shown here. 

Enter the settings below to configure Alarm/Email service. 

Alarm/Email Settings: 

• SMTP Server IP or Name (Requires DNS Setup). 

• Email Server Port Number: 25 

• Administrator Email Address/To Address: for user preferred address or any 
monitoring software receive address such as GE Multilin’s Dial-In Server. 

• Return/Reply/From Address. 

• Subject Text: any 

6.5.6 FTP Client 
This feature allows the user to substitute his own (user-defined) polling profile, web pages 
or graphics for the web server. User should set up an FTP Server nearby with a user 
account and read-only access for this purpose. 

Access the Advanced Network Card Settings (see above). 

Click the Services tab. 
The Services screen appears. 

Enable/Disable the sending of Email by clicking FTP Client .
The Initial Setting is OFF. 
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Click on the FTP Client tab. 
An example screen is shown here.  

Enter the following settings to load user defined files.
FTP Client Settings: 

• FTP Server IP or Name (requires DNS setup). 
• FTP Server Port, Initial Setting is xx. 
• Startup Directory: (where files are located)(subdirectory is not 

supported). If the file has the same name as the one in the Initial 
Files within the meter, the new file will replace the Initial one. 

• User Name 
• Password. 

FTP Client Settings Example: 

By default, Microsoft’s FTP Server will use “C:\Inetpub\ftproot\” as the root directory. When 
a user logs onto the FTP Server, this is the initial directory the user will see. 

1. If the files for INP100 are stored in the root directory (“C:\Inetpub\ftproot\”), leave the 
“Startup Remote Directory” text box empty. 

Example Files in FTP Server’s Root Directory: 

• C:\Inetpub\ftproot\index.htm 

• C:\Inetpub\ftproot\poll_profile.xml 

• C:\Inetpub\ftproot\logo.gif When INP100 starts up, it will check to see 
what files are in the server’s directory and will download them all. 

2. If the files for INP100 are stored in a subdirectory in the root directory, such as 
C:\Inetpub\ftproot\EPM_meters\feeder_12345\, put EPM_meters/feeder_12345 in 
the Startup Remote Directory text box. 
Note the different “/” between directory names. 

When INP100 starts up, it will check for all files in the server’s directory (EPM_meters/
feeder_12345) and download all files found. 
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If there is another subdirectory inside this directory that is not listed in the server’s 
directory as above, such as “C:\Inetpub\ftproot\EPM_meters\feeder_12345\info\”, 
INP100 will not locate that subdirectory and no files will be downloaded from that 
subdirectory to INP100. 

That may cause an error during the file downloading process and the system may not 
enter its normal operation mode until the subdirectory is removed from the server. 

3. The user should always check the FTP server to see if it’s configured properly. To do 
this, open the IE browser window, enter the correct address in the URL window. 

The standard format is: ftp://[username]:[password]@[ip_address]. 

Example: 
ftp://john:1a2b3c@192.168.1.1 where John is the user name and 1a2b3c is the 
password. 

6.5.7 INP 102 Ethernet/Modem Combination 
INP 102 is an extension of INP 100. It has all the features of an INP 100, plus a built-in 
modem. The communication protocol supported by the modem is Modbus ASCII. The 
communication protocol supported by the RS-485 Ethernet/Modem gateway port is 
Modbus RTU. 

The INP 102 converts all Modbus ASCII incoming modem requests to Modbus RTU for 
internal and gateway communication, then it converts all response Modbus RTU messages 
into Modbus ASCII protocol and send out to the modem. Some of the fixed parameters for 
the Ethernet/Modem gateway port are: 8 data bits, no parity, 1 stop bit. The Ethernet/
Modem gateway port's baud rate and delay time are configurable. 

The modem has three operational modes: 

1. Modem Command 
Mode Invisible to users. Modem is idle, waiting for incoming call. 

2. User Command Mode 
Visible to users. If modem password protection is enabled, the user can enter the 
password in this mode, so that the modem can grant him access. In addition, the user 
can query the modem for its boot and runtime firmware version, modem 
identification information. 

3. Passthrough Mode 
Normal Operation mode. Modbus requests and responses are passed through the 
modem. 
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Example: 

call failure reset limit = 1 hour 

violation lockout time = 24 hours 

incoming connection failure count = 3 

The first connection with a bad password occurred at 10:00am. Another occurred at 10:05, 
a third at 10:30, a fourth at 10:45 (all with a bad password). That's more than 3 in 1 hour, so 
the modem will not answer the phone again until 10:45am the next day. If the fourth 
connection attempt had been received at 11:31 instead of 10:45, the modem would have 
answered the call because the first 3  had "expired" at 11:30.

Table 6–1: INP102 Settings

Setting Description 

Inactivity Timeout Limits (Minutes) In Passthrough Mode, if the user does not send 
anything to the modem, the modem will 
disconnect when this Inactivity Timeout Limit has 
been reached. 

Rings to Answer (Rings) The modem will answer the call after a certain 
number of rings. 

Identification User-defined modem ID: up to 32 characters. 

Password User-defined modem password: up to 16 
characters. 

Enable Password Option to enable or disable modem password 
feature. 

Violation Limit (Attempts) If Password was enabled and the user failed to 
enter a correct password, a Violation (Call Failure) 
Flag will be set and the Violation Counter will 
Increment by 1. Once the total number of 
violations goes over the limit of three, the modem 
will enter Lockout mode. The modem will not 
answer calls until the Violation Lockout Time is 
reached.

Violation Lockout Time (Hours) Modem will stay in Lockout mode until this 
Lockout Time is reached. 

Call Failure Reset Limit (Hours) If the Password was enabled and the Total 
Violations (Call Failures) did not reach the 
Violation Limit (modem not in Lockout Mode), the 
modem resets the Violation (Call Failure) Counter 
when it reaches this reset limit. 

Share the Phone Line Option to Enable or Disable modem’s Share the 
Phone Line feature. 
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More information about the modem operation 

1. When the Share the Phone Line option is set, the modem should drop the 
connection in about 5 seconds, assuming someone picked up the receiver and 
didn't hang up. If the receiver was hung up quickly, the connection will not 
drop. 

2. When the Share the Phone Line option is not set, the modem should not drop 
the connection and communication should resume about 10 seconds after 
the receiver was hung up. The modem can still drop the connection if the 
noise level is too high, such as with repeated pick-up and hang-up or noise at 
the receiver. The performance of this mode is not guaranteed. There will be no 
valid communication if the receiver is picked up for any substantial length of 
time. 

3. No dial out support: User cannot "flash upgrade" the Ethernet/modem's 
firmware from a modem connection. 

4. Modem and Ethernet connections will close if either detects a change in 
device profile or are forced to reset by the user from a web interface. 

5. If the firmware does not detect the modem hardware, the modem task will be 
stopped. 

A modem status/diagnostic web page can be found at /diag_modem.htm.

Table 6–2: INP102 Modem Commands

Command Description 

[3 seconds pause] 
:CM 
[3 seconds pause] 

Set the modem to User Command mode

ONLINE<CR>  Set the Modem to Passthrough mode 

E<CR> Command or querying modem’s characteristic information. 
Modem returns “INP-102 Ethernet/Modem” 

MODEM?<CR> Command for querying modem’s ID 

PASSWORD?<CR> If the Modem Password was enabled, the modem will send this 
query to the user once the connection is established, asking for 
a Password . 
The user must enter the Correct Password before sending any 
other user data. The user has 20 seconds to reply with a 
Password. If there is no response from the user, the modem will 
resend this command. 
If the Password was incorrect, the modem will resend this 
command. The user can have 3 attempts to enter the Correct 
Password before the modem automatically disconnects. 

FBOOT?<CR> Command for querying modem’s boot firmware version 

FRUN?<CR> Command for querying modem’s Runtime Firmware version  
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6.5.8 DNP for LAN/WAN 
The original DNP 3.0 was designed for serial point-to-point communication (e.g. RS-232) 
with limited support for half-duplex serial networks (e.g. RS-485). In order for devices to 
exchange DNP messages in a local (LAN) or wide area network (WAN), one must either 
augment the protocol to support a network environment or use an existing network 
transport mechanism. DNP 3.0 LAN/WAN was specifically defined to transport DNP traffic 
on the Internet Protocol Suite. 

GE’s DNP 3.0 LAN/WAN implementation was based on the specifications described in 
DNP3 Specification, Volume 7, Networking, according to the Version 2.0 Draft E of March 12, 
2004. The official DNP 3.0 specifications can be found at www.dnp.org. 

Table 6–3: DNP Parameters

Name Settings Notes

DNP Over TCP Enabled
Disabled

If set to Enabled, network card will receive DNP 
over TCP requests.

DNP Over TCP 
Listen on Port

20000 
User Defined

TCP Listening Port

DNP over UDP Enabled
Disabled

If set to Enabled, network card will receive DNP 
over UDP requests.

DNP Over UDP 
Listen on Port

20000 
User Defined

UDP Listening Port

UDP Respond to Client Port  
User Defined

If set to Client Port , UDP response will be sent 
to the UDP Request Port. Otherwise, UDP 
Response will be sent to a user-defined port 
number. Default is fixed at 20000.

UDP Addressing Unicast
Broadcast

Unicast & 
Broadcast

If set to Unicast & Broadcast , all UDP requests 
are accepted.
If set to Unicast, network card will check to see 
if the UDP Destination Address matches the 
meter’s IP Address.
If set to Broadcast, network card will check to 
see if the UDP Destination Address is 
255.255.255.255.
If no match, the UDP connection is refused.

Validate Sources 
IPs

Validation 
Disabled

1 IP Address

2 to 4 IP 
Addresses

If set to Disabled, network card will not perform 
validation on any incoming IP Addresses.

If set to 1 to 4, network card will perform 
validations on every IP Address defined by user.
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Note Settings in bold are default for Standard Mode

GE's DNP 3.0 LAN/WAN feature is available for certain EPM advanced meters with INP-100/
102 Network Card. Currently, advanced power meters with INP-100/102 have this feature. 
If a user chooses to use this feature, the user has to configure the EPM meter's DNP 
Custom Classes Map in the meter's Device Profile. See Chapter 4 of this manual for 
configuration screens and details. 

Modes of Operation 

Disabled: Feature is disabled. No DNP 3.0 LAN/WAN communication will be accepted. 

Standard: Feature is enabled. Most communication parameters are fixed, except the 
port number to which UDP packets respond. Security features are not available. 

Manual: Feature is enabled. All communication parameters are configurable. Security 
features are available. 

A single DNP Over TCP connection and a single DNP Over UDP connection will be available 
when it is enabled. While DNP Over TCP connections may be closed at the decision of the 
network card, the main meter might also determine that the current DNP Over TCP 
connection should be closed. 

Since INP-100/102 has several built-in servers, the DNP LAN/WAN TCP and UDP Listen on 
Ports defined by the user cannot be one of the following: 

Example of setting up validation for IP Addresses 

1. Set Validate Source IPs to 1 IP Address.

2. Set Validate Source ports to Yes. 

3. Enter IP address, such as 10.0.0.101. 

4. Enter mask, such as 255.255.255.128. 

5. Enter TCP ports range, such as 20000-20000. 

Validate Source 
Ports

No
Yes

If set to No, network card will not perform 
validations on incoming TCP and UDP Ports for 
a given IP Address.

IP Addresses User Defined Up to 4 IP Addresses to validate.

Subnet Mask User Defined Masking bits applied to IP Address. When 
defined properly, user can specify validation on 
a single (or a range of) IP Address.

TCP Ports, Start 
and End

User Defined TCP Port Range to be validated.

UDP Ports, Start 
and End

User Defined UDP Port Range to be validated.

Table 6–3: DNP Parameters

Name Settings Notes
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6. Enter UDP ports range, such as 20000-20000. 

As a result, a valid DNP 3.0 LAN/WAN request must come from a device with IP address of 
10.0.0.1 to 10.0.0.127, with TCP and UDP ports set at 20000. 

If a DNP Over TCP connection was established and Validation was also enabled, any new 
incoming DNP Over UDP connection has the same IP Address as the TCP connection. If 
they are different, the UDP connection will be closed. 

The DNP address in the DNP LAN/WAN request should always be 1. All incoming 
communication for DNP LAN/WAN will go to the main meter and no DNP communication 
will go to the INP-100/102's gateway port. 

Name Port Number 

Echo 7 

FTP Server Data 20 

FTP Server Control 21 

Web Server 80 

Modbus TCP Server 502 
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6.6 Customizing Screens 

6.6.1 Configuring WebExplorer© 
All polled data is stored in an XML file: poll_data.xml. Each polled item is located in its 
DEVICE_x section as it is programmed in the poll_profile.xml file. The standard data 
format for each device is: 

up to 64, each with its D_UID, D_LABEL and D_VALUE. 

This XML file can be viewed directly in your browser. To display it on a customized web 
page, you must set up your browser to run JavaScript.  (Configuring XML is detailed in 
section 6.6.2.) 

Note Auto Refresh Rate is set in the SetTimeout ()Function (see Java Script example below). 

Example of the data file: 
<?xml version=”1.0” encoding=”UTF-8”?>

<!--Embedded network server polled data-->

<GE_Multilin_DATA>

<GE_Multilin_SYSTEM>

</GE_Multilin_SYSTEM>

<DEVICE_1>

<DEV_NAME>Meter Demo 1</DEV_NAME>

DEV_TYPE>Meter 1250</DEV_TYPE>

<item D_UID=”1_1” D_LABEL=”Inst Van” 
D_VALUE=”+122.46”><item>

</DEVICE_1>

<DEVICE_2>

<DEV_NAME>N/A</DEV_NAME>
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DEV_TYPE></DEV_TYPE>

<item D_UID=”2_1” D_LABEL=”Inst Watt” D_VALUE=”+0.08 k”></
item>

</DEVICE_2>

</GE_Multilin_DATA>

Displaying a value in an HTML file:  
(Use JavaScript in the web browser) 

Define a unique name for a value to be displayed, such as data_name. Insert [CODE] in the 
HTML file where it will be displayed. 

Create JavaScript code inside the HTML file (Auto Screen Refresh is set at 5000ms in the 
Set Timeout () Function; see Example below) : 

Example: 

<Script language=Javascript>

<!--var disp_value;

var timerID;

var tmp_name;

var xmlDoc=new ActiveXObject(“MSXML.DomDocument”);

xmlDoc.async=true;

xmlDoc.onreadyststechange=do_get_data;

function do_get_xml()

{

xmlDoc.load(“poll_data.xml”);

{

function do_get_data()

{

if (xmlDoc.readyState == 4)

{

if (xmlDoc.documentElement == null)

{

timerID = setTimeout(“do_get_xml();”,5000);

}

else

{

disp_value =

xmlDoc.documentElement.selectSingleNode

(“//item[@D_UID=’1_1’]”).

getAttribute(“D_VALUE”);

data_name.innerHTML = disp_value;

timerID = setTimeout(“do_get_xml();”,5000);

}

}

}
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//--></SCRIPT>

Note Inside the <body> of the HTML file, add on the following: 

Load=”do_get_xml()”

Server Side Include Functions 

These functions will send data directly to the browser as part of a requested document. 

Example of using Server Side Include Functions: 

1. In HTML file, add to the first line of that file 

<!-- ** THIS FILE DOES CONTAIN REALTIME DATA ** -->

Without that line, any server side Include functions will not be processed by the web 
server. 

2. Inside the HTML file where you want the info displayed, add 

<!--#exec cgi=”/[server_side_include_function_name]”-->

where [server_side_function_name] can be one of the function names. 

3. To display stored email #1’s date/time, add the following to your HTML file at the 
location where you want the data displayed: 

<!--#exec cgi=”/ssi_show_email_date_time 1”-->

Table 6–4: General Functions

Server Side Include Function 
Name Parameter Description 

get_ip.fn Show local IP address 

Table 6–5: Diagnostic Functions

Server Side Include Function 
Name Parameter Description 

ssi_diag_cpu Show CPU 

info ssi_diag_ethernet_hardware Show ethernet hardware 

info ssi_diag_firmware Show firmware 

info ssi_diag_ftp_server Show FTP Server 

info ssi_diag_imported_files Show FTP client/imported files 
status 

ssi_diag_memory Show memory 

info ssi_diag_modbus_com Show all Modbus communication 
info 

ssi_diag_modbus_tcp_server Show Modbus TCP Server info 
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ssi_diag_modem Show internal modem (INP102) 
status 

ssi_diag_system Show system info, such as start time 

ssi_diag_web_server Show Web server info

stats.fn Show ethernet communication 
status  

Table 6–6: Stored E-mail Functions

Server Side Include Function 
Name Parameter Description 

ssi_show_email_date_time 1 to 10 Show stored email’s date/time 

ssi_show_email_subject 1 to 10 Show stored email’s subject text 

ssi_show_email_from 1 to 10 Show stored email’s from text 

ssi_show_email_to 1 to 10 Show stored email’s to text 

ssi_show_email_cc 1 to 10 Show stored email’s cc text 

ssi_show_email_device_name 1 to 10 Show stored email’s device name 
text 

ssi_show_email_contact_person 1 to 10 Show stored email’s contact person 
name 

ssi_show_email_contact_phone 1 to 10 Show stored email’s contact phone 
number 

ssi_show_email_alarm_ids 1 to 10 Show stored email’s alarm IDs 

ssi_show_email_alarm_names 1 to 10 Show stored email’s alarm names 

ssi_show_email_alarm_details 1 to 10 Show stored email’s alarm details 

ssi_show_email_send_status 1 to 10 Show stored email’s send status 

NOTE: 1 = Newest, 10 = Oldest STORED EMAIL FUNCTIONS 

Table 6–7: Special Functions for MODBUS DEVICE 1

Server Side Include Function 
Name Parameter Description 

ssi_show_pt Show PT ratio 

Table 6–5: Diagnostic Functions

Server Side Include Function 
Name Parameter Description 
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6.6.2 Configuring WebXML© 
The term XML stands for EXtensible Markup Language. XML is a markup language similar 
to HTML which is used to describe data. 

HTML displays the data. XML does not replace HTML; it compliments HTML. 

An XML document is information wrapped in XML tags. A piece of software has to be 
written to send, receive or display the document. 

The “Rules” of XML

1. The first line of the document, the XML declaration, defines the XML version 
and the characters used in the document. 

2. All XML elements MUST have a closing tag. It is illegal to omit the closing tag. 

3. XML tags are case sensitive. 

4. All XML elements must be properly nested. 

5. All XML documents must have a root tag (first tag in an XML document). 

ssi_show_ct Show CT ratio 

ssi_show_system Show hookup info 

ssi_show_dev_type Show device type/model 

ssi_show_dev_name Show device name 

ssi_show_boot Show boot firmware version 

ssi_show_run_time Show runtime firmware version 

ssi_show_dsp_boot Show DSP firmware boot version 

ssi_show_dsp_runtime Show DSP runtime firmware version 

ssi_show_sn Show device serial number 

ssi_show_com_state Show COM firmware runtime state 

ssi_show_dsp_state Show DSP firmware runtime state 

ssi_show_pw_state Show password protection state 

ssi_show_mac Show ethernet MAC address 

ssi_show_ip Show IP address 

ssi_show_mask Show subnet mask 

ssi_show_gateway Show default gateway IP address 

ssi_show_dnp_lan_wan Show DNP LAN/WAN status 

Table 6–7: Special Functions for MODBUS DEVICE 1

Server Side Include Function 
Name Parameter Description 
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6. Attribute values must always be quoted. It is illegal to omit quotation marks 
around attribute values. 

7. Comment syntax is similar to HTML. <!--This is a comment--> 

Example of Root Tag and Elements: 

The first tag in an XML document is the root tag. All XML documents must contain a single 
tag pair to define the root element. All other elements must be nested within the root 
element. 

All elements can have subelements ("children"). Subelements must be correctly nested 
within their parent elements as shown below: 

<root>

<child>

<subchild>.....</subchild>

</child>

</root>

Example of Attributes: 
<data id=”1” value=”123”></data>

Poll_profile.xml: 

File configured to poll parameters of each device 

Root tags: <GE_Multilin_POLL_DATA> and </GE_Multilin_POLL_DATA>

System elements: <GE_Multilin_SYSTEM> and </GE_Multilin_SYSTEM>

Contains system parameters and email addresses 

General attribute:  

<item DATA_POLL_DELAY=”400”

ALARM_POLL_DELAY=”1000”

SYSTEM_COMM_TIMEOUT=”1000”

ALARM_CONTACT_PHONE=””

ALARM_CONTACT_PERSON=”Administrator”

></item>

Table 6–8: System Attributes

Attribute Description Settings 

DATA_POLL_DELAY Poll delay between each Modbus 
poll, in milliseconds 

Min=500 Max=65536 
Default=500 

SYSTEM_COMM_TIMEOUT System communication timeout, 
in milliseconds 

Min=500 Max=32000 
Default=500 

ALARM_POLL_DELAY Poll delay between each Modbus 
poll for each device’s alarm 
polling, in milliseconds 

Min= 1000 
Max=65535 
Default=1000 
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Email Attributes
<item EMAIL_1=””FORMAT_1=”long”

EMAIL_2=””FORMAT_2=”long”

EMAIL_3=””FORMAT_3=”long”

EMAIL_4=””FORMAT_4=”short”

EMAIL_5=””FORMAT_5=”short”

EMAIL_6=””FORMAT_6=”short”

EMAIL_7=””FORMAT_7=”short”

EMAIL_8=””FORMAT_8=”short”

></item>

Device Elements <DEVICE_X> and </DEVICE_X>

where X is from 1 to 16. 

Contain parameters for each device. 

General Attributes 
<item DEV_TYPE=”Meter 1250”

DEV_PROTOCOL=”Modbus RTU”

DEV_NAME=”Meter Demo 1”

DEV_ADDRESS=”1”

DEV_IP=””

DEV_MAX_PACKET_LEN=”127”

DEV_POLL_ALARM=”yes”

DEV_ALARM_OPTIONS=”1+2+3+4+5+9”

DEV_ALARM_DELAY=”2000”

DEV_COMM_TIMEOUT=”750”

DEV_PARENT=”1”

></item>

Polling Data Elements <DEV_DATA> and </DEV_DATA>

Polling data attributes, up to 64 in each <DEV_DATA> element: 

<item D_UID=”1_1”

D_LABEL=”Inst Van”

D_ADDR=”180”

D_LENGTH=”2”

D_TYPE=”7”

ALARM_CONTACT_PHONE Alarm contact phone number Max size=10 digits 

ALARM_CONTACT_PERSON Alarm contact person name Max size=64 
characters

Table 6–8: System Attributes

Attribute Description Settings 
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D_USE_SPECIAL=”3”

D_VALUMODE=”Primary”

></item>

 

Table 6–9: E-mail Attributes

EMAIL_X Email address, X is from 1 to 8 Max size = 64 characters 

FORMAT_Y Email format, Y is from 1 to 8 Strings ‘long’ or ‘short’ 

Table 6–10: System Elements

Device Element 
Description Settings 

DEV_TYPE Supported device 
name 

Generic Modbus 
EPM 1250 (EPM 9450) 
EPM 1252 (EPM 9650) 
EPM 1260 
EPM 1262 
EPM 1270 
EPM 1272 (EPM 9800) 
[~DEVICE_TYPE_LABEL] = Auto 
detect device’s type (Only 
supported in EPM devices) 

DEV_PROTOCOL Protocol name Modbus RTU 
Modbus TCP 

DEV_NAME User assigned device 
name 

Max = 32 characters 
[~DEVICE_LABEL] = Use the 
name stored inside the device 
(Only supported in EPM devices) 

DEV_ADDRESS Device address Modbus protocol = 1 to 247 

DEV_IP IP address for 
Modbus TCP devices 

xxx.xxx.xxx.xxx 

DEV_MAX_PACKET_LEN Max modbus 
registers for a 
device’s response 
buffer 

EPM = 127 
EPM & DMMS = 50 

DEV_POLL_ALARM Enable or disable 
device alarm poll 
function 

Yes = Enable 
No = Disable 
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DEV_ALARM_OPTIONS Alarm poll options 1 = Limits changed 
2 = Inputs changed 
3 = Waveform captured 
4 = PQ (CBEMA) event captured 
5 = Control output changed 
9 = Communication failure 

DEV_ALARM_DELAY Delay time for 
reporting alarm 
condition (in 
milliseconds) for limit 
and input type 
alarms 

Min = 0 
Max = 300000 
Default = 0 

DEV_COMM_TIMEOUT Device 
communication 
timeout (in 
milliseconds) 

Min = 500 
Max = 32000 
Default = 500 

DEV_DATA_FORMAT Data format 0 to 0.000000 

DEV_PARENT Parent device ID (see 
NOTE) 

Value from 1 to 16 

DEV_MODBUS_REG_BASE Device’s modbus 
register base is either 

0 based integer value or 
1 based integer value (default) 

DEV_TCP_PORT Remote Modbus TCP 
device’s port number 

Default setting = 502 

Table 6–11: Data Element Attributes

Attribute Description Settings 

D_UID User assigned device polling 
data unique ID 

Max = 16 characters 

D_LABEL User assigned data label Max = 32 characters 

D_ADDR Modbus register address 0 or 1 based integer value 

D_LENGTH Number of Modbus registers 

D_TYPE Data type For EPM9450/9650, 9800 
devices, use Fx 
Communication Data Formats 
For Generic Modbus Device 
Type, see NOTE below for 
values 

D_USE_SPECIAL Special functions See NOTE* 

Table 6–10: System Elements

Device Element 
Description Settings 
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D_VALUEMODE Value mode Raw 
Primary 
Secondary 
Value (for Generic Modbus 
Device Type)
Interpreted. See NOTE**

D_CHANNEL Channel ID for I/O type values  (EPM only)

D_SHOW_KM Format value with k or M Auto = auto show k or M 
k = fixed to k 
M = fixed to M 

D_NA_VAL If a numerical value is set 
here and a real polled value 
matched with this number, a 
‘***’ string will be stored in 
the xml data file. 

Numerical Value for ‘***’ (EPM 
only) 

D_FUNCTION_CODE Modbus protocol function 
code 

1, 2, 3 (default), 4 

D_BYTE_ORDER Data byte order for Generic 
Modbus device. (Settings if 
source is 0x12345678) 

0 MSR, MSB 0x1234, 0x5678: 
MS reg first, MS byte first 
(default) 
1 MSR, LSB 0x3412, 0x7856, MS 
reg first, LS byte first 
2 LSR, MSB 0x5678, 0x1234, LS 
reg first, MS byte first 
3 LSR, LSB 0x7856, 0x3412, LS 
reg first, LS byte first 

D_SPECIAL Generic multiplier value for 
Generic Modbus device; 
applied when 
D_USE_SPECIAL is set to 6 

1 = Default 

D_TAG_SPECIAL Cross linked multiplier ID for 
Generic Modbus device 

Setting is any unique D_UID’s 
setting within polling profile 

D_MASKING_TYPE Data masking type for 
Generic Modbus device 

0 = do nothing (default) 
1 = NOT 
2 = OR 
3 = AND 
4 = NOR 
5 = NAND 
6 = XOR 
7 = XNOR

Table 6–11: Data Element Attributes

Attribute Description Settings 
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Note Parent device ID (DEV_PARENT), for polling expansion beyond the 64 items per device 
limitation. If set, it will use the parent device’s communication settings. 

Note Values for Generic Modbus D_TYPE: 

1 = ASCII string 

2 = 1 byte, signed high byte of the Modbus Register 

3 = 1 byte, signed low byte of the Modbus Register 

4 = 1 byte, unsigned high byte of the Modbus Register 

5 = 1 byte, unsigned low byte of the Modbus Register 

6 = 2 bytes, signed integer 

7 = 2 bytes, unsigned integer 

8 = 4 bytes, signed long integer 

9 = 4 bytes, unsigned long integer 

10 = 8 bytes, signed long long integer 

11 = 8 bytes, unsigned long long integer 

12 = 4 bytes, IEEE float 

13 = 1 digit, 8 bits representation 

14 = 1 digit, 4 bits representation (aka Packed BCD) 

15.= 1 byte, signed 

16 = 1 byte, unsigned 

17 = 8 bytes, IEEE float 

D_MASKING_VALUE Data masking value for 
Generic Modbus device; 
setting is hex ASCII string for 
up to 8 bytes of data 

0x0 = default 
Example of a 3 byte value: 
0xAB12CD

D_CFG_FILE Configuration file name for 
Generic Modbus device 

Case sensitive file name up to 
128 characters; the file must 
be available at system start up 
using FTP download 

D_VALUE Value processed by Total 
Web Solutions and stored in 
poll_data.xml file 

D_REF Reference info or value for 
polled item; stored in 
poll_data.xml file 

Data source is the 
configuration file

Table 6–11: Data Element Attributes

Attribute Description Settings 
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Note * Parameters for D_USE_SPECIAL: 

0 = do not multiply any number 

1 = multiply by CT ratio (mainly used for current values) 

2 = multiply by CT Aux ratio 

3 = multiply by PT ratio (mainly used for voltage values) 

4 = multiply by PT Aux ratio 

5 = multiply by CT and PT ratio (mainly used for power, energy values) 

6 = multiply by the value in D_SPECIAL (generic modbus device only) 

Note ** If D_VALUEMODE is set to Interpreted, when used with Meter Input Values, the result will 
be a user-defined name in the Meter’s Device Profile instead of a value of 0 or 1.

Poll_data.xml 

Root tag: <GE_Multilin_DATA> and </GE_Multilin?DATA>

One (1) system element: <GE_Multilin_SYSTEM> and </GE_Multilin_SYSTEM> 

Eight (8) device elements: <DEVICE_X> and </DEVICE_X> where X is from 1 to 8.

In each of the 8 device elements: Device info elements: card copies data from 
poll_profile.xml 

<DEV_NAME> and </DEV_NAME>

<DEV_TYPE> and </DEV_TYPE>

Up to 64 polling data attributes: card copies data from poll_profile.xml 

<item D_UID=”1_1”

D_LABEL=”Inst Van”

D_VALUE=”+126.06” (Data value).

></item>

Configuration File (for Generic Modbus Device) 

The purpose of the configuration file is to allow the user to set what real value or 
information could be available in the poll_data.xml file. Each configuration file allows the 
user to set up 8 interpreted values or strings. The configuration file’s format is XML.

Below is an example xml file with three values: 

<?xml version=”1.0” encoding=”UTF-8” ?>

<GE_Multilin_CONFIGURATION>

<item CFG_COMPARE_TYPE=”Value” CFG_VALUE=”0” CFG_REF=”Disabled” />

<item CFG_COMPARE_TYPE=”Value” CFG_VALUE=”128” CFG_REF=”Enabled” />

<item CFG_COMPARE_TYPE=”String” CFG_VALUE=”107 EPM 1250”

CFG_REF=”EPM 1250 Meter” />

</GE_Multilin_CONGFIGURATION>

The root tags are <GE_Multilin_CONFIGURATION> and </GE_Multilin_CONFIGURATION> 
with up to 8 items between the root tags. 
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CFG_COMPARE_TYPE settings are “Value” for numeric comparison or “String” for text 
comparison. 

CFG_VALUE can be a numeric value or text string (up to 256 characters) to be used for 
comparison. 

CFG_REF is any interpreted value or text string when the comparison returned a 
match (up to 256 characters for a text string). 

D_REF is the corresponding value in the poll_data.xml file. 

Order of Data Processing for Generic Modbus Device 

The steps in data processing are as follows: 

Set byte order 

Apply bit masking 

Apply multiplying factor 

Apply interpreted values from generic file(s)

6.6.3 Configuring WebReacher© 
Through the configuration of poll_profile.xml, you can poll up to 8 individual devices or up 
to 512 unique items via Modbus RTU protocol or Modbus TCP protocol. 

Devices supported: Any device that supports Modbus RTU or Modbus TCP protocol (with at 
least one available socket). 

Devices supported for Advanced Features: EPM 9450/9650 and EPM 9800. (Use Generic 
Modbus device settings for EPM 4000, 5000, 6000, 7000 meters.) 

System set-up: Set DATA_POLL_DELAY in milliseconds; the system will pause between each 
Modbus poll. Set SYSTEM_COMM_TIMEOUT in milliseconds. 

Example:

<GE_Multilin_POLL_DATA>

<GE_Multilin_SYSTEM>

<item DATA_POLL_DELAY=”400”SYSTEM_COMM_TIMEOUT=”500”></Item>

</GE_Multilin_SYSTEM>

</GE_Multilin_POLL_DATA>

Device Set-up: within the boundary of <DEVICE_X> and </DEVICE_X> 

Assign a device type, DEV_TYPE. 

Assign a protocol, DEV_PROTOCOL 

Assign user defined device name, DEV_NAME (should be unique in 
a system). 

Assign Modbus device address, DEV_ADDRESS. 

If protocol is Modbus TCP, assign the remote device’s IP address 
and the TCP port number, DEV_IP and DEV_TCP_PORT. 

Set max Modbus packet length in number of registers, 
DEV_MAX_PACKET_LEN. 
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Set device’s communication timeout in milliseconds, 
DEV_COMM_TIMEOUT. 
The timeout value should be longer for devices that speak Modbus 
TCP than for devices that speak Modbus RTU, depending on 
network traffic. 

Set device’s data display format, DEV_DATA_FORMAT, from 0 to 
0.000000. 

You can expand the polling item limitation of 64 items per device by 
setting a device as a child device of a parent device. 

For example, in <DEVICE_X> section, if you set it to be the parent device, DEV_PARENT must 
be X or 0. Then for  <DEVICE_Y>section, if you set the device to be a child device of X, set 
DEV_PARENT to X. Other parameters can be omitted.  

Example: 

<GE_Multilin_POLL_DATA>

<DEVICE_1>

<item DEV_TYPE=”EPM 1250”

DEV_PROTOCOL=”ModbusRTU”

DEV_NAME=”EPM Demo 1”

DEV_ADDRESS=”1”

DEV_IP=””

DEV_TCP_PORT=””

DEV_MAX_PACKET_LEN=”127”

DEV_COMM_TIMEOUT=”750”

DEV_DATA_FORMAT=”0.00”

DEV_PARENT=”1”>
</item>

</DEVICE_1>

</GE_Multilin_POLL_DATA>

Polling Item Set-up 

In each DEVICE_X, DEV_DATA section, you can have up to 64 items. Any extra items will be 
ignored. 

Set a unique ID, D_UID, so any program can easily access this item. 

Set a data label, D_LABEL (optional). 

Set Modbus register in decimal, 1 based, D_ADDR. 

Set how many Modbus registers, D_LENGTH. Note: Each register is 
2 bytes long. 

Set data type, D_TYPE. (See Modbus Protocol Mapping Manual.) 

Set special operations, such as multiplying PT or CT ratio, 
D_USE_SPECIAL. 

Set value mode, D_VALUEMODE as primary, secondary or raw 
value. 

Set display units, D_SHOW_KM (optional). 
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Set a N/A value, D_NA_VAL (optional). 

Example:

<GE_Multilin_POLL_DATA>

<DEVICE_1>

<DEV_DATA>

<item D_UID=”1_1”

D_LABEL=”Inst Van”

D_ADDR=”180”

D_LENGTH=”2”

D_TYPE=”7”

D_USE_SPECIAL=”3”

D_VALUEMODE=”Primary”

></item>

[...up to 64 items...]

</DEV_DATA>

</DEVICE_1>

</GE_Multilin_POLL_DATA>

6.6.4 Configuring WebMod© 
WebMOD© allows the network to interface with Modbus-based EIDs. WebMOD© supports 
12 Modbus TCP sockets (12 simultaneous connections). The Modbus Port Number is 502. 
The Modbus Port Number is set on the Location Editor screen and Devices are added to the 
Network on this screen. 

Note If you have a firewall in your system, you must ask your network administrator to grant 
communication access on TCP/IP Port 502. 

Modbus TCP Format: 
[6-byte Header] [Modbus RTU message without checksum]

Header detail: [2 Bytes - Sequences/Transactions ID] [2 Bytes - 0s] [2 Bytes - Length, 
Number of Bytes following] 

Example: 

Request:

01 03 00 00 00 06 01 03 00 00 00 02 

Transaction #259, 6 Bytes long, Modbus RTU Request for Address 01, Function Code 
03 (read holding registers), Start at Register 0 for 2 registers. 

Response: 

01 03 00 00 00 07 01 03 04 xx xx xx xx 

Transaction #259, 7 Bytes long, Modbus RTU Response for Address 01, Function Code 
03, 4 Bytes long data. 
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This will not support multiple Modbus requests and responses in a single Modbus TCP 
packet. For INP10 and INP100 Options, all requests with Modbus Address 01 will transmit 
to the meter itself. All other requests with Modbus Addresses other than 01 will transmit to 
the RS-485 Gateway Port. 

6.6.5 Configuring WebAlarm© 
The user must Enable this feature. 

From the Device Profile, click Communication Ports

Click the Advanced Settings button. 
The following tabbed screens will appear:

Click the Services tab.  

On that screen, click the SMTP Client box.

Click the Alarm/Email tab. 

The screen (shown here) allows you to configure one Email 
Address, which will be stored in the meter for single user or 
administrative use. Eight additional addresses can be 
programmed in the poll_profile.xml file (see WebXML). 
The alarm format for the Administrative Address is always Long 
Format to insure that the alarm detail will be transmitted. 

Enter the following values on this screen to configure the 
Administrative Address:

• Email Server IP Address/Name: 
• IP Address, Name, 10.0.0.250, or mail@abccorp.com. 
• Email Server Port: Port 25 is the Default. 
• Email Monitor Email Address/To Address: the Primary Email 

Address to be notified of an event. 
• Return/Reply Address/From Address: Administrative Email 

Address. 
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• Email Subject Text: Typical Message might be “Limits Exceeded”. 

If your email server (SMTP server) requires authentication before sending out the 
email, you must enable the checkbox and supply the correct user name and password 
in the configuration screen or the device will not be able to send out emails. This 
feature is implemented according to ESMTP Specification and supports 64-bit 
encryption for the user name and password. 

Click OK or Cancel. 

Configure more Email Recipients: 

Edit the poll_profile.xml file saved in FTP Server (see FTP Server): 

From EMAIL_1 to EMAIL_8, enter the email address within the 
double quotes 

From FORMAT_1 to FORMAT_8, enter the format name as either 
“short” or “long” within the double quotes. 
A section of a poll_profile.xml file is shown below without values 
entered.

<GE_Multilin_POLL_DATA>

<GE_Multilin_SYSTEM>

<item EMAIL_1=””FORMAT_1=””

EMAIL_2=””FORMAT_2=””

EMAIL_3=””FORMAT_3=””

EMAIL_4=””FORMAT_4=””

EMAIL_5=””FORMAT_5=””

EMAIL_6=””FORMAT_6=””

EMAIL_7=””FORMAT_7=””

EMAIL_8=””FORMAT_8=””>
</item>

</GE_Multilin_SYSTEM>

</GE_Multilin_POLL_DATA>

Short Format 

For all handheld mobile devices with text messaging service capable of receiving up to 160 
characters. Character number includes sender address, subject and body plus additional 
separator characters. This format is defined by GE Multilin and the user cannot modify it .

Example of the Short Format: 
[64 characters of sender’s email address]##[32 characters of Meter ID]
#Alarm[10digit operator’s phone number]
IDs1+2+3+4+5+6+7+8+9+10+11+12+13+14+15+16 

Long Format

For all handheld mobile devices and PC users who can receive regular email. This includes 
detailed alarm information. 

Example of Long Format: 
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Device Name: Meter Demo 1 
Contact Person: Administrator 
Contact Phone: 1234567890 
Alarm IDs: 1+2+3+4 
Alarm Names: 
- (1)  Limits changed 
- (2)  Inputs changed 
- (3)  Waveform captured
-  (4)  PQ (CBEMA) event captured 

Alarm Details: 
Limits: 
- (4)  1s IA, Below Limit 2, Combination=OR, value = +0.38 
- (5)  1s IB, Below Limit 2, Combination=OR, value = +0.38 
- (6)  1s IC, Below Limit 2, Combination=OR, value = +0.38 

Inputs: 
- (1)  HSI Input 1 BK101 Off 
- (3)  HSI Input 3 Closed 
- (4)  HSI Input 4 Closed 

Configure Alarm Polling Options: 

Enter values within the double quotes. 

To enable the polling for a device, set DEV_POLL_ALARM to Yes; to 
disable it, set No.

Alarm polling options: 1 to 9 (See table below). 

The default is to send alarm emails for all options, 1 to 9. 

You can configure the polling profile to have any combination of options: 

Edit the poll_profile.xml. 

Set up the alarm polling options by concatenating the options IDs, 
such as: “1+2+3+4+5+9”.

Set the alarm delay for limits in Milliseconds (a value of 1000 = 1 
second). 
If a limit condition occurs for 1 second or more, an alarm email will 
be sent.

<GE_Multilin_POLL_DATA>

<DEVICE_x>

<item DEV_POLL_ALARM=””

DEV_ALARM_OPTIONS=””

DEV_ALARM_DELAY=””>
</item>

</DEVICE_x>

</GE_Multilin_POLL_DATA>

Note Most of the Alarm Triggering Conditions for EPM devices rely on the device’s 
configuration in the Device Profile. Make sure that the settings are correct for Limits, 
Inputs, Waveforms, etc.  
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Configure Alarm Polling for more individual devices. 

Edit the poll_profile.xml file for each device’s section.  Configure the parameters. 

<GE_Multilin_POLL_DATA>

<DEVICE_x>

<item DEV_POLL_ALARM=””

DEV_ALARM_OPTIONS=””

></item>

</DEVICE_x>

</GE_Multilin_POLL_DATA>

Common Problem 

If you entered a name for the SMTP Server instead of an IP Address, make sure your DNS 
Server is working and you have either set a DSP IP inside the meter or your DNS can supply 
a DNS IP. Otherwise, if it cannot resolve the name to an IP translation; no email will be sent. 

Stored Emails 

User can access the stored_emails.htm page from any internet browser. The last 10 emails 
sent will be stored in the RAM on a FIFO basis (First In, First Out) and will be displayed in 
descending order. The page will be cleared after a complete system restart. 

Table 6–12: Alarm Polling Options

Option 
ID Option Name Description 

1 Limits exceeded Any limit condition exceeded for the 32 
EPM limit channels 

2 Inputs abnormal condition Any internal digital input abnormal 
condition 

3 Waveform captured When EPM captures a waveform 

4 PQ (CBEMA) event captured When EPM captures a PQ event 

5 Control Output changed When any relay modules connected to 
meter changes state 

9 Communication Failure Network card has difficulty talking to EPM 
Meter
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6.7 FTP Server 

A built-in FTP Server is available for INP100. It has a 3-user limit; three users can connect to 
the FTP Server simultaneously. The FTP Server logon User Name and Password are stored 
in the INP100 card, not in the meter’s programmable settings. The Initial FTP Server User 
Name and Password are: GE Multilinnet and inp100. The FTP Server’s quota is 4Meg RAM. 

To change the Initial FTP User Name and Password, switch to INP100’s boot mode and 
change the Initial Settings. (See section 6.9.) 

To copy a file into the FTP Server, simply copy the file and paste it into the Server. If there is 
a file with the same file name in the Server, you must delete the existing file first, then copy 
and paste the new file.

If the memory quota is filled before a new file is completely copied into the FTP Server, that 
file will be deleted and an error will be sent to the FTP Client. 

Since poll_profile.xml and poll_data.xml file sizes can be dynamic, it’s preferable to have 
some reserved space in the FTP Server for those files. 

Example: After a test run, if poll_data.xml is approximately 1kB, you should reserve at 
least 4kB for those files. The ratio is about 1 to 4. 



6–44 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

UPDATE NETWORK CARD FIRMWARE FROM A BROWSER (IN RUNTIME MODE ONLY) CHAPTER 6: TOTAL WEB SOLUTIONS

6.8 Update Network Card Firmware from a Browser (in Runtime Mode ONLY) 

Network card firmware can be easily updated via the Web. Follow these steps: 

Start your browser. 

If you know the meter’s IP Address, type it in the browser’s URL 
Address Bar. 
The Main WebExplorer screen appears. 

Click Tools. 

Click on Firmware Upgrade, or add /update1.htm to the end of 
the URL. 
The Enter Network Password screen will appear and ask for a User 
Name and Password. 

Type User Name and Password into Windows. 

Initial User Name = eignet 

Initial Password = inp100 
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Note See section 6.9 to change User Name and Password. 

Click OK. 
The Update Run-Time Firmware screen appears:

Click the Browse button to select the correct runtime firmware file. 

Click on the Update Run-Time Firmware button to continue. 

The whole process can take several minutes. Make sure that 
during the process you do not close the Update Run-Time 
Firmware screen (or update1.htm browser window). 
During the update process, the INP100 Update Run-Time 
Firmware Status screen appears. It displays the current status of 
the update. 

If the update is successful, restart the connected meter. 

Restart one of two ways: 

Go to reset_ethernet.htm. (Click on Restart .) 

Power down/up the connected meter. 
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6.9 Update Network Card Firmware from GE Communicator EXT 

Using this screen is the ONLY way to change the Boot Firmware and Username and 
Password. Changes are easy with this screen. Usage is the same for all meters. 
Connections are different. 

Note While you are on this screen, the Network Card is in BOOT MODE. 

Note Changes made here DO NOT modify the meter’s Device Profile. 

Using an RS-232/RS-485 converter, connect your computer to the 
EPM 9800 Port 1. 
Port 1 is RS- 485, so an RS-232/RS-485 Converter is required to 
create an RS-232 serial connection. 

For EPM 9450/9650, move the switch beneath Port 1 to select RS-
232; no converter is required. 
Make sure that the meter is connected to your network and is 
operating properly. 

Note This screen is not supported by meters with the INP10 Option.

Close the Device Status window. 

Select from the menu bar Tools/Network Card Settings. 
The Network Card Run Time Update screen appears (see below). 

Make sure there is a check mark in the checkbox at the top of the 
window for Communicate through Meter. If there is no check, click 
on the box. 

Click Connect at the top left of the window. (Progress is shown in a 
sub-window at the bottom of the screen.) 
When connected the “Boot Version” window lists data about the 
Network board. 

Note A blinking red bar at the bottom of the window (and a pinging sound) will remind the user 
that the meter is now in Boot Mode and the meter is not available to other users via the 
Internet.
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Click on Retrieve Settings to retrieve the network settings used to 
download Flash Files for updating the network option board via 
TFTP.  (The Initial Settings appear in the settings windows.) 

In the text boxes provided, enter the name of the Runtime Update 
File and/or Boot Update File. 
Check with your Network Administrator and make any changes 
necessary to the network settings. 

Note These changes facilitate file transfers while in Boot Mode; there is no permanent change. 
Click on Write Settings to send the updated settings to the Meter. A screen will ask, “Are 
you sure you want to Update the Flash File Settings?” Click Yes to update. The sub-window 
will display “Write Completed”. 

Start up a TFTP server on your computer. 

Set the default file path for the TFTP server to the location of the 
Runtime/Boot Flash file location (TFTP server software is available 
from GE.) 
See Appendix D for more information on TFTP.). 

To update Runtime/Boot, click on Update Runtime or Update 
Boot . 

Click Yes to verify that you would like to update the Runtime/Boot 
firmware. 
After the update is completed, the message Update Completed 
will appear in the sub-window. 

To Change the Username and Password, type in the Current 
Username and Password, then the New Username and Password.
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The Initial Username and Password are GE Multilinnet and 
inp100. You will not be able to change the Username and 
Password unless you know the Current Username and Password. 
(A screen will ask, “Are you sure you want to change the 
Username and Password?”) If you click Change Password, a note 
in the sub-window will confirm the Password changes. 

To close the Network Card Runtime Update window, click OK. 
GE Communicator EXT will update the meter. After approximately 
one minute the network will resume its normal functions. 

Note It is VERY IMPORTANT to store the passwords in a safe place and to change them 
frequently. 
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6.10 WebXML Flow Chart 



6–50 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

WEBEXPLORER FLOW CHART CHAPTER 6: TOTAL WEB SOLUTIONS

6.11 WebExplorer Flow Chart
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6.12 WebAlarm Flow Chart
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GE Communicator EXT

Chapter 7: Real-Time Polling

GE Consumer & Industrial
Multilin

Real-Time Polling

7.1 Overview 

The Real-Time Polling features of GE Communicator EXT are used to continuously view 
instantaneous and stored values within one or several EPM Series 6000, 7000 and 9000 
Meters. GE Communicator EXT provides tabular views of Metered Values, Circuit 
Measurements, Interval Data, Power Quality Values, Pulse Data and Input/Output Status 
and Accumulations. 

The Real-Time Polling features are divided into three groups, accessed by clicking the 
Real-Time Polling menu: 

1. Real-Time Readings

2. Revenue, Energy and Demand Readings 

3. Power Quality and Alarms. 
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All screens are not available on all models. (EPM 6000 meters have a unique screen,) 

GE Communicator EXT receives data from one connected device at a time—by default, the 
Primary Device. To view polling data from multiple devices, either select Poll Multiple 
Devices (section 7.2.4) or change the Primary Device (select Connection, Change Primary 
Device; see section 2.7). 

Note Clicking the Polling button on the Tool Bar is the same as selecting Instantaneous Polling 
from the Menu Bar. Clicking the Phasors button on the Tool Bar is the same as selecting 
Phasors from the Menu Bar.  
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7.2 Real Time Readings 

7.2.1 Instantaneous Polling 
To view instantaneous polling data for the primary device, either 

Select Instantaneous Polling from the Real-Time Polling menu, 

OR 

Click the Polling button on the Tool Bar. 

The Instantaneous Polling screen appears. 

The graphic representation on the right side of the screen displays the options listed in the 
pull-down menu beneath it (Volts A, B, C; Current A, B, C). Select either spectrum or 
waveform view by clicking on the Spectrum/Waveform button. 

Click the radio button in the lower right corner to select either 1 
Second or 0.1 Second measurements for all data. 

Click Print to send a copy of the screen to a printer. 

Click OK to return to the main GE Communicator EXT screen. 

7.2.2 Poll Max and Min Readings 
To view the Maximum and Minimum readings for the currently connected device, 

Select Poll Max and Min Readings from the Real-Time Polling 
menu. 
The Max and Min Readings with Time Stamps screen appears. 

Note The Max/Min is the Max/Min of the Thermal Average in the profile. 
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Scroll left/right and up/down to access all data. 

Note To adjust the column widths, position the cursor on a line between columns at the top of 
the screen. When the cursor changes to a left/right arrow, hold down the left mouse button 
and drag the column border left or right. Release the button when the column is at the 
desired width. 

Click Pause to temporarily stop the screen update and enable the 
Copy button. 

Click Resume to continue the real-time update. 

Click Print to send the data to a printer. 

To Copy the data into another program, click Pause to enable the 
Copy button; then click Copy. 

Paste into your new document. 

Click OK to return to the main GE Communicator EXT screen. 

To reset the Max/Min and Demand Readings, see Chapters 3, 4, 5. 
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7.2.3 Poll Reading Grid 
To view all available polling data of the currently connected device, 

Select Poll Reading Grid from the Real-Time Polling menu. 
The following screen appears. 

Scroll left/right and up/down to access all data. The first two columns are Instantaneous 
values, Column 3 is the Thermal Average, Columns 4 to 7 are the Thermal Max and Mins 
and Column 8 is a Single Cycle value captured during the last screen update. 

Note To adjust the column widths, position the cursor on a line between columns at the top of 
the screen. When the cursor changes to a left/right arrow, hold down the left mouse button 
and drag the column border left or right. Release the button when the column is at the 
desired width. 

Click Pause to temporarily stop the screen update and enable the 
Copy button. 

Click Resume to continue the real-time update. 
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Click Print to send the data to a printer. 

To Copy the data into another program, click Pause to enable the 
Copy button; then click Copy. 

Paste into your new document. 

Click OK to return to the main GE Communicator EXT screen. 

7.2.4 Poll Multiple Devices 
To view polled data from multiple devices connected to your computer, 

Select Poll Multiple Devices from the Real-Time Polling menu. 
The Poll Multiple Devices screen appears. 

Click on the tabs to access the following readings (see previous 
page for details on measurements): 

• 0.1 Seconds: Volts AN, BN, CN, Aux, IA, B, C, Nm, Volts AB, BC, CA, 
VAA, B, C, Total, VAR A, B, C, Total, Watt A, B, C, Total, Freq, Power 
Factor A, B, C, Total, VAN Aux, Update Time. 

• 1 Second: Volts AN, BN, CN, Aux, IA, B, C, Nm, Nc, Volts AB, BC, CA, 
VAA, B, C, Total, VAR A, B, C, Total, Watt A, B, C, Total, Freq, Power 
Factor A, B, C, Total, Imb V, I, Update Time. 

• Average: Volts AN, BN, CN, Aux, IA, B, C, Nm, Nc, Volts AB, BC, CA, 
VAA, B, C, Total, VAR A, B, C, Total, Watt A, B, C, Total, Freq, Power 
Factor A, B, C, Total, Imb V, I, Update Time. 

• Maximum, Minimum: Volts AN, BN, CN, Aux, IA, B, C, Nm, Nc, Volts 
AB, BC, CA, VAA, B, C, Total, P VAR A, B, C, Total, N VAR A, B, C, Total, 
PWatt A, B, C, Total, N Watt A, B, C, Total, Update Time. 

• Hour Readings: Quad (1+4) Watthour, Quad 1 VAhour, Quad 1 
VARhour, Quad 4 VAhour, Quad 4 VARhour, Quad (2+3) Watthour, 
Quad 2 VAhour, Quad 2 VARhour, Quad 3 VAhour, Quad 3 VARhour. 

• Device Time and Accumulations: Date and Time, Internal 
Temperature. 
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• Accumulations: I SquaredTA, TB, TC, V Squared TA, TB, TC. 

Use the scroll bar at the bottom of the screen to access all the 
values. 

Click OK to return to the main GE Communicator EXT screen. 

7.2.5 Poll External Analog Inputs 
To view the polling screens for the External Analog Inputs, 

Select Poll External Analog Inputs from the Real-Time Polling 
menu. 
The following screen appears: 

Information on the screen includes: 

• Input number 

• Name assigned to the input

• Raw Value (Actual Value the input is measuring)

• Primary Value (Scaled Value from the Device Profile). 

See Chapter 11 for setup instructions. 

The Copy button at the right of the screen will allow you to copy the information 
from up to 32 Inputs and paste that data into a document. 

Click OK to return to the main screen. 
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7.3 Revenue, Energy and Demand Readings 

7.3.1 Power
To view Power readings for the currently connected meter, 

Select Power from the Real-Time Poll > Revenue, Energy and 
Demand Readings menu. 
The set of Power screens appears. 

Click on the tabs at the top of each screen to access other 
readings. 
Examples of the additional screens follow. 

Total 

Multiphase Total and Individual Phase Readings for Watts, VARS, VA and PF. 

Instantaneous per Phase 

One second Per Phase Values and Multiphase Totals 
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Thermal per Phase 

Per Phase and Multiphase Totals  

Uncompensated 

Metered Values without Line and Loss Compensation and Multipliers. Includes Interval 
and Rolling Demand. 

Click Print to send a copy of the screen to a printer. 

Click OK to return to the main GE Communicator EXT screen. 

7.3.2 Demand 
To view Demand data for the currently connected device, 

Select Demand from the Real-Time Poll>Revenue, Energy and 
Demand Readings menu. 
The set of Demand screens appears. 

Click on the tabs at the top of each screen to access other 
readings. 
Examples of the additional screens follow. 
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Peak

Peak Demand Readings for Watts, VARS, VA and PF. (Peak or Maximum Demand is the 
largest Average Value for the selected demand interval.) 

Thermal Demand 

Thermal or Exponential Demand is used to emulate the operation of 
electromechanical Thermal Demand meters. This measurement responds like lagged 
thermal heating effects in electrical equipment. 
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Thermal Average VARS 

The exponential average VARs. Exponential averages are used because they discount 
older values and respond more like the thermal effects.

Thermal Average VA 

Block Window Average (or Average Demand) 



7–12 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

REVENUE, ENERGY AND DEMAND READINGS CHAPTER 7: REAL-TIME POLLING

Max and Min Watts, VARS and VA readings with Time Stamp. Click on tabs to access 
readings. 

Rolling Window Average (or Average Rolling Demand) 

Max and Min Watts, VARS and VA readings with Time Stamp. Click on Watts, VARS, and 
VA tabs to access readings. 
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7.3.3 Energy 
To view Energy data for the currently connected device, 

Select Energy from the Real-Time Poll > Revenue, Energy and 
Demand Readings menu. 
The set of Energy screens appears:

Click on the tabs to move from screen to screen. 

The EPM 9450/9650 Series Meters are true four-quadrant power meters. In the Quadrant 
Energy (Primary) section of this screen (shown above), readings are displayed for the VARS 
and VA in each quadrant. 

 

Note Power Factor Lag and Lead is programmable in the Limits section of the Device Profile 
(3.5.1, 4.5.1

Additional screens are shown below. 

Quadrant Power Factor Watts VARS 

1 Lag + + 

2 Lead – + 

3 Lag – – 

4 Lead + – 
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Cumulative Demand: 

Readings in Secondary and Primary. 

I & V Squared T: 

Positive Readings for Phases A, B and C. 
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Q Hours: 

Plus and Minus Readings in Secondary and Primary. 

Uncompensated Energy: 

Plus and Minus Watt, VAR and VA Readings in Secondary and Primary. 
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Energy (Secondary): 

Plus and Minus Watt, VAR and VA Readings. 

Click Print to send the data to a printer. 

Click OK to return to the main GE Communicator EXT screen. 

7.3.4 Energy, Pulse and Accumulations in the Interval 
To view the Energy, Pulse & Accumulations in the Interval of the currently connected 
device, 

Select Energy, Pulse & Accumulations in the Interval from the 
Real-Time Poll>Revenue, Energy and Demand Readings menu. 
The following set of screens appears: 
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These screens are Read Only. They display the readings from the Interval set on several 
screens.

Demand Integration Intervals (Chapters 3, 4) 

Primary Current & Voltage Thresholds 

Interval in minutes (15 = Initial setting) 

Internal KYZ Outputs (Chapters 3, 4)
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I & V Squared T 

Pulse Accumulations (Chapters 3, 4) 
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Uncompensated Energy: 

Readings that are NOT adjusted by Transformer Loss Compensation. 

Q Hours: 

Q is the quantity obtained by lagging the applied voltage to a wattmeter by 60 
degrees.
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To change any of the settings that effect the readings, click OK. 
You will return to the main GE Communicator EXT screen. 

Click Edit Profile. 

Double click on the appropriate screen to access settings and 
make adjustments. 

Click Update Profile to send the new settings to the meter. 

7.3.5 Internal KYZ Output Accumulations 
To view the Internal KYZ Output Accumulations of the currently connected device, 

Select Internal KYZ Output Accumulations from the Real-Time 
Poll > Revenue, Energy and Demand Readings menu. 
The following screen appears:.

This screen is read-only. It displays the readings from the KYZ Output Relays. Internal KYZ 
Outputs are configured in sections 3.4.3 and 4.4.3. 

To change any of the settings that effect the readings, click OK. 
You will return to the main GE Communicator EXT screen. 

Click Edit Profile. 

Double-click on the appropriate screen to access settings and 
make adjustments. 

Click OK to exit this screen and return to the main GE 
Communicator EXT screen. 
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7.3.6 Total Average Power Factor 
To view Total Average Power Factor from the device connected to your computer, 

Select Total Average Power Factor from the Real-Time Poll > 
Revenue, Energy and Demand Readings menu. 
The following screen appears. 

This is a read-only screen. Readings are based on Power Factor settings from the Device 
Profile of the connected device. 

To make changes on this screen, click OK and return to the main GE 
Communicator EXT screen. 

In the Device Profile, make changes to Maximum and Minimum 
Power settings. 

Click OK to return to the main GE Communicator EXT screen. 
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7.3.7 Time of Use Registers 
To view Time-of-Use Readings from the device connected to your computer, 

Select Time of Use from the Real-Time Poll > Revenue, Energy 
and Demand Readings menu. 
The following screen appears: 

This is a read-only screen. Readings are based on Time-of-Use settings from the Device 
Profile of the connected device. 

Use windows at the top of the screen to view a choice of Groups 
and Registers. 

Type in  start and end times. 

To make changes on this screen, click OK and return to the main GE 
Communicator EXT screen. 

In the Device Profile, make changes to time-of-use settings. 

To Copy the data into another program, click Copy. 

Paste into your new document. 

Click Export to send the data to another device. 

Click Print to send a copy of the screen to a printer. 

Click OK to return to the main GE Communicator EXT screen. 

7.3.8 Poll Pulse Accumulations 
To view the Pulse Accumulations readings for the currently connected device, 
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Select Poll Pulse Accumulations from the Real-Time Poll > 
Revenue, Energy and Demand Readings menu. 
The Pulse Accumulations screen appears: 

This screen displays the scaled Pulse Accumulations from the meter’s eight internal digital 
inputs. It also displays the Fixed Window Average and Max Demand for the eight Pulse 
Accumulations. At the bottom of the screen, you will also find four Totalizers, which are 
combinations of the eight internal inputs and the meter’s watt-hour counter. 

This screen is the result of configuring the Pulse Accumulations settings in the Device 
Profile. See Chapters 3 and 4 for details on settings and to edit settings. The meter can be 
programmed to accumulate and aggregate poles from any pulse-generating device. 

Click OK to return to the main GE Communicator EXT screen. 

Click Print to print this screen. 

Click Export to save a text file of the Input Readings. Your 
computer will ask you to name the file and choose a “save in” 
location. 

Click Save or Cancel to return to the main GE Communicator EXT 
screen. 
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7.4 Power Quality and Alarms 

7.4.1 Phasors 
The Phasors screen displays the phase relationships of the currently connected device. 

Note The EPM 9800 screen displays the Form and Configuration at the top of the screen. 

Select Phasors from the Real-Time Poll > Power Quality and 
Alarms menu, or click the Phasors button on the tool bar. 
The Phasors screen: 

If you have an auxiliary voltage reading (i.e. generator and bus where the VAux is the 
generator), Aux box and the VAux phaser will be displayed. The VAux phasor is referenced to 
VA phase. 
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From the buttons at the bottom of the screen, click on Options. 
A pop-up window, Phasor Diagram Options, appears: 

Check Display Voltage Phase-to-Phase Readings When In Wye 
Configuration, if you want to include that reading in the graph. 

In the Display Angles Increasing and Phasor Rotation boxes, select 
either Clockwise or Counter Clockwise. 

From the pull-down menu at the bottom of the screen, select 
Vectors, Triangles or Vectors and Triangles to change the graphic 
representation of the data.

Click OK to save your selections and return to the main Phasors 
screen.

Use the Buttons at the bottom of the screen to complete the following tasks: 

Click Copy to save a copy of the screen to the clipboard. 

Click Print to send a copy of the graph to a printer. 

Click OK to return to the main GE Communicator EXT screen. 
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7.4.2 Poll Harmonics
To view harmonics data for the currently connected device, 

Select Poll Harmonics from the Real-Time Poll>Power Quality 
and Alarms menu. 
The Harmonics screen appears: 

To change the presentation format, click on the Values, Spectrum 
or Waveform buttons. 
The screen above is in Values mode. 

To change the channel, use the pull-down menu, located beneath 
the Spectrum radio button. Select from Volts A, B, C or Current (I) A, 
B, C. 

Use the scroll bar at the right side of the screen to access all the values. The EPM 
9450 and 9650 poll harmonics to the 127th order. 

Click Print to send the data to a printer. 

Click Copy to send the contents of the screen to the clipboard.

Click OK to return to the main GE Communicator EXT screen. 
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7.4.3 Flicker 
To view Flicker data for the currently connected device, 

Select Flicker from the Real-Time Polling menu. 
The Flicker screen appears: 

To view Short Term or Long Term Flicker data, click on the tabs at 
the top of the screen. 
The Short Term or Long Term screen will appear: 

Use the Flicker Monitoring buttons to Start or Stop Flicker 
Monitoring or to Reset the meter’s Flicker Monitoring. 

Click Print to send the data to a printer. 

Click OK to return to the main GE Communicator EXT screen. 
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7.4.4 Alarm Status 
To view Alarm Status data for the currently connected device, 

Select Alarm Status from the Real-Time Poll>Power Quality and 
Alarms menu. 
The Limit Status screen appears: 

This screen displays the Status of the Limits set in the Programming Limits section of the 
Device Profile (sections 3.10 and 4.10). Up to 32 Limits can be set. 

To change any of the settings, click OK, which will return you to the 
main GE Communicator EXT screen. 

Click Edit Profile. 

Double click on Limits and any of the settings to access the 
programming screen. 

Click Print to send the data to a printer. 

Click OK to return to the main GE Communicator EXT screen. 

Note To adjust the column widths, position the cursor on a line between columns at the top of 
the screen. When the cursor changes to a left/right arrow, hold down the left mouse button 
and drag the column border left or right. Release the button when the column is at the 
desired width.
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7.4.5 Poll Device Control Status 
To view the status of the currently connected device, 

Select Poll Device Status from the Real-Time Poll > Power Quality 
and Alarms menu.
The Device Status screen appears: 

This screen displays the Status of the Settings set in the Programming Relay section of the 
Device Profile (sections 3.11 and 4.11). Up to 8 assignments can be set per relay. If there 
are no relays installed, a note “Relay Module Not Installed” will appear on the screen. 

To print this screen, click on the Print button. 

This is a read-only screen. 

To change any of the settings, click OK, which will return you to the 
main GE Communicator EXT screen. 

Click Edit Profile. 

Double click on Relay to access the programming screen. 

To select a different relay, click on the pull-down menu in the upper 
right corner of the screen. 

Click on your selection. 
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7.4.6 Poll Internal Inputs 
To view Internal Input data for the currently connected device, 

Select Poll Internal Inputs from the Real-Time Poll > Power 
Quality and Alarms menu. 
The Internal Inputs screen appears. 

To change this screen in any way Click OK to return to the GE 
Communicator EXT screen. 

Click on Edit Profile. 

See sections 3.5.6 and 4.5.6 for details. 
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7.4.7 Poll External Digital Inputs 
To view the polling screens for the External Digital Inputs, 

Select Poll External Digital Inputs from the Real-Time Poll>Power 
Quality and Alarms menu. 
The following screen appears: 

Information appearing on the screen will include: 

• Input number

• Name given to the device

• State and Transitions. 

With the buttons on the right side of the screen, you can use the pull-down 
menu to Reset Counters or Copy the data from up to 32 inputs and paste it 
into a document. 

Click OK to return to the main screen. 

The Copy button at the right of the screen will allow you to copy the 
information from up to 32 Inputs and paste that data into a document. 
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7.5 Poll Real Time Trends 

The EPM 6000 meter has a unique screen, Real Time Trends. 

To view the Real Time Trends polling screen, 

Select Real Time Trends from the Real Time Poll menu (shown 
here). 

The following screen appears: 

To view parameters on this screen, in the Parameters section of 
the screen, select a set of values by clicking on the boxes next to 
the values. 

Click Start . 
This will start the graph. 

Enter a value greater than 0 in the AutoStore box to create a .csv 
(Comma Separated Value Excel file) that contains a log of the 
current values of the Store Interval. 
The number entered is the Store Interval in seconds. Stores all 
values, not just those selected. 

Click on the Store button at the bottom of the screen to grab the 
most current values and add them to the file. 

The Poll Interval can be set. Set to 0 for as fast as possible. 
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The Min and Max Y Values that the graph displays (the Y Range) can be set. Auto Scale 
determines the best range of values automatically. 

Click Cancel to return to the main screen.
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GE Communicator EXT

Chapter 8: Viewing Logs

GE Consumer & Industrial
Multilin

Viewing Logs

8.1 Overview 

The EPM 9450/9650 and EPM 9800 Meters record the following logs (EPM 7000 logs as 
noted): 

Historical Trends Logs 1 and 2 (EPM 7000 - Historical Log) 

These logs are two separate collections of time-stamped records (or “snapshots”) used 
to track any parameter over time. Each record or snapshot can contain multiple data 
items, which are recorded at specific intervals and stamped with the time of 
recording. The following programmable criteria determine when the Meter will take a 
snapshot: 

The user-specified time interval 

A parameter’s exceeding of a limit or a return to within limits 

The capture of a waveform 

An I/O event (a change in a relay or input) 

Limits Log 

The Limits Log retrieves independent out-of-limit information, creating a sequence of 
events for any occurrence. 

Event-Triggered Waveform Log (EPM 7000 Series) 

The Event-Triggered Waveform log records a waveform when a user-programmable 
value goes out of limit and when the value returns to normal. All information is time-
stamped to the nearest 1 msec. A new feature for interharmonic analysis observes 
further frequencies. 
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Power Quality (CBEMA) Log 

This log records magnitude and duration of voltage and current surges and sags for 
every power quality (PQ) event. The associated waveform is also recorded. 

Status Change (Input) Log 
(Included in EPM 7000 Series Event I/O Log) 

This log displays the input change status for a selected meter file and time range. 

Control Output (Relay) Log 
(Included in EPM 7000 Series Event I/O Log) 

This log displays the relay change status for a selected meter file and time range. 

AiReports 

AiReports 2.0 is an optional power quality analysis software package used in 
conjunction with meter Logs. It provides a comprehensive report on the status of the 
equipment being monitored; it uses artificial intelligence to diagnose PQ events and 
provide the possible cause of the event. 

System Events Log 

The log records system events for security and anti-tampering.  

The following is the general sequence for working with all logs: 

1. Program parameters specific to each log in the meter’s Device Profile (section 
8.2). Logs run automatically. 

2. Retrieve the logs manually from the meter (section 8.3); or retrieve logs 
automatically using the Script & Scheduler Program. See Chapter 15 for 
further details. 

3. View and analyze log data with GE Communicator EXT’s Log Viewer (sections 
8.5–8.18). 

4. Diagnose PQ Events from meter logs, create comprehensive report, transmit, 
modify, print or export file with optional AiReports software (section 8.15). 

Free Space Calculation Feature 

The Log Converter automatically checks your computer and calculates the amount of free 
space on your hard drive. This calculation is performed to insure enough hard drive space 
for the Log Converter to operate. Below are the parameters for the calculations and the 
actual calculation performed by the meter.  

Table 8–1: Free Space Calculation Parameters

ITEM DESCRIPTION MINIMUM VALUE 

THDS Total Hard Disk Space 

THDFS Total Hard Disk Free Space 
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Note Min%ofFreeSpace and MinFreeSpace Values are set in the LogConverter.ini file.

CALCULATION: 

Min%THDS x THDS = CalMinFS 

If CalMinFS < MinSetFS then CalMinFS = MinSetFS 

If CalMinFS <= THDFS then OK 

If CalMinFS > THDFS then Need More Space on your HD 

MIN%THDS Minimum % of Free Space of 
Total Space (Min%ofFreeSpace) 

1 
(After 3/19/2002) 

MinSetFS Minimum Free Space 
(MinFreeSpace) 

50 MB 

CalMinFS Calculated Minimum Free Space 

Table 8–1: Free Space Calculation Parameters
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8.2 Programming and Running Logs 

Program the following parameters specific to each type of log in the meter’s Device 
Profile. See Chapter 3 (9450/9650), Chapter 4 (9800) or Chapter 5 (7000) for details. 

Note Any time you update the Device Profile, a pop-up screen will announce that the logs are 
not being reset and asks if you would like to reset them. Resetting the logs is 
recommended if you make changes to CT & PT Ratios, Limits or Limit Full Scales. 

• Limit and Waveform Full Scales 

• Limits 

• Trending Setup 

• Trending Log Time Intervals 

• Power Quality and Waveform Thresholds 

• Labels — YOU MUST LABEL THE METER 

You do not need to start the logs; the meter is always recording. 

To confirm the parameters and track the progress of the logs, 

Select Statistics from the Logs menu (or click on the Log Status 
icon on the Tool Bar). 
The Log Statistics screen appears. 
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8.3 Retrieving Logs 

To retrieve logs from the meter and convert them for viewing and analysis: 

Click on the Retrieve Logs button, or select Logs > Retrieve Log(s) 
from Device. 
The following screen appears. 

Double-click on the logs you would like to retrieve from the meter.
The “No” in the Retrieve column will become a “Yes.” 

Double-click again to change the “Yes” back to a “No.” 
GE Communicator EXT will only retrieve those logs with a “Yes” in 
the Retrieve column. 

Note Note on the Meter Designation field: 

• If you have entered a label for the meter in the Labels section of the Device Profile 
(Chapters 3, 4,5), the label will appear here. GE Communicator EXT will apply this 
name to the file containing the logs you choose to retrieve, placing the file in the 
Retrieved Logs folder. 

• If the EPM Meter does not have a meter designation or label, this field will appear 
blank and GE Communicator EXT will ask you to name the log file and supply a 
destination. See Chapter 3 (9450/9650), chapter 4 (9800) or chapter 5 (7000) for 
how to give the meter a label. 
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Click Start . 
GE Communicator EXT begins to retrieve the log. 
The following screen appears: 

After GE Communicator EXT has retrieved the log it converts the data. The Log 
Converter application runs automatically. 

GE Communicator EXT then runs Log Viewer: See sections 8.4–8.18 for information 
on using Log Viewer. 

Note Retrieve logs as often as you want. Each time you retrieve a log file, GE Communicator EXT 
appends only the newest records and captures to the existing database. These “partial 
downloads” are listed in Log Viewer’s Database Status screen (see section 8.13). 
Snapshots, or partial downloads, must be a time frame within the database dates. 
Otherwise, there is no data from which to retrieve the snapshot. 
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8.4 Viewing Logs with GE Communicator EXT’s Log Viewer 

GE Communicator EXT’s Log Viewer displays retrieved logs in a variety of formats.

To access Log Viewer, either: 

Retrieve logs from a connected meter, as in section 8.3. 

OR

Click the Open Log button. 
GE Communicator EXT will ask you to select a previously stored log 
file (.DB). GE Communicator EXT defaults to the Retrieved Logs 
directory. 

OR

Run Log Viewer from the Windows® Start menu. 
Log Viewer’s main screen appears: 

Choose the log data file(s) you would like to view: 

If you have retrieved a log from GE Communicator EXT, that file is selected for 
Meter 1, as in the example above (“Meter 1”); 

OR 

Click on either meter button (1 or 2) that displays a meter name.
Log Viewer will ask you to select a log database file:
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You may choose a different log file for Meter 1 and for Meter 2. You 
may only load one log file per meter. 

The log file assigned to each meter is listed in the pull-down menu 
above the button. 

Select No Meter from the pull-down menu to close a log file. 

Select what log data points you would like to view by clicking on the 
Data Points button in the Select Data section. 
The following screen appears: 

The Data Points available will vary with the type of log and the parameters set for 
it . 

From the Available Data Points column, click on the data points 
you want to include when viewing the log file. 

To select multiple points, hold down the Ctrl key while clicking. 

To select a complete sequence of points, hold down the Shift key 
while clicking. 
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Click on the Add button to move the Data Points to the Selected 
Data Points column. 

Click on the Restore button to return the selection to its previous 
setting. 

When you have made your selection, click OK to return to Log 
Viewer’s main screen. 

The pull-down menu above the Data Points button lists the points you have 
selected. 

You can select what portion of the log(s) you wish to view by specifying a time 
range. 
Log Viewer bases its time/date format on your computer’s Regional Settings 
(Windows® Control Panel). 

Click on the Time Range button in the Select Time section. 
The following screen appears: 

To select a specific time range, click the Between radio button and 
enter a date and time in each field. 

Double-click either date/time field to bring up the following 
calendar. 
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Click the selected day and use the slide at the bottom of the screen 
to select a time. 

Click OK. 

To select a range of hours, days, months or years only, click the 
appropriate radio button and the counter menu beside it. 

To return to the main screen, click OK. 
The time range you selected is displayed above the button. 

After you have loaded the log file(s), selected data points and chosen a time range, you 
may begin viewing the data. The following sections detail the different viewing formats for 
each type of log. 
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8.5 Viewing Historical Trends and Snapshots 

From Log Viewer’s main screen, click on the Historical Trends 
button or View Data > Snapshots. 
Log Viewer will display Snapshot Information for the selected log 
file(s) based on the time range and data points specified in the 
Select Data and Time Range windows of the main screen (section 
8.4). 

The name of the log file (“Feeder 1” in this example) and the type of data point are 
listed in the top row. 

The viewer can move columns, so that the most important data is most accessible.

Right-click on the column title and drag it to the desired location on 
the table. Repeat as desired to customize the table. 

To save the data to your clipboard, right-click with the cursor 
positioned anywhere in table. 

To sort the data by record type in either ascending or descending 
order, click on the Sort button and use the pull-down menu to 
make your selection. 

See the following section 8.8 for details about viewing Snapshot Graphs. 
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8.6 Sort 

At the bottom of all the display pages for the selected log file(s), including the Historical 
Trends display page, you’ll find a Sort button. The Sort button allows you to customize the 
Log Viewer data to your needs by using the pull-down menus to set the criteria for the sort. 

Select from the variety of Record Types, determined by the type of 
log being viewed. 
For example, the Historical Trends Log includes the following 
choices in the Record Type menu: All Snapshots, Group by Type, Log 
1, Log 2, Limits, Input, Relay, Flicker 

Click on the Sort Item pull-down menu to select Date/Time or 
Readings for the currently selected meter. 

Click on the Sort Order pull-down menu to select Ascending or 
Descending Order 

Click OK.  
In a few moments, the customized data will load on to your screen. 
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8.7 Viewing Trending and Demand Graphs (XY and Circular) 

To display Trending or Demand data as either an XY or Circular graph, 

NOTE: Holding down the Ctrl key allows you to add or remove multiple items.

Click on the Graph button in the main Log Viewer (Historical) Trend 
or Demand screen. 

The following screen appears: 

The Available Items column lists the data points that have been selected for the log 
file. 

To add a new data point, return to Log Viewer’s main screen and 
click on the Data Points button (see section 8.4). 



8–14 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

VIEWING TRENDING AND DEMAND GRAPHS (XY AND CIRCULAR) CHAPTER 8: VIEWING LOGS

From the Available Items column, click on the parameters you want 
to graph. 
You can select up to six parameters. 

If you want to remove a parameter from the Graph Items list, 
highlight it and click the Remove button.

Click the Add button. 
The items will appear in the Graph Items column. 

To select multiple points, hold down the Ctrl key while clicking. 

To select a sequence of points, hold down the Shift key while 
clicking. 

Note Only a total of six pens may be used at one time. If there are two log files open, you will be 
allowed to select only three data points from the left column. 

To view the graph, press either the Advanced, Circular or XY 
Graph button: 
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The following pertain to either type of graph: 

To change the starting point of the graph: 

Choose a new date/time segment from the Starting Date/Time to 
view pull-down menu. 

To change the amount of time represented on the graph: 

Enter a value in the Number of Days to View field 

Press Enter or click on the Redraw button. 

To change the scale of the graph:

Enter a value in the Minimum Value and Maximum Value fields

Press Enter or the Redraw button.

To view one sample at a time: 

Click in the Move by Sample box.

Click on the Forward or Reverse buttons each time you would like 
to view the next (or previous) sample. 

To view a continuous, sample-by-sample rendering of the graph:

Click the Move by Sample box and the Auto Show box. 

Select a speed by sliding the Auto Show Speed bar left or right.

Click on the Forward or Reverse button to determine the direction 
of the Auto Show. 

To stop Auto Show, deselect the Auto Show box. 
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To print the graph on a color printer: 

Check the Color Printout box 

Click Print . 

To print the graph on a black-and-white printer:

Click the Use Symbols box 

Click Print . 

To copy the graph data to the computer’s clipboard: 

Select Copy from the File menu. 

Paste the data into a spread sheet, such as Excel. 

To export the graph’s data: 

Select Export Data from the File menu. 

To change the graph’s color assignments: 

Select Select Colors from the Options menu. 
The following screen appears: 

The small squares under the Color heading represent the color currently assigned 
to each component of the graph. 

To make adjustments to an item’s color: 

Click the radio button beside it 

Create a new color by moving the red, green and blue sliders.

Create black by moving all sliders down, white by moving all sliders 
up. 
The large square on the right shows the color you have created. 

Click OK to return to the graph.
Log Viewer will redraw using the new color scheme. 

Click the Restore button to return all color schemes to default 
values.

To create a label for the graph: 
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Select User Labels from the Options menu. 
The following screen appears: 

Enter a label in each line and click OK. 
The two-line label will appear on the right side of the graph. 

Click Restore to enter the previous label. 

To view a summary of data for any point on the graph: 

Position the curser on the graph and hold down the mouse button. 
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8.8 Viewing the Limits Log 

From Log Viewer’s main screen click on the Out of Limit button or 
View Data > Limits. 
Log Viewer displays limit information for the selected log file(s) 
based on the time range specified in the Select Time Range section 
of its main screen (see section 8.4). 

Click the Show Snapshots box on the left side of the screen to 
display the limits snapshot information. 

To copy the data to the computer’s clipboard, right-click with the 
cursor positioned anywhere in the table. 

To sort the data by record type in either ascending or descending 
order, click on the Sort button and use the pull-down menus to 
make your selection. 
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8.9 Viewing the Waveform Log 

From Log Viewer’s main screen (section 8.4), click on the 
Waveform button or View Data > Waveform. 
Log Viewer will display waveform information for the selected log 
file(s) based on the time range specified in the Select Time Range 
section of its main screen. (EPM Series 7000 Waveform Time 
Precision is 1 second.) 

To save the data to your clipboard, right-click anywhere in the 
table. 

To view the Waveform Settings, click on a waveform record then 
click the Show Waveform Settings box on the left side of the 
screen. 

To adjust the column widths, position the cursor between columns 
at the top of the screen. When the cursor changes to a left/right 
arrow, hold down the left mouse button and drag the column 
border left or right.  Release the button when the column is at the 
desired width. 

To sort the data by record type in either ascending or descending 
order, click on the Sort button.  Use the pull-down menus to make 
your selection. 

To view the waveform graphs, see the following section. 
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8.10 Viewing Waveform Graphs 

To view any waveform in the main Waveform Log screen (section 
8.9), click on the desired record and then click the Graph button (or 
double-click on the desired record).

To change the Waveform Display Settings, click the Options button 
in the upper left corner of the screen. 
The Waveform Options screen will appear: 
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Configurable options include: 

1. Start Up Mode: Classic, Overlay or Overlay (group) 

2. Overlay Mode: Overlay or Group 

3. Plotting Method: Line, Point or Line and Point (Line and Point is slower than 
the other two options.) 

4. Colors: Background, Foreground, Subsets (User can reverse the colors.) 

5. Point Sizes for Each Subset: Small, Medium, Large or Micro 

6. Line Types for Each Subset: Pull-down menu offers Dashed, Dot, Dash Dot, 
Dash Dot Dot, Medium Solid, Thick Solid, Medium Thin Solid, Medium Thick 
Solid, Extra Thick Solid. 

7. Item Point Types for Each Subset: Pull-down menu offers Plus, Cross, Solid 
Circle, Square, Solid Square, Diamond, Solid Diamond, Upward Triangle, Solid 
Upward Triangle, Downward Triangle, Solid Downward Triangle, Dash or Pixel. 

To include the Iaux in the graph:

Click the Iaux On button. 

Click the Iaux Off button to remove. 

Double click on the Iaux graph for a closer view. 

To include the High Speed Inputs in the graph: 

Click the Inputs On button. 

Double click on the Inputs graph for a closer view. 
Each input is listed on the Y axis followed by a 1 or 0—a 1 denotes 
that the input is open; a 0 denotes that the input is closed. 

Click Inputs Off to remove.

To Print the graph: 

Click the Print Graph button. 

To Export an image from the screen: 

Click the Export Picture button. 

To Export the data only: 

Click the Export Data button. 

To view the previous or next waveform record: 

Click the Previous or Next buttons. 

To Zoom In on a portion of the graph: 

Click and drag to form a box. Double click. 

To Zoom Out: 

Click the Zoom Out button. 
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To view the Waveform Properties:

Click the Waveform Properties button. 
The following screen appears:

To view the Advanced Waveform screen: 

Click Advanced Waveform. 
This screen appears: 

The user can select a complete or partial waveform from multiple devices, different 
channels and different times for a single graph. Up to six sets of waveforms can be 
graphed together. 

To select items for the Advance Waveform Setup: 
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Use radio buttons to select the Entire Capture or a Selected 
Window. 
Selected Window is enabled if if a user sets mark 1 and mark 2 for a 
given channel. The waveform for that channel between those 
marks will be graphed in the overlaid advanced graph. 

To add to the Selected Waveform Items list, from the Current Waveform Items 
indexed on the left of the screen: 

Click on an item. 

Click on Add. 

To remove an item from Selected Waveform Items: 

Click on the item. 

Click Remove. 

To view the Original Waveform Property of a Selected Waveform Item: 

Click on one of the list items. 
The Waveform Property for that item will appear. 

To return to the main Waveform Graph: 

Click the Back button. 

To create an Advanced Waveform Graph: 

Click the Graph button. 
This screen appears:
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To edit the Advanced Waveform Graph: 

Cick on Edit Graph. 
The first of a series of screens appears. These screens help the user 
customize Advanced Waveform Graphs. 

This screen’s special features include: 

1. Main Title: user can edit the Main Title of the graph.. 

2. User Annotation: user can add a line of text inside the graph in the form of a 
Sub Title. This feature applies to graph with single Y axis, non-overlaid. 

3. Viewing Style: Color, Monochrome or Monochrome and Symbols. 

4. Font Size: Large, Medium or Small 

5. Numeric Precision: digits behind the decimal (from 0-3). 

6. Grid Lines: All (Both), Y, X, None, Grid in Front of Data. 

To Apply changes: 

Click Apply. 

To return to the Original screen:

Click Original. (This will erase any changes.) 

To Export:

Click Export (see details below). 

To Maximize the screen: 

Click Maximize. 
The graph will fill your screen. 
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To add style and dimension to graphs, use the Plot screen and follow these steps: 

Choose one or more axes.

From the 3D buttons, choose Shadow, 3D or Off. 

Choose to Mark Data Points or not . 

Choose a style from Plot Style. 

Choose a Comparison Plot Style. 

To Add Subsets to the Graph: 

Use the Subsets screen: 

From the Subsets screen, choose Subsets to Graph. 

Choose number of Scrolling Subsets to be graphed. 

To Set the Configuration of the Y Axis and the X Axis: 
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Use the Axis screen: 

• Set Linear or Log Axis. 
• Set Auto, Min, Max or Min/Max. 
• Set Numeric Min and Max for each axis. 

In the Font screen, to set the Fonts for the Graph::

Select from the list of different font styles in Bold, Italic or Underline 
for: 

Main Title 

Sub-Title 

Subset / Point / Axis Labels 
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In the Color screen, to choose colors from Graph Attributes: 

Select from the available colors for:

Desk Foreground and Background (area surrounding graph). 

Shadow Color 

Graph Foreground (lines andpoints) 

Graph Background 

Table Foreground and Background 

To select color Point Type and Line Type from a wide selection: 

Use the Style screen. 

To combine multiple waveforms into one graph: 

Click the items on the left side of the Advanced Waveform screen 
for each waveform you wish to include. 

Click the Add button to add the selected items to the Selected 
Waveform Items list on the right side of the screen.
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Click the Graph button at the bottom of the screen. 
The following example screen shows the Vbn and Ic channels: 

To move Hash Marks on the screen: 

Move the mouse. 
Duration is calculated from mark 2 to mark 1 in milliseconds. 

To zoom in on a portion of the graph:

Draw a box around the desired area by dragging the mouse and 
holding down the left button. 

Release the mouse button to activate the zoom. 

Click the Zoom Out button to decrease the resolution. 

To include the Iaux in the graph: 

Press the Iaux On button. 

Click Iaux Off to remove it. 

To include the High Speed Inputs in the graph:

Click Inputs On. 

Double click on the Inputs graph for a closer view. 
Each input is listed on the Y axis followed by a 1 or 0. A 1 denotes 
that the input is open; a 0 denotes that the input is closed. 

Click Inputs Off to remove the graph. 

To print the graph:

Click the Print Graph button. 
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To export an image from the screen: 

Click the Export Picture button. 

To export the data only:

Click the Export Data button. 

To view details of one of the Waveform graphs: 

Double-click on the desired graph. 

To view details for this waveform: 

Click on the Waveform Details On button. 
The following screen appears:

 

To return to the previous graph: 

Click Back or click Waveform Details Off. 

To zoom in on a portion of the graph: 

Draw a box around the desired area by dragging the mouse and 
holding down the left button. 

Release the mouse button to active the zoom. 

To zoom out on a portion of the graph:

Click the Zoom Out button to decrease the resolution. 
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8.10.1 Interharmonic Analysis 
A new feature has been added to the Log Viewer program for Interharmonic Analysis. It is 
only available for advanced meters on Voltage (VA, VB, VC) and Current channels (IA, IB, IC, 
IAUX). 

IEC-1000-2-1 [1] defines Interharmonics as follows: “Between the harmonics of the power 
frequency voltage and current, further frequencies can be observed which are not an 
integer multiple of the fundamental. They can appear as discrete frequencies or as a wide-
band spectrum.” 

To perform the analysis, there must be a waveform record with a 200ms duration. For a 
50Hz system, the waveform is 10 cycles; for a 60Hz system, the waveform is 12 cycles. By 
default, the starting point for Interharmonic Analysis of a Waveform is its first point. But, a 
user can set a starting point (place the mark) anywhere in the waveform, assuming that 
there will be enough sample points available after the starting point. If there are not 
enough points in this waveform capture, the software will check the next waveform 
record(s) stored in the database. If it is contiguous, additional points up to 200ms will be 
retrieved for analysis. For a waveform with sampling rate equal to or less than 64, the 
software will only check the next (1) contiguous record. For a waveform with a sampling 
rate equal to or greater than 128, the software will check the next two contiguous records. 
Resetting the mark will set the starting point back to the waveform’s first point. 

From the detailed view of the graph from the main Waveform 
screen, click the Interharmonic Analysis button. 
The following screen will appear. 

To view a graph: 

Select a Starting Point , if it is other than the first point of the 
waveform (default). 
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Select System Frequency (50Hz or 60Hz) before performing the 
analysis by clicking Options (at the top of the screen) and clicking 
50Hz or 60Hz. 
(The last frequency set will be the default until it is changed.)  

Two more graphs will be displayed:
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Measurement 

IEC 61000-4-7 ([ref] First Edition) establishes a well disciplined measurement method for 
harmonics which utilizes 10 (50Hz systems) or 12 cycle (60Hz systems) sample windows 
upon which to perform the Fourier transform. The result is a spectrum with 5Hz resolution 
for both 50Hz and 60Hz systems. The standard further defines ways of combining 
individual 5 Hz bins to produce various groupings and components for referenced limits 
and guidelines. 

The IEC Measurement Method defines interharmonic groups. These indices are the RMS 
values of the interharmonic components between adjacent harmonic components. The 
frequency bins directly adjacent to the harmonic bins are omitted. This relationship is 
defined by the following equation:

   (50Hz Systems)  (EQ 8.1)

  (60Hz Systems)  (EQ 8.2)
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8.11 Viewing the Power Quality Log 

From Log Viewer’s main screen, click on the Power Quality button 
or View Data  > Power Quality. 
Log Viewer will display power quality information for the selected 
log file(s) based on the time range specified in the Select Time 
Range section of its main screen (see section 8.4). 

To save the data to your clipboard: 

Right-click with the cursor positioned anywhere in table. 

To view waveform information associated with a record or a range of records: 

Click on the record(s). 

Click the Show Waveform Settings box on the left side of the 
screen. 

To view the PQ/Waveform Settings: 

Click on the record(s). 

Click the PQ/Waveform Settings box. 

To view a waveform:

Double-click on the waveform record. 
See section 8.10 for details on viewing waveforms. 

To adjust the column widths:

Position the cursor between columns at the top of the screen.

When the cursor changes to a left/right arrow, hold down the left 
mouse button and drag the column border left or right. 

Release the button when the column is at the desired width. 
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8.12 Viewing the Power Quality Graph 

To view a graph of any PQ record: 

Click on the desired record 

Click the Graph button. 
The following screen appears. 

Use the pull-down menu on the lower right of the screen to access 
a 3D graph and a Histogram of the record.  
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Note Use Scroll Bars on the side and bottom of the screens to adjust the view. 
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8.13 Database Status 

The Database Status screen provides statistical information about the selected log(s). 

Click on the Database button or View Data > Database Status. 
The following screen appears: 

A partial download consists of the newest records and captures appended to the existing 
records in the log database. The snapshot must be a timeframe within the database dates, 
otherwise, there is no data from which to retrieve the snapshot. 

To copy the data to the computer’s clipboard: 

Right-click with the cursor positioned anywhere in the table. 

To return to Log Viewer’s main screen, click Back. 
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8.14 AiReports

AiReports 2.0 is an optional power quality analysis software package used in conjunction 
with GE Communicator EXT Logs. It provides a comprehensive report on the status of the 
equipment being monitored and it uses artificial intelligence to diagnose PQ events and 
provide the possible cause of the event. The screen below is an example of one of the 
screens. 

AiReports 2.0 must be installed on your computer for the view button to be enabled, 
otherwise, the button will be disabled. 

To view the AiReport 

From the GE Multilin Log Viewer, select a Meter Database File for 
Meter 1 and set a Time Range. 

Click on the AiReports button and the report will be generated. 

Once the detailed report is generated, you can transmit it to a colleague, modify 
the report with your favorite word processing software, print it and/or export the 
file using PDF format. 

Reasons for Incomplete Analysis

AiReports for GE Communicator EXT analyzes the voltage waveform records in the 
meter database file. If the file does not contain any voltage waveform records, 
AiReports will not run. 

AiReports will not perform a valid analysis on a waveform record if it was 
converted by the Log Converter program with a version of v1.0.11 (June 26, 2000) 
or older. 
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8.15 PQDIF Converter 

The latest release of AiReports includes a new useful feature, PQDIF Converter. Power 
Quality Data Interchange Format (PQDIF) is a tagged, compressible binary file format 
which offers a platform-neutral, flexible means of exchanging power quality data between 
instruments and data management and analysis software. PQDIF is currently under 
adoption by EPRI as the standard file format for power quality data and under 
consideration by IEEE as its standard file format. 

Using the PQDIF Export Feature with Log Viewer 

System Requirements: Installation of AiReports with NEXAIPWR.DII file version 
2.1.0.8 or higher. PQDIF Viewer Program optional. 

Meters Supported: EPM 9450, 9650 and 9800. 

Operation: 

Use the Meter 1 button, select a DB file with waveform data. 

Select a Time Range. 

Press the PQDIF Format button. 

Select a PQDIF file name (*.PQD) to which you will export data. 

Click OK. 
PQDIF exports the waveform data and converts it to PQDIF format. 
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8.16 COMTRADE Converter 

The latest release of AiReports includes a new useful feature: COMTRADE Converter. 
Common Format for Transient Data Exchange (COMTRADE) is a standard that defines a 
format for the files containing transient waveform and event data collected from power 
systems or power system models. The format is intended to provide an easily interpretable 
form for use in exchanging data. As such, it does not make use of the economies available 
from data encoding and compression that proprietary formats depend upon for 
competitive advantage. 

The standard is for files stored on physical media, such as digital hard drives and diskettes. 
It is not a standard for transferring data files over communication networks. This standard 
defines a common format for the data files and an exchange medium needed for the 
interchange of various types of fault, test and simulation data. 

The COMTRADE Converter carefully adheres to COMTRADE specification IEC 60255-24 
(2001). 

File types and operations 

COMTRADE converter will generate the following types of file:

filename.cfg 

filename.dat 

filename.inf 

filename.d## 

filename_*.cfg 

filename_*.dat 

filename_*.inf 

filename_*.d## 

The term filename represents the user specified file name. 

The symbol ## represents a value from '00' through '99'. 

The symbol * is the number of 1 or above for each additional waveform record. 

File type cfg is for Configuration. 

File type dat is for Data. 

File type inf is for Information. 

The software requires user to enter a unique filename each time the COMTRADE converter 
runs. Upon COMTRADE Converter startup, it will scan all files with the filename provided by 
the user at a location associated with COMTRADE (file types listed above). If it finds any file 
that already exists, the software will issue a  message and no conversion will take place. 

Note The software will not overwrite an existing file; it will only convert to a new filename. 
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Using the COMTRADE Converter Feature with Log Viewer 

System Requirements: Installation of AiReports with NEXAIPWR.DII file version 
2.1.2.8 or higher. COMTRADE Viewer Program is optional. 

Meters Supported: EPM 9450, 9650 and 9800. 

Log Viewer Operation: 

Use the Meter 1 button, select a DB file with meter waveform data. 

Select a Time Range. 

Press the COMTRADE format button. 

Enter a unique file name (file extension is not needed) to which you 
will export data. 

Click OK. 

COMTRADE Converter exports the waveform data and converts it to COMTRADE 
format files. 
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8.17 Status Change Log (Inputs) 

The Status Change Log (Input Log) displays the input change status for a selected meter 
file and time range. 

To view the Status Change Log

From the Log Viewer, select a Meter Database File and set a Time 
Range. 

Click the Status Change Log button or View Data > Status 
Change (Inputs). 
The above screen will appear. 

Usually, if a record being displayed in the grid box has a start date/time and an 
end date/time, the state being displayed is and out-of-normal state. 

If a record does not show the start time/date or the end date/time, this means that 
at the time of the log conversion by the Log Converter it could not find the start or 
end record. This situation can be caused by log rollover and/or other interruptions. 
Without a start or end record, this will not be a complete record and no duration 
will be calculated. 

Note Module Index 0 refers to HSI Internal Meter Inputs. 
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8.18 Control Output Log (Relays) 

The Control Output Log (Relay Log) displays the relay change status for a selected meter 
file and time range. 

To view the Control Output Log

From the Log Viewer, select a Meter Database File and set a Time 
Range. 

Click on the Control Output Log button or View Data > Control 
Output (Relays). 
This screen appears.

There are three stages in the relay process: 

Stage 1 = Trigger 

Stage 2 = Command 

Stage 3 = Acknowledgement 

Stage 1: The change relay state process starts. 

Stage 2: A meter responds to the change relay request and sends out the change 
relay command to the relay device. 

Stage 3: The meter gets a response back from the relay device. 

A complete record should have all three stages’ date/time stamp. The Start State is the 
relay state at the time of the Trigger. The End State is the relay state at Stage 3 or the 
Acknowledgement Stage. 

Reasons for Incomplete Records 

• At the time of the log conversion process, if the Log Converter cannot find the 
Stage 1 record (which can be caused by log roll over), the Trigger date/time and the 
Start State will not be displayed. 

• At the time of log conversion, if the Log Converter cannot find the Stage 1 record, 
the Inputs, Gates and the Relay Start State will not be displayed. 
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• If the Log Converter program cannot find the Stage 2 record, the Command date/
time will not be displayed. 

• If the Log Converter cannot find the Stage 3 record, the Acknowledgement date/
time and End State will not be displayed and the appropriate duration will not be 
calculated. 

• If any one stage is missing, the appropriate duration will not be calculated. 

To view the GE Graph

Click on an event 

Click on the Graph button. 
The following screen will appear: 

Key Functions for the GE Graph 

Page Up = Previous Relay Record 

Page Down = Next Relay Record 

Home = Current Relay Start State 

End = Current Relay End State
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GE Communicator EXT

Chapter 9: Time-of-Use

GE Consumer & Industrial
Multilin

Time-of-Use

9.1 General Procedure 

See the meter’s Installation and Operation Manuals for a detailed discussion of the GE 
Communicator EXT Time-of-Use (TOU) function. 

The following is a general outline for programming TOU. Each step is described in detail in 
subsequent sections. 

From the Tool Bar, select Time-of-Use > Calendar Settings:

Create a TOU calendar profile using the following elements: 

• Usage registers (eg “Peak,” “Off Peak,” “Shoulder Peak”) for each 
fifteen-minute block of the day; 

• Demand Integration Averaging for Block (Fixed) or Rolling (Sliding) 
Window

• Programmable start dates for four seasons per year
• Programmable bill dates for each month of the year 
• TOU schedules—eg, “Weekday,” “Weekend,” “Holiday”—for each 

day of the year. 

Send the TOU calendar profile to the connected meter. 
TOU accumulations will begin. 

View, print or export the TOU accumulations. 

Reset the TOU accumulations at any time by selecting Reset Meter 
Information from the Tools Menu (see Chapter 3 for EPM 9450/
9650 (Chapter 4 for EPM 9800) for details). 

Resetting clears all accumulations of the current month or season, causes the 
accumulations to use the present date as the start-date, and accumulates to the next new 
end-date, which is taken from the new calendar. 
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To use Daylight Savings Time, you must enable it in the meter’s Device Profile (see 
Chapter 3 (EPM 9450/9650) or 4 (EPM 9800)), and enter the associated dates. Or you can 
use Auto DST, which sets Daylight Savings Time automatically for the United States only. 

If GPS Time (IRIG-B) is connected, you must set the appropriate time zone. Date and time 
settings (except year) are overridden by GPS Time.

Note An IRIG-B signal-generating device connected to the GPS satellite system will synchronize 
meters located at different geographic locations. See the meter’s Installation and 
Operation Manuals for installation instructions. 
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9.2 Creating a TOU Calendar Profile 

The TOU calendar profile sets the parameters for TOU data accumulation. You may store 
up to twenty calendars in the meter and an unlimited amount on your computer. To create 
a new calendar, follow the steps below. To edit an existing calendar, see section 10.3. 

From the Time-of-Use menu, select Calendar Settings. 
The following screen appears: 

From the pull-down menu, choose the year for which you would 
like to create a TOU usage structure. 

Click on New Calendar. 
The following screen appears: 
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Click on TOU Registers. 
The following screen appears: 

A register is a type of rate structure, for example “Peak”, “Off-Peak” or “Shoulder Peak.” You 
will assign one register to each fifteen-minute interval of the day when you set up the TOU 
schedule (see below). 

Enter a name for each different register (up to eight). 

Click OK to return to the main Edit Calendar screen. 

Click Averaging. 
The following screen appears: 

Select the type of Demand Averaging to be applied to the TOU 
accumulations. 
For a discussion on Demand, see the meter’s Installation and 
Operation Manuals. 

Click OK to return to the main Edit Calendar screen. 
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Click on Monthly Bill Date. 
The following screen appears: 

To program a specific Bill Date for each month, use the pull-down menus. If you do not 
select a specific billing date for a given month, accumulations will continue until the next 
monthly billing date is reached or December 31, if there is no next year spanning calendar. 

When you have entered all Monthly Bill Dates, click OK to return to 
the main Edit Calendar screen. 

Click Period Selection. 
The following screen appears: 

Use the pull-down menus to program a Freeze Period and Hour of 
Day to Freeze. 
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Double-click one of the Season Start windows. 
The Season Start screen appears: 

Assign a Start Date for up to four seasons per year. Enter a date in 
each window or double-click to retrieve a calendar from which you 
can choose a Month and a Day. 
All Start Dates also act as the End Date of the prior season or 
month. A season ends at midnight of the day before the start of the 
next season. 

Click OK to return to the Adjustable Self Period Selection screen.

Note The date format you use here should be the same the date format set for your 
computer. To change or view your computer’s date settings, click on the Windows® 
Start Menu and select Settings, Control Panel, Regional Settings. Click on the Date tab.

 

When all selections are made, click OK to return to the main Edit 
Calendar screen. 

Click Method in the Register Accumulation section of the window. 
The following screen appears: 

Click the radio button for the type of Accumulations you require 
and click OK. 
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Click TOU Schedules. 
The following screen appears: 

• The first column lists each fifteen-minute block of a 24-hour day. 
• The Individual Registers defined in Step 5 will be applied to each 

fifteen-minute block. 
• A schedule is the type of accumulation structure you will apply to 

individual days. You may program up to 16 different schedules. 

Double-click on one of the Schedule Headings — for example: 
“Schedule_1”. 
The following screen appears:

Enter a Name for the schedule, such as “Weekday,” “Weekend” or 
“Holiday”. 

Click OK. 
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Double-click on one of the fifteen-minute blocks in the schedule. 
The following screen appears: 

From the pull-down menu, select the Register Name you would 
like to apply to this fifteen-minute block. 

Click OK. 

Repeat the above procedure until all fifteen-minute blocks in the 
schedule(s) are assigned registers. 

When all schedules are formatted, click OK to return to the main 
Edit Calendar screen. 

Click on Calendar Assignments. 
The following screen appears: 

The schedules created in steps 16–21 are shown beneath the calendar. Each 
schedule is color-coded. 
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Assign a particular Schedule to each day by clicking on the day. 
The following screen appears: 

From the pull-down menu, select the Schedule you would like to 
apply to this day. 

Click OK to return to the calendar. 

To apply a Schedule to a Range of Dates or to selected days of the 
week, select and click Multi Date. 
The following screen appears: 

Note With the Multi Date button, you can quickly program a whole year (For Example, 2005) 
by selecting, for instance, all the weekdays (Mon - Fri) and in the Date Range type 01/
03/05 to 12/30/05. Do the same for the weekend days. Fill in holidays and vacations 
for each month. 

Enter a Date Range; select the type of Schedule and, if desired, 
choose a Day of the Week. 

Click OK. 

Use the color-coded key below the calendar to review which 
Schedules have been applied to the month. 

Click Next Month and repeat the process for the year. 

When the calendar settings are complete, click OK to return to the 
main Edit Calendar screen. 

You may now: 

Click Save to File to send the calendar to the computer for future 
use. 
See section 10.3 for how to edit a previously saved calendar. 
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Click on Save to File to store the file in your computer. 
Your computer screen will ask you the File Name, Save In and Save 
as Type information. Enter data. 

Click Save or Cancel.  

Click Update EPM to send the calendar to the meter. 
The following screen appears: 

Before updating the meter, GE Communicator EXT checks that the data entered is valid. It 
will warn you if any data is not correct. If one of the Status Screens fails, GE Communicator 
EXT not let you update the device. A pop-up screen will tell you that it is an Invalid 
Calendar. Click OK. You will return to the Edit Calendar screen to create another calendar. 

Click Continue. 
The following screen appears: 

Select the slot you would like to use. 
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Click Send. 

Communicator will send the calendar to the meter. The above pop-up window will tell you 
that the calendar was received. Click OK. The meter will use the calendar for the 
designated year, based on the date settings of your computer.

Note Do not enter more than one calendar for the same year (ie, do not store two calendars for 
2005). If this occurs, the meter will use the first calendar entered. 
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9.3 Update a TOU Calendar Profile 

From the Time-of-Use menu, select Calendar Settings. 
The following screen appears: 

Click Edit Calendar. 
The following screen appears:

To edit a calendar saved on the computer’s hard drive, click Load 
From File. 
Communicator EXT will ask you to locate the calendar. After the 
calendar has loaded, see section 10.2 for details on programming 
the calendar. 
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To edit one of the calendars stored in the meter, click Load From 
Meter. 
The following screen appears: 

Select the calendar year you would like to edit and click Retrieve. 
After the calendar year has been retrieved, see section 10.2 for 
details on editing. 
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9.4 Viewing TOU Accumulated Data 

From the Real Time Poll menu select Revenue, Energy and 
Demand Readings > Time of Use Registers. 

The following screen appears: (If Passwords are Enabled, you must 
enter a Password to view this screen.) 

From the Group pull-down menu, select the month or season 
accumulations you would like to view. 

From the Register pull-down menu, select the individual register 
accumulation (or the total of all registers) you would like to view for 
the selected month or season. 
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The EPM Advanced Meters are true four-quadrant power meters. They display the 
VARs and VA for each quadrant, as illustrated below: 

Print or Export the data by clicking the appropriate button at the 
bottom of the screen.

Send Password: If Passwords are Enabled, the Send Password 
button will be visible on the screen. You must enter a Password 
initially to view the screen. Then, when the Password has expired, 
you must click “Send Password” to continue polling. This feature 
was initiated because some users found that continuous polling 
filled up the system event log too fast. 

Click OK to close this window and return to the main GE 
Communicator EXT screen.

Quadrant Power Factor Watts VARs

1 Lag + +

2 Lead - +

3 Lag - -

4 Lead + -
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GE Communicator EXT

Chapter 10: External I/O Modules

GE Consumer & Industrial
Multilin

External I/O Modules

10.1 Overview 

EPM 9450/9650

Addr
160

Addr Addr
128 156

I/Os must use the EPM Meter’s 
Port 4. EPM9450/9650 can also 
use Port 3. Set the port to 57600 
Baud, Master.

Group of 3 I/Os

Use these Edit buttons to 
configure the connected I/Os.

The External Devices section 
of the EPM Meter’s Device 
Profile (Chapter 3 - 9450/
9650, Chapter 4 - 9800) tells 
the Meter which I/O Modules 
are connected to it at which 
addresses. This profile must 
reflect what is physically 
attached to the unit. Revise 
the EPM Meter’s Device Pro-
file each time an I/O is added, 
removed or configured. 

The EPM Meter recognizes I/O mod-
ules by the unique address 
assigned to each one. Use the 
Change I/O Module Address/Baud 
Rate function to assign a unique 
address to each I/O before con-
necting the group to the EPM Meter.

RS 485 Cable
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10.2 Outline of the Procedure for Installing I/O Modules 

The steps below are detailed in subsequent sections of this chapter. 

Review I/O hardware details in the meter’s Installation and 
Operation Manuals. 

Before connecting any I/Os to the EPM Meter, make sure each one 
has its own unique address. 
All I/Os are shipped with a pre-set address and a baud rate of 
57600. See section 11.5 for a list of factory-set addresses and baud 
rates. To assign or change I/O addresses, see section 11.6. 

Write down the name and unique address of each I/O you will be 
using. (You will need to know the addresses for the EPM Meter’s 
Device Profile.) 

Connect the I/O or group of I/Os to the EPM9450/9650 Meter’s Port 
3 or 4 or EPM 9800 Meter’s Port 4. 

• You must use the correct port. Be sure ports are set to operate at 
the same baud rate as the I/O modules. 

• The ports must also be configured as Masters. See Chapters 3 
(EPM 9450/9650) and 4 (EPM 9800) for how to configure the 
communication ports. 

Retrieve the EPM Meter’s Device Profile. 

• In the External Devices section, enter the name of each I/O and 
its unique address. 

• Use the Edit buttons to configure the I/Os. 
• Each I/O connected to the unit must be included in the Device 

Profile. 
• Update the Device Profile to record the changes. See section 

11.7. 

Note Updating the Device Profile will reset all logs. 

This chapter also covers the following I/O utilities: 

• Meter I/O Device Status (section 11.13): lists all registered I/Os currently in use. 

• Query I/O Module (section 11.14): locates an I/O’s address and baud rate. 

• Locator Utility (section 11.15–16): locates an I/O’s address and baud rate without 
using the reset button. 

• Stand Alone Programmer (section 11.17): allows you to configure all I/O 
parameters directly from a computer, not through a EPM Meter. 
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10.3 Using Multiple I/O Modules 

Each type of I/O module is shipped with a factory-set address (see section 11.5). If you plan 
to use more than one I/O module of the same type (such as three KYZ modules), you must 
change the address of each module individually before connecting the group to the EPM 
Meter. See section 11.6 for how to change a module’s address and baud rate. 

Each I/O module in a group must have its own unique address. Each module must be set to 
operate at the same baud rate as the EPM 9450/9650 Meter’s Port 3 or Port 4 (Port 4 ONLY 
for EPM 9800) (57600 is recommended). 

If you do not know an I/O module’s address or baud rate, use the Query I/O function 
detailed in section 11.14. This function works only on Port 4. 

To connect multiple I/Os together, attach the male RS-485 port of one module to the 
female RS-485 port of another. Secure by tightening built-in fasteners. Attach mounting 
brackets to the outside modules. Use the steps below (section 11.4) to determine if you 
must use a separate power source (for example, GE Multilin PSIO) to supply added power 
to the group. 

To connect a group of I/Os to the EPM Meter, connect an RS-485 cable to the group’s 
available female RS-485 port. Connect the other end of the cable to the EPM 9450/9650 
Meter’s Port 3 or 4 (Port 4 ONLY for EPM 9800). 

You may combine different types of I/O modules together in a group. 

After all modules have been assigned a unique address and connected to the EPM Meter, 
you must enter them in the EPM Meter’s Device Profile. See section 11.7. 
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10.4 Steps to Determine Power Needed 

• Available power for All Ports of the EPM 9450/9650 is 12 VA. EPM 9800 does NOT 
support I/O Modules; a power supply is required. 

• Refer to the table in the next section (Section 11.5) to determine the VA Ratings for 
I/O modules and displays. 

• Add together the VA Ratings for I/Os and Displays in use. 

• Compare Available Power to Power Needed. See the Meters’ Installation and 
Operation Manuals for details. 
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10.5 I/O Modules’ Factory Settings and VA Ratings 

All I/Os are shipped pre-programmed with a baud rate of 57600 and addresses. The table 
below details the factory-set address for each module and the VA Ratings for I/O modules 
and displays. Refer to the previous section (section 11.4) for the steps to determine if you 
must use an additional power source with the EPM 9450/9650. EPM 9800 does NOT 
support I/O Modules; a power supply, such as the PSIO, is required. See section 11.5.1. 

To temporarily reset an I/O module to address 247 and 57600 baud (program defaults), 
press and hold the reset button for 3 seconds. The module will remain in reset mode for 30 
seconds. 

10.5.1 Additional Power Source for I/O Modules 
Available power for All Ports of the EPM 9450/9650 is 12 VA. The EPM 9800 Power Supply 
will NOT SUPPLY POWER TO THE I/O MODULES. You must use a power source, such as the 
PSIO (12V), for additonal I/Os connected to the EPM 9450/9650 and for ANY I/Os connected 
to the EPM 9800. RS-485 communication is viable for up to 4000 feet (1219 meters). 

I/O MODULES FACTORY SETTINGS AND VA RATINGS

MODEL 
NUMBER 

MODULE ADDRESS VA RATING 

1mAON4 0-1mA, 4 Analog Outputs 128 2.7 VA

1mAON8 0-1mA, 8 Analog Outputs 128 3.2 VA

20mAON4  4-20mA, 4 Analog Outputs 132 5.0 VA

20mAON8 4-20mA, 8 Analog Outputs 132 8.5 VA

8AI1 0-1mA, 8 Analog Inputs 136 2.3 VA

8AI2 0-20mA, 8 Analog Inputs 140 2.3 VA

8AI3 0-5 VDC, 8 Analog Inputs 144 2.3 VA

8AI4 0-10 VDC, 8 Analog Inputs 148 2.3 VA

4RO1 4 Latching Relay Outputs 156 2.7 VA

4PO1 4 KYZ Pulse Outputs 160 2.7 VA

8DI1 8 Status Inputs (Wet/Dry) 164 1.0 VA

DISPLAYS VA RATINGS

 P40N LED Display 8 VA

 P60N Touch Screen Display 5 VA 
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Below are the dimensions and the labels for the PSIO. 

PSIO Power Source (Male RS-485 Side Port)

PSIO Power Source with I/O Modules
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Connection Steps 

Connect the A(+) and B(-) terminals on the meter to the A(+) and B(-) 
terminals of the male RS-485 port. 

Connect the shield to the shield (S) terminal. 
The (S) terminal on the meter is used to reference the meter’s port 
to the same potential as the source. It is not an earth ground 
connection. 
You must also connect the shield to earth-ground at one point. 

Put termination resistors at each end, connected to the A(+) and B(-
) lines. RT is ~120 Ohms. 

Side LabelTop Label

Labels for PSIO Power Source
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10.6 Assigning Addresses and Baud Rates to an I/O Module 
Note The utility described below requires the I/O to be connected to the EPM 9450/9650 Meter 

at Port 3 or 4 (EPM 9800 at Port 4 ONLY). To configure an I/O module by connecting it 
directly to your computer, use the Stand Alone Programmer utility, section 11.17. 

You must know the current address and baud rate of the I/O you want to change. See 
section 11.5 for a list of factory-settings, if the I/O is new, or use the Query I/O function 
(section 11.14)  (Port 4 ONLY), if the address and/or baud rate has been changed or is no 
longer known. When you have determined the current address and baud rate, proceed 
with the steps listed below. 

Make sure the EPM Meter’s Port 3 or 4 is configured to 
communicate with the I/O module at the same baud rate (57600 
recommended). 

Set the Port to Master mode. See Chapter 3 (EPM 9450/ 9650) or 
Chapter 4 (EPM 9800) for details on configuring the EPM Meter’s 
communication ports. 

Connect the I/O to the EPM 9450/9650 Meter’s Port 3 or 4 or EPM 
9800 Port 4. 

Note You may connect a group of I/Os to the EPM Meter to make address/baud rate changes 
only if each I/O already has a unique address. If the I/Os have the same address—such as 
three new KYZ modules—you must connect and change their addresses individually. See 
section 11.3 for details on using multiple I/O modules. 

From the I/O Devices menu select Change I/O Module Address/
Baud Rate. 
The following screen appears: 

From the pull down menus, enter the module’s current address and 
baud rate.

Enter the address and baud rate you would like to assign. 

Enter an address from 1 to 247, being sure that the address is not 
already assigned to any other I/O you will be using. 

Click Make Change. 
A confirmation screen appears after the module has been updated. 

Repeat the procedure for all I/Os in the group. 

Write down the module’s new address and baud rate. 
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Proceed to section 11.7 to enter the I/O in the EPM Meter’s Device 
Profile and configure all other I/O parameters. 
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10.7 Entering I/O Modules in the EPM Meter’s Device Profile 

The EPM Meter uses a Master/Slave polling architecture when communicating with the I/O 
modules; therefore you must enter all I/Os in the EPM Meter’s Device Profile. This 
procedure tells the unit what types of modules are connected to it , what parameters you 
have set for them and at what address they may be found. 

Write down the name and unique address of each I/O you plan to 
use. 
Be sure all baud rates match that of the EPM 9450/9650 Meter’s 
Port 3 or 4 (EPM 9800’s Port 4) (57600 is recommended). 
Be sure all addresses are unique. See section 11.6 for how to assign 
addresses and baud rates. 

Connect the I/O module(s) to the EPM 9450/9650 Meter’s Port 3 or 4 
(EPM 9800’s Port 4); see the Meter’s Installation and Operation 
Manuals for hardware/installation details. 
Be sure Port 3 or 4 is operating at 57600 baud and is in Master 
mode (see Chapter 3 (EPM 9450/9650), Chapter 4 (EPM 9800)). 

Click on the Edit Profile button (or select Edit Current Device Profile 
from the Tools Menu) to retrieve the EPM Meter’s Device Profile. 
(See Chapter 3 (EPM 9450/9650), Chapter 4 (EPM 9800)). 

When GE Communicator EXT has retrieved the Device Profile from 
the EPM Meter, double click on External Devices. 
The following screen appears. 

Click in the Type column and use the pull-down menu to select the 
specific I/O you wish to enter. 
You may enter up to 16 modules. 

Enter each module’s unique address. 
If you have not assigned a unique address to each module, see 
section 11.6. Each module’s address must be unique, otherwise 
communication will not function properly. 
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You may now configure the modules using the Edit buttons. See the following 
sections (11.8–11.12) for details on how to configure each type of module. 

Check the Table of Contents for the type of module you want to 
configure and read the corresponding section. 

After you have configured all modules, click OK. 

Note Log / Limit ID is an internal identification based on the order in which the modules are 
entered into the profile. 

The EPM Meter will begin to look for the modules at the addresses listed. If all are 
present, the main Device Profile screen will appear. If an incorrect address is given, 
a  screen appears and the changes are rejected. Determine the correct address of 
any missing I/O using the Query I/O function (section 11.14) (Port 4 Only) or the 
Locator Utility (section 11.15 - 11.16) and enter the correct information in the 
External Devices section of the meter’s Device Profile. 

You MUST now Update the EPM Meter’s Device Profile to enter the Modules. 

Click on Update Device. 
This sends the new Device Profile, with the I/O information, to the 
EPM Meter. 

Click Report to print out a copy of the I/O information. 

Click Save to save these parameters to your computer. 

Click Load to enter a previously saved set of parameters. 
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10.8 Configuring the Analog Output Module 

Be sure each module has a unique address and is connected to the 
EPM 9450/9650 Meter’s port 3 or 4 or the EPM 9800 Meter’s Port 4 
at the same baud rate as the port (57600 recommended); see 
section 11.6. 

Retrieve the External I/O Modules section of the Device Profile 
from the EPM Meter (see Chapter 3 (9450/9650) or Chapter 4 (EPM 
9800) for more detail on the Device Profile and section 11.7). 

After you have entered the type of Analog Output Module in the 
Type column and its address in the assigned address column, click 
on the Edit button in the EPM Meter Settings column. 
The following screen appears: 

From the pull-down menus, select the type of reading and the 
channel to which it will be applied. 

The module reads a 4-byte value per channel. So, you must select 4 
of the 8 bytes to be read by the module. 
Use the pull-down menu to choose 4 of the 8 bytes. 

Click OK when all channels are set. 
The Device Profile: I/O Modules screen appears. 
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Click on the Edit button in the Scale Settings.
GE Communicator EXT retrieves the settings from the I/O module. 
The following screen appears: 

For each channel, enter the scale setting according to the needs of your application. 
The scale High Value refers to the high end of the module; the scale Low Value refers 
to the low end of the module. For example, if you have a 4–20mA module, the scale 
High Value determines what 20mA equals. The scale Low Value determines what 4mA 
equals. (See note below on How to Set Scale Values.) 

To change the I/O’s Transmit Delay, you must use the Stand Alone Programmer, 
section 11.17. 

To enter the scale settings, click on the Module Settings button. 
GE Communicator EXT will send the new scale settings to the 
module and then reset it. 

Be sure to send the updated Device Profile to the EPM Meter after 
you have finished configuring all I/Os. 

Click on the Update Device button. 

Note How to Set Scale Values: Enter values for volts, current and power in secondary. All 
other values should be set in primary. 
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10.9 Configuring the Analog Input Module 

The Analog Input Module can measure any type of reading, once it is converted to an 
electrical signal (within limits of the I/O Module). Below is an example of a reading and its 
conversion to a value: 

Following are the steps to configure the Analog Input Module: 

Be sure each module has a unique address and is connected to the 
meter’s Port 3 or 4 at the same baud rate as the port (57600 
recommended) (see section 11.6). 

Retrieve the External I/O Modules section of the Device Profile 
from the meter (section 11.7).

After you have entered the type of Analog Input Module in the Type 
column and its address in the Assigned Address column, click on 
the meter’s Settings Edit button. 
The following screen appears: 

CONVERSION TO  VALUE

READING SIGNAL VALUE

1000 1.0 mA 100%

500 0.5 mA 50%

00 0.0 mA 0%

500 -0.5 mA -50%

1100 -1.0 mA -100%
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Enter label and scaling factor for each input. 
The Value columns will appear in either milliamps or Volts, 
depending on the type of input chosen in the Device Profile. 

Click OK when done. 

Click on the Module Settings button. 
The following screen will appear, reflecting the settings for Address, 
Baud Rate and Transmission Delay. 



10–16 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

CONFIGURING THE KYZ OUTPUT MODULE CHAPTER 10: EXTERNAL I/O MODULES

10.10 Configuring the KYZ Output Module 

Be sure each module has a unique address and is connected to the EPM Meter’s Port 3 
or 4 at the same baud rate as the port (57600 recommended); see section 11.6. 

Retrieve the External I/O Modules section of the Device Profile from 
the EPM Meter (see Chapter 3). 

After you have entered the KYZ module in the Type column and its 
address in the Assigned Address column, click on the Edit button in 
the EPM Meter Settings column. 
The following screen appears: 

Assign an accumulation to each relay based on the needs of your 
application. 

Click OK to return to the main I/O Device Profile screen. 

Click on the Edit button in the Scale Settings.
GE Communicator EXT retrieves the settings from the I/O module. 
The following screen appears: 

For each output, enter the Watt per Pulse and the Minimum Pulse 
Width in milliseconds. 

Leave the Roll Over at the default value of sixteen 9s. 
This value matches the Roll Over of the EPM Meter. It is important 
that the Roll Over of the module match the Roll Over of the device 
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to which it is connected. Change the Roll Over only if you are using 
the module with a device other than an EPM Meter or if you are 
using the module as a stand-alone unit. 

To change the I/O’s Transmit Delay you must use the Stand Alone Programmer, 
section 11.17. 

When you have entered the scale settings, click Update. 
GE Communicator EXT will send the new scale settings to the 
module and then reset it. 

Be sure to send the updated Device Profile to the EPM Meter after 
you have finished configuring all I/Os. 

Click on the Update Device button. 
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10.11 Configuring the Digital Output Module 

Be sure each module has a unique address and is connected to the meter’s Port 3 or 4 
at the same baud rate as the port (57600 recommended); see section 11.6. 

Retrieve the External Devices section of the Device Profile from 
the meter (see Chapter 3). 

After you have entered the Digital Output module in the Type 
column and its address in the Assigned Address column, click on 
the Edit button in the EPM Meter Settings column.
The following screen appears: 

Enter label and Common Shorted to N.C. or N.O. for each output. 
Click Lock to Manual Control, if desired. 

Click OK when done. 

Click on the Module Settings button. 
The following screen will appear, reflecting the settings for Address, 
Baud Rate and Transmission Delay.
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10.12 Configuring the Relay Outputs 

Be sure each module has a unique address, is entered in the EPM Meter’s Device 
Profile and connected to Port 3 or 4 at the same baud rate. See section 11.7. 

From the I/O Devices menu select Relay Control. 
The following screen appears:

Each module has four relays that can be configured using this screen. 

To change the state of one or more relays, click the box next to the 
relay(s) you want to change. 

Use the pull down menu next to "Select New State" to assign a Lock 
Common to N.C., Lock Common to N.O. or an Unlock state to the 
relay(s). 

Click on the Apply button to send the new setting to one or more 
relays of one or more modules. 

Click OK when you have finished configuring all Relay Outputs. 
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10.13 Using the Digital Input Module 

Be sure each module has a unique address and is connected to the meter’s Port 3 or 4 
at the same baud rate as the port (57600 recommended); see section 11.6. 

Retrieve the External Devices section of the Device Profile from 
the meter (see Chapter 3). 

After you have entered the Digital Input module in the Type column 
and its address in the Assigned Address column, click on the Edit 
button in the EPM Meter Settings column. 
The following screen appears: 

Enter Channel Label, Open Label, Closed Label and Normal State 
for each input. 

Click OK when done. 

Click on the Module Settings button. 
The following screen will appear, reflecting the settings for Address, 
Baud Rate and Transmission Delay. 

Note If you are using a Digital Input module with a EPM Meter, you only need to enter the 
module in the EPM Meter’s Device Profile (section 11.7) and configure the screen 
above; you do not need to configure the module further unless you want to change 
the roll over. The module’s Roll Over should always match the Roll Over of the device to 
which the module is connected. The Digital Input’s default Roll Over parameters are 
set for use with a EPM Meter; therefore they do not need to be changed
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. 

To change the I/O’s Transmit Delay, you must use the Stand Alone Programmer, section 
11.17. 

Assign a Roll Over to each relay based on the needs of your 
application. 
If the module is connected to a EPM Meter, you do not need to 
change the Roll Over from the default. 

Click Update to send the new Roll Over settings to the module. 

Be sure to send the updated Device Profile to the EPM Meter after you have 
finished configuring all I/Os. 

Click on the Update Device button. 
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10.14 I/O Device Status

This utility allows you to view a list of all the modules that have been entered (“registered”) 
in the EPM Meter’s Device Profile (see section 11.7). 

From the I/O Devices menu, select I/O Device Status. 
GE Communicator EXT searches for all entered I/O modules. 
The following screen appears (the listings shown are for example 
only): 

To view the current programmable settings of a particular module, 
select it and click Query. 
For example, a query of the KYZ module at address 247 yields the 
following: 

To change the I/O’s Transmit Delay, you must use the Stand Alone 
Programmer, section 11.17. 

Query screens are read-only. To change any parameters you must 
edit the EPM Meter’s Device Profile (see section 11.7). 

Click Refresh to initiate a new search and listing of connected I/Os. 
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10.15 Query I/O—Locating an Unknown Address and Baud Rate 
Note This utility requires you to press the I/O module’s reset button. If you are off-site, or cannot 

access the reset button, use the Locator Utility described in section 11.15–16. 

I/Os may be connected to either the EPM Meter’s Port 3 or 4. However, ONLY Port 4 is 
programmed to query. Be sure the port is configured to operate at 57600 and is set to 
Master mode; see Chapter 3 for how to configure the EPM Meter’s communication 
ports. 

Select I/O Devices > Query I/O Module. 
The following screen appears: 

Click Continue. 
The following screen appears: 

Use a fine point to depress the I/O module’s reset button. Hold it in 
for at least three seconds. 
This resets the I/O module to address 247 at 57600 baud for thirty 
seconds, allowing GE Communicator EXT to retrieve the stored 
address and baud rate. 
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Click OK. 
The EPM Meter will begin looking for the device at the temporary 
address of 247. When the I/O’s programmable information is 
located, the following screen appears: 

Write down the address and baud rate. 
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10.16 Locator Utility—Through Meter Method 

Use this utility if you do not have accesses to an I/O module’s reset button; otherwise use 
the Query I/O function. The Through Meter Locator Utility searches each address in 
succession only at the baud rate at which the computer and the EPM Meter are connected. 

Note The Locator Utility—Stand Alone Locator method (section 11.16) allows you to search for 
an I/O’s address and baud rate without a EPM Meter by connecting the I/O directly to the 
computer. 

Connect the module to the EPM Meter at Port 4. 

Establish a connection between the computer and the EPM Meter. 
The baud rate at which the computer and the EPM Meter are 
connected is the baud rate that Locator will use to search for the 
I/O’s address. 

From the I/O Devices menu, select Locator Utility > Through EPM. 
The following screen appears: 

Set the Address range for the search. 
GE Communicator EXT will begin at the start address, searching 
every address up to and including the End Address. 
Set the Address range as small as possible to limit the time of the 
search. 

Click the Start button to begin the search.
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Device Locator lists any device it finds: 

Device Locator will continue to search for devices until it reaches 
the end of the specified criteria or until you click Stop. 

Click OK to return to the main GE Communicator EXT screen. 
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10.17 Locator Utility—Stand Alone Method 

The Stand Alone Locator utility searches for any I/O device connected directly to your 
computer (it is not for use with remote connections). The search criteria is a programmable 
range of baud rates and addresses. When a device is found, Locator displays its name, 
baud rate and address. 

To make a Stand Alone connection you will need the following: 

• RS-232 Cable 

• Unicom 2500 (or similar RS-232/RS-485 converter) 

• An RS-485 cable with power wires separated from communication wires; see 
diagram below. 

• A 15–20V DC at 50–200 mA power source for the I/O module, such as model PSIO; 
you may also use any port on a EPM 9450/9650 Meter as a power source. 

Wire the Unicom, I/O module and computer as shown:

Use an RS-232 cable to connect the RS232/485 Converter and your 
computer: 

• Set the Converter to operate at 57600 baud. 
• Set the Converter to DCE and HD. 
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Click on the GE Communicator EXT Connect icon on the tool bar, 
or select Connect > Quick Connect . 
The following screen appears: 

This screen displays your computer’s communications settings. 

Leave the Device Address field at 1. 

In the Baud Rate field enter 57600 (or the baud rate to which the 
RS-232/RS-485 converter is set). 

In the Serial Port field enter the computer’s communication port 
into which the RS-232 cable is inserted. 

Leave the Protocol field set at Modbus RTU. 

Click Connect . 
GE Communicator EXT will be unable to locate the device; after a 
few seconds a No Device Found At This Location dialogue box will 
appear. 

Click OK. 
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From the I/O Devices menu select Locator Utility > Stand Alone. 
The following screen appears: 

Set the Address and baud rate ranges for the search. 
GE Communicator EXT will begin at the start address and baud 
rate, searching every address up to and including the End Address; 
then it will begin the same address search at the next baud rate in 
the range. 

Note If you include ALL BAUD RATES, the Device Locator will take about 12 hours to complete the 
search. If you know the baud rate of the device (EPM Meters are normally 115200, I/O’s are 
57600), just look in that baud rate. The search will take minutes instead of hours. 
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Click Start . 
The Device Locator begins searching for devices within the 
specified baud rate and address range. 

The Device Locator will continue to search for devices until it reaches the end of the 
specified criteria or until you click Stop. 

Write down the address and baud rate. 

Click Exit to return to the main GE Communicator EXT screen. 
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10.18 Stand Alone Programmer 

The Stand Alone programmer allows you to configure all parameters of an I/O module or 
group of I/O modules by connecting the I/O(s) directly to the computer. 

Note If you plan to connect the module(s) to a EPM Meter in the future, you must still enter them 
in the External Devices section of the EPM Meter’s Device Profile. See section 11.7.

To use the Stand Alone Programmer, you will need the following: 

• RS-232 Cable 

• RS-232/RS-485 Converter 

• An RS-485 cable with power wires separated from communication wires; 
see diagram below. 

• A 15–20V DC at 50–200 mA power source for the I/O module, such as 
PSIO; you may also use any port on a EPM 9450/9650 Meter as a power 
source. 

Wire the RS232/485 Converter, I/O module(s) and computer as 
shown:

Use an RS-232 cable to connect the Unicom 2500 and your 
computer: 

Set the Converter to operate at 57600. 

Set the Converter to DCE and HD. 
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Click on the GE Communicator EXT Connect icon on the tool bar, 
or select Connect > Quick Connect . 
The following screen appears. 

This screen displays your computer’s communications settings. 

In the Device Address field, enter the current address of one of the 
I/O modules in the group. 
If you do not know the address, use the Stand Alone Locator utility 
(section 11.16). 

In the Baud Rate field, enter a baud rate that matches the baud 
rate of the I/O(s)—57600 recommended. 
If you do not know the baud rate, use the Stand Alone Locator 
utility (section 11.16). 

In the Serial Port field, enter the computer’s communication port 
into which the RS-232 cable is inserted. 

Leave the Protocol field set to Modbus RTU. 

Click Connect . 
GE Communicator EXT searches for a module at the specified baud 
rate and address. 

When it has located the I/O(s), the following screen appears (see NOTE below):

Note GE Communicator EXT will find a group of I/Os, if they have been added together on the 
Connection Manager screen. 

Click OK to to close the status screen. 
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From the I/O Devices menu, select Stand Alone Programmer. 
GE Communicator EXT retrieves the current settings from the 
specified I/O and displays them in the Module Programmer screen. 

The contents of this screen will vary, depending on the type of module in use. The 
example below shows the Digital Output Module Programmer screen. See sections 
11.8–11.12 for details on the specific programming functions of each module. 

Make changes to this screen according to the needs of your 
application. 

When you have finished configuring the address, baud rate and 
other programmable settings, click Send to send the new settings 
to the I/O module. 

If you have connected a group of I/O modules to the computer, 
click Retrieve. 

• At the prompt, enter the address of the next module you wish to 
program. 

• Click OK. 
GE Communicator EXT will retrieve the programmable settings of 
that device. 

When you have finished with all programming, click Exit . 
Be sure to enter any I/Os in the External Devices section of the 
meter’s Device Profile when you connect them. See section 11.7.
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11.1 Overview 
Note The use of the Password feature is recommended ONLY if there are security issues and 

ONLY if you have a secure place in which to save the password. If you have forgotten 
your meter password, you cannot call the factory for help. There is no “back door”. If you 
lose or forget your password, you must send the unit back to the factory to have the Flash 
RAM that stores the password replaced. 

If you are not using this meter for primary revenue metering or for protective functions, 
you do not need to put a password protection scheme in the unit. If you do, make sure you 
archive the meter location and associated passwords carefully! 

GE Communicator EXT’s password feature protects the following from unauthorized use: 

• Changes to an GE Meter’s Device Profile 

• Setting Meter Time 

• Resetting Meter Information (Max/Min/Demand, Hour Counters, Logs and Time-of-
Use) 

• Test Mode Entry from software 

• Flash Upgrades 

• Flicker Start and Stop 

• Pulse Test 

• CT and PT Compensation 

• Relay Control and I/O Utilities 

• Time-of-Use Accumulations and changes to the Time-of-Use calendar settings 

Password protection has two levels: 

• Level 1 accesses Time-of-Use Accumulations Only. These are billing functions. 

• Level 2 accesses all password-protected functions (listed above). The Level 2 
Password also allows a user to enable or disable the password function. 
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When the password feature is enabled, GE Communicator EXT will ask for the appropriate 
password each time a user attempts to perform a protected operation. 

The password feature is on a two-minute timer: after exiting from a password-protected 
area, the user has two minutes to access another protected area without re-entering the 
password. If more than two-minutes elapse, GE Communicator EXT will ask for the 
appropriate password. Use the Log On/Off feature (section 12.4) to renew password 
protection immediately. 
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11.2 Enabling Passwords 

From the Tools Menu select Passwords > Enable/Disable: 

Passwords may contain up to 10 characters and may include the digits 0–9 and/or the 
letters A–Z. Passwords are not case-sensitive. 

Enter a password for Level 1 and then retype it. 
The Level 1 password blocks a user access to the Poll Time-of-Use 
Registers screen only without a password. 

Note If you enter and retype only a Level 1 Password or Level 2 Password and click OK, the 
following screen will appear: 

You must enter passwords in both fields for the system to accept any password. 

Enter a password for Level 2 and then retype it. 
The Level 2 password blocks the user’s access to all password-
protected functions listed in section 12.1 without a password. Only 
the Level 2 password can disable the password feature. 3.
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 Click OK. 
A  screen appears: 

Click Yes. 
The Password Status screen appears: 

Click OK. 

Note The password function is now enabled. The computer status bar at the bottom of the 
screen will read PW: Enabled. See section 12.4 for how to disable passwords. 



CHAPTER 11: PASSWORDS PASSWORD STATUS

GE COMMUNICATOR EXT – INSTRUCTION MANUAL 11–5

11.3 Password Status 

To confirm if the password protection feature is enabled or disabled, do either of the 
following: 

From the Tools menu, select Passwords > Status. 
One of two screens will appear -- either the screen stating 
Password Protection Enabled or the screen stating Password 
Protection Disabled. 

Click OK. 

Check the computer status bar at the bottom of the screen. 
If passwords are enabled, it will read “PW: Enabled”. If passwords 
are disabled, it will read “PW: Disabled.” (Access the computer 
status bar from the View menu). 
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11.4 Disabling Passwords

To disable the password function, you must use the Level 2 password. 

From the Tools menu select Passwords > Enable/Disable 
Passwords. 
The following screen appears: 

Enter the Level 2 password and click OK. 

The password function is now disabled. The status bar at the bottom of your 
screen will now read: PW: Disabled. 
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11.5 Logging On and Off 

When passwords are enabled, you may Log On using either password level to gain access 
to protected areas. The two-minute timer described in section 12.1 will still run. Log Off to 
end your password session and renew password protection immediately (rather than wait 
for the two-minute timer to expire). 

Select Tools > Passwords > Enable/Disable Passwords (to enable 
passwords). 

Select Tools > Passwords > Log On. 

Enter a Level 1 or Level 2 password. 

Click OK. 

To Log Off, select Tools > Passwords > Log Off. 
The status screen returns to remind you that password protection 
is still enabled. 

Click OK. 
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11.6 Changing Passwords 

If you are going to use Passwords, it is a good idea to change them from time to time. 

From the Tools menu select Passwords > Change. 

Enter the password you would like to change in the Current 
Password field. 
You may enter either the Level 1 or the Level 2 password. 

Type the new password in the New Password field, then retype it 
below. 

Click OK. 
The following screen will appear: 

Click Yes. 

Note If you forget to type in a new password before you click OK in the Change Meter Password 
screen, the following screen will appear. The password has to have at least one character 
and not more than ten. 

Click OK. 

Type in new password then retype it.

Click OK. 

Click Yes. 

You now have a new password.
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12.1 Overview 

The Flash command allows you to upgrade the following firmware components: 

• GE Communication Processor (“GE Comm”).
This processing chip performs all tasks related to communication and storing data. 

• GE Digital Signal Processor (“GE DSP’). 
This processing chip performs all tasks related to data calculation. 

• LED Display. 
This processing chip is installed in the GE External LED Display. 

• Internal Modem Card. 
This optional card is installed in the meter and enables the meter to act as meter 
and modem in one device. This card must be upgraded in addition to upgrading 
the GE Comm and DSP. (Refer to section 13.5.) 

• Internal Network Option. 
This meter option allows a meter to communicate with multiple PC’s concurrently. 
This card must be upgraded in addition to upgrading the GE Comm and DSP. (Refer 
to section 13.6.) 

Note The new GE Unit button upgrades the GE Comm and GE DSP firmware files at the same 
time and provides the checksum automatically (see section 13.2). Again, the optional 
Internal Modem Card or Internal Network Card must be upgraded separately. 

There are 3 ways to learn what firmware versions are currently installed in your GE Meter: 

Click on the Device Status icon (or select Retrieve Device Status 
from the Tools Menu). 
The “Run-time” field shows the current EPM Comm firmware 
version number; the “DSP Run-time” field shows the current EPM 
DSP firmware version number. 
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Click on the Edit Profile icon to retrieve the current Device Profile 
from the connected GE Meter. 

• Click on Report . The GE Comm and GE DSP firmware are listed in 
the Runtime column. 

If you have an External Display connected to the meter, see the 
Meter Installation and Operation Manual for details on using it to 
access firmware version numbers.

Note • To flash upgrade, you must have the most recent upgrade file from the factory. 

• Flash upgrading erases the existing firmware and replaces it with the new version. 

• Flash Upgrading should only be done with the proper firmware. Otherwise, data may 
be lost! Back up your stored data prior to installing new flash programming into your 
unit. 
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12.2 Flash Upgrading the EPM Unit 

Contact GE to receive the most recent firmware upgrade. 
Be sure your version of GE Communicator EXT is compatible with 
the firmware upgrade you want to perform. 
You can download the latest software version through the internet 
site at: www.GEmultilin.com.  Click on the Free Downloads button. 

Copy the new firmware upgrade files to a directory on your 
computer. 
The GE Comm firmware upgrade is divided into two files. The DSP 
upgrade is a single file. 
The GE Unit button will upgrade all three files (GE Comm and GE 
DSP) at the same time. Generally, when you perform an update, 
update all firmware at the same time. 

Be sure to read the text file accompanying the firmware files for 
important information such as the Checksum Code. 
Write down the Checksum Code. 
If you are flashing “GE Comm Only” or “GE DSP Only”, you will need 
it later in the Flash upgrade process. 
Flash upgrading will fail if an incorrect Checksum Code is entered. 
If you are flashing using “GE Unit”, the checksum will be entered 
automatically. 

Note The Checksum Code consists only of the digits 0–9 and the letters A–F. The checksum will 
never contain the letters O or l, which are often confused for zeros and ones. 

Connect to the GE Meter: 

From the Tools Menu, select Flash Me. 
The following screen appears: (If you have not upgraded your 
software, you will not have a EPM Unit button). 
To Flash Upgrade GE Comm Only or GE DSP Only, see section 13.3. 
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Choose the type of upgrade you want to perform: GE Unit , GE 
Comm or GE DSP. 
See section 13.3 to Flash Upgrade GE Comm Only or GE DSP Only. 
See section 13.4 to Flash Upgrade the GE External Display, section 
13.5 to Flash Upgrade the Internal Modem Card and section 13.6 to 
Flash Upgrade the Internal Network Option. 

Click Next . 
The screen below appears: 

Note If your meter has the Internal Network Option, that option will appear instead of Internal 
Modem (see example above). Your meter cannot have both of those options. 

Click the Browse button beside File 1. 

Locate the firmware file on your computer. 
You will need only one file (*.ini file) for the GE Unit upgrade. File 
names and formats may vary from the example screen above. Be 
sure to read the text file accompanying the firmware files. 

Select the file.
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Click Open. 

When the files have been entered, click Next . 
The following screen appears:

.

If you are already connected to the GE Meter you want to upgrade, 
disregard this screen, click Next and skip to Click Start to begin 
the upgrade below.

If you are not connected to the GE Meter and/or you have a series 
of GE Meters to upgrade, this screen avoids the reloading of files.

In the Address field, enter the Address of the GE Meter to which 
your computer is connected that you want to 11Flash upgrade. 

In the Baud Rate field, enter the baud rate of the GE Meter port to 
which your computer is connected that you want to Flash upgrade. 

In the Serial Port field enter the computer’s comm port you are 
using. 

Click Next . 
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Note If you want to Flash upgrade using a modem, connect with a modem connection first; 
then, enter the Flash sequence mode. 

Click Start to begin the upgrade. 
A final  warning screen appears. 

Click Yes.

Flash upgrading begins. The following screen displays the progress of the upgrade: 

When the Flash upgrade is complete, the Cancel button changes to OK. 

Click OK. 

Note To upgrade additional GE Meters, click Previous and return to the Communications 
Parameters screen. Repeat the steps as needed, entering a unique address for each unit.
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12.3 Flash Upgrading the GE Comm and GE DSP Firmware 

Contact GE to receive the most recent GE firmware upgrade. 
Be sure your version of GE Communicator EXT software is 
compatible with the firmware upgrade you want to perform. 
You can download the latest software version through the internet 
site at: www.GEmultilin.com. Click on the Free Downloads button. 

Copy the new firmware upgrade files to a directory on your 
computer. 
The GE Comm upgrade is divided into two files. The DSP upgrade is 
a single file. The GE Unit upgrade will upgrade all three files (GE 
Comm files and GE DSP file) at the same time. Generally, when you 
perform an update, update all firmware at the same time. 

Be sure to read text file accompanying the firmware files for 
important information such as the checksum code. 
Write down the Checksum Code. If you are flashing “GE Comm 
Only” or “GE DSP Only”, you will need it later in the Flash upgrade 
process. 
Flash upgrading will fail if an incorrect checksum code is entered. 

Note The checksum code consists only of the digits 0–9 and the letters A–F. The checksum will 
never contain the letters O or l, which are often confused for zeros and ones. 

Connect to the GE Meter. 

From the Tools Menu, select Flash Me. 
The following screen appears: (If you have not upgraded your 
software, you will not have a GE Unit button). 

Choose the type of upgrade you want to perform: GE Comm or GE 
DSP. 
See section 13.2 for how to Flash upgrade the GE Unit. See section 
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13.4 to Flash Upgrade the GE External Display, section 13.5 to Flash 
Upgrade the Internal Modem Card and section 8.6 to Flash 
Upgrade the Internal Network Option. 

Click Next . 
The following screen appears: 

Click the Browse button beside File 1. 

Locate the firmware files on your computer. 
File names and formats may vary from the example screen above; 
be sure to read the text file accompanying the firmware files. 

Select the file and click Open. 

If you are upgrading GE Comm firmware, repeat the process for File 2. 

GE DSP firmware requires only one file. 
Two files are entered for a GE Comm upgrade. 
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When the files have been entered, click Next . 
The following screen appears: 

If you are already connected to the GE Meter you want to upgrade, 
disregard this screen, click Next and skip to Click Start to begin 
the upgrade below. 

If you are not connected to the GE Meter and/or you have a series of GE Meters to 
upgrade, this screen avoids the reloading of files. 

In the Address field, enter the Address of the GE Meter to which 
your computer is connected that you want to flash upgrade. 

In the Baud Rate field, enter the baud rate of the GE Meter port to 
which your computer is connected that you want to flash upgrade. 

In the Serial Port field enter the computer’s comm port you are 
using. 

Click Next . 
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Click Start to begin the upgrade.
A final  warning screen appears. 

Click Yes. 
This screen appears: 

Enter the checksum code from the text file accompanying the 
firmware files. 
If you do not enter the correct checksum code, the flash upgrade 
will fail. 

Click OK. 
Flash upgrading begins. 
The following screen displays the progress of the upgrade: 

When the Flash upgrade is complete, the Cancel button changes to OK. 

Click OK. 

Note To upgrade additional GE Meters, click Previous and return to Communications Parameters 
screen. Repeat the steps as needed, entering a unique address for each unit.
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12.4 Flash Upgrading the GE External Display 

Flash upgrading the GE Display takes approximately 15 minutes. 

Contact GE to receive the most recent GE External Display 
firmware upgrade. 
Be sure your version of GE Communicator EXT software is 
compatible with the firmware upgrade you want to perform. 

Copy the new firmware upgrade file to a directory on your 
computer. 
Be sure to read the accompanying text file for important 
information, such as the checksum code. 
Write down the Checksum Code; you will need it later in the Flash 
upgrade process. Flash upgrading will fail, if an incorrect checksum 
code is entered. 

Note The checksum code consists only of the digits 0–9 and the letters A–F. The checksum will 
never contain the letters O or l, which are often confused for zeros and ones. 

Make sure the External Display is connected to a GE Meter port 
operating at 9600 baud. See Chapter 3 for details on configuring 
the GE Meter’s communication ports. 

Connect to the GE Meter. 

From the Tools Menu, select Flash Me. 
The following screen appears:

Click the LED Display radio button. 
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Click Next . 
The following screen appears: 

The GE External Display firmware upgrade requires only one File. 

Click the Browse button beside File 1. 

Locate the GE External Display file on your computer. 
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Select the file and click Open. 
File names and formats may vary from the example screen above; 
be sure to read the text file accompanying the firmware files. 
The following screen appears: 

Click Next . 
The following screen appears: 

If you are already connected to the GE Meter, disregard this screen, 
click Next and skip to Click Start to begin the upgrade process 
below.

If you are not connected to the GE Meter: 

In the Address field, enter the Address of the GE Meter to which 
your computer is connected and that you want to flash upgrade. 
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In the Baud Rate field, enter the baud rate of the GE Meter port to 
which your computer is connected and that you want to flash 
upgrade. 

In the Serial Port field enter the computer’s comm port you are 
using. 

Click Next . 

Click Start to begin the upgrade process. 
A final warning screen appears.

Click Yes. 
The following screen appears: 

From the pull-down menus, select Through Meter and the port to 
which the External Display is connected.
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Click OK. 
In a moment the following screen appears: 

Enter the checksum code from the text file accompanying the 
firmware upgrade file. 
If you do not enter the correct checksum code, the flash upgrade 
will fail. 

Click OK. 
Flash upgrading begins. 
The following screen displays the progress of the upgrade:

When the Flash upgrade is complete, the Cancel button changes to OK. 

Click OK. 

Note To upgrade additional GE External Displays, click Previous and return to Communications 
Parameters screen. Repeat the steps as needed, entering a unique address for each unit. 
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12.5 Flash Upgrading the Internal Modem Card 

Contact GE to receive the most recent Internal Modem Option Flash 
firmware upgrade. 
This Flash Upgrade effects ONLY the Internal Modem Card within 
the meter. 
This Flash Upgrade DOES NOT UPGRADE THE GE UNIT. To upgrade 
the GE device, refer to sections 13.2, 13.3 and 13.4 of this manual. 
You can download the latest software version through our internet 
site at: www.GEmultilin.com.  Click on the Free Downloads button. 

Copy the new firmware upgrade file to a directory on your 
computer. 
The Internal Modem firmware upgrade is a single file. 

Be sure to read the text file accompanying the firmware files for 
important information such as the Checksum Code. 
Write down the Checksum Code. You will need to verify it later in 
the Flash Upgrade process. 

Note The Checksum Code consists only of the digits 0–9 and the letters A–F. The checksum will 
never contain the letters O or l, which are often confused for zeros and ones. 

Connect to the GE Meter. 

From the Tools Menu, select Flash Me. 

If the Password Feature is Enabled, the following Password screen appears: 

The Password is the number 2. 
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Enter 2 and click OK. 
The Internal Modem Flash Programmer screen appears. Enter 
Command Mode is highlighted. 

Click on Enter Command Mode. 
In the Status windows, the words “Entering Command Mode” and 
“Sending Escape Sequence” will appear. 
Then, “In Command Mode” appears on the screen. 

Click on Program Flash. 
The following screen appears: 
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Note In this example, the hex file is in a file on the desktop. The hex file may be stored anywhere 
in your system, on disk or CD. This screen browses your system to find the file. 

Locate the firmware file on your computer. 
You will need only one file (*.hex file) for the Internal Modem 
Upgrade. File names and formats may vary from the example 
screen above. 
Be sure to read the text accompanying the firmware files. 

Select the file name and click Open. 

The program automatically uploads the data. Lines 1 and 2 of the Status window display 
the progress of the upgrade. When the Flash Upgrade is complete, the Status window will 
say “Flash has been Programmed” and the Checksum verification window appears: 

Click Yes. 
If you click No, the Flash will fail. 

Click Exit to exit the program and return to the Main screen. 
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12.6 Flash Upgrading the Internal Network Option 

Flash upgrading the Internal Network (Ethernet) Option takes approximately 30 minutes. 

Contact GE to receive the most recent Internal Network (Ethernet) 
Option firmware upgrade. 
This Flash Upgrade effects ONLY the Internal Network Option 
within the meter. This Flash Upgrade DOES NOT UPGRADE THE GE 
UNIT. To upgrade the GE device, refer to sections 13.2, 13.3 and 
13.4 of this manual. 
You can download the latest software version through our internet 
site at: www.GEmultilin.com. Click on the Free Downloads button. 

Copy the new firmware upgrade file to a directory on your 
computer. 
The Internal Network firmware upgrade consists of two files - an 
.ini and a .hex file. 

Connect to the GE Meter. 

From the Tools Menu, select Flash Me. 
This screen appears: 

Click Internal Network and the Next button. 
If the Password Feature is Enabled, the following Password screen 
appears: 

Enter your Level 2 Password. 
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Click OK. 
The Internal Network Flash Programmer screen appears. 
Enter Command Mode is highlighted. 

Click on Enter Command Mode. 
After a moment “In Command Mode” appears on the screen. 

Click on Program Flash. 
The following screen appears: 

Note In this example, the *.ini file is in a file on the desktop. The *.ini file may be stored in your 
system, on disk or on CD. Use the “Look In:” window at the top of the screen to browse your 
system. 

Locate the firmware file on your computer. You will need two files (*.ini and .hex files) for 
the Internal Network Upgrade. Both files must be in the same directory. File names and 
formats may vary from the example screen above. Be sure to read the text accompanying 
the firmware files. 
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Select the file name and click Open. 
A  screen will appear. 

Click Yes. 
The program automatically uploads the data. Lines 2 and 3 of the 
Status window and the Status Bar below them display the progress 
of the upgrade. It will automatically retrieve the Checksum from 
the device. Again, flash uploading takes about 30 minutes.

When the Flash Upgrade is complete, the Status window will say 
“The Flash has been Programmed” as below. 

Click Exit to exit the program and return to the Main screen.
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Chapter 13: Energy Billing Module

GE Consumer & Industrial
Multilin

Energy Billing Module

13.1 Overview 

13.1.1 Managing Your Load Profile 
Your monthly electric bill is composed of your total energy usage (kWh) plus your 
maximum demand (kW) during the billing period. Maximum demand, (a.k.a. peak demand), 
can represent 30% to 60% of your total energy cost. Managing your load profile is the key 
to reducing your costs; reducing your peak demand, even without changing your total 
usage, lowers your costs. 

The optimal load profile would be flat, with minimum demand at constant usage. But, a 
flat load profile is not possible in industrial and commercial environments because of the 
variation and number of loads in the system. However, there are steps you can take to 
control those variations and ultimately reduce costs. The steps are listed below: 

• Collect historical and real time energy data. 

• Use graphical tools to calculate and analyze the data. 

• Control loads and shift the timing of demands. 

• Calculate savings and results. 

The Energy Billing Module detailed in this chapter gives you a tool to use with the EPM 
9450, 9650 and 9800 meters to collect data and analyze it . With a few clicks, you can 
collect historical and real time power usage data so that you can make changes necessary 
to reduce costs.
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FIGURE 13–1: Example Screen for the Energy Billing Module

The Energy Billing Module Graph Screen, as shown in the example screen above, displays a 
Demand Graph, a Graph Profile by Day and a Graph of kWh Usage by Day for the Date 
Range selected. 
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13.2 Basic Energy Management 

To understand how to manage your power usage, you must understand billing 
determinants and the terminology of energy management. Below are Basic Energy Terms 
followed by an Energy Management Example. 

13.2.1 Basic Energy Terms
 

Kilowatt hour (kWh) Measurement for energy equal to the amount of 
work done by 1,000 watts for one hour. 

Kilovolt-ampere-reactive hour 
(kVARh) 

Measurement similar to kWh that reflects current 
drawn by a customer that produces no useful work, 
but takes up space on the electrical distribution 
system. 

Megawatt-hour (MWh) 1,000 kWh. 

Energy (Active and Reactive) The total consumption that is measured in Kilowatt 
hours (kWh) and Kilovolt-ampere-reactive hours 
(kVARh). 

Interval Type An interval is composed of N subintervals 
(1<=N<=10). The data collected in the previous N 
subintervals is used in the demand calculation. 

Demand Rate at which electric energy is delivered to a 
system, usually expressed in kW or MW. There are 
two methods for calculating demand: (1) Block 
window and (2) Rolling (or sliding) window. 

Load Factor An indicator of the quality of the load profile (0 to 1) 
for a certain period in the electrical system. 

Block Demand Demand calculations performed over a fixed period 
(interval) of time. When that time period lapses, the 
next interval starts where the previous interval 
ended.

Rolling (Sliding) Demand 
Window

Demand calculations performed over a fixed period 
(interval) of time that is made up of (n) subintervals 
(n=>2). When one subinterval elapses, the demand 
value is computed by adding the most recently 
completed subinterval data to the demand interval 
and subtracting the oldest subinterval data from 
the demand interval.  
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Energy Management Example: 

A light manufacturer operates on two shifts. The typical electricity cost is about $150,000 
per year. Before the installation of any energy management equipment and software, the 
facility was paying, in a typical summer month, $12,000 for electricity. 

56,000 kWh (Off-Peak) - $2,400 

120,000 kWh (On-Peak) - $5,500 

480 kW (Peak Demand) - $4,100 

Total Bill  - $12,000 

Thermal Demand Emulation of a Thermal Demand Meter that 
provides an exponentially time-lagged demand 
where, given a constant load, the indication reads 
90% of the actual demand in 15 minutes. 

Power Factor An indicator of the quality of the power (-1 to +1) at 
a certain point in the electrical system. 

Time of Day or Time of Use Rates vary at different times of the day (on-peak 
and off-peak) for Energy and Demand. 

Off-Peak Designated periods of low system demand (usually 
non-business hours) when electricity is generally 
less expensive. 

On-Peak Designated periods of high system demand when 
electricity is generally more expensive. 

Shoulder Designated periods between off-peak and on-peak. 

Real Time Pricing The instantaneous pricing of electricity based on 
the cost of the electricity available for use at the 
time the electricity is demanded by the customer. 
Rates are downloaded over the phone or Internet. 
This is a customized plan. 

Aggregation The combined total energy use of customers/ units/ 
cost centers for billing purposes. 
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FIGURE 13–2: Energy Management Example - Before 

With the Energy Billing Module, plant management is able to optimize the loads. Essential 
loads are monitored and turned on or off in sequence. Simple steps are taken without 
jeopardizing the integrity of the manufacturing process. Savings in energy costs = 4% (see 
calculations above and below). 

56,000 kWh (Off-Peak) - $2,400 

120,000 kWh (On-Peak) - $5,500 

480 kW (Peak Demand) - $3,600 

Total Bill $11,500 

FIGURE 13–3: Energy Management Example - After 

Further savings can be realized by doing the following: 

• Shift non-essential loads to off-peak hours. 

• Flatten the demand curve wherever possible. 

• Identify equipment and process problems. 

• Negotiate with your utility based on peak demand.

• Source the best utility for your needs. 
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13.3 Cost Allocation 

In addition to the cost savings steps listed above, further steps can be taken using Cost 
Allocation. By submetering , one of your primary fixed costs, electricity, becomes a variable 
cost that can be accurately allocated. 

13.3.1 Cost Allocation Steps
• Determine cost centers. 

• Use submeters to monitor usage at each cost center. 

• Assign accountability and offer incentives for departments within a facility to 
reduce their own energy usage. 

• Determine equipment and system efficiency within cost centers. 

• Make sure Tenant Billing accurately reflects usage. 

13.3.2 Cost Allocation System
• One computer at primary facility. 

• A number of low cost, high quality meters to monitor usage at each cost center. • 
A simple network connecting the meters to the computer. 

• Energy Billing Module. 
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13.4 System Configuration 

The basic Energy Billing Module System consists of the following components: 

Hardware 

A dedicated Energy Billing Module PC or Laptop 

A Unicom RS-232/485 Converter 

At least one Energy Billing Module meter 

Software 

GE Communicator EXT Software (meter programming and communication) 

Energy Billing Module with MS-Excel Macros 

Note MS Excel (‘97 or later) must be installed in the computer 

13.4.1 Setup Requirements for EPM 9450, 9650 and 9800 
1. GE Communicator EXT Software 

2. GE Log Converter Software 

3. GE_Multilin_EBM.EBM-DB (template database file) 

4. EPM 9450, 9650 or 9800 Meter Log 2, logging interval greater than 0 seconds, 
less than and equal to 900 seconds and will have an integer number of 
records during a 15 minute period. 
Example: If Log 2 interval is set at x and 900 modulo with interval x is at 0, 
then setting is OK. 

5. EPM Meter Log 2, Log Block Window Avg Watt (Modbus Register 0A35-0A36). 

6. EPM Meter Block Window Avg interval set at 15 minutes. 

7. GE’s EBM Excel worksheet. 

13.4.2 Setup Requirements for EPM Series 7000 Meters 
1. GE Communicator Software 

2. GE Log Converter Software 

3. GE_Multilin_EBM.EBM-DB (template database file) 

4. Meter Historical Logging Interval greater than or equal to 60 seconds, less 
than and equal to 900 seconds and with an integer number of records during 
a 15 minute period. 
Example: If Log Interval is set at x, if 900 modulo with interval x is at 0, then the 
setting is OK. 

5. Meter Historical Log, Log Avg Watt. 
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6. Meter Avg Window Interval set at 900 seconds (15 minutes). 

7. GE’s EBM Excel worksheet. 

8. Must set Time Sync for Historical Logging. 

9. Firmware must support Time-stamped Record. 
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13.5 Operation Overview 

13.5.1 Creating a Demand Database
Click View > Options > Energy Billing Module and the screen 
below appears. 

Click Enable Energy Billing Module. (If the Enable Box is not 
checked, no data will be processed by EBM.) 
If the option is set, Log Converter will store the Avg Watt values 
from the log into the new Demand Database. 

The new database will carry the same file name as the regular meter database, 
except the file extension is EBM-DB. If the file does not exist, Log Converter will 
make a duplicate copy of the template database and rename it 
[Device_Name].EBM-DB. There should be no more than 96 records per day in the 
database. GE’s EBM Excel worksheet can be used to load and view the Demand 
Database. 

System Requirements: 

MS Excel ‘97, 2000 with SP3 or 2002 installed. 

Note The EBM Excel Spreadsheet File Location is C:\Program Files\GE Applications\ 
Communicator_Ext\Add-Ins\GE_Multilin_EBM.xls (shown below: View > Options - click 
on Energy Billing Module). 

Click Select for a different location. 

13.5.2 Using the Excel Spreadsheet 
1. On startup, the user must select a valid EBM database file or click the Load 

Database button to select a file. 

2. Under File > Properties > Summary, the EBM Excel Spreadsheet information 
will be displayed, including version number and release date. 
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13.6 Hardware and Software Installation and Setup 

Hardware Installation: 

The typical Hardware Installation for the Energy Billing Module System is an RS-485 loop. 
However, the network that connects the hardware can be simple or complicated. See 
Setup Requirements in Section 14.4. 

Software Installation: 

The software required for the system, GE Communicator EXT, enables the user to program 
the meter and to communicate to the computer. GE Communicator EXT software is 
installed in the meter at the factory. The Energy Billing Module is also installed at the 
factory. The user may only be required to update the software at some time in the future, 
when new features are added to the software. The initial installation is done for you. 

Note MS Excel ‘97, 2000 with SP3 or 2002 Software must be installed on your computer for the 
Energy Billing Module to work. 
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13.7 Using the Energy Billing Module 

The Energy Billing Module software is an MS-Excel based graphical user interface for 
viewing, tracking, comparing and analyzing real time electrical energy data. It is a 
productivity tool that provides the energy information you need so you can monitor and 
control your loads to reduce overall energy cost. 

The Energy Billing Module is a Visual Basic macro that runs inside MS Excel. The module 
contains three worksheets: 

• Demand Graphs 
Graphical presentations of demand and energy usage information. 

• Demand Statistics 
Statistical data and analysis on demand and energy. 

• Bill Verification 
Calculate and verify your electrical utility cost based on a utility rate structure. 

Start-up 

First, make sure that your meter is connected to the PC. 

To start the Energy Billing Module, simply go to the bottom left corner of your Windows 
main screen and click through the following: 

Start > Programs > GE Applications > Log Viewer  
The Log Viewer screen appears. 

Click $Bill button MS Excel will start automatically. 
A message box will appear to ask if you want to enable the macros. 

Click on Enable Macros. 
Your screen will display the Demand Graphs screen. 
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13.8 Demand Graphs 

First, make sure that the CAM Logger is running at the bottom of your screen. 

Available Energy Data will be shown above the Demand Graph, indicating the start and 
end dates of the data. If you just installed the system, “No Data Available” will appear in 
this section. 

Select Date Range 

To view the graphs, enter your start and end dates in the Start Date and End Date fields. 
Ranges are limited to days only. 

For example, if you want to view data from January 1, 2005 3:00pm to February 23, 2005 
6:00am, enter “1/1/2005” in the Start Date field and “2/24,2005” in End Date field. 

Note Make sure the dates are with the range of the Available Energy Data start and end dates. 
Otherwise, the graphs will not be correct. 

Select Parameters 

A list of Energy Billing Module meters will be displayed in the pull-down menu in this 
section. Select a meter from which you want to retrieve data.

Refresh Graph 

Click on Refresh Graph to start retrieving graphs for the dates and 
parameters selected. 

Note DO NOT click anywhere on the spreadsheet while the system is in Calculation Mode! 
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Demand Graph 

This graph shows the Demand History. Demand data is collected every 15 minutes from 
the Energy Billing Module meter. 

Profile by Day Graph (upper right) 

This graph shows the Daily Peak Demand for the period you selected. 

kWh Usage by Day Graph (lower right) 

This graph shows the Aggregated Daily Usage (kWh) for the period you selected. Generic 
load information is displayed at the bottom of the screen. 
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13.9 Demand Statistics 

The Demand Statistics screen displays statistical energy data for the time period you 
selected. 

Click the Demand Statistics tab in the Demand Graph screen. 
The Demand Statistics screen appears.

Select Parameters 

Enter a Start Date, End Date and Select a meter. 
Peak Time Range is your Utility Time Structure setup. 

Example: Your utility has the following setup: 

  On-Peak: 7:00am - 6:00pm. 

  Off-Peak: 6:00pm - 7:00am. 

To retrieve statistics for that setup: 

Select the following: 

Select On-Peak from 7:00 to 18:00 in Range 1 and N/A’s in Range 2. 

Since no Mid-Peak is given, select Mid-Peak from 6:00 to 6:00 in 
Range 1 and 18:00 to 18:00 in Range 2. 

Select Off-Peak from 18:00 to 0:00 in Range 1 and from 0:00 to 7:00 
in Range 2. 

Click on Refresh Data to get statistical results. 
Data will appear for each time period and for each day. 

Note DO NOT click anywhere on the spreadsheet while the system is in Calculation Mode! 
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13.10 Bill Verification 

The Bill Verification screen calculates and displays cost analysis results for a billing period 
you selected. 

Click the Bill Verification tab in the Demand Graph screen. 
The Bill Verification screen appears. 

Select Parameters 

In the Select Data Range field, enter a Start Date and an End Date. 

In the Select Parameters field, select a meter from which to 
calculate data. 

In the Peak Time Range fields, enter the peak time structure (or 
make changes). 

In the Rate Structure Table, enter your rate structure in the white 
spaces in the table. Leave a space empty if it does not apply. 
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Rate Structure Table 

This generic rate structure table is set up based on utility rates for small and medium 
industrial and commercial facilities. This model has charges for Distribution, Generation, 
Transmission and some miscellaneous items. It also allows 1 to 2 tiers in rate structure. 

Example of tiered rate structures: 

A company used 5,000 kWh with a 400 kW peak demand during a billing period. 

Single Tier Rate Structure: 

Utility charges a flat usage rate of 4 cents per kWh and a flat demand rate of 2 cents 
per kW. 

Double Tier Rate Structure: 

Utility charges a usage rate of 4 cents per kWh for the 1st 2000 kWh and a lower 
usage rate of 3 cents per kWh for the remaining 3000 kWh. Demand rate is 2 cents per 
kW for the 1st 300kW and 1 cent per kW for the remaining 100kW. 

Double check the data entered in the table and click on Calculate. 

Note DO NOT click anywhere on the spreadsheet while the system is in Calculation Mode! 
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13.11 Notes 

13.11.1 Excel 2002
The Excel Spreadsheet used in the EBM is designed for use with Excel ‘97. When using this 
module with Excel 2002, the first time a file is opened it takes several minutes for the file to 
be converted into the updated format. Save the file immediately after the load is 
completed. After the initial conversion, the file will open more quickly.

When using Excel 2000 with SP3 or 2002, check that a level of security is in place.  

Select Tools > Macro.

Click on Security. 

The following screen appears: 

Click Medium. 

Click OK. 

13.11.2 Trouble Shooting
If you are experiencing a problem executing this module, you may be missing the DAO 
component. To add the DAO component to your system, do the following: 

Click Tools > Macro > Visual Basic Editor. 
The Visual Basic Editor screen appears. 
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On the VB Editor Screen:

Click Tools > References > VBA Project . 
The following screen appears. 

Select the Microsoft DAO 3.6 Object Library (as highlighted). 
If 3.6 is not available, select the next highest below 3.6. 

Make sure only one DAO Library is selected.

Click File > Save before closing the Macros. 

Save the Excel spreadsheet before closing. 

Note If the user tries to open the EBM file saved in Excel 2002 using Excel ‘97, a conflict could 
occur. DO NOT ATTEMPT THIS! 
The File Format is not Backwards Compatible!
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Script & Scheduler Program

- Automated Data Retrieving and Processing - 

14.1 Overview 

GE Script & Scheduler software program serves as a stand-alone module for the GE 
Communicator EXT software package. The GE Script & Scheduler program is Automated 
Data Retrieving and Processing software which automatically retrieves data from GE 
Power Meters.

With this easy-to-use application, you can set up multiple scripts and schedules that 
command an GE device to automatically execute scheduled scripts, retrieve stored data 
files from installed devices and manage batch log conversions. The data retrieved and 
converted by the Scheduler, as well as other retrieved data, is in Access format and can be 
viewed in the device Log Viewer. 
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This is the main screen for the Scheduler. This one screen gives you an overview of the 
program by displaying the current active scripts and the current status and it provides the 
links to all the programming features in the sections at the bottom of the screen.  

There are two supporting programs: GE Communicator EXT software program and Log 
Converter program. After GE Communicator EXT finishes retrieving a log or finishes a 
script, the Log Converter program automatically translates the binary logged data into a 
database file (Access format). 

14.1.1 Features 
At the top of the screen, the Run/Stop button turns the Scheduler On and Off. To add 
scripts to the Scheduler or edit existing scripts, the Scheduler must be turned OFF. You 
can perform only one of the following tasks at a time; set up scripts, set up scheduler 
or run scheduler. 

Active Scripts window displays the scripts that are currently running on the Scheduler. 
Using the buttons at the bottom of the screen, those scripts can be edited or deleted 
and new scripts can be added. 

Current Status displays the Script & Scheduler operations. 

14.1.2 Using the GE Scheduler 
Access the GE Script & Scheduler program from Drive C:\ Program 
Files \ GE Applications \ GE Communicator \ Script & Scheduler. 

Click on it. 
The main screen (above) will appear. 

There are four sections at the bottom of the screen: Script, Scheduler, Status and the Help/
Exit section. The components in these sections enable the user to set up all the elements of 
the Script & Scheduler program and view the resulting logs. Step by step directions are 
given in the following sections and Help buttons are on each screen. 

Note To work on the Scheduler, the Scheduler must be stopped, by pressing the Run/Stop button 
at the top right of the Scheduler window.

• Set Up Script: 
Create a new script, open an existing script or delete a script (sections 14.3 - 14.5); 
Set up Script Devices and Script Commands with buttons on the Set Up Script 
screen. 

• Set Up Script Devices: 
Add, edit or delete script devices (sections 14.6 - 14.8) 

• Set Up Script Commands: 
Add, edit or delete script commands (sections 14.9 - 14.12); 

• Set Up Scheduler: 
Once a script is created, you must add it to the Scheduler. Add a script to the 
Scheduler, edit a script or delete a script from the Scheduler (sections 14.13 - 
14.15); 

• Status: 
View the Scheduler Log and clear Current status (section 14.16); 
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• Exit: 
Exit from the program (section 14.17). Help Files appear on each page. 

Appendix A lists the Component Files of the GE Script & Scheduler program with each file’s 
location in your system. 
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14.2 Operational Overview 

The user creates the scripts with the software, adding devices and commands, and sets up 
the Scheduler. Once this is accomplished, the Scheduler runs automatically, executing the 
script with the oldest scheduled run time first. 

When the script is run by the Scheduler, small windows appear on your PC to advise you 
that the script is running and data switch strings (if needed) and commands are being 
sent. A new scheduled run time is calculated. If the Frequency Type is “Once”, this script will 
be removed from the Scheduler immediately. Any failures to connect or complete 
commands will be noted in the Scheduler log (see Process Log below). A multiple page 
Script Report will be generated when a user selects a script from the list box and clicks the 
Report button. 

After GE Communicator EXT finishes the script, the Scheduler starts the Log Converter 
Manager to convert the binary logs to Microsoft Access format. The Scheduler 
automatically launches the Log Converter program which converts the log files one at a 
time to a database file after a download has succeeded. 

After the Log Converter Manager finishes its conversion, the Scheduler can resume its 
process and run the next script with the oldest run time. If there are no files to convert, the 
screen will appear as above. 

Note Log Converter: The log converter’s purpose is to convert the binary data accumulated 
from the GE device into the ODBC compliant (Access) database for later retrieval. This is 
done automatically within the software.

Note Devices: The GE Script & Scheduler can be used with many GE devices, including EPM9450/
9650, EPM9800 and Series 7000 meters. The Scheduler Log can be viewed by clicking View 
Log on the main Scheduler screen. The script logs produced by the Scheduler can be found 
in Drive:\ Program Files\ GE \ Communicator\ Retrieve\ Logs. The files produced by the 
Log Converter program can be accessed in Drive:\ Program Files\ GE \ Communicator 
EXT in a default subdirectory. 

GE Script and Scheduler has a new Process Log, which is in HTML format and carries the 
.HTML extension. The Process Log consists of three top level files that work together to 
signal an error and provide links to detailed script logs and detailed log converter logs. 
Following are the files that make up the Process Log: 

EPMSchedulerLog - Main.Html: Software generated top layer file with frame set 
linked to EPMSchedulerLog - Detail.Html and EPMSchedulerRun-TimeLog.Html. 

EPMSchedulerLog - Detail.Html: Software generated blank frame file. 

EPMSchedulerRun - TimeLog.Html: Software generated schedule process log with 
hypertext link to detailed script logs and detailed Log Converter logs.

If any type of error occurs during the execution of a scheduled script, EPMSchedulerRun-
Time Log.Html will have an entry in red with the appropriate hypertext link to its detailed 
logs. The Reset Alarm button will also create a visual alarm (red background color) and a 
continuous beep (until the user clears it), if an error occurs. To clear the contents of a 
current EPMSchedulerRun-TimeLog.Html file, the user deletes that file from its location. 
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Note It is strongly recommended that the user back up that file before deleting it . 

For a list of all the component files... 

of the GE Script & Scheduler Program and their default locations, see Appendix A. 

Default locations can be changed... 

but, you must also change the associated programs so they know where to find the files. 

To change default locations: 

GE Communicator EXT: View > Options 

Scheduler Auto Run and Hide on Windows Start-up: 

The Scheduler runs automatically whenever Windows starts up, if desired. The program 
will hide the main screen and add an icon to the system tray (lower right hand corner of 
your screen) and will run unattended. To open the main screen, click on the icon in the 
system tray. The following are the procedures to set up Auto Run and/or Hide: 

Create a shortcut for this program and place it in the Windows 
Startup folder. 

Add the following to the command line: /auto /hide. 
After the Windows operating system has restarted, this program 
will automatically start. 
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14.3 Scripts 

This application will enable you to set up as many as 300 independent scripts. Each script 
tells the software to make a connection to a particular GE device and retrieve data from 
that device. By making selections from the windows on the script screens, you can easily 
create scripts that automatically retrieve the data you need. This screen is a window to the 
other script screens. 

Note Each single script can be used to retrieve data from multiple GE meters. You need to assign 
one script for each telephone number. 

The pull-down menu lists all the scripts that have been created and are currently in use 
with the number the Scheduler assigns to it . If you currently have no scripts, a screen will 
appear that shows “New Script 1” in the window. “#” is not a valid character for a script 
name. 

Stop the Scheduler by clicking the Run/Stop button at the top right 
side of the Scheduler window.

Press the Scripts button on the Scheduler window.

To create a new script, click New. 
The Set Up Script screen will appear (see section 14.5). 
After the new script is created, Scheduler will add it to the pull-
down menu. 

To edit an existing script, use the pull-down menu to select a script.

• Click on the script name. 
• Click Open. 

The Set Up Script screen will appear (see section 14.5). 
• Make desired changes. 

To delete an existing script, use the pull-down menu to select a 
script. 

• Click on the script name. 
• Click Delete. 

A window will appear which asks, "Are you sure you want to 
delete this script?"

•  Click Yes or No. 

To exit either screen and return to the main screen, click Close. 

To generate a multiple page Script Report, select a script from the 
pull-down menu.
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Click the Report button. 
An example of a Script Report appears in the next section.  
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14.4 Script Report

The Script Report provides a detail of a particular script. For scripts that have many devices 
and/or many commands, the report may be quite lengthy. 

14.4.1 Features 
• Print: To print all or part of the report, type the page numbers and click 

on Print . 

• Save: To save the report to a particular file, click on Save. 

• Cancel: To exit the report and return to the main screen, click Cancel. 

• Scroll Bar: To move from page to page in the report, click the Back or 
Forward Arrows. 

• Zoom: Use the pull-down menu to select from a variety of 
magnifications (from Thumbnail to 400%). The screen capture above 
shows a Zoom of 100%. 
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14.5 Set Up a Script 

In the Script Name window, type in a name for the script. 
Each script must have a unique name. If the script is not named, a 
default name is assigned by the software. Most users assign the 
name of the substation where the device is located as the name. (# 
is not a valid character for a script.) 

To select a Connection Type, use the pull-down menu to select 
either Remote - Dial Up or Direct - Single COM Port . 
The Script Connection Properties are disabled until you enter this 
selection. If the Connection Type is not set, GE Communicator EXT 
program will treat it as an empty script. 

From the pull-down menu, select the Number of Retries (the 
number of times the software will try to connect) from 0 to 5. 
In some situations, connecting lines are shared by other programs 
or telephones. The retries enable the software to try to connect 
more than once (over a period of a few seconds). If the retries fail, 
the log will automatically note the date, time and script name for 
which the connection was not completed. The script will fail. 

Connection Type: Direct - Single COM Port

Using the pull-down menus, enter the following selections: 

• Comm Port - Select from Com 1 to Com 99. (See note below). 
• Baud Rate - Select 1200, 2400, 4800, 9600, 19200, 38400, 57600 

or 115200. 
• Flow Control - Select None or Hardware. 
• Data Bits - Select 7 or 8. 
• Parity - Select None, Even or Odd. 

Connection Type: Remote - Dial Up 

Two additional screens will appear. 
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Enter the following selections: 

• Phone Number - Type in Phone Number. 
• Setup String - Type in Data Strings, if needed. 

New Connection Type: Ethernet. 

To add, edit or delete devices: 

Click Devices button. 

To add, edit or delete commands: 

Cick Commands button. 

To exit the screen and return to the main screen:

Click Close.

Note Choosing a port: The script opens and closes a PC communication port, creates a log and 
creates a database for the script. When you run the Scheduler, if the port your script is 
using is already open (i.e. being used by a different program), the script's command will fail. 
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14.6 Devices 

This screen lists the current devices for a particular script. Columns shown include: the 
device’s number or identification, the device’s unique address, the device type and the 
device’s unique name. 

• You can enter up to 256 devices for each script. The Add, Edit and Delete buttons 
on this screen facilitate the adding of new devices and the editing and deleting of 
current devices.

• You must set up an address, protocol, device type and a unique name for each 
device. Optional settings for each device are passwords for an EPM9450, 9650 or 
9800 device. When GE Communicator EXT retrieves a log from a device and it does 
not have a predefined name, it will use the device name assigned here as the file 
name for the retrieved log file. If you already named your device, you do not have 
to assign it a name in this section. We recommend that you keep both names the 
same. 

• To add a device 

Click Add. 
The Edit Script Device screen will appear.

• To edit a device 

Select a device from the list by clicking on it. 

Click Edit . 
The Edit Script Device screen will appear. 

• To delete a device

Select a device from the list by clicking on it. 

Click Delete. 
A window will appear that asks, "Are you sure you want to delete 
this device?" 

Click Yes or No. 

• If you Click Edit or Delete before you select a device, a window will appear that 
says, "Please select a device." 

Click OK. 
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Select a device and follow the above steps. 

Click Close to return to the Set Up Script screen. 
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14.7 Adding a Script Device 

This screen facilitates the adding of new devices to a particular script. You can enter up to 
256 devices for each script. For editing of devices, see section 14.8.

You must set up an address, protocol, device type and a unique name for each device. 
Optional settings for each device are passwords for an EPM 9450, 9650 or 9800. When GE 
Communicator EXT retrieves a log from a device and it does not have a predefined name, it 
will use the device name assigned here as the file name for the retrieved log. If you have a 
name already designated in the device, the device name shown here will not be used. 
Note: The EPM7000 Series meters will use the name shown here. 

Add an EPM 9450, 9650 or 9800 

Type in a unique Device Name. 

Under Device Information, type in a unique Address. 

To select a protocol, use the pull-down menu. Select Modbus RTU, 
Modbus ASCII or Modbus TCP EI Protocol. 

To select a Type (of device), use the pull-down menu.

Click your selection. 

Add Level 1 Password and/or Level 2 Password, if desired. (Not 
required.) 
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Note The device you choose will determine what data is required for this screen. When you add 
a device, passwords are not required. Also, Data Switch Strings will probably not be 
necesssary. Data Switch Strings tell GE Communicator EXT how to connect to and 
disconnect when a data switch is present. It already knows how to connect to a single 
device. 

You must set up an address, protocol, device type and a unique name for each device. 
Optional settings for each device are passwords for an EPM 9450, 9650 or 9800. When GE 
Communicator EXT retrieves a log from a device and it does not have a predefined name, it 
will use the device name assigned here as the file name for the retrieved log. 

Add Multiple Devices 

Type in a unique Device Name. 

Under Device Information, type in a unique Address. 

To select a protocol, use the pull-down menu. 
Select Modbus RTU or Modbus ASCII. 

To select a Type (of device), use the pull-down menu. 

Click your selection. 

Add Level 1 Password and/or Level 2 Password, if desired. (Not 
required.) 

Click OK or Cancel to return to the Devices for Scripts screen. 
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14.8 Editing a Script Device 

Select a device that you would like to edit, by clicking on it. 
The Edit Script Device screen will appear. 
If you click Edit before you select a device, a window will appear 
that reminds you to “Please select a device.” 

Using the windows available, select or deselect the item(s) you 
would like to change. 

Edit the items. 

Click OK. 
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14.9 Script Commands 

This screen lists all the current commands for a particular script. You can enter up to 1000 
commands for each script and each command is assigned to a selected device for that 
script. Each device is listed by Index Number, Type, Name and Address and the Command 
Description follows the device information. 

You cannot set up multiple retrieve commands for a single device. But, you can have up to 
256 devices for each script.

The sequence of the commands listed on the screen must be valid. To move a command 
record to a different sequence, 

Click on the command.

Click the Up or Down buttons to move it. 
The new sequence will be saved to the database when the window 
is closed. 

Note If the sequence is not correct, you may clear the device’s log before retrieving it . 

To add a command, click Add. 
The Edit Script Command screen will appear. 

To edit a command, select a command by clicking on it. 

Click Edit . 
The Edit Script Command screen will appear. 

To delete a command, select a command by clicking on it. 

Click Delete. 
A  window will appear which asks, "Are you sure you want to delete 
this command?" 

Click Yes or No. 

To exit the screen, click Close. 
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14.10 Add a Script Command 

This screen enables you to add or edit a script command. This section will discuss adding a 
script, Section 14.11 will discuss editing a script command. 

14.10.1 Add a script command 
Use the pull-down menu to select a Device. 
The device you choose in this window will determine the choices 
available for the other screens: 

Use the pull-down menu to select the Number of Retries (from 0 to 
5). 
This is the number of times the software will attempt to connect. 

Use the pull-down menu to select a Primary Command. 

Type in or click to select the Secondary Command(s). 
When you add a Device, the Primary Command will be "Retrieve" 
and the Secondary Commands will be a selection of logs.

Click OK. 

14.10.2 Add an EPM 7000 Series Device script command 
If you have an EPM 7000 Series Device connected to the GE Script & Scheduler, the above 
screen will appear slightly different. The process is the same as for an EPM 9450, 9650 and 
9800. 



14–18 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

EDIT A SCRIPT COMMAND CHAPTER 14: SCRIPT & SCHEDULER PROGRAM

14.11 Edit a Script Command 

Select a command that you would like to edit, by clicking on it.
 If you click the Edit button before you select a command to edit, a 
window will appear to remind you to select a command. 

Click OK. 

Select a command. 

Click Edit . 
The command you choose will determine the screen that appears. 

14.11.1 Edit an Advanced script command 
If you selected an EPM 9450, 9650 or 9800 script command to edit, the following window 
will appear:  

When you edit an advanced device, the Primary Command will be Retrieve and the 
Secondary Commands will be a selection of logs. 

Using the windows available, select or deselect the item(s) you 
would like to change. 

Make the change(s). 

Click OK. 
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14.11.2 Editing a Data Switch or System Device command 
If you select a Data Switch or System Device Command to edit, the following screen will 
appear: 

If you edit a Data Switch or System Device Command, the Primary Command will be "Send 
Switch String" and the Secondary Commands will request a System Data Switch String. A 
tool-tip screen will display special characters to be used in the Data Switch Strings: “&” = 
line feed, “|” = carriage return. Select or deselect to make changes. Click OK. 

14.11.3 Editing a EPM+ Device command 
If you have an EPM7000 Series meter connected to the GE Script & Scheduler, the above 
screen will appear slightly different. The editing process is the same as for an EPM 9450, 
9650 or 9800 device. 
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14.12 Delete a Script Command 

Select a command you would like to delete by clicking on it. 

Click the Delete button. 
A  window will appear. 

Click Yes or No.

Click Close to return to the main script screen. 
A nother warning window will appear. 

Click Yes or No to return to the Set Up Script screen. 

Click Close to return to the main Scheduler screen. 
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14.13 Add Scripts to the Scheduler 

Once you have created the scripts, they have to be added to the Scheduler. From there, the 
Scheduler sends the scripts to GE Communicator EXT to be executed. It is at this stage that 
you set the time and interval for the automatic data retrieval. 

First, Stop the Scheduler. 

On the main Scheduler screen, click Add Script in the Scheduler 
section of the screen. 
The following screen will appear: 

To add a script to the Scheduler, select an Available Script from 
the pull-down menu. 
By changing the Frequency, you can create additional versions of 
the script and add the updated version(s) to the Scheduler. 



14–22 GE COMMUNICATOR EXT – INSTRUCTION MANUAL

ADD SCRIPTS TO THE SCHEDULER CHAPTER 14: SCRIPT & SCHEDULER PROGRAM

In the Schedule section of the screen, use the pull-down menu to 
select the desired Frequency. 
Select from: Yearly, Once, Interval, Daily, Weekly, Monthly by Date, 
Monthly by Day or Last Day of the Month. 

Based on the desired frequency, the screen will change to offer the following 
selections: Month, Date, Day and/or Time (if appropriate). 

For example: 

Use the pull-down menus to make selections. 

Type in desired time. 

Click OK to add to the Scheduler. Or, click Cancel. 
If you click OK, the new scripts will immediately be added to the 
Scheduler and you will return to the main Scheduler screen. 

Repeat steps to add additional scripts to the Scheduler. 
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14.14 Edit Scheduler Scripts 

To edit a script currently running on the Scheduler, 

Stop the Scheduler. 

Select a script from the Active Scripts window. 

Click Edit Script . 
One of the Add/Edit Script to Scheduler screens will appear; the 
one that is appropriate for the Frequency of the selected script. 
(Refer to section 14.13 to see a sampling of Add/Edit Script to 
Scheduler screens.) 

Below is a screen for the selected script in the illustration above: 
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To change the frequency, click the pull-down menu for Frequency 
and make a selection. 
If you change the frequency, the screen will change to offer the 
appropriate selections (Refer to section 14.13 to see a sampling of 
Add/Edit Script to Scheduler screens).

Using the available pull-down menus, make selection(s).

Type in the time, if you want it to change. 

Click OK to add to the Scheduler. Or, click Cancel. 
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14.15 Delete Scheduler Scripts 

To delete a script that is currently running on the Scheduler, 

Stop the Scheduler. 

Select a script from the Active Scripts window by clicking on it. 

Click Delete Script . 
A warning window will appear: 

Click Yes.
The script will be deleted immediately from the Active Scripts 
window and you will return to the main Scheduler screen. 
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14.16 Status 

The Current Status window on the Scheduler screen displays entries in the EPM Scheduler 
Log. It shows the date, time in minutes and seconds and the status or action performed. 
The EPM Scheduler Log records all the activities for the GE Script & Scheduler program. 

To view the entire Scheduler Log, click the View Log button. 
The Scheduler Run-Time Status Log screen will appear: 

Scroll down to find a particular date, time or action. 

To clear the Current Status window, click the Clear Status button. 
The screen will be cleared as follows: 
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Note Individual logs for each script can be found by the name of the script in Drive C:\ Program 
Files \ GE Applications \ Communicator EXT \ Script Logs. 
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14.17 Exit 

The best way to Exit the GE Script & Scheduler software program is to click the Exit button 
on the main Scheduler screen. 

First, you must Stop the Scheduler.

If you are on a screen other than the main Scheduler screen, click 
the Close button until you return to the main Scheduler screen. 

Click Close. 

Click Exit . 
A  window will appear. 

Click Yes to Exit. Click No to remain on the screen. 

Note You can also Minimize the program, if you want the Scheduler to continue to run but not 
appear on your PC, by clicking the Minimize button in the upper right hand corner of the 
screen. The icon will appear at the bottom of your screen. To restore the Scheduler to view 
on your screen, click the icon at the bottom of your screen.
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GE Communicator EXT

Chapter 15: Flicker

GE Consumer & Industrial
Multilin

Flicker

15.1 Overview 

Flicker is the sensation that is experienced by the human visual system when it is 
subjected to changes occurring in the illumination intensity of light sources. The primary 
effects of flicker are headaches, irritability and sometimes epilepsy. 

IEC 61000-4-15 and former IEC 868 describe the methods used to determine flicker 
severity. This phenomenon is strictly related to the sensitivity and the reaction of 
individuals. It can only be studied on a statistical basis by setting up suitable experiments 
among people. 
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15.2 Theory of Operation 

Flicker can be caused by voltage variations which are caused by variable loads, such as 
arc furnaces, laser printers and microwave ovens. In order to model the eye brain change, 
which is a complex physiological process, the signal from the power network has to be 
processed while conforming with Figure 16.1 below. 

• Block 1 consists of scaling circuitry and an automatic gain control function that 
normalizes input voltages to Blocks 2, 3 and 4. For the specified 50 Hz operation, 
the voltage standard is 230 V RMS. 

• Block 2 recovers the voltage fluctuation by squaring the input voltage scaled to 
the reference level. This simulates the behavior of a lamp. 

• Block 3 is composed of a cascade of two filters and a measuring range selector. In 
this implementation, a log classifier covers the full scale in use so the gain 
selection is automatic and not shown here. The first filter eliminates the DC 
component and the double mains frequency components of the demodulated 
output. 
The configuration consists of a .05 Hz Low High Pass filter and a 6 Pole 
Butterworth Low Pass filter located at 35 Hz. The second filter is a weighting filter 
that simulates the response of the human visual system to sinusoidal voltage 
fluctuations of a coiled filament, gas-filled lamp (60 W - 230 V). The filter 
implementation of this function is as specified in IEC 61000-4-15. 

• Block 4 is composed of a squaring multiplier and a Low Pass filter. The Human 
Flicker Sensation via lamp, eye and brain is simulated by the combined non-linear 
response of Blocks 2, 3 and 4. 

• Block 5 performs an online statistical cumulative probability analysis of the flicker 
level. Block 5 allows direct calculation of the evaluation parameters Pst and Plt. 

Flicker Evaluation occurs in the following forms: Instantaneous, Short Term or Long Term. 
Each form is detailed below: 

15.2.1 Instantaneous Flicker Evaluation
An output of 1.00 from Block 4 corresponds to the Reference Human Flicker Perceptibility 
Threshold for 50% of the population. This value is measured in Perceptibility Units (PU) and 
is labeled Pinst. This is a real time value and it is continuously updated. 

15.2.2 Short-Term Flicker Evaluation
An output of 1.00 from Block 5 (corresponding to the Pst value) corresponds to the 
conventional threshold of irritability per IEC 1000-3-3. In order to evaluate flicker severity, 
two parameters have been defined: one for the short term called Pst (defined in this 
section) and one for the long term called Plt (defined in the next section). 

The standard measurement time for Pst is 10 minutes. Pst is derived from the time at level 
statistics obtained from the level classifier in Block 5 of the flicker meter. The following 
formula is used: 
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 (EQ 15.1)

Where the percentiles P(0.1), P(1), P(3), P(10), P(50) are the flicker levels exceeded for 0.1, 1, 2, 
20 and 50% of the time during the observation period. The suffix S in the formula indicates 
that the smoothed value should be used. The smoothed values are obtained using the 
following formulas: 

P(1s) = (P(.7) + P(1) + P(1.5))/3  (EQ 15.2)

P(3s) = (P(2.2) + P(3) + P(4))/3  (EQ 15.3)

P(10s) = (P(6) + P(8) + P(10) + P(13) + P(17))/5  (EQ 15.4)

P(50s) = (P(30) + P(50) + P(80))/3  (EQ 15.5)

The .3-second memory time constant in the flicker meter ensures that P(0.1) cannot 
change abruptly and no smoothing is needed for this percentile. 

15.2.3 Long-Term Flicker Evaluation
The 10-minute period on which the short-term flicker severity is based is suitable for short 
duty cycle disturbances. For flicker sources with long and variable duty cycles (e.g. arc 
furnaces) it is necessary to provide criteria for long-term assessment. For this purpose, the 
long-term Plt is derived from the short-term values over an appropriate period. By 
definition, this is 12 short-term values of 10 minutes each over a period of 2 hours. The 
following formula is used: 

 (EQ 15.6)

Where Psti (i = 1, 2, 3, ...) are consecutive readings of the short-term severity Pst. 

Summary 

Flicker = Changes in the illumination of light sources due to cyclical voltage variations. 

Pinst  =  Instantaneous flicker values in Perceptibility Units (PU). 

Pst  =  Value based on 10-minute analysis. 

Plt  =  Value based on 12 Pst values. 

Measurement Procedure 

1. Original Signal with amplitude variations. 

2. Square demodulator. 

3. Weighted filter. 

4. Low pass filter 1st order. 

5. Statistical computing. 

Pst 0.0314P0.1 0.0525P1s 0.0657P3s 0.28P10s 0.08P50s+ + + +( )=

Plt

Σ
i 1=

N

N
----------------

Psti3
3

=
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Data available 

Pst, Pst Max, Pst Min values for long term recording 
Plt , Plt Max, Plt Min values for long term recording Figure 16.1: Simulation of Eye Brain 
Response 
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15.3 Setup 

Initially the user must set up several parameters to properly configure Flicker. 

Using GE Communicator EXT, from the Icon Menu select Profile.

From the Device Profile screen, open +/- Power Quality and Alarm 
Settings, then select  EN 50160 Flicker. 
The following screen will appear: 

Select a Pst time range from 1 to 10 minutes. 
The standard measurement period is nominally 10 minutes. 

Select a Plt time range from 1 to 240 minutes. 
The standard measurement is nominally 12 Pst periods (120 
minutes). Plt time must always be equal to or great than and a 
multiple of Pst time. This is reflected in the selections available to 
the user. 

Select the frequency of operation. 
50 Hz is the approved frequency according to Flicker standards. A 
60 Hz implementation is available and can be selected. This 
implementation is the proposed 60 Hz standard that is still in the 
approval process. 
Remember the voltage is normalized. For 50 Hz, the normalized 
voltage is 230 V and for 60 Hz, the normalized voltage is 120 V. 

Press OK when you are finished. 

Press Help for more information on this topic. 
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15.4 Software - User Interface 

Main screen 

From the GE Communicator EXT Icon Menu select Real Time Poll > 
Power Quality and Alarms > Flicker. 
The following screen appears:

This section describes the Main Screen functions. The available values (Instantaneous, 
Short Term, Long Term) will be described below. 

Time 

• Start/Reset is the time when Flicker was started or reset. A Reset of Flicker causes 
the Max/Min values to be cleared and restarts the Flicker Pst and Plt timers. A Start 
of Flicker is also equivalent to a Reset in that the Pst and Plt are restarted and the 
Max/Min Values are cleared. 

• Stop corresponds to the time when Flicker is turned off. 

• Current is the current clock time. 

• Next Pst is the countdown time to when the next Pst value is available. 

• Next Plt is the countdown time to when the next Plt value is available. 

Status

• Indicates the current status. Active = On. Stopped = Off. 

Frequency 

• Base is the current operating frequency selected by the user (50 or 60 Hz). 

• Current is the real time frequency measurement of the applied voltage. 
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• Base Voltage is the normalized voltage for the selected frequency (230 V for 50 Hz 
or 120 V for 60 Hz). 

Flicker Monitoring 

Click on Stop to cause Flicker to stop being processed and freeze 
all the current values. 
Stop Time is recorded and clears the current Max/Min Values 

Click on Start to start Flicker processing. 
Start Time is recorded. 

Click on Reset to cause the Max/Min values to be cleared and 
restart the Flicker Pst and Plt timers. 

Click OK to exit the Flicker screen. 

Click Help for more information on this topic. 

Instantaneous Readings 

Refer to the Instantaneous section of the Main screen above. 

If you are on the Short or Long Term screens, click on the 
Instantaneous tab to display the Instantaneous screen. 
The PU values, Pinst for Voltage Inputs Va, Vb and Vc are displayed 
here and are continuously updated. The corresponding Current 
Voltage values for each channel are displayed for reference. 

Short Term Readings 

Click on the Short Term tab to access the screen containing three 
groups of Pst readings. 

Pst Readings Displayed 

• Current Pst values for Va, Vb and Vc and the time of computation. 

• Current Pst Max values for Va, Vb and Vc since the last reset and the time of the last 
reset. 
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• Current Pst Min values for Va, Vb and Vc since the last reset and the time of the last 
reset. 
The following screen is displayed: 

Long Term Readings 

Click on the Long Term tab to access the Plt readings. 
The screen below displays three groups of Plt values. 

Plt Readings Displayed 

• Current Plt values for Va, Vb and Vc and the time of computation. 

• Current Plt Max values for Va, Vb and Vc since the last reset and the time of the last 
reset. 



CHAPTER 15: FLICKER SOFTWARE - USER INTERFACE

GE COMMUNICATOR EXT – INSTRUCTION MANUAL 15–9

• Current Plt Min values for Va, Vb and Vc since the last reset and the time of the last 
reset. 
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15.5 Logging 

The EPM 9450, 9650 and 9800 meters are capable of logging Flicker values in an 
independent log. When Flicker is on, entries are made into the log in accordance with the 
times that associated values occur. Pst, Pst Max, Pst Min, Plt , Plt Max, Plt Min, Start/Reset and 
Stop times are all recorded. All values can be downloaded to the Log Viewer where they 
are available for graphing or export to another program, such as Excel. 

All Flicker values are predefined and cannot be changed. 
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15.6 Polling 

The Pinst , Pst , Pst Max, Pst Min, Plt , Plt Max, Plt Min values are all capable of being polled 
through the Communications Port. Refer to the appropriate Modbus and DNP Mappings 
for register assignments and data definitions. 
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15.7 Log Viewer

From the GE Communicator EXT Log Viewer screen, using the 
menus at the top of the Log Viewer screen, select a meter, time 
ranges and values to access. 

Select Flicker. 

The values and the associated time stamps (when the values occurred) are displayed in a 
grid box. Use the buttons at the bottom of the screen to create a graph or export the data 
to another program. Max and Min values are only displayed; they cannot be graphed. But, 
Max and Min values are available for export. 

Graphed values include Pst and Plt Va, Vb and Vc. 

Displayed values include Pst and Plt Max and Min for Va, Vb and Vc.  
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15.8 Performance Notes 

Pst and Plt average time are synchronized to the clock (e.g. for a 10 minute average, the 
times will occur at 0, 10, 20, etc.). The actual time of the first average can be less than the 
selected period to allow for initial clock synchronization. 

If the wrong frequency is chosen (e.g. 50Hz selection for a system operating at 60Hz), 
Flicker will still operate but the values computed will not be valid. Select carefully. 

User settings are stored. If Flicker is on and power is removed from the meter, Flicker will 
still be on when power returns. This can cause data gaps in the logged data. 

The Max and Min values are stored and are not lost if the unit is powered down. 

Flicker meets the requirements of IEC 61000-4-15 and former IEC 868. Refer to those 
specifications for more details, if needed. 

Operation is at 230V for 50Hz and 120V for 60Hz as per specification. If the input voltage is 
different, the system will normalize it to 230V or 120V for computational purposes.
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Customizing DNP V3.0 Configuration Using GE Communicator EXT

An advanced EPM meter (EPM 9650 and 9800) can measure more than 3000 DNP Static 
Points. But not all points can be polled at a time. In order for the meter to have the 
appropriate data, the user should customize the DNP Point Map. This can be done easily 
using GE Communicator EXT software. Up to 250 points of Event Data can be created in 
the meter. Refer to DNP V3.00 Level 2 Protocol Assignments for EPM 9650 and 9800, Rev. 
1.8, for more details. 

16.1 Connecting to GE Communicator EXT 

Open GE Communicator EXT software by double-clicking on the 
icon. 

Connect to the meter. 

Click on Quick Connect , checking the settings and clicking 
Connect 

OR 

Click on Connection Manager, select a location and click Connect . 

See Chapter 2 of this manual for complete connection instructions. 

When a connection is made, a Status Bar will appear showing a Healthy status. 

Click OK. 

Click the Edit Profile icon. 
A pop-up window will tell you that data is being retrieved. 
The Device Profile screen appears. If the meter (EPM 9650 and 
9800) supports DNP V3.00 Level 2, DNP Level 2 will appear in the 
profile. 

Click on +/- General Settings to open the menu.

Click on +/- DNP Custom Classes Map to open the menu.
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Click on DNP Level 2. 
A set of programming screens appears, the DNP Custom Mapping 
screens.  Each screen has a tab at the top. 

Click on any tab to move from screen to screen.
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16.2 Binary Input 

Object 1 

A meter can use up to 64 Binary Input Points. Values available for Binary Input use can be 
found in the DNP Object Mapping. Only Class 0 is used when polling Binary Input (Object 1) 
Data. Class 1, 2 or 3 is used when polling Binary Input Change (Object 2) Data. 

Line, Point, Description 

Double-click on the box under Description to Add, Delete or Modify 
DNP Points to the screen above. 
A pull-down window will appear. 

Choose a Type (of reading) and a Channel.

Click OK. 

The corresponding numbers for the selected reading and channel will appear in the Line 
and Point columns. 

Line and Point Numbers for a Binary Input value can also be found in the DNP Object 
Mapping (Ch. 7 of the DNP V3.00 Level 2 Protocol Assignments for EPM 9650 and 9800 
Rev.1.8). 

Example 

1 Cycle High Speed Input Delta and Current State has Line Number 16 and Point 
Number 0 in the DNP Object Mapping. 

Write those numbers into the Object 1 – Binary Input window of the 
GE Communicator EXT. 

When the Line and Point Numbers are written, the software fills in 
the description on the screen. 

Repeat for each desired Binary Input Point. 

Update the device. 

The meter will scan those points every second. 

Object 2 

Any DNP Static Point can be configured to create a DNP Event Points. Class Assignments 
on the Object 2 screen are used to configure Binary Input Change Event Points. In order to 
create Event Data, Object 2 Points must be assigned to Class 1, 2 or 3. Each point can have 
a different Class Assignment. 

The Clear All button clears all assigned items on all the tabs. 

The Clear button clears only the items on the current tab view. 
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16.3 Analog Input (Object 30) 

A meter can use up to 64 Analog Input points. Values available for Analog Input use can be 
found in the EPM DNP Object Mapping. Only Class 0 is used when polling Analog Input 
(Object 30) Data. Class 1, 2 or 3 is used when polling Analog Change Event (Object 32) Data.

Line, Point, Description 

Double-click on the box under Description. 
A pull-down window will appear. 

Choose a Type (of reading) and a Channel.

Click OK. 

The corresponding numbers for the selected reading and channel will appear in the 
Line and Point columns. 

Line and Point Numbers can also be found in the DNP Object Mapping (Chapter 7 of the 
DNP V3.00 Level 2 Protocol Assignments for EPM 9650 and 9800 Rev. 1.8). 

Example 

One Second Phase A-N Voltage is Line Number 34 and Point Number 0 in the DNP 
Object Mapping. 

Write these numbers into the Object 30 – Analog Input window of 
GE Communicator EXT. 

When the Line and Point Numbers are written, the software will fill in the description. 

Repeat for each desired Analog Input Point. 

Click OK to return to the main GE Communicator EXT screen. 

Click Update Device to update the meter. 

The meter scans those points every second (except for Tenth Second Readings). Tenth 
Second Readings (Line 18 to 32) are scanned as soon as the meter detects a change (as 
often as every 50 milliseconds). 
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Deadband (%) (Object 32) 

Any DNP Static Point can be configured to create DNP Event Points. Deadband and Class 
Assignments on the Object 32 screen are used to configure Analog Change Event Points. In 
order to create Event Data, Object 32 Points must be assigned to Class 1, 2 or 3. Each point 
can have a different Class assignment. 

Deadband (%) defines the boundary value for that point. For example, suppose One 
Second Phase to Neutral Volts AN is programmed and the Voltage Full Scale is 120.00V for 
the meter. Entering 10% for Deadband will define the boundary value of 12V (10% of 120V). 
Every second, new Static Data is scanned for One Second Phase to Neutral Volts AN. If the 
new data is different from the previous standard value by the boundary value, an Analog 
Change Event will be created. 

Example

If the previous standard value is 110 and new data is lower than 98V or higher than 
122V, a new Analog Change Event Point will be created. The new value then becomes 
the previous standard value for future scans.  

Analog Input Points have various Full Scales values due to different data types (Volts, 
Amps, Watts, etc.). These Full Scale values are used for Exception Polling in DNP. Some 
Full Scale values are programmable by users and others have fixed numbers. See the 
chart of Full Scale Values below. 

The Clear All button clears all assigned items on all the tabs. 

The Clear button clears only the items on the current tab view. 

Full Scale values are 4-byte integer numbers. The units are as follows: 

Analog Input Full Scale Unit 

I A, B, C, Nc Programmable 1/65536 Amps

I Nm Programmable 1/65536 Amps 

V AN, BN, CN Programmable 1/65536 Volts

V AB, BC, CA Programmable 1/65536 Volts 

V Aux Programmable 1/65536 Volts 

Power Phase Programmable 1/65536 Watts 

Power Total Programmable 1/65536 Watts 

Frequency Programmable 1/65536 Hz 

Power Factor 4000 0.001 PF 

Angles 18000 0.001 PF 

Percent 10000 0.01 % 

K-Factor 500 0.01 

TOU Ratio N/A N/A 

Temperature 10000 0.01 
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Example

In order to find out if there is new log data, use a Log Index Number. One of the Log Index 
Numbers (Last Index) will increase when a new log is created. In Object 30, Program Last 
Log Record Index: Waveform Log (Line 499, Point 7). Input Deadband 1.00% and assign a 
Class. The exception data will be created when the Index Number increases by one. 

Flicker 65536 0.0001 

In Interval 1000 1000 

Day of Week 6 1 

Sequence 1 1 

Status 100 1 

Avg Select 100 1 

Delay 100 1 

Log Index 100 1 

Countdown 100 1 
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16.4 Binary Counter (Object 20) 

A meter can use up to 8 Binary Counter Points. Values available for Binary Counter use can 
be found in the DNP Object Mapping. Only Class 0 is used when polling Binary Counter 
(Object 20) Data and Frozen Counter (Object 21) Data. Class 1, 2 or 3 is used when polling 
Counter Event (Object 22) Data and Frozen Counter Event (Object 23) Data. 

Line, Point, Description 

Double-click on the box under Description to Add, Delete or Modify 
DNP Points. 
A pull-down window appears. 

Choose a Type (of reading) and a Channel and click OK. 

The corresponding numbers for the selected data and channel will appear in the Line and 
Point columns. 

Line and Point Numbers can also be found in the DNP Object Mapping (Ch. 7 of DNP V3.00 
Level 2 Protocol Assignments for EPM 9650 and 9800 Rev. 1.8). 

Example 

VA hour has Line Number 133 and Point Number 0 in the DNP Object Mapping. 

Write those numbers into the Object 20- Binary Counter window of 
GE Communicator EXT. 

When the Line and Point Numbers are written, the software fills in the description 
on the screen. 

Repeat for each desired Binary Counter Point. 

Update the device. 

The meter scans those points every second.  
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Scaling 

A meter can measure its Binary Counter value using up to a 16-digit number (0 to 
9,999,999,999,999,999). DNP Binary Counter Points use up to 32 bits. That means that the 
range is 0 to 4,294,967,295 (0x0FFFFFFFF). This maximum number is only a 10-digit 
number. In order to deal with a 16-digit number, Scaling is necessary. 

Scaling is used to select a unit in powers of 10: 1 = x10, 2 = x100 and so on. The Scaling 
value can be 0 to 15. 

Example 

If the value inside the meter is 3,000,000 and a Scaling value of 2 (x100) is used, the 
Binary Counter value will be reported as 30000. The actual value is 30000x100 = 
3,000,000. 

Delta (Object 22) 

Any DNP Static Point can be configured to create DNP Event Points. Delta and Class 
Assignments on the Object 22 screen are used to configure Counter Change Event Points. 
In order to create Event Data, Object 22 must be assigned to Class 1, 2 or 3. Each point can 
have a different Class Assignment. 

The Delta value defines the boundary value for that point.

Example 

Suppose VA hour is programmed and the Delta is 5. That represents 5 increments from 
the returned 32-bit Binary Counter value. Every second, new Static Data is scanned for 
VA hour. If new data is different from the previous standard value by the Delta value, 
the Counter Change Event Data will be created. That means, if the previous standard 
polled value is 50000 VA hour and if the VA hour reading increases to 50005, it will 
create a Counter Change Event Point for VA hour and 50005 VA hour will become the 
previous standard value for the next Static Data. 

The Scaling setting for a point also applies to the Delta value. If Delta is 5 and Scaling 
is 2, this indicates a 500-count change in the internal representation. 

Object 23 

Frozen Analog Event (Object 23) will be created if Object 23 is assigned to Class 1, 2 or 3.

Line, Point, Description 

Double-click on the box under Description. 
A window will appear. 

Choose a type of data and a channel. 

Click OK. 
The corresponding numbers for the selected data and channel will 
appear in the Line and Point columns. 

Line and Point Numbers for a Binary Input value can also be found in the DNP Object 
Mapping (Chapter 7 of this manual). 
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Example 

1 Cycle High Speed Input Delta and Current State has Line Number 16 and Point 
Number 0 in the DNP Object Mapping. Write those numbers into the Object 1 – Binary 
Input window of the GE Communicator EXT. When the Line and Point Numbers are 
written, the software fills in the description on the screen. Repeat for each desired 
Binary Input Point. Update the device. 

The meter will scan those points every second. 

Object 2 

Any DNP Static Point can be configured to create a DNP Event Points. Class Assignments 
on the Object 2 screen are used to configure Binary Input Change Event Points. In order to 
create Event Data, Object 2 Points must be assigned to Class 1, 2 or 3. Each point can have 
a different Class Assignment. 

The Clear All button clears all assigned items on all the tabs. 

The Clear button clears only the items on the current tab view. 
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16.5 Binary Output (Object 10) 

Class 0 is used when polling Binary Output (Object 10) Data. 

External Relay Output Modules can be attached to the meter. Up to 4 Relay Output 
Modules can be attached and each Relay Module has 4 Relay Outputs.

To control a Relay by DNP, check its box. If unchecked, the relay will not be controlled by 
DNP. The Master in DNP protocol can control 16 relays. In order to do that, each relay box 
should be checked and the meter should be updated with this profile. 

Check the box for the Reset Enable you want to control through 
DNP.  

Example 1

The Master can control Relay 1 by sending this message (Meter Address 1, Master 
Address 10): 

05 64 

18 C4 01 00 0A 00 6C 1A 

C0 

C0 05 

06 

01 17 01 

00 03 01 01 00 00 00 00 00 3B EF 00 00 00 FF FF 

Example 2

The Master can control Relay 2 by sending this message: 

05 64 
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18 C4 01 00 

0A 00 6C 1A 

C0 

C1 05 

0C 

01 17 01 

01 03 01 01 00 00 00 00 00 E2 5F 00 00 00 FF FF

The Master not only controls relays but also can do various resets. Each box should be 
checked in order for the Master to do the reset. 

Example 3

The Master can do a Log Reset by sending this message: 

05 04 

18 C4 01 00 0A 00 6C 1A 

C0 

C2 05 

0C 

01 17 01 

10 03 01 01 00 00 00 00 00 C5 1B 00 00 00 FF FF 

Example 4 

The Master can do an Energy Reset by sending this message: 

05 04 

18 C4 01 00 0A 00 6C 1A 

C0 

C3 05 

0C 

01 17 01 

13 03 01 01 00 00 00 00 00 E7 5B 00 00 00 FF FF 

Note All above examples are done with Function 5 (Direct Operate Relay) using Qualifier 0x17. 

Relay Status and Reset Status can be polled using Object 10. 

For Controlling Relays and performing Resets, Object 12 is used. 

The Point Numbers for Relays and Resets are as follows:
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The Clear All button clears all assigned items on all the tabs.

The Clear button clears only the items on the current tab view. 

Points Assignment

0 Relay 1 

1 Relay 2

2 Relay 3

3 Relay 4 

4 Relay 5 

5 Relay 6 

6 Relay 7 

7 Relay 8 

8 Relay 9 

9 Relay 10 

10 Relay 11 

11 Relay 12 

12 Relay 13 

13 Relay 14 

14 Relay 15 

15 Relay 16 

16 Log Reset 

17 Maximum Reset 

18 Minimum Reset 

19 Energy Reset 

20 Reset Time of Use Current Season and 
Current Month 

21 Manual Waveform Capture 

22 Reset Internal Input Accumulations and 
Aggregations 

23 Reset Unit to Boot Mode – Default 
Communication Settings
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16.6 Global Values 

Each Object can be polled by Variation 0. In this window, you can assign a default variation 
to be returned for each Object. 

Click on the Object on the left side of the screen. 

Click on a Variation on the right side of the screen. 

Click OK to save the new settings. 

The Clear All button clears all assigned items on all the tabs. 

The Clear button clears only the items on the current tab view. 
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16.7 DNP Settings 

In this window, you can enable DNP Time Synchronization. The Time Interval is the amount 
of time the device waits before requesting Time Synchronization from the Master (using 
IINI-4). The Time Interval is configurable from 1 minute to 1 day in 1-minute intervals. The 
initial factory setting is 1 day. 

Select a Class 0 Poll Counter Object using the lower pull-down 
menu. 

Click OK to save the new settings. 

The Clear All button clears all assigned items on all the tabs. 

The Clear button clears only the items on the current tab view.



GE COMMUNICATOR EXT - INSTRUCTION MANUAL A–1

GE Communicator EXT

Appendix A: GE Script & Scheduler 
Component Files

GE Consumer & Industrial
Multilin

GE Script & Scheduler Component Files

A.1 GE Script & Scheduler Component Files

The GE Script & Scheduler software program is a stand-alone module for the GE 
Communicator EXT software package. There are two supporting programs; the GE 
Communicator EXT program and the Log Converter program. Below is a list of the 
component files that complete this software program with a brief description of each and 
their location in your system. 

1. EPM Script & Scheduler.Exe 
EPM’ script and scheduler software program. 
Location: Drive C:\Program Files\GE Applications\Communicator_Ext 

2. CommExt.exe GE 
Communicator EXT software program. 
Location: Drive C:\Program Files\GE Applications\Communicator_Ext 

3. LogConverter.exe 
GE’s log converter program. After GE Communicator EXT finishes retrieving a 
log or finishes executing a script, the Log Converter program translates the 
binary log into a database file (Access format). 
Location: Drive C:\Program Files\GE Applications\Log Viewer 

4. EPM Scheduler.Log 
EPM Script & Scheduler program generated log file (Text format). It records all 
activities of the EPM Script & Scheduler program. 
Location: Drive C:\Program Files\GE Applications\Communicator_Ext 

5. [script name].Html (New format) [script name].Log (Old format) 
Communicator EXT generated log file (Text format). It records all activities 
when GE 
Communicator EXT runs a script. Each log file is for a specific script only. 
Future activities for the same script will be appended to the same log file. 
Location: Drive C:\Program Files\GE Applications\Communicator_Ext\Script 
Logs 
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6. [Log_yyyy_mm].Html (New format) [Log_yyyy_mm].Txt (Old format) 
Log Converter generated log. It records the activity of the Log Converter 
program. The yyyy and mm in the file name are for the year and month when 
the Log Converter runs. 
Location: Drive C:\Program Files\GE Applications\LogViewer\Converter 
Activity Logs 

7. EPM_Script_Schedule.Template 
Template database file for GE Script & Scheduler program and GE 
Communicator EXT program in Access 97 format. 
Location: Drive C:\Program Files\GE Applications\Communicator_Ext 

8. EPM_Script_Schedule.DB 
Run time database file for GE Script & Scheduler program and GE 
Communicator EXT program. Generated by GE Script & Scheduler program, it 
holds the scripts and scheduler information. 
Location: Drive C:\Program Files\GE Applications\Communicator_Ext\Scripts 

9. EPMScriptDLFiles.Template 
Template database file for GE Communicator EXT and GE Script & Scheduler 
program in Access 97 format. 
Location: Drive C:\Program Files\GE Applications\Communicator_Ext 

10. EPMScriptDLFiles.DB 
Run time database for GE Communicator EXT and GE Script & Scheduler 
program. 
Generated by GE Communicator EXT program, it holds the retrieved log files’ 
locations and the addresses for the converted logs. If all processes are done, 
the GE Script & Scheduler program will delete this file. 
Location: Drive C:\Program Files\GE Applications\Communicator_Ext\Scripts 

11. EPMSchedulerLog - Main.Html 
Software generated top layer file with frame set linked to EPM Scheduler Log - 
Detail.Html and EPM Scheduler Run-Time Log.Html. 

12. EPMSchedulerLog - Detail.Html 
Software generated blank frame file. 

13. EPMSchedulerRun-TimeLog.Html 
Software generated schedule process log with hypertext link to detailed script 
logs and detailed Log Converter logs.
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Transformer/Line Loss Compensation Calcn. Worksheets

B.1 Introduction 

The Edison Electric Institute’s Handbook for Electricity Metering, Ninth Edition, defines Loss 
Compensation as: 

A means for correcting the reading of a meter when the metering point and point 
of service are physically separated, resulting in measurable losses including I2R 
losses in conductors and transformers and iron-core losses. These losses may be 
added to, or subtracted from, the meter registration. 

Loss compensation may be used in any instance where the physical location of the meter 
does not match the electrical location where change of ownership occurs. Most often this 
appears when meters are connected on the low voltage side of power transformers when 
the actual ownership change occurs on the high side of the transformer. This condition is 
shown pictorially in Figure B.1. 

FIGURE B–1: Low Voltage Metering Installation Requiring Loss Compensation Ownership Change 
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It is generally less expensive to install metering equipment on the low voltage side of a 
transformer and in some conditions other limitations may also impose the requirement of 
low-side metering even though the actual ownership change occurs on the high-voltage 
side. 

The need for loss compensated metering may also exist when the ownership changes 
several miles along a transmission line where it is simply impractical to install metering 
equipment. Ownership may change at the midway point of a transmission line where 
there are no substation facilities. In this case, power metering must again be 
compensated. This condition is shown in Figure B.2. 

FIGURE B–2: Joint Ownership Line Metering Requiring Loss Compensation M Point of Ownership 
Change 

A single meter cannot measure the losses in a transformer or transmission line directly. It 
can however, include computational corrections to calculate the losses and add or 
subtract those losses to the power flow measured at the meter location. This is the method 
used for loss compensation in the EPM meter. 

The computational corrections used for transformer and transmission line loss 
compensation are similar. Generically, no-load losses and full-load losses are evaluated 
and a correction factor for each loss level is calculated. However, the calculation of the 
correction factors that must be programmed into the meter differ for the two different 
applications. For this reason, the two methodologies will be treated separately in this 
chapter.

In the EPM 9450, 9650 and 9800 meters, Loss Compensation is a technique that 
computationally accounts for active and reactive power losses. The meter calculations are 
based on the formulas below. These equations describe the amount of active (Watts) and 
reactive (VARs) power lost due to both iron and copper effects (reflected to the secondary 
of the instrument transformers). 

Total Secondary Watt Loss  =  (((Measured Voltage/Cal point Voltage)2 x %LWFE) + 
((Measured Current/Cal Point Current)2 x %LWCU)) x Full-scale Secondary VA 

Total Secondary VAR Loss =  (((Measured Voltage/Cal point Voltage)4 x %LVFE) + ((Measured 
Current/Cal Point Current)2 x %LVCU)) x Full-scale Secondary VA 

• The Values for %LWFE, %LWCU, %LVFE, %LVCU are derived from the transformer 
and meter information, as demonstrated in following sections. 

• The calculated loss compensation values are added to or subtracted from the 
measured Watts and VARs. 

• The selection of adding or subtracting losses is made through the meter profile 
when programming the meter. 
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• The meter uses the combination of the add/subtract setting and the directional 
definition of power flow (also in the profile) to determine how to handle the losses. 

• Losses will be "added to" or "subtracted from" (depending on whether add or 
subtract is selected) the Received Power flow. 

Example 

If losses are set to "Add to" and received power equals 2000 kW and losses are equal 
to 20kW then the total metered value with loss compensation would be 2020 kW; for 
these same settings if the meter measured 2000 kW of delivered power the total 
metered value with loss compensation would be 1980 kW. 

Since transformer loss compensation is the more common loss compensation 
method, the meter has been designed for this application. Line loss compensation is 
calculated in the meter using the same terms but the percent values are calculated by 
a different methodology as described in a subsequent section below. 

B.1.1 Transformer/Line Loss Compensation 
• Performs calculations on each phase of the meter for every measurement taken. 

Unbalanced loads are accurately handled. 

• Calculates numerically, eliminating the environmental affects that cause 
inaccuracies in electromechanical compensators. 

• Performs Bidirectional Loss Compensation. 

• Requires no additional wiring; the compensation occurs internally. 

• Imposes no additional electrical burden when performing Loss Compensation. 

Loss Compensation is applied to 1 second per phase Watt/VAR readings and, because of 
that, affects all subsequent readings based on 1 second per phase Watt/VAR readings. 
This method results in loss compensation be applied to the following quantities: 

• Total Power. 

• Demands, per phase and Total (Thermal, Block (Fixed) Window, Rolling (Sliding) 
Window and Predictive Window). 

• Maximum and Minimum Demands. 

• Energy Accumulations. 

• KYZ Output of Energy Accumulations. 

Note Loss Compensation is disabled when the meter is placed in Test Mode. 
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B.2 Transformer / Line Loss Compensation 

The meter provides compensation for active and reactive power quantities by performing 
the numerical calculations using factors derived in two ways; using the TLC Calculator 
button on the Transformer Loss screen of the Meter’s Device Profile or using the worksheet 
found in section B.2.1, (Calculating Transformer Loss Compensation Percentages Work 
Sheet). Enter the derived values in the Device Profile screen of the GE Communicator EXT 
software. 

The GE Communicator EXT software allows you to enable Transformer Loss Compensation 
for Losses due to Copper and Iron, individually or simultaneously. Losses can either be 
added to, or subtracted from, measured readings. 

Loss compensation values must be calculated based on the meter installation. As a result 
transformer loss values must be normalized to the meter by converting the base voltage 
and current and taking into account the number of elements used in the metering 
installation. 

For three element meters, the installation must be normalized to the phase-to-neutral 
voltage and the phase current; in two element meters the installation must be normalized 
to the phase-to-phase voltage and the phase current. This process is described in the 
following sections. 

B.2.1 Loss Compensation in Three Element Installations 
Loss Compensation is based on the loss and impedance values provided on the 
Transformer Manufacturer’s Test Report. A typical test report will include at least the 
following information: 

• Manufacturer 

• Unit Serial Number 

• Transformer MVA Rating (Self-Cooled) 

• Test Voltage 

• No Load Loss Watts 

• Load Loss Watts (or Full Load Loss Watts) 

• % Exciting Current @ 100% voltage 

• % Impedance 

The transformer MVA rating is generally the lowest MVA rating (the self-cooled or OA rating) 
of the transformer winding. The test voltage is generally the nominal voltage of the 
secondary or low voltage winding. For three phase transformers these values will typically 
be the three-phase rating and the phase-to-phase voltage. All of the test measurements 
are based on these two numbers. Part of the process of calculating the loss compensation 
percentages is converting the transformer loss values based on the transformer ratings to 
the base used by the meter. 

Correct calculation of loss compensation also requires knowledge of the meter installation. 
In order to calculate the loss compensation settings you will need the following 
information regarding the meter and the installation: 

• Number of meter elements 
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• Potential Transformer Ratio (PTR) 

• Current Transformer Ratio (CTR) 

• Meter Base Voltage 

• Meter Base Current 

This section is limited to application of EPM 9450, 9650 and 9800 meters to three-element 
metering installations. As a result, we know that: 

• Number of metering elements = 3 

• Meter Base Voltage = 120 Volts 

• Meter Base Current = 5 amps 

The loss compensation values can be calculated in two ways: 

Click the TLC Calculator button on the Transformer Loss screen of 
the EPM Device Profile. 
The TLC Calculator button activates an Excel Spreadsheet, ONLY if 
you have MS Excel installed on your computer. A copy of the Excel 
Spreadsheet with Example Numbers is included at the end of this 
Appendix. 

Enter the required data into the Excel Spreadsheet. 
The Excel program will calculate the values needed for the 
Transformer Loss screen of the Device Profile. 

Enter the values into the Device Profile. 

• Use the worksheet found in section B.2.1.1, “Three Element Loss Compensation 
Worksheet” to calculate the values by hand. Notes under each section will assist 
you. 

Enter values based on the tranformer manufacturer’s test report. 
The worksheet is progressive and notes under each section will 
guide you to the next section. 

Enter the values into the Device Profile. 

Note See Chapters 3 and 4 - Transformer Loss sections - for more details. 

B.2.2 Three Element Loss Compensation Worksheet 
(Use MS Excel Worksheet discussed in sections 3.8 and 4.8 if you have Excel installed on 
your PC.) 

Company Station Name

Date Trf Bank Number

Trf Manuf Trf Serial Number

Calculation By
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Transformer Data (from Transformer Manufacturer’s Test Sheet)

Enter 3-Phase or 1-Phase values. 
If 3-Phase values are entered, calculate 1-Phase values by dividing 
3-Phase values by three. Convert 1-Phase Loss Watts to 1-Phase 
kW by dividing 1-Phase Loss Watts by 1000.

Enter 3-Phase or 1-Phase values. 
If 3-Phase values are entered, calculate 1-Phase values by dividing 
3-Phase values by three. Convert 1-Phase Self-Cooled MVA to 1-
Phase kVA by multiplying by 1000.

Test Voltage is generally Phase-to-Phase for three-phase transformers. Calculate Phase-
to-Neutral Voltage by dividing Phase-to-Phase Voltage by v3. Calculate Full Load Current 
by dividing the (1-Phase kW Self-Cooled Rating) by the (Phase-to-Neutral Voltage) and 
multiplying by 1000. 

Winding Voltage MVA Connection

HV-High Delta-Y

XV-Low Delta-Y

YV-Tertiary Delta-Y

Value
Watts Loss

3-Phase 1-Phase 1-Phase kW

No-Load Loss

Load Loss

Value 3-Phase MVA 1-Phase MVA 1-Phase kVA

Self-Cooled Rating

% Exciting Current

% Impedance

Value Phase-to_Phase Phase-to-Neutral

Test Voltage (volts)

Full-Load Current (amps)
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Meter/Installation Data

Enter the Numerator and Denominator for each instrument 
transformer. 
For example, a PT with a ratio of 7200/120 has a numerator or 
7200, a denominator or 120 and a multiplier of 60 (7200/120 = 60/
1).

Base Conversion Factors 

For Transformer Voltage - enter the Phase-to-Neutral value of 
Test Voltage previously calculated. 

For Transformer Current - enter the Full-Load Current previously 
calculated. 

For Multipliers - enter the PT and CT multipliers previously 
calculated. 

TrfIT Secondary is the Base Value of Voltage and Current at the Instrument 
Transformer Secondary of the Power Transformer. These numbers are obtained by 
dividing the Transformer Voltage and Current by their respective Multipliers. 

The Meter/Trf values for Voltage and Current are obtained by dividing the Meter 
Base values by the TrfIT Secondary values. 

Instrument Transformers Numerator Denominator Multiplier

Potential Transformer

Current Transformer

Power Multiplier [(PT Multiplier) X (CT Multiplier)]

Meter Secondary Voltage (volts)

Meter Secondary Current (amps)

Quantity Transformer Multiplier Trf IT Sec Meter Base Meter/Trf

Voltage

Current
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Load Loss at Transformer 

No-Load Loss Watts (kW) = 1-Phase kW No-Load Loss = ______________ 

No-Load Loss VA (kVA) = (%Exciting Current) * (1-Phase kVA Self-Cooled Rating) / 100

= (______________) * (________________) / 100 

= _______________ kVA 

No-Load Loss VAR (kVAR) = SQRT((No-Load Loss kVA)2 - (No-Load Loss kW)2) 

= SQRT((_________________)2 - (________________)2) 

= SQRT((__________________) - (_________________)) 

= SQRT (_________________) 

= ____________________ 

Full-Load Loss Watts (kW) = 1-Phase Kw Load Loss = ______________ 

Full-Load Loss VA (kVA) = (%Impedance) * (1-Phase kVA Self-Cooled Rating) / 100

= (______________) * (________________) / 100 

= _______________ kVA 

Full-Load Loss VAR (kVAR)  = SQRT((Full-Load Loss kVA)2 - (Full-Load Loss kW)2) 

= SQRT((_________________)2 - (________________)2)

= SQRT((__________________) - (_________________)) 

= SQRT (_________________)

= _________________ 

Normalize Losses to Meter Base 

Enter Value at Transformer Base for each quantity from 
calculations above. 

Enter Meter/Trf Factor value from Base Conversion Factor 
calculations above. 

Quantity Value at 
Trf Base

M/T
Factor

M/T 
Factor
Value

Exp
M/T

Factor
w/Exp

Value
at

Meter
Base

No-Load Loss (kW) V ^2

No-Load Loss (kVAR) V ^4

Load Loss (kW) I ^2

Load Loss (kVAR) I ^2
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Calculate M/T Factor with Exponent by raising the M/T Factor to 
the power indicated in the “Exp” (or Exponent) column. 

Calculate the Value at Meter Base by multiplying the (M/T Factor 
w/ Exp) times the (Value at Trf Base). 

Loss Watts Percentage Values 

Meter Base kVA = 600 * (PT Multiplier) * (CT Multiplier) / 1000 

= 600 * (____________) * (___________) / 1000 

= ________________ 

Calculate Load Loss Values

Enter Value at Meter Base from Normalize Losses section. 

Enter Meter Base kVA from previous calculation.

Calculate % Loss at Meter Base by dividing Value at Meter Base 
by Meter Base kVA and multiplying by 100. 

Enter calculated % Loss Watts values into EPM meter using 
Communicator EXT software. 

B.2.3 MS Excel Spreadsheet with Example Numbers 
If you have MS Excel installed in your computer, use the TLC Calculator button on the 
Transformer Loss screen of the Device Profile. A copy of the MS Excel Spreadsheet with 
Example Numbers on the following pages will assist you.

Quantity
Value at

Meter 
Base

Meter 
Base 
(kVA)

% Loss 
at

Meter Base
Quantity

No-Load Loss (kW) % Loss Watts FE

No-Load Loss (kVAR) % Loss VARs FE

Load Loss (kW) % Loss Watts CU

Load Loss (kVAR) % Loss VARs CU
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GE Communicator EXT Command Line Arguments V 1.11

C.1 Script Command Line Methods 

Tells GE Communicator EXT to perform a task corresponding to the Script ID Number. /

snnnn Script ID Number 

Example : 

CommExt /s1234 (/s Script ID Number) 

uc: Start Log Converter 

0Do not start log converter 

1 Start log converter 

If left out of command line, Start Log Converter assumed. 

Example : 

CommExt with Script 1234 will Start Log Converter if Log Retrieval is in the script. 

CommExt /s1234 uc:1 
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C.2 Application Command Line Methods 

Tells GE Communicator EXT to make a connection and display a particular application 
screen. 

/c (additional arguments with a space between each argument) 

Example 1: 

Meter with address 2 on network with IP address 10.0.0.1 using Modbus TCP Start 
on device status screen. 

CommExt /c cm:1 ad:2 pr:3 ip:10.0.0.1 np:502 

Example 2: 

Meter with address 2 at remote location with Phone Number 555-545-5110 using 
Modbus ASCII Start on device status screen. 

CommExt /c cm:0 ad:2 pr:1 cp:3 BR:3 um:1 pn:555-545-5110 

cm: Connect Mode 

0 Serial Port 

1 Network 

If left out of command line, Serial Port assumed. 

ad: Address 

1 - 247 

If left out of command line, Address 1 assumed. 

nm: Network Mode 

0 One IP Address for n Devices 

If left out of command line, 0 assumed. 

pr: Protocol 

0 Modbus RTU 

1 Modbus ASCII 

2 DNP 3.0 (Not Supported) 

3 Modbus TCP 

4 EI Protocol 

If left out of command line, Modbus RTU assumed. 

ip: IP Address or Host Name 

xxx.xxx.xxx.xxx or 1 - 16 Alphanumeric characters with no spaces. 

If left out, error assumed. 
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np: Network Port 

502   Open Modbus (Modbus TCP) 

If left out, Port 502 assumed. 

cp: Com Port 

1 - 98 

If left out, Com Port 1 assumed. 

br: Baud Rate 

0 1200 

1 2400 

2 4800 

3 9600 

4 19200 

5 38400 

6 57600 

7 115200 

If left out, Baud Rate is 9600. 

um: Use Modem 

0 No 

1 Yes 

If left out, No modem selected. 

pn: Phone Number 

Use No spaces. To be defined. 

ms: Modem Setup String 

To be defined. 

dc: Data Switch Connect String 

To be defined. 

dd: Data Switch Disconnect String 

To be defined. 

ss: Start Screen 

0 Device Status 

1 Phasors Diagram (EPM9450, 9650 & 9800 Only) 

2 Instantaneous Polling 
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3 Poll All (EPM9450, 9650 & 9800 Only) 

4 Poll Max/Min 

5 Poll Power Readings 

6 Poll Harmonics 

7 Poll Internal Inputs 

8 Poll Multiple Devices (EPM9450, 9650 & 9800 Only) 

9 Poll Pulse Accumulations (EPM9450, 9650 & 9800 Only) 

10 Poll Limit Status 

11 Poll Time of Use Readings (EPM9450, 9650 & 9800 Only) 

12 Poll Meter External Digital Inputs (EPM9450, 9650 & 9800 Only) 

13 Poll Meter External Analog Inputs (EPM9450, 9650 & 9800 Only) 

14 Poll Meter ElectroLogic Status (EPM9450, 9650 & 9800 Only) 

15 Poll Relay Control 

16 Poll Readings with DDE Service (EPM9450, 9650 & 9800 Only) (Tech Mode ONLY) 

17 Poll Log Statistics (Added 08-06-2003) 

18 Log Retrieval Screen (Added 08-06-2003) 

19 Poll Power and Demand (EPM9450, 9650 & 9800 Only) (Added 01-22-2004) 

20 Poll Energy (EPM9450, 9650 & 9800 Only) (Added 01-22-2004) 

If left out, Start screen is Device Status. 

dn: Device Name 

Must use period as place holder for a space. 

ln: Location Name 

Must use period as place holder for a space. 

vm: View Mode 

0 Normal 

1 Hide Main Window and Exit Program upon closing of Start Screen. 
GE Communicator EXT acts as a plug-in for integrating with third party software. 

If left out, Normal is the View Mode. 

am: Answer Modem 

0 No 

1 Open Port. 
Wait for Modem to ring and attempt to answer Modem if ringing. 

If left out, software does not answer Modem. 
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dr: Dial Out Receive Call 

0 No 

1 After Software successfully answers the call, it looks for a reason of call code 
(based on the code Perform Automated functions). 
Upon completion of all functions, GE Communicator EXT places the Remote 
Modem into command mode, sends an acknowledgment, hangs up, closes the 
communications port and exits the program. 

mp: Modem Password 

Must use period as place holder for a space. 

dt: User Defined DDE Topic Name for Start Screen 16 

Topic Name must contain no spaces. 

If left out, Meter Designation is used as Topic. 

lr: Retrieve Log Number 

1 Historical Log 1 

2 Historical Log 2 

3 Both 1 and 2 

See Table Below for Other Combinations: 
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Example: To retrieve Historical Log 1 and Limit Log 

101b = 5d = 5

Log to
 Retrieve Bits

15 14 13 12 10 9 8 7 6 5 4 3 2 1 0

Historical 
Log 1

X

Historical 
Log 2

X

Limit 
Log

X

PQ/Waveform
Log

X

Digital Input
Log

X

Digital Output
Log

X

Reserved
(Max/Min Log)

X

Flicker X

System of
Events Log

X

Reset Log
(Disabled)

X
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TFTP Server Program Setup

D.1 TFTP Server Program Setup

A free shareware TFTP (Trivial File Transfer Protocol) server program known as tftpd32 is 
provided to customers to be used to update firmware for the INP-100 Ethernet card. The 
program files are located on the software installation CD. 

Note tftpd32 must be running to update the firmware. 

Setup requirements 

1. Windows Operating System 

2. A working Ethernet card with a valid IP Address 

3. Winzip software (only if Windows OS does not open the zip file automatically) 

Setup procedures 

1. In your PC’s hard disk, create a folder with a name. 
Example: C:\Program Files\TFTPD32. 

2. Locate the Zipped tftpd32 program files on the CD. Then, use the Winzip 
program to extract all compressed files into the folder you have created in 
Step 1. 

3. In your PC’s hard drive, create a folder with a name to be used as the root 
directory for TFTP Server. 
Example: C:\Program Files\TFTPD32\TFTP_files. 

4. To start running the program, double click on tftpd32.exe. 

Configuring tftpd32 

Start the TFTPD32 program (Step 4 above). 
The following screen appears: 
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Click the Settings button. 
The Tftpd32: Settings screen appears. 

Note The screen shown here displays GE’s recommended settings. 

Note All firmware files for INP100 should be placed inside the C:\Program Files\TFTPD32 
\TFTP_files folder before updating firmware. 

It is not recommended to check the Activate Tftpd32 on this interface box. Once that box 
is checked and your computer’s IP is changed, the TFTPD32 program may not work 
properly. To fix the problem, you may have to disable this feature inside the Windows 
Registry.
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DNP Custom Class Map Readings

E.1 Available DNP Class Map Readings for EPM9450Q: 

1 Second Readings 

Thermal Readings 

Accumulations 

Maximum Readings 

Minimum Readings 

Block Window Average 

Rolling Window Average 

THD and K-Factor 

Phase Angles and Voltage Sequence 

0.1 Second Readings 

Harmonic Magnitudes 

Harmonic Phases 

External Analog Inputs 

Time of Use 

Binary States 

Action Block 

Time Stamps 

Energy and Pulses in the Interval 

Flicker 

Miscellaneous
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Application Notes

Application Notes are designed to help you with various applications of GE Communicator 
EXT software. GE Communicator EXT has expansive capabilities that can make your 
Monitoring and Power Control tasks much easier, once the software is set up to do what 
you need it to do. 

F.1 Total Web Solutions MEGA PAGE 

Displaying Data from Multiple INP100/102 Units on One Web Page

With Total Web Solutions’WebExplorer and WebReacher features, it’s possible to design a 
single web page that displays data from multiple EPM 9450, 9650 and 9800 meters that 
have INP100/102 Network Options. To achieve this goal, the user should have a basic 
understanding of Total Web Solutions. Refer to Chapter 6 of this manual for setup and 
utililization. In addition, the user should modify the Java Script Code on the web pages in 
use and also make a change to the Internet Explorer browser settings, as detailed below.
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F.2 Modify JavaScript 

Using the default files supplied by INP100/102 Network Options as templates, the user 
should modify the JavaScript code for all web pages using the sample below. The sample 
portion of JavaScript code is for demonstation purposes only. You must insert your own 
code where needed.

<script language=Javascript>

// insert your own code here

// Define multiple XML DOM Documents objects

var xmlDoc_Meter_1 = new ActiveXObject(“MSXML.DomDocument”);

var xmlDoc_Meter_2 = new ActiveXObject(“MSXML.DomDocument”);

var xmlDoc_Meter_1.async = true;

var xmlDoc_Meter_1.onreadystatechange = do_get_data_Meter_1;

var xmlDoc_Meter_2.async = true;

var xmlDoc_Meter_2.onreadystatechange = do_get_data_Meter_2;

//function name ‘start process’ should be placed in web page’s <body> 
tag

// such as ‘<body onLoad=”start_process()”>’

function start_process()

{

do_get_xml_Meter_1();

do_get_xml_Meter_1();

}

// Load each poll_data.xml file from different locations into an XML DOM 
Document objects

function do_get_xml_Meter_1()

{

xmlDoc_Meter_1.load(“http://192.168.1.2/poll_data.xml”);

}

function do_get_xml_Meter+2()

{

xmlDoc_Meter_1.load(“http://192.168.7.8/poll_data.xml”);

}

// functions to read, parse and display data from each XML file

function do_get_data_Meter_1()

{

// insert your own code here

}

function do_get_data_Meter_2()

{

// insert your own code here

}

// insert your own code here

</script>
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F.3 Change Browser Settings 

Changes to the Internet Explorer (IE, Version 6) Browser Settings: 

Go to Internet Explorer’s Internet Options window. 

Click Security tab > Internet Icon > Custom Level 
A security Settings window appears. 

In the Security Settings window, scroll down to the Miscellaneaous 
section. Set Enable for Access data source across domains and 
Set Enable for Navigate sub-frames from across different 
domains. 

Click OK to close the Security Settings screen. 
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Click OK again to close the Internet Options screen.
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Ethernet Network Error Codes

G.1 Network Error Codes

G.1.1 Network Error Codes Reported by Software that uses Ethernet (including GE 
Communicator EXT) 

These codes are provided for your information. 

Case 10004: GetWSAErrorString = "Interrupted system call." 

Case 10009: GetWSAErrorString = "Bad file number." 

Case 10013: GetWSAErrorString = "Permission Denied." 

Case 10014: GetWSAErrorString = "Bad Address." 

Case 10022: GetWSAErrorString = "Invalid Argument." 

Case 10024: GetWSAErrorString = "Too many open files." 

Case 10035: GetWSAErrorString = "Operation would block." 

Case 10036: GetWSAErrorString = "Operation now in progress." 

Case 10037: GetWSAErrorString = "Operation already in progress." 

Case 10038: GetWSAErrorString = "Socket operation on nonsocket." 

Case 10039: GetWSAErrorString = "Destination address required." 

Case 10040: GetWSAErrorString = "Message too long." 

Case 10041: GetWSAErrorString = "Protocol wrong type for socket." 

Case 10042: GetWSAErrorString = "Protocol not available." 

Case 10043: GetWSAErrorString = "Protocol not supported." 

Case 10044: GetWSAErrorString = "Socket type not supported." 

Case 10045: GetWSAErrorString = "Operation not supported on socket." 
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Case 10046: GetWSAErrorString = "Protocol family not supported." 

Case 10047: GetWSAErrorString = "Address family not supported by protocol family." 

Case 10048: GetWSAErrorString = "Address already in use." 

Case 10049: GetWSAErrorString = "Can't assign requested address." 

Case 10050: GetWSAErrorString = "Network is down." 

Case 10051: GetWSAErrorString = "Network is unreachable." 

Case 10052: GetWSAErrorString = "Network dropped connection." 

Case 10053: GetWSAErrorString = "Software caused connection abort." 

Case 10054: GetWSAErrorString = "Connection reset by peer." 

Case 10055: GetWSAErrorString = "No buffer space available." 

Case 10056: GetWSAErrorString = "Socket is already connected." 

Case 10057: GetWSAErrorString = "Socket is not connected." 

Case 10058: GetWSAErrorString = "Can't send after socket shutdown." 

Case 10059: GetWSAErrorString = "Too many references: can't splice." 

Case 10060: GetWSAErrorString = "Connection timed out." 

Case 10061: GetWSAErrorString = "Connection refused." 

Case 10062: GetWSAErrorString = "Too many levels of symbolic links." 

Case 10063: GetWSAErrorString = "File name too long." 

Case 10064: GetWSAErrorString = "Host is down." 

Case 10065: GetWSAErrorString = "No route to host." 

Case 10066: GetWSAErrorString = "Directory not empty." 

Case 10067: GetWSAErrorString = "Too many processes." 

Case 10068: GetWSAErrorString = "Too many users." 

Case 10069: GetWSAErrorString = "Disk quota exceeded." 

Case 10070: GetWSAErrorString = "Stale NFS file handle." 

Case 10071: GetWSAErrorString = "Too many levels of remote in path." 

Case 10091: GetWSAErrorString = "Network subsystem is unusable." 

Case 10092: GetWSAErrorString = "Winsock DLL cannot support this application." 

Case 10093: GetWSAErrorString = "Winsock not initialized." 

Case 10101: GetWSAErrorString = "Disconnect." 

Case 11001: GetWSAErrorString = "Host not found." 

Case 11002: GetWSAErrorString = "Nonauthoritative host not found." 

Case 11003: GetWSAErrorString = "Nonrecoverable error." 

Case 11004: GetWSAErrorString = "Valid name, no data record of requested type."
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0.1 Second Values: These values are the RMS values of the indicated 
quantity as calculated after approximately 50 
milliseconds (3 cycles) of sampling. 

1 Second Values: These values are the RMS values of the indicated 
quantity as calculated after one second (60 cycles) of 
sampling. 

Alarm: An event or condition in a meter that can cause a trigger 
or call-back to occur. 

Annunciator: A short label that identifies particular quantities or 
values displayed, for example kWh. 

Average (Current): When applied to current values (amps) the average is a 
calculated value that corresponds to the thermal 
average over a specified time interval. The interval is 
specified by the user in the meter profile. The interval is 
typically 15 minutes. So, Average Amps is the thermal 
average of amps over the previous 15-minute interval. 
The thermal average rises to 90% of the actual value in 
each time interval. For example, if a constant 100amp 
load is applied, the thermal average will indicate 90 
amps after one time interval, 99 amps after two time 
intervals and 99.9 amps after three time intervals. 

Average (Input Pulse 
Accumulations):  

When applied to Input Pulse Accumulations, the 
“Average” refers to the block  (fixed) window average 
value of the input pulses. 
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Average (Power): When applied to power values (watts, VARs, VA), the 
average is a calculated value that corresponds to the 
thermal average over a specified time interval. The 
interval is specified by the user in the meter profile. The 
interval is typically 15 minutes. So, the Average Watts is 
the thermal average of watts over the previous 15-
minute interval. The thermal average rises to 90% of the 
actual value in each time interval. For example, if a 
constant 100kW load is applied, the thermal average will 
indicate 90kW after one time interval, 99kW after two 
time intervals and 99.9kW after three time intervals. 

Bit: A unit of computer information equivalent to the result 
of a choice between two alternatives (Yes/No, On/Off, for 
example). Or, the physical representation of a bit by an 
electrical pulse whose presence or absence indicates 
data. 

Binary: Relating to a system of numbers having 2 as its base 
(digits 0 and 1). 

Block Window Avg 
(Power):

The Block (Fixed) Window Average is the average power 
calculated over a (Power) user-set time interval, typically 
15 minutes. This calculated average corresponds to the 
demand calculations performed by most electric utilities 
in monitoring user power demand. (See Rolling Window 
Average.) 

Byte: A group of 8 binary digits processed as a unit by a 
computer (or device) and used especially to represent an 
alphanumeric character. 

CBEMA Curve: A voltage quality curve established originally by the 
Computer Business Equipment Manufacturers 
Association. The CBEMA Curve defines voltage 
disturbances that could cause malfunction or damage in 
microprocessor devices. The curve is characterized by 
voltage magnitude and the duration which the voltage is 
outside of tolerance. (See ITIC Curve.) 

Channel: The storage of a single value in each interval in a load 
profile. 

Cold Load Pickup: This value is the delay from the time control power is 
restored to the time when the user wants to resume 
demand accumulation. 
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CRC Field: Cyclic Redundancy Check Field (Modbus 
communication) is an error checksum calculation that 
enables a Slave device to determine if a request packet 
from a Master device has been corrupted during 
transmission. If the calculated value does not match the 
value in the request packet, the Slave ignores the 
request. 

CT (Current) Ratio: A Current Transformer Ratio is used to scale the value of 
the current from a secondary value up to the primary 
side of an instrument tranformer. 

Cumulative Demand: The sum of the previous billing period maximum 
demand readings at the time of billing period reset. The 
maximum demand for the most recent billing period is 
added to the previously accumulated total of the 
maximum demands. 

Demand: The average value of power or a similar quantity over a 
specified period of time. 

Demand Interval: A specified time over which demand is calculated. 

Display: User-configurable visual indication of data in a meter. 

DNP 3.0: A robust, non-proprietary protocol based on existing 
open standards. DNP 3.0 is used to operate between 
various systems in electric and other utility industries 
and SCADA networks. EPM 9450 supports Level 1; EPM 
9650 & 9800 support Level 2. 

EEPROM: Nonvolatile memory. Electrically Erasable 
Programmable Read Only Memory that retains its data 
during a power outage without need for a battery. Also 
refers to meter’s FLASH memory. 

Energy Register: Programmable record that monitors any energy 
quantity. Example: Watthours, VARhours, VAhours. 

Ethernet: A type of LAN network connection that connects two or 
more devices on a common communications backbone. 
An Ethernet LAN consists of at least one hub device (the 
network backbone) with multiple devices connected to it 
in a star configuration. The most common versions of 
Ethernet in use are 10BaseT GE Multilin Glossary-3 and 
100BaseT as defined in IEEE 802.3 standards. However, 
several other versions of Ethernet are also available. 

Exception Response: Error Code (Modbus communication) transmitted in a 
packet from the Slave to the Master if the Slave has 
encountered an invalid command or other problem. 
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Flicker: Flicker is the sensation that is experienced by the human 
visual system when it is subjected to changes occurring 
in the illumination intensity of light sources. IEC 61000-4-
15 and former IEC 868 describe the methods used to 
determine flicker severity. 

Form: Wiring and Hookup configuration for the EPM 9800. 

Harmonics: Measuring values of the fundamental current and 
voltage and percent of the fundamental. 

Heartbeat Pulse: Energy indicator on the face of the EPM9450/9650; 
pulses are generated per the programmed Ke value. 

I2T Threshold: Data will not accumulate until current reaches 
programmed level. 

Infrared Test Pulse: Energy indicator located on the upper left side of the 
face of the EPM 9800 meter; pulses are generated per 
the programmed Ke value. 

Integer: Any of the natural numbers, the negatives of those 
numbers or zero. 

Internal Modem: An optional modem within the meter’s enclosure that 
connects to the RJ-11 telephone connector. 

Invalid Register: In the meter’s Modbus Map there are gaps between 
Registers. For example, the next Register after 08320 is 
34817. Any unmapped Register stores no information 
and is said to be invalid. 

ITIC Curve: An updated version of the CBEMA Curve that reflects 
further study into the performance of microprocessor 
devices. The curve consists of a series of steps but still 
defines combinations of voltage magnitude and 
duration that will cause malfunction or damage. 

Ke: kWh per pulse; i.e. the energy. 

kWh: kilowatt hours; kW x demand interval in hours. 

KYZ Output: Output where the rate of changes between 1 and 0 
reflects the magnitude of a metered quantity. 

LCD: Liquid Crystal Display. 

LED: Light Emitting Diode. 

Master Device: In Modbus communication, a Master Device initiates and 
controls all information transfer in the form of a Request 
Packet to a Slave Device. The Slave reponds to each 
request. 

Maximum Demand: The largest demand calculated during any interval over 
a billing period. 
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Modbus ASCII: Alternate version of the Modbus protocol that utilizes a 
different data transfer format. This version is not 
dependent upon strict timing, as is the RTU version. This 
is the best choice for telecommunications applications 
(via modems). 

Modbus RTU: The most common form of Modbus protocol. Modbus 
RTU is an open protocol spoken by many field devices to 
enable devices from multiple vendors to communicate 
in a common language. Data is transmitted in a timed 
binary format, providing increased throughput and 
therefore, increased performance. 

Network: A communications connection between two or more 
devices to enable those devices to send and receive 
data to one another. In most applications, the network 
will be either a serial type or a LAN type. 

NVRAM: Nonvolatile Random Access Memory is able to keep the 
stored values in memory even during the loss of circuit 
or control power. High speed NVRAM is used in the EPM 
9450, 9650 & 9800 to gather measured information and 
to insure that no information is lost. 

Optical Port: A port that facilitates infrared communication with an 
EPM 9800 meter. Using an ANSI C12.13 Type II magnetic 
optical communications coupler and an RS-232 cable 
from the coupler to a PC, the meter can be programmed 
with GE Communicator EXT software. 

Packet: A short fixed-length section of data that is transmitted 
as a unit. Example: a serial string of 8-bit bytes. 

Percent (%) THD: Percent Total Harmonic Distortion. (See THD.) 

Protocol: A language that will be spoken between two or more 
devices connected on a network. 

PT Ratio: Potential Transformer Ratio used to scale the value of 
the voltage to the primary side of an instrument 
transformer. Also referred to as VT Ratio. 

Pulse: The closing and opening of the circuit of a two-wire 
pulse system or the alternate closing and opening of 
one side and then the other of a three-wire system 
(which is equal to two pulses). 

Q Readings: Q is the quantity obtained by lagging the applied voltage 
to a wattmeter by 60 degrees. Values are displayed on 
the Uncompensated Power and Q Readings screen. 
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Quadrant 
(Programmable Values 
and Factors on the EPM 
9450, 9650 and 9800): 

Watt and VAR flow is typically represented using an X-Y 
coordinate system.  The four corners of the X-Y plane are 
referred to as quadrants. Most power applications label 
the right hand corner as the first quadrant and number 
the, remaining quadrants in a counter-clockwise 
rotation. Following are the positions of the quadrants: 
1st - upper right, 2nd - upper left, 3rd - lower left and 4th 
- lower right. Power flow is generally positive in 
quadrants 1 and 4. VAR flow is positive in quadrants 1 
and 2. The most common load conditions are: Quadrant 
1 - power flow positive, VAR flow positive, inductive load, 
lagging or positive power factor; Quadrant 2 - power 
flow negative, VAR flow positive, capacitive load, leading 
or negative power factor. 

Register: An entry or record that stores a small amount of data. 

Register Rollover: A point at which a Register reaches its maximum value 
and rolls over to zero. 

Reset: Logs are cleared or new (or default) values are sent to 
counters or timers. 

Rolling Window 
Average (Power):

The Rolling (Sliding) Window Average is the average 
power calculated over a  user-set time interval that is 
derived from a specified number of sub-intervals, each 
of a specified time. For example, the average is 
calculated over a 15-minute interval by calculating the 
sum of the average of three consecutive 5-minute 
intervals. This demand calculation methodology has 
been adopted by several utilities to prevent customer 
manipulation of kW demand by simply spreading peak 
demand across two intervals. 

RS-232: A type of serial network connection that connects two 
devices to enable communication between devices. An 
RS-232 connection connects only two points. Distance 
between devices is typically limited to fairly short runs. 
Current standards recommend a maximum of 50 feet 
but some users have had success with runs up to 100 
feet. Communications speed is typically in the range of 
1200 bits per second to 57,600 bits per second. RS-232 
connection can be accomplished using Port 1 of the EPM 
9450/9650 or the Optical Port on the face of the EPM 
9800. 
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RS-485: A type of serial network connection that connects two or 
more devices to enable communication between the 
devices. An RS-485 connection will allow multi-drop 
communication from one to many points. Distance 
between devices is typically limited to around 2,000 to 
3,000 wire feet. Communications speed is typically in the 
range of 120 bits per second to 115,000 bits per second. 

Sag: A voltage quality event during which the RMS voltage is 
lower than normal for a period of time, typically from 1/2 
cycle to 1 minute. 

Secondary Rated: Any Register or pulse output that does not use any CT or 
VT Ratio. 

Serial Port: The type of port used to directly interface with a PC. 

Slave Device: In Modbus communication, a Slave Device only receives 
a Request Packet from a Master Device and responds to 
the request. A Slave Device cannot initiate 
communication. 

Swell: A voltage quality event during which the RMS voltage is 
higher than normal for a period of time, typically from 1/
2 cycle to 1 minute. 

THD: Total Harmonic Distortion is the combined effect of all 
harmonics measured in a voltage or current. The THD 
number is expressed as a percent of the fundamental. 
For example, a 3% THD indicates that the magnitude of 
all harmonic distortion measured equals 3% of the 
magnitude of the fundamental 60Hz quantity. 

Time Stamp: A stored representation of the time of an event. Time 
Stamp can include year, month, day, hour, minute and 
second and Daylight Savings Time indication. 

TOU: Time of Use. 

Uncompensated Power: VA, Watt and VAR readings not adjusted by Transformer 
Loss Compensation. 

V2T Threshold: Data will stop accumulating when voltage falls below 
programmed level. 

Voltage Imbalance: The ratio of the voltage on a phase to the average 
voltage on all phases. 

Voltage Quality Event: An instance of abnormal voltage on a phase. The events 
the meter will track include sags, swells, interruptions 
and imbalances. 

VT Ratio: The Voltage Transformer Ratio is used to scale the value 
of the voltage to the primary side of an instrument 
transformer. Also referred to as PT Ratio. 
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Voltage, Vab: Vab, Vbc, Vca are all Phase-to-Phase voltage 
measurements. These voltages are measured between 
the three phase voltage inputs to the meter. 

Voltage, Van: Van, Vbn, Vcn are all Phase-to-Neutral voltages applied 
to the monitor. These voltages are measured between 
the phase voltage inputs and Vn input to the meter. 
Technologically, these voltages can be “measured” even 
when the meter is in a Delta configuration and there is 
no connection to the Vn input. However, in this 
configuration, these voltages have limited meaning and 
are typically not reported. 

Voltage, Vaux: This is the fourth voltage input measured from between 
the Vaux and Vref inputs. This input can be scaled to any 
value. However, the actual input voltage to the meter 
should be of the same magnitude as the voltages 
applied to the Va, Vb and Vc terminals.
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